Thank you for purchasing the Daqstation DX1000 (hereafter referred to as “DX”). This User’s Manual explains how to use the useful functions of the DX. To ensure correct use, please read this manual thoroughly before operation.

The following manuals are provided for the DX:

- **Paper Manual**

<table>
<thead>
<tr>
<th>Manual Title</th>
<th>Manual No.</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DX1000 Operation Guide</td>
<td>IM 04L41B01-02E</td>
<td>Explains the basic operations of the DX. It is also provided in the CD-ROM.</td>
</tr>
<tr>
<td>Control of Pollution Caused by the Product</td>
<td>IM 04L41B01-91C</td>
<td>Gives a description of pollution control.</td>
</tr>
</tbody>
</table>

- **Electronic Manuals Provided on the Accompanying CD-ROM**

<table>
<thead>
<tr>
<th>Manual Title</th>
<th>Manual No.</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DX1000/DX1000N Operation Guide</td>
<td>IM 04L41B01-02E</td>
<td>This is the electronic version of the paper manual.</td>
</tr>
<tr>
<td>DX1000/DX1000N User’s Manual</td>
<td>IM 04L41B01-01E</td>
<td>Describes how to use the application functions. The communication and network functions, custom display functions, and some of the options are excluded.</td>
</tr>
<tr>
<td>DX1000/DX1000N/DX2000 Multi Batch (/BT2) User’s Manual</td>
<td>IM 04L41B01-03E</td>
<td>Describes how to use the multi batch function (/BT2 option).</td>
</tr>
<tr>
<td>DX1000/DX1000N/DX2000 Custom Display User’s Manual</td>
<td>IM 04L41B01-04E</td>
<td>Describes how to use the custom display function.</td>
</tr>
<tr>
<td>DX1000/DX1000N/DX2000 Communication Interface User’s Manual</td>
<td>IM 04L41B01-17E</td>
<td>Describes how to use communication functions through an Ethernet or serial interface.</td>
</tr>
<tr>
<td>DX1000/DX1000N/DX2000 EtherNet/IP Communication Interface User’s Manual</td>
<td>IM 04L41B01-18E</td>
<td>Describes how to use communication functions through an EtherNet/IP interface.</td>
</tr>
<tr>
<td>DX1000/DX1000N/DX2000 PROFINET-DP (/CP1) Communication Interface User’s Manual</td>
<td>IM 04L41B01-19E</td>
<td>Describes how to use communication functions through the PROFINET-DP interface (/CP1 option).</td>
</tr>
</tbody>
</table>

- **DAQSTANDARD Manuals**

All manuals other than IM 04L41B01-66EN are contained in the DAQSTANDARD CD.

<table>
<thead>
<tr>
<th>Manual Title</th>
<th>Manual No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>DAQSTANDARD Data Viewer User’s Manual</td>
<td>IM 04L41B01-63EN</td>
</tr>
<tr>
<td>DAQSTANDARD Hardware Configurator User’s Manual</td>
<td>IM 04L41B01-64EN</td>
</tr>
<tr>
<td>DAQSTANDARD DX100P/DX200P Configurator User’s Manual</td>
<td>IM 04L41B01-65EN</td>
</tr>
<tr>
<td>Installing DAQSTANDARD</td>
<td>IM 04L41B01-66EN</td>
</tr>
</tbody>
</table>
Notes

- The contents of this manual are subject to change without prior notice as a result of continuing improvements to the instrument’s performance and functions.
- Every effort has been made in the preparation of this manual to ensure the accuracy of its contents. However, should you have any questions or find any errors, please contact your nearest YOKOGAWA dealer.
- Copying or reproducing all or any part of the contents of this manual without YOKOGAWA’s permission is strictly prohibited.
- The TCP/IP software of this product and the document concerning the TCP/IP software have been developed/created by YOKOGAWA based on the BSD Networking Software, Release 1 that has been licensed from the Regents of the University of California.

Trademarks

- vigilantplant, DAQSTATION, Daqstation, and DXAdvanced are registered trademarks of Yokogawa Electric Corporation.
- Microsoft and Windows are registered trademarks or trademarks of Microsoft Corporation in the United States and/or other countries.
- Adobe and Acrobat are registered trademarks or trademarks of Adobe Systems Incorporated.
- Kerberos is a trademark of the Massachusetts Institute of Technology (MIT).
- Company and product names that appear in this manual are registered trademarks or trademarks of their respective holders.
- The company and product names used in this manual are not accompanied by the registered trademark or trademark symbols (® and ™).

Revisions

First edition: December 2005
Second edition: October 2006
Third edition: April 2007
Fourth edition: December 2007
Fifth Edition: November 2008
Sixth edition: March 2010
## DX’s Version and Functions Described in This Manual

The contents of this manual corresponds to the DX with release number 4 and style number 3.

### DX’s Version and Functions

For the procedure to check the version, see section 2.5.

<table>
<thead>
<tr>
<th>Edition</th>
<th>DX</th>
<th>Addition and change to functions</th>
<th>Refer to</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Version 1.11</td>
<td>(Added) German, French, and Chinese as display language</td>
<td>Section 2.6</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(Added) Modbus client connection retry interval: 10 s, 20 s, and 30 s</td>
<td>Section 1.0 in IM04L41B01-17E</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(Added) 24 VDC/AC power supply (P1 option)</td>
<td>IM04L41B01-02E</td>
</tr>
<tr>
<td></td>
<td>Version 1.21</td>
<td>(Added) Tab key on the USB keyboard corresponds to arrow keys.</td>
<td>Section 2.11</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(Added) Operations to request and release network information</td>
<td>Section 1.3 in IM04L41B01-17E</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(Changed) Modbus client: Function to connect a server with a unit number is changed.</td>
<td>Section 1.10 in IM04L41B01-17E</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(Changed) Modbus registers (floating point type for communication input data)</td>
<td>Section 6.3 in IM04L41B01-17E</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(Added) A data output format (Skip or OFF channel data not output)</td>
<td>Section 3.7 in IM04L41B01-17E</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(changed) Error messages 105, 221, and 222 are added.</td>
<td>Section 10.1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(Changed) Error messages 215, 218, and 536 are changed.</td>
<td>Section 10.1</td>
</tr>
<tr>
<td>3</td>
<td>Release number 2</td>
<td>(Added) Improvement to the operability on the historical trend display.</td>
<td>Section 4.3</td>
</tr>
<tr>
<td></td>
<td>(Version 2.0.0x)</td>
<td>(Changed) Displaying the date in the grid time of the trend display when the trend interval is greater than or equal to 1 h/div.</td>
<td>Sections 1.3 and 2.4</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(Added) Improvement to the display group setup operation.</td>
<td>Section 5.1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(Added) Addition of the Upper and Lower settings to the bar graph base position.</td>
<td>Section 5.11</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(Added) Addition of the relay action when alarm ACK is executed to the alarm output relay settings.</td>
<td>Sections 1.2, 3.5, and 3.8</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(Added) Ability to reset the computed value during computation.</td>
<td>Section 9.4</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(changed) Changes to how the data files are named.</td>
<td>Section 1.4</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(Added) Sorting the files by the update date/time.</td>
<td>Sections 6.7, 6.8, and 6.9</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(Added) Storage method for constantly retaining the most recent data files in the CF card (Media FIFO).</td>
<td>Sections 1.4 and 6.2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(Added) Progress display when saving all data of the internal memory.</td>
<td>Sections 4.8</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(Changed) Changing the initial display selection menu.</td>
<td>Sections 4.8 and 5.17</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(Changed) Improvement to the data save operation to the USB flash memory.</td>
<td>Sections 2.12 and 5.17</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(Changed) Retaining the state of the CapsLock and NumLock keys on the USB keyboard</td>
<td>Section 2.11</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(Changed) Changing the default setting of the web server function.</td>
<td>IM04L42B01-02E, Section 1.5 in IM04L41B01-17E</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(Added) Error messages, 513, 514, 515, and 516 have been added.</td>
<td>Section 10.1</td>
</tr>
<tr>
<td>4</td>
<td>Style number 2</td>
<td>(Added) The waterproof construction of the DX front panel complies with the NEMA4 standard</td>
<td>Section 12.6</td>
</tr>
<tr>
<td></td>
<td>edition 3</td>
<td>Added explanations. Fixed explanations.</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Changed the direction of the clamp input terminal (/H2 option)</td>
<td>IM04L4101-02E</td>
</tr>
</tbody>
</table>
# DX's Version and Functions Described in This Manual

<table>
<thead>
<tr>
<th>Edition</th>
<th>DX</th>
<th>Addition and change to functions</th>
<th>Refer to</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>Release number 3 (Version 3.0x)</td>
<td>Divided the setting mode displays with tabs</td>
<td>All setting displays</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Added method for switching from setting mode to basic setting mode</td>
<td>Section 2.14</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Improved numeric input operation</td>
<td>Numeric input display</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Added the ability to input the following characters: [ ] and :</td>
<td>Character string input display</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Added new input type (GOST, /N3 option)</td>
<td>Section 3.3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Increased measurement range for TC Type N</td>
<td>Section 12.5</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Custom display</td>
<td>IM04L41B01-04E</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Multi Batch (/BT2 option)</td>
<td>IM04L41B01-03E</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Alarm level display</td>
<td>Section 3.7</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Alarm annunciator</td>
<td>Section 3.12</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Common alarm (/F1 option)</td>
<td>Section 2.9</td>
</tr>
<tr>
<td></td>
<td></td>
<td>32-character tag comments and 16-character tag numbers</td>
<td>Section 5.2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Faster display update interval</td>
<td>Section 3.1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Secondary trend interval changeable during recording</td>
<td>Section 5.3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Added 15-, 20-, and 30-minute event data sample rates.</td>
<td>Section 6.1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Fine grid</td>
<td>Sections 4.2 and 4.3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Auto zone display</td>
<td>Sections 4.2 and 4.3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Indication that the DX is waiting for a trigger.</td>
<td>Section 1.3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Decimal point types “Point” and “Comma”</td>
<td>Section 2.13</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Added favorite key operations</td>
<td>Section 5.15</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Data searching with date and time</td>
<td>Section 4.3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Historical trend relative time display, auto span display, and top channel display.</td>
<td>Section 4.3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Number of batch text fields changed to 24</td>
<td>Section 6.3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The start recording screen appears when you press the start key while using the batch function</td>
<td>Section 6.3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Changed contents of the system and network information displays</td>
<td>Section 2.5</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Limits on setting load function</td>
<td>Section 8.1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Event switch</td>
<td>Section 7.1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Added “CommentDisplay” and “FavoriteDisplay” actions to the event action function</td>
<td>Section 7.1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Remote control contact input changed from operating on Close to operating on Open (/R1 and /PM1 options)</td>
<td>Section 7.1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Match time timer reset (/M1 and /PM1 Options)</td>
<td>Section 7.1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Added “Year” to match time timer conditions (/M1 and /PM1 options)</td>
<td>Section 7.1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Match time timer usable for TLOG computation (/M1 and /PM1 options)</td>
<td>Section 9.1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Stacked bar graphs for report data (/M1 and /PM1 options)</td>
<td>Section 4.10</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Added recording condition variables to equations (/M1 and /PM1 options)</td>
<td>Section 1.8</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Added USB barcode reader support (/USB1 option)</td>
<td>Section 2.11</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Saving of data from the internal memory to USB flash memory or a CF card (/USB1 option)</td>
<td>Section 2.12</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Added data searching, report layout display, a print button, and an FTP link to the Web server function.</td>
<td>Section 1.5 in IM04L41B01-17E</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Modbus register map expansion and floating-point data writing</td>
<td>Section 6.3 in IM04L41B01-17E</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Only send alarm e-mails when an alarm has occurred</td>
<td>Section 1.4 in IM04L41B01-17E</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Added tag and channel number to alarm e-mails</td>
<td>Section 1.4 in IM04L41B01-17E</td>
</tr>
<tr>
<td></td>
<td></td>
<td>E-mail transfer authentication (Pop Before SMTP)</td>
<td>Section 1.4 in IM04L41B01-17E</td>
</tr>
<tr>
<td></td>
<td></td>
<td>“°C” displayed in e-mails and the Web settings</td>
<td>Section 1.5 in IM04L41B01-17E</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Added the ability to input the square and cube characters (² and ³) in communications (only for English, German, and French)</td>
<td>Appendix 3 in IM04L41B01-17E</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Added FTP data transfer wait operation</td>
<td>Section 1.7 in IM04L41B01-17E</td>
</tr>
<tr>
<td></td>
<td></td>
<td>FTP server directory output format can be set to MS-DOS and UNIX.</td>
<td>Section 1.6 in IM04L41B01-17E</td>
</tr>
<tr>
<td></td>
<td></td>
<td>EtherNet/IP</td>
<td>IM04L41B01-18E</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PROFIBUS-DP (/CP1 option)</td>
<td>IM04L41B01-19E</td>
</tr>
</tbody>
</table>

**Style number 3**

Changed the boot ROM

---
## DX's Version and Functions Described in This Manual

<table>
<thead>
<tr>
<th>Edition</th>
<th>DX</th>
<th>Addition and change to functions</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>4</td>
<td>Advanced security function (/AS1 option)</td>
<td>IM04L41B01-05E</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Report template (/M1 and /PM1 options)</td>
<td>Section 9.6</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Added the &quot;Seprt2&quot; report file separation method</td>
<td>Section 9.6</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Calibration management (/CC1 option)</td>
<td>Section 9.5</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Added functions and improvements to the custom display. The main changes are listed below.</td>
<td>IM04L41B01-04E</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The status display section can be hidden.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Items have been added (system icons, group names, memory bar, date and time labels, batch group numbers, batch names, Modbus input).</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Custom grids can be displayed on the trend display.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>The bitmap data of the built-in screen is saved to internal memory.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Labels and tags can be displayed vertically.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Additional types of current value marks for the scale have been added.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>The scale unit indication can be hidden.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Time can be displayed on all grids on the trend display.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Group switching can be stopped.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Added an alarm sound to the Web server function</td>
<td>Section 1.5 in IM04L41B01-17E</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The DX outputs the Modbus input value specified in the custom display.</td>
<td>Sections 1.10 and 2.6 in IM04L41B01-17E</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The &quot;E-M&quot; command has been added for the Modbus client and master.</td>
<td>IM04L41B01-04E</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Authenticated e-mail transmission (Authentication SMTP)</td>
<td>Section 1.4 in IM04L41B01-17E</td>
</tr>
<tr>
<td></td>
<td></td>
<td>A switch from on to off can be specified as an event.</td>
<td>Section 7.1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The duration for which the reflash relays are deactivated can be set to 500 ms, 1 s, or 2 s.</td>
<td>Section 3.5</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Added new input type (Pt200(WEED); /N3 option)</td>
<td>Section 3.3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Text fields can be input when the batch function is being used and recording starts.</td>
<td>Section 6.3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The length of the user password that can be registered with the login function has been extended to 20 characters.</td>
<td>Section 8.2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Operations can be assigned to the output relays (/F1 and /F2 options).</td>
<td>Section 2.9</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Models with 400 MB of internal memory have been added (internal memory size suffix code: &quot;-3&quot;).</td>
<td>IM04L42B01-02E</td>
</tr>
<tr>
<td></td>
<td></td>
<td>MODEL and SUFFIX Code</td>
<td></td>
</tr>
</tbody>
</table>

---

**Notes:**

- **Model and Suffix Code:**
  - **MODEL** and **SUFFIX Code** are specific identifiers for certain DX models and configurations.
  - These codes are used to distinguish between different versions or configurations of the DX meters.

---

**Reference:**

- Sections 1.5, 9.6, 9.5, 3.13, 9.6, 3.3, 6.3, 3.5, 6.3, 8.2, 2.9, 1.5, 1.4, 1.4, 7.1.
How to Use This Manual

Structure of the Manual

Read the Operation Guide first to familiarize yourself with the basic operation, and then read this manual. For a description of the communication function and the accompanying software program, DAQSTANDARD, read the respective manual.

This user's manual consists of the following sections.

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title and Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Overview of Functions</td>
</tr>
<tr>
<td></td>
<td>Describes the functions of the DX.</td>
</tr>
<tr>
<td>2</td>
<td>Common Operations</td>
</tr>
<tr>
<td></td>
<td>Describes the procedure to set the time and the operating procedure using the remote control terminal (/KB1 or /KB2 option) and keyboard (/USB1 option).</td>
</tr>
<tr>
<td>3</td>
<td>Measurement Channels and Alarms</td>
</tr>
<tr>
<td></td>
<td>Describes how to set the measurement conditions and alarms.</td>
</tr>
<tr>
<td>4</td>
<td>Switching Operation Screens</td>
</tr>
<tr>
<td></td>
<td>Describes the operations on the operation screen.</td>
</tr>
<tr>
<td>5</td>
<td>Operations for Changing the Displayed Contents</td>
</tr>
<tr>
<td></td>
<td>Describes how to change the displayed contents on the operation screen and how to write messages.</td>
</tr>
<tr>
<td>6</td>
<td>Saving and Loading Data</td>
</tr>
<tr>
<td></td>
<td>Describes how to acquire and store the data. Also describes the procedure to load measured data/setup data on the CF card or the USB flash memory (/USB1 option).</td>
</tr>
<tr>
<td>7</td>
<td>Customizing Actions Using the Event Action and Remote Control Functions (/R1 and /PM1 Options)</td>
</tr>
<tr>
<td></td>
<td>Describes how to carry out specific actions when a given event occurs, when a remote control signal is applied, and when the USER key is pressed.</td>
</tr>
<tr>
<td>8</td>
<td>Using the Security Function</td>
</tr>
<tr>
<td></td>
<td>Describes how to use the key lock function and the function that allows only registered users to operate the DX.</td>
</tr>
<tr>
<td>9</td>
<td>Computation and Report Functions (/M1 and /PM1 Options)</td>
</tr>
<tr>
<td></td>
<td>Describes how to use computation channels and how to create reports such as hourly, daily, weekly, and monthly reports.</td>
</tr>
<tr>
<td>10</td>
<td>Troubleshooting</td>
</tr>
<tr>
<td></td>
<td>Describes error messages and troubleshooting.</td>
</tr>
<tr>
<td>11</td>
<td>Maintenance</td>
</tr>
<tr>
<td></td>
<td>Describes periodic inspection and calibration.</td>
</tr>
<tr>
<td>12</td>
<td>Specifications</td>
</tr>
<tr>
<td></td>
<td>Lists the specifications of the DX.</td>
</tr>
</tbody>
</table>

Appendix

Describes how to estimate the file size, the types of data that the DX can generated and how to use them, the data format of text files, etc.

Index

Note

• This user's manual covers information regarding DX1000s that have a suffix code for language "-2" (English).
• For details on setting the display language, see section 2.6, "Changing the Displayed Language."
Conventions Used in This Manual

Unit

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Denotes 1024. Example: 768 KB (file size)</th>
</tr>
</thead>
<tbody>
<tr>
<td>K</td>
<td>Denotes 1000.</td>
</tr>
</tbody>
</table>

Markings

- **WARNING**: Improper handling or use can lead to injury to the user or damage to the instrument. This symbol appears on the instrument to indicate that the user must refer to the user's manual for special instructions. The same symbol appears in the corresponding place in the user’s manual to identify those instructions. In the manual, the symbol is used in conjunction with the word "WARNING" or "CAUTION."

- **WARNING**: Calls attention to actions or conditions that could cause serious or fatal injury to the user, and precautions that can be taken to prevent such occurrences.

- **CAUTION**: Calls attentions to actions or conditions that could cause light injury to the user or damage to the instrument or user’s data, and precautions that can be taken to prevent such occurrences.

- **Note**: Calls attention to information that is important for proper operation of the instrument.

Subheadings

- **Bold characters**: Denotes key or character strings that appear on the screen. Example: **Volt**

- **AA** Indicates character types that can be used.
  - Uppercase alphabet, lowercase alphabet, symbols, numbers.

- **Procedure**: Carry out the procedure according to the step numbers.

- **Explanation**: All procedures are written with inexperienced users in mind; depending on the operation, not all steps need to be taken. Explanation gives information such as limitations related the procedure.

- **Setup Screen**: Indicates the setup screen and explains the settings. A detailed description of the function is not provided in this section. For details on the function, see chapter 1.
Contents

DX's Version and Functions Described in This Manual ........................................... iii
How to Use This Manual ......................................................................................... vi

Chapter 1 Overview of Functions
1.1 Input Section ......................................................................................................... 1-1
1.2 Alarms .................................................................................................................. 1-4
1.3 Display ................................................................................................................ 1-9
1.4 Data Storage Function ......................................................................................... 1-26
1.5 Batch Function .................................................................................................... 1-36
1.6 Event Action and Remote Control Functions (/R1 and /PM1 Options) ............... 1-37
1.7 Security Function ............................................................................................... 1-42
1.8 Computation and Report Function (/M1 and /PM1 Options) ............................. 1-44
1.9 FAIL/Status Output Function (/F1 Option) ....................................................... 1-52
1.10 Other Functions ................................................................................................. 1-54

Chapter 2 Common Operations
2.1 Setting the Date/Time .......................................................................................... 2-1
2.2 Setting the Time Difference from GMT ............................................................... 2-2
2.3 Setting the Time Correction Operation during Memory Sampling .................. 2-3
2.4 Setting the Date Format ....................................................................................... 2-4
2.5 Viewing the DX Information ............................................................................... 2-5
2.6 Changing the Displayed Language ..................................................................... 2-7
2.7 Setting the LCD Brightness and Backlight Saver ............................................. 2-8
2.8 Initializing Settings and Clearing the Internal Memory ................................. 2-9
2.9 Outputting the DX Status via the Relay Contact (/F1 Option) ......................... 2-11
2.10 Controlling the DX with the Remote Control Terminal (/KB1 and /KB2 Options) 2-14
2.11 Controlling the DX with a Keyboard or Barcode Reader (/USB1 option) ....... 2-19
2.12 Using the USB Flash Memory (/USB1 Option) ............................................... 2-24
2.13 Setting the Decimal Point Type (Release number 3 or later) ......................... 2-26
2.14 Showing or Hiding the Menu Item for Switching from Setting Mode to Basic Setting Mode (Release number 3 or later) .................................................. 2-27

Chapter 3 Measurement Channels and Alarms
3.1 Setting the Scan Interval and the Integration Time of the A/D Converter .......... 3-1
3.2 Setting the Burnout Detection and the Reference Junction Compensation of the Thermocouple Input ................................................................. 3-2
3.3 Setting the Input Range ...................................................................................... 3-3
3.4 Setting the Moving Average of the Input ........................................................... 3-6
3.5 Setting the Auxiliary Alarm Function ............................................................... 3-7
3.6 Hiding the Alarm Indication .............................................................................. 3-10
3.7 Setting Alarms on Channels ............................................................................. 3-11
3.8 Releasing the Alarm Output (Alarm ACK Operation) ..................................... 3-15
3.9 Performing Calibration Correction (/CC1 Option) ........................................... 3-16
3.10 Counting Pulses (/PM1 Option) ....................................................................... 3-17
3.11 Setting the Method of Detecting Over-Range Values of Linearly Scaled Measurement Channels ................................................................. 3-20
3.12 Using the Alarm Annunciator Function (Release number 3 or later) .............. 3-21
3.13 Managing the Input Calibration Interval (/IC1 option; release numbers 4 and later) . 3-30
Chapter 4  Switching Operation Screens

4.1  Operations in Operation Mode ................................................................. 4-1
4.2  Displaying the Measured Data as Waveforms, Values, or Bar Graphs .......... 4-4
4.3  Displaying Past Measured Data (Historical Trend Display) ...................... 4-9
4.4  Display the Statuses of All Channels on One Screen (Overview Display) ... 4-22
4.5  Displaying Various Information ............................................................... 4-25
4.6  Using the Alarm Summary ....................................................................... 4-28
4.7  Using the Message Summary ................................................................. 4-30
4.8  Using the Memory Summary .................................................................... 4-32
4.9  Displaying a List of Operation Logs ....................................................... 4-35
4.10 Displaying Stacked Bar Graphs (/M1 and /PM1 options; release number 3 or later) .... 4-40

Chapter 5  Operations for Changing the Displayed Contents

5.1  Setting Display Groups ........................................................................... 5-1
5.2  Displaying Tags or Channel Numbers ..................................................... 5-3
5.3  Setting the Trend Interval and Switching to the Secondary Trend Interval ... 5-5
5.4  Writing Messages .................................................................................... 5-7
5.5  Changing the Channel Display Colors ................................................... 5-10
5.6  Displaying Channels in Display Zones ................................................... 5-11
5.7  Displaying a Scale on the Trend Display ............................................... 5-12
5.8  Displaying Alarm Point Marks and Color Scale Band on the Scale .......... 5-15
5.9  Partially Expanding the Waveform ....................................................... 5-17
5.10 Changing the Display Layout, Clearing of the Waveform at Start, Message Display Direction, Waveform Line Width, and Grid .................................................. 5-19
5.11 Changing the Bar Graph Display Method ............................................... 5-20
5.12 Changing the Background Color of the Display .................................... 5-23
5.13 Automatically Switching Display Groups ............................................... 5-24
5.14 Automatically Switching Back to the Default Display .......................... 5-25
5.15 Using the Favorite Key ........................................................................... 5-26
5.16 Writing a Message When the DX Recovers from a Power Failure .......... 5-28
5.17 Changing the FUNC Key Menu and Display Selection Menu ............... 5-29
5.18 Displaying Comments (Release number 3 or later) .................................. 5-33

Chapter 6  Saving and Loading Data

6.1  Setting the Recording Conditions of the Measured Data ....................... 6-1
6.2  Setting the Method for Saving the Data ................................................ 6-4
6.3  Using the Batch Function ....................................................................... 6-6
6.4  Starting/Stopping the Recording and Saving the Measured data ............ 6-10
6.5  Manually Saving the Measured Data (Manual Sample) .......................... 6-14
6.6  Saving the Screen Image Data (Snapshot) ............................................ 6-15
6.7  Managing the Files on the Storage Medium ....................................... 6-16
6.8  Loading and Displaying the Measured Data in the Storage Medium .... 6-18
6.9  Saving/Loading the Setup Data ............................................................. 6-19
6.10 Loading and Saving Report Templates (/M1 and /PM1 options; release numbers 4 and later) ......................... 6-22
Contents

Chapter 7 Customizing Actions Using the Event Action and Remote Control Functions (/R1 and /PM1 Options)

7.1 Setting the Event Action Function (Including the remote control function of the /R1 and /PM1 options and the USER key) ................................................................. 7-1
7.2 Setup Examples of Event Action .............................................................................. 7-7
7.3 Changing the Response to Remote Contact Input Opening and Closing (/R1 and /PM1 options; release number 3 or later) ................................................................. 7-10

Chapter 8 Using the Security Function

8.1 Disabling the Key Operation (Key Lock Function) .......................................................... 8-1
8.2 Enabling Only Registered Users to Operate the DX (Login Function) ........................ 8-3
8.3 Logging in and Logging Out ........................................................................................ 8-6

Chapter 9 Computation and Report Functions (/M1 and /PM1 Options)

9.1 Setting the Expression, Measurement Range, Alarm, Tag, and Data Storage on Computation Channels ........................................................................................................ 9-1
9.2 Writing Expressions ..................................................................................................... 9-5
9.3 Displaying the Computation Channels ......................................................................... 9-11
9.4 Starting/Stopping Computation, Resetting Computation, and Releasing Computation Data Dropout Display .............................................................................................. 9-14
9.5 Creating Reports ......................................................................................................... 9-16
9.6 Creating a Report Template (Release numbers 4 and later) .......................................... 9-19

Chapter 10 Troubleshooting

10.1 A List of Messages .................................................................................................... 10-1
10.2 Troubleshooting ......................................................................................................... 10-21

Chapter 11 Calibration

11.1 Periodic Inspection .................................................................................................. 11-1
11.2 Calibrating the DX ................................................................................................... 11-2
11.3 Pulling Out the Inner Instrument (DX1000N) ............................................................ 11-4

Chapter 12 Specifications

12.1 Signal Input and Alarm ........................................................................................... 12-1
12.2 Display Function ....................................................................................................... 12-3
12.3 Data Saving Function ............................................................................................... 12-6
12.4 Other Standard Functions ....................................................................................... 12-9
12.5 Options .................................................................................................................... 12-11
12.6 General Specifications ............................................................................................. 12-19
12.7 External Dimensions ............................................................................................... 12-24

Appendix

Appendix 1 File Size of Display Data and Event Data .................................................. App-1
Appendix 2 Types of Data Files That the DX Can Create and Their Application .......... App-4
Appendix 3 Text File Data Format ................................................................................ App-5

Index
1.1 Input Section

Measurement Channel

- **Number of Measurement Channels and Scan Interval**
  The DX samples the input signals on the measurement channels at the scan interval to obtain the measured values. The table below shows the relationship between the number of measurement channels and the scan interval.

<table>
<thead>
<tr>
<th>Model</th>
<th>No. of Measurement Channels</th>
<th>Normal Mode</th>
<th>Fast Sampling Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>DX1002, DX1002N</td>
<td>2</td>
<td>125 ms, 250 ms</td>
<td>25 ms</td>
</tr>
<tr>
<td>DX1004, DX1004N</td>
<td>4</td>
<td>1 s, 2 s, 5 s</td>
<td>125 ms</td>
</tr>
<tr>
<td>DX1006, DX1006N</td>
<td>6</td>
<td>2 s, 5 s</td>
<td>125 ms</td>
</tr>
<tr>
<td>DX1012, DX1012N</td>
<td>12</td>
<td>125 ms</td>
<td>600 Hz (fixed)</td>
</tr>
</tbody>
</table>

For the setting procedure, see section 3.1.

- **Integration Time of the A/D Converter**
  The DX uses an A/D converter to convert the sampled analog signal to a digital signal. By setting the integration time of the A/D converter to match the time period corresponding to one cycle of the power supply or an integer multiple of one cycle, the power supply frequency noise can be effectively eliminated.
  - Because 100 ms is an integer multiple of 16.7 ms and 20 ms, this setting can be used to eliminate the power frequency noise for both frequency, 50 Hz and 60 Hz.
  - In fast sampling mode, the performance of eliminating power frequency noise is worse than in normal mode. We recommend that you use normal mode when making measurements in an environment affected by power frequency noise.

For the setting procedure, see section 3.1.

Input Type and Computation

You can make measurements using the following input types.

<table>
<thead>
<tr>
<th>Input Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DC voltage</td>
<td>You can measure DC voltages in the range of ±20 mV to ±50 V.</td>
</tr>
<tr>
<td>DC current</td>
<td>You can measure a DC current signal by converting it to a voltage signal using a shunt resistor attached to the input terminal. The converted signal can be measured within the DC voltage range (see above).</td>
</tr>
<tr>
<td>Thermocouple</td>
<td>You can measure temperatures corresponding to these thermocouple types: R, S, B, K, E, J, T, N, W, L, U, and WRe3-25. It is also possible to measure using other thermocouples, such as PR40-20 and PLATINEL.</td>
</tr>
<tr>
<td>RTD</td>
<td>You can measure temperatures using RTD types Pt100 and JPt100. It is also possible to measure using other RTD types such as Cu10, Cu25, Pt50, and Ni100.</td>
</tr>
<tr>
<td>ON/OFF input</td>
<td>You can display contact input or voltage input signals correlated to 0% or 100% of the display range. Contact input: A closed contact is on (1). An open contact is off (0). Voltage input: Less than 2.4 V is off (0), 2.4 V or more is on (1).</td>
</tr>
<tr>
<td>Pulse input</td>
<td>You can count pulses.</td>
</tr>
</tbody>
</table>

*1 Item sold separately. For example, you can use a 250-Ω shunt resistor to convert a 4- to 20-mA signal to a 1- to 5-V signal.

*2 /N3 option
*3 /N1 option
*4 /PM1 option
The following input processing and computation are available.

**DC Voltage**
- Shunt resistor
- DC current

**1 - 5 V**
- Burnout detection

**Thermocouple**
- Burnout detection

**RTD**

**ON/OFF input**

**Pulse** (PM1 Option)
- Convert to number of pulses over 1 second

**Dotted lines indicate that the function can be selected.**

<table>
<thead>
<tr>
<th>Reference Junction Compensation</th>
<th>Burnout Detection</th>
</tr>
</thead>
<tbody>
<tr>
<td>Performs reference junction compensation on the thermocouple.</td>
<td>Detects and indicates a burnout in the sensor.</td>
</tr>
<tr>
<td>Thermocouple</td>
<td>Burnout</td>
</tr>
<tr>
<td>Thermocouple</td>
<td>Thermoelectromotive force</td>
</tr>
<tr>
<td>External reference junction</td>
<td>Indicated as Burnout.</td>
</tr>
<tr>
<td>Internal reference junction</td>
<td>Indicated as Burnout.</td>
</tr>
</tbody>
</table>

For the setting procedure, see section 3.2.

## Moving Average

<table>
<thead>
<tr>
<th>Sampling data in the buffer</th>
<th>Measured value</th>
<th>New sampled data</th>
<th>New sampled data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1st time</td>
<td>10.0 mV</td>
<td>15.0 mV</td>
<td>10.0 mV</td>
</tr>
<tr>
<td>2nd time</td>
<td>5.0 mV</td>
<td>10.0 mV</td>
<td>15.0 mV</td>
</tr>
<tr>
<td>3rd time</td>
<td>0.0 mV</td>
<td>5.0 mV</td>
<td>10.0 mV</td>
</tr>
</tbody>
</table>

For the setting procedure, see section 3.4.
## 1.1 Input Section

### Square Root Computation

Takes the square root of the input value and converts the unit to obtain the measured value.

\[
X = \sqrt{\frac{B - A}{b - a}} + A
\]

For the setting procedure, see section 3.3.

### Linear Scaling

Converts the unit to obtain the measured value.

\[
\begin{align*}
10 \text{ V} & \rightarrow 300 \degree C \\
0 \text{ V} & \rightarrow -100 \degree C
\end{align*}
\]

For the setting procedure, see section 3.3.

### Calibration Correction (/CC1 Option)

Corrects the input value with the characteristics specified by segments to obtain the measured value.

For the setting procedure, see section 3.9.

### Low-cut

For square root computation, measured values below the specified value are cut. For 1-5 V input, values below 0 % are cut.

For the setting procedure, see section 3.3.

### Difference computation

The measured value of the channel is set to the difference with respect to the measured value of the reference channel.

For the setting procedure, see section 3.3.

### Pulse Input (/PM1 Option)

Pulse that can be counted

Pulse

100 Hz or less

Contact

or

Open collector

Count on the DX

The contact changes from open to close.

The signal level at the input terminal changes from high to low.

For the setting procedure, see section 3.10.

### Note

Difference computation is executed even if the input type or range is not the same between the difference computation channel and the reference channel. The difference is computed after discarding the decimal place and unit, and the decimal place and unit of the difference computation channel are applied.

Example 1: If the input value of the difference computation channel is 10.00 and the measured value of the reference channel is 100.0, the computed result is 10.00 – 100.0 = –90.0.

Example 2: If the input value of the difference computation channel is 10.00 V and the measured value of the reference channel is 5.00 mV, the computed result is 10.00 V – 5.00 mV = 5.00 V.

### Calibration Management (/CC1 option; release numbers 4 and later)

You can use this function to make sure that calibration is performed regularly.

When you enable calibration management, a screen (the calibration notification screen) appears to notify you in advance that the calibration due date is approaching.

For the setting procedure, see section 3.13.
### 1.2 Alarms

This function generates an alarm when the measured data meets a certain condition. Up to four alarms can be set for each channel.

#### Alarm Type

You can use the alarms shown below. The character inside the parentheses is the symbol denoting each alarm.

For the alarm setting procedure, see section 3.7.

<table>
<thead>
<tr>
<th>High Limit Alarm (H)</th>
<th>Low Limit Alarm (L)</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="High Limit Alarm Diagram" /></td>
<td><img src="image" alt="Low Limit Alarm Diagram" /></td>
</tr>
<tr>
<td>Alarm value</td>
<td>Alarm value</td>
</tr>
<tr>
<td>Measured value</td>
<td>Hysteresis</td>
</tr>
<tr>
<td>Alarm output ON</td>
<td>Alarm output ON</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Delay High Limit Alarm (T)</th>
<th>Delay Low Limit Alarm (t)</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Delay High Limit Alarm Diagram" /></td>
<td><img src="image" alt="Delay Low Limit Alarm Diagram" /></td>
</tr>
<tr>
<td>Alarm value</td>
<td>Alarm value</td>
</tr>
<tr>
<td>Delay time</td>
<td>Delay time</td>
</tr>
<tr>
<td>Measured value</td>
<td>Measured value</td>
</tr>
<tr>
<td>Alarm output ON</td>
<td>Alarm output ON</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>High Limit on Rate-of-Change Alarm (R)</th>
<th>Low Limit on Rate-of-Change Alarm (r)</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="High Limit on Rate-of-Change Alarm Diagram" /></td>
<td><img src="image" alt="Low Limit on Rate-of-Change Alarm Diagram" /></td>
</tr>
<tr>
<td>Measured value</td>
<td>Measured value</td>
</tr>
<tr>
<td>Change in the measured value</td>
<td>Amount of change in the setting</td>
</tr>
<tr>
<td>Interval (t2-t1)</td>
<td>Amount of change in the setting</td>
</tr>
<tr>
<td>Time</td>
<td>Time</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Difference High Limit Alarm (h)</th>
<th>Difference Low Limit Alarm (l)</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Difference High Limit Alarm Diagram" /></td>
<td><img src="image" alt="Difference Low Limit Alarm Diagram" /></td>
</tr>
<tr>
<td>Difference in the measured values of two channels</td>
<td>Difference in the measured values of two channels</td>
</tr>
<tr>
<td>Alarm value</td>
<td>Alarm value</td>
</tr>
<tr>
<td>Hysteresis</td>
<td>Hysteresis</td>
</tr>
<tr>
<td>Alarm output ON</td>
<td>Alarm output ON</td>
</tr>
</tbody>
</table>

- **Alarm Hysteresis**
  You can set a width (hysteresis) to the value used to activate and release alarms.

- **Delay High Limit Alarm and Delay Low Limit Alarm**
  An alarm occurs when the measured value remains above or below the alarm value for a specified time period (delay period).

- **High Limit on Rate-of-Change Alarm and Low Limit on Rate-of-Change Alarm**
  The rate-of-change of the measured values is checked over a certain time (interval). An alarm occurs if the rate-of-change of the measured value in the rising/falling direction is greater than or equal to the specified value. The alarm value of the rate-of-change alarm is set using an absolute value. The interval is derived using the following equation and set using the number of samples.

  \[
  \text{Interval} = \text{the scan interval} \times \text{the number of samples}
  \]

  For the setting procedure, see section 3.5.

- **Difference Upper Limit Alarm and Difference Lower Limit Alarm**
  An alarm occurs when the difference in the values of two channels is greater/less than or equal to the specified value. These alarms can be specified on measurement channels set to difference computation.
1.2 Alarms

Alarm Indication

The alarm conditions are displayed as alarm icons in the status display section and on the operation screen such as the trend, digital, bar graph, overview displays. Detailed information about the alarms is displayed in the alarm summary.

- **Alarm Levels and Colors (Release number 3 or later)**

  You can set separate levels and colors for the four alarms on a single channel. When multiple alarms occur, the DX gives higher priority to the display of alarms with higher levels. It is easy to understand what processes are taking place when alarms occur if you associate an alarm's color with its level. Level and color settings are the same for each channel.

  - In the overview display, the channel display area appears in the color of the alarm that has occurred.

  - The following items also appear in the color of the alarm that has occurred.
    - Alarm marks in the trend, digital, and bar graph displays
    - The alarm point marks on scales (when they are set to “Alarm”)
    - The alarm occurrence mark in the alarm summary

When multiple alarms occur on the same channel, the various displays respond as described below:

- In the overview display, the channel display area is displayed using the color of the alarm with the highest priority level.
- In the trend and digital displays, the alarm type is displayed using the symbol for the alarm with the highest priority level.
- In the annunciator display, the display window is displayed using the color of the alarm with the highest priority level.

For the setting procedure, see section 3.7.

- **Alarm-Activated Text Display (Release number 3 or later)**

  You can set strings of text to appear when alarms occur.

  For the setting procedure, see section 5.18.

- **Hold/Non-hold of Indications**

  The alarm indication can be set to operate in the following fashion when the condition is no longer met.

  - Clear the alarm indication (non-hold).
  - Hold the alarm indication until the alarm ACK operation is executed (hold).

  The default setting is non-hold.

  For the setting procedure, see section 3.5.

- **Alarm Hide Function**

  No indication is made when an alarm occurs. The alarm is also not recorded in the alarm summary. The alarm is output to the relay (/A[ ] option) or internal switch. This function can be set for each channel and each alarm.

  For the setting procedure, see section 3.6.
## 1.2 Alarms

**Alarm Output Relay Operation**

Contact signals can be generated from alarm output relays (/A_ option) when alarms occur. The alarm output relay operation can be changed. For the setting procedure, see section 3.5.

<table>
<thead>
<tr>
<th>Reflash</th>
<th>Non-hold/Hold</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm</td>
<td></td>
</tr>
<tr>
<td>Channel 1</td>
<td></td>
</tr>
<tr>
<td>Channel 2</td>
<td></td>
</tr>
<tr>
<td>Channel 3</td>
<td></td>
</tr>
</tbody>
</table>

**Alarm output relay (Reflash on)**

500 ms, 1 s, or 2 s

**Alarm output relay (Reflash off)**

(when a relay is set to OR logic)

---

### AND/OR

<table>
<thead>
<tr>
<th>Alarm</th>
<th>Alarm output relay or internal switch</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel 1</td>
<td>AND</td>
</tr>
<tr>
<td>Channel 2</td>
<td>OR</td>
</tr>
</tbody>
</table>

(You can set AND/OR for the alarm output relay and internal switch. For details about the internal switch, see the next page.)

---

**Energize or De-energize**

<table>
<thead>
<tr>
<th>Energize</th>
<th>When power is shut down</th>
<th>Normal operation</th>
<th>When an alarm is occurring</th>
</tr>
</thead>
<tbody>
<tr>
<td>NO C NC</td>
<td>NO C NC</td>
<td>NO C NC</td>
<td>NO C NC</td>
</tr>
</tbody>
</table>

| De-energize |                        |                  |                            |
| NO C NC     |                        |                  |                            |

**Relay Action on ACK**

**Hold**

<table>
<thead>
<tr>
<th>Alarm output relay</th>
<th>Activated</th>
<th>Deactivated</th>
</tr>
</thead>
<tbody>
<tr>
<td>Non-hold</td>
<td>Activated</td>
<td>Deactivated</td>
</tr>
<tr>
<td>Hold</td>
<td>Activated</td>
<td>Deactivated</td>
</tr>
</tbody>
</table>

**Alarm ACK**

Relay is activated at the next scan interval.

Relay is activated when the next alarm occurs.

---

- **Reflash**
  
  When multiple alarms are assigned to one alarm output relay, this function notifies the occurrence of subsequent alarms after the relay is activated by the first alarm. When subsequent alarms occur, the output relay is released temporarily. The duration for which the relays are deactivated can be set to 500 ms, 1 s, or 2 s. The reflash function is set on the first three output relays.
  
  * I01 to I03 or I11 to I13. I01 and I02 for the /A1 option.

  **Note**

  When reflash is enabled, the first three output relays are used exclusively as reflash relays. The first three output relays are set to OR logic and de-energize operation regardless of the AND/OR and energize/de-energize settings explained below.

- **AND/OR**
  
  When multiple alarms are assigned to one alarm output relay, the condition for activating the output relay can be selected from the following: You can select AND operation also for the internal switch.
  
  - **AND**: Activated when all assigned alarms are occurring simultaneously.
  - **OR**: Activated when any of the specified alarms is occurring.
- **Energize or De-energize Operation**
  You can select whether the alarm output relay is energized or de-energized when an alarm occurs. If de-energized is selected, the status of the alarm output relay when an alarm occurs is the same as the status that results when the DX power is shut down. The setting applies to all alarm output relays.

- **Non-Hold/Hold**
  The alarm output relay can be set to operate in the following fashion when the alarm condition is no longer met.
  - Turn OFF the relay output (non-hold).
  - Hold the relay at ON until the alarm ACK operation is executed (hold).
  The setting applies to all alarm output relays.

- **Alarm ACK Operation**
  The alarm acknowledge (alarm ACK) operation releases all alarm indications and relay outputs. For the action of alarm indication and alarm output relay when you carried out the alarm ACK operation, see the previous page.

- **Individual Alarm ACK Operation (Only on DXs with the /AS1 advanced security option)**
  This operation releases the relay output of individual alarms. This operation is referred to as “individual alarm ACK.” For information about how alarm display and output relay operations respond to an individual alarm ACK, see the previous page. You can perform individual alarm ACK from the overview display. For operating instructions, see section 4.4.

  **Note**
  When you enter the basic setting mode, the hold/non-hold condition of the alarm output relay immediately before is retained. In the basic setting mode, alarms are not detected, and you cannot acknowledge alarms.

### Internal Switch
The alarm status can be output to software switches (30 internal switches). The values of the internal switch are shown below. Like the alarm output relay, you can specify AND/OR operation (see the previous page).

<table>
<thead>
<tr>
<th>Alarm occurrence</th>
<th>Alarm release</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm</td>
<td></td>
</tr>
<tr>
<td>Internal switch</td>
<td>0</td>
</tr>
</tbody>
</table>

The internal switches can be used events of the event action function (see section 1.6). In addition, the internal switches can be written in calculation expressions of computation channels (/M1 or /PM1 option).
1.2 Alarms

Alarm Annunciator Function (Release number 3 or later)

You can use the DX as an alarm annunciator. No lock-in, lock-in, and double lock-in sequences are supported. The alarm display and alarm output relay operations follow the annunciator sequence.

For the setting procedure, see section 3.12.
1.3 Display

Common Items Related to the Display

• 5.5-inch TFT Color LCD and the Screen Configuration
  The DX has a 5.5-inch TFT color LCD (240 × 320 dot resolution). The screen consists of the status display section and the data display section.

- Status Display Section
  The status display section shows the display name, date/time, batch name (when using the batch function), user name (when using the login function), usage of the internal memory or CF card, alarm occurrence, computation status (/M1 or /PM1 option), and usage of key lock or e-mail transmission.

- Data Display Section
  The data display section shows the measured data using numeric values, waveforms, and bar graphs. It also shows the setup screen when setting functions.

- Group Display
  On the trend, digital, and bar graph displays, the data of channels is displayed by groups that are set in advance. Up to 10 groups can be registered, and up to six channels can be assigned to each group. Groups are common to the trend, digital, and bar graph displays.
  The displayed group can be switched automatically at a specified time interval (5 s to 1 min).
  For the setting procedure, see section 5.1.

- Channel Number Display and Tag Display
  You can choose to label displayed channels according to their tags or according to their channel numbers. In the tag display, you can display tag numbers and comments. This setting applies to all channels.
  For the setting procedure, see section 5.2.

- Update Interval of Measured Values
  The values are updated every second. However, if the scan interval is greater than 1 s, the values are updated at the scan interval.
  For the setting procedure, see section 5.3.

- Alarm Indication
  Alarms that are set for each channel are checked at all times and are indicated with the symbol representing the alarm type on each display.

<table>
<thead>
<tr>
<th>Alarm Type</th>
<th>Symbol</th>
<th>Alarm Type</th>
<th>Symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>High limit alarm</td>
<td>H</td>
<td>High limit on rate-of-change alarm</td>
<td>R</td>
</tr>
<tr>
<td>Low limit alarm</td>
<td>L</td>
<td>Low limit on rate-of-change alarm</td>
<td>r</td>
</tr>
<tr>
<td>Difference high limit alarm</td>
<td>h</td>
<td>Delay high limit alarm</td>
<td>T</td>
</tr>
<tr>
<td>Difference low limit alarm</td>
<td>l</td>
<td>Delay low limit alarm</td>
<td>t</td>
</tr>
</tbody>
</table>
1.3 Display

Status Display Section

The following information is displayed in the status display section during operation mode or setting mode.

Memory sampling status

- Memory sampling stopped
- Memory sampling in progress

Data type
- DISP: Display data
- EVENT: Event data

Memory sampling progress
Displays the progress using a green bar graph. The frame indicates the file save interval (display data) or the data length (event data).

Error in internal memory.
Contact your nearest YOKOGAWA dealer for repairs.

Displays the remaining memory sampling time for the left bar graph.

Status icon
- The status assigned to the status output relay (/F1 option) is occurring.

Alarm icon
-Displayed when any alarm is activated.
- Blinks when there are alarms that are occurring but have not been acknowledged.
- All alarms have been released after they have occurred, but there are alarms that have not been acknowledged.

Display name or group name
- For all channel display on the trend display, "All" is displayed.

Date and time
- Displayed in yellow while the time is being corrected.

When using the batch function
- Batch name and the display name are shown alternately.
- Date and time
- If the "batch number-lot number" exceeds 20 characters, the "date and time" position is used to display the "batch number-lot number."

When using the login function
- Name of the user logged in
- Date and time and the display name are shown alternately.

When using the login and batch functions
- Name of the user logged in
- Batch name, the display name, and date and time are shown alternately.

The green level display indicates the amount of CF card used. If Media FIFO is not enabled and the free space on the CF card falls below 10%, the level indicator changes to red.

* See section 1.4, in the DX1000/DX1000N User's Manual. Media FIFO is a function available on release number 2 or later.

Alarm icon
- Displayed when any alarm is activated.
- Blinks when there are alarms that are occurring but have not been acknowledged.
- All alarms have been released after they have occurred, but there are alarms that have not been acknowledged.

User locked icon (/AS1 option)
-Displayed when the user is locked.
- Keys are locked.
- E-mail transmission is enabled.

Computation icon (/M1 or /PM1 option)
- White icon: Computation started
- Yellow icon: Computation data dropout occurred
- Red icon: Computation data dropout occurred

CF card icon
- CF card is being accessed.
- Waiting.
- Light blue icon: CF card in the slot is not recognized. Remove and reset it.
- CF card error.
- Carry out the procedure below to reset the CF card icon to normal.
  - Remove the CF card, and then reinsert it.
  - Replace the CF card with a normal one.
  - Format the CF card on the DX (the data on the CF card will be erased).

Bar Graph

When event data recording is set to pretrigger, the DX will start recording pretrigger data after you press the START key. "Waiting" appears in the bar graph (release number 3 or later). At this time, the progress bar will turn orange. After the pretrigger time elapses, the length of the bar fixed at that point. However, the relevant data is updated until the trigger condition is met. When the trigger condition is met, the bar turns green, and data is recorded after the data in the pretrigger section.
1.3 Display

Trend Display (T-Y)

Measured data is displayed in a waveform. For the operating procedure, see section 4.2.

- **Current value mark**
- **Scale**
  - See section 5.7
- **Trend interval**
- **Grid**
  - See section 5.3
- **Trip line (up to four lines)**
  - See section 5.1
- **Numeric display section**
  - See section 5.10
- **Tag or channel number, measured value, unit, and specified alarm**
- **Waveform (displayed with the set channel color)**
  - To change channel colors, see section 5.5.
  - To change waveform line width, see section 5.10.
  - To display every channel’s waveform, see section 4.2.
- **Maximum value**
- **Minimum value**
- **1 dot**

Displays the maximum and minimum values sampled in the time corresponding to one dot.

- **Time at the grid position**
  - Either displays the time, or the date and time.
  - See sections 2.4 and 5.3
- **Trend Space function**
  - Inserts a division-wide space here.
  - See section 4.2

- **1 division**
  - (30 dots)

- **Waveform (displayed with the set channel color)**
  - To change channel colors, see section 5.5.
  - To change waveform line width, see section 5.10.
  - To display every channel’s waveform, see section 4.2.

- **Color scale band**
  - See section 5.8

- **Current value indicated by bar**
  - See section 5.8

- **Alarm point mark**
  - See section 5.7

- **Alarm mark**
  - See section 5.8

- **Alarm type**

**Horizontal display**

- **Horizontal split display (displays two groups)**
  - The waveforms of two consecutive groups are displayed. The numeric display sections show the data for the first four channels in their groups.

**Horizontal wide display**
• Updating of the Waveform

On the screen, 30 dots along the time axis is represented by a unit called division (see the figure on the previous page). The displayed waveform is updated at an interval corresponding to one dot. This interval is determined by the time corresponding to one division (referred to as the trend interval). The relationship between the trend interval and the speed of movement of waveforms on the screen is as follows:

<table>
<thead>
<tr>
<th>Trend interval (/DIV)</th>
<th>5 s (^{-1})</th>
<th>10 s (^{-1})</th>
<th>15 s (^{-2})</th>
<th>30 s</th>
<th>1 min</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time corresponding to one dot (in seconds)</td>
<td>0.125</td>
<td>0.25</td>
<td>0.5</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>Speed of waveform movement (approximation in mm/h)</td>
<td>10000</td>
<td>5000</td>
<td>2500</td>
<td>1250</td>
<td>625</td>
</tr>
<tr>
<td>Trend interval (/DIV)</td>
<td>2 min</td>
<td>5 min</td>
<td>10 min</td>
<td>15 min</td>
<td>20 min</td>
</tr>
<tr>
<td>Time corresponding to one dot (in seconds)</td>
<td>4</td>
<td>10</td>
<td>20</td>
<td>30</td>
<td>40</td>
</tr>
<tr>
<td>Speed of waveform movement (approximation in mm/h)</td>
<td>312</td>
<td>156</td>
<td>78</td>
<td>42</td>
<td>31</td>
</tr>
<tr>
<td>Trend interval (/DIV)</td>
<td>30 min</td>
<td>1 h</td>
<td>2 h</td>
<td>4 h</td>
<td>10 h</td>
</tr>
<tr>
<td>Time corresponding to one dot (in seconds)</td>
<td>60</td>
<td>120</td>
<td>240</td>
<td>480</td>
<td>1200</td>
</tr>
<tr>
<td>Speed of waveform movement (approximation in mm/h)</td>
<td>21</td>
<td>10</td>
<td>5.2</td>
<td>2.6</td>
<td>1.0</td>
</tr>
</tbody>
</table>

*1 40 dots per division. Selectable on the DX1002, DX1002N, DX1004, and DX1004N (release number 3 or later).
*2 Selectable on the DX1006, DX1006N, DX1012, and DX1012N when the scan interval is set to fast sampling mode (release number 3 or later).

Switching the Trend Interval

You can switch from the normal trend interval to the secondary trend interval during memory sampling and vice versa. For the operating procedure, see section 5.3.

• Writing Messages

Preset messages

<table>
<thead>
<tr>
<th>1</th>
<th>Start</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Material 1</td>
</tr>
<tr>
<td>3</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
</tr>
</tbody>
</table>

Free message

Set the message when writing the message

Preset Messages

Preset messages are recalled and written. The number of messages that you can use are 100 (message 1 to 10 are shared with free messages). For the operating procedure, see section 5.4

Free Messages

Messages are entered when you need to enter them. The number of messages that you can use are 10. For the operating procedure, see section 5.4

Automatic Message Writing

• A message is written when the trend interval is switched during memory sampling. For the setting procedure, see section 5.3.
• A message is written when the power recovers from a power failure during memory sampling. For the operating procedure, see section 5.16.
• A message is written when the setting mode setup items are changed during memory sampling (only on DXs with the /AS1 advanced security option).
1.3 Display

**Message display method**
- Except for the vertical display, you can set the direction in which messages are displayed to horizontal or vertical. For the setting procedure, see section 5.10.
- Messages can be displayed consolidated at the upper left of the screen (list display). For the operating procedure, see section 4.2.

**Zone Display**
You can display channels in specified zones. This function can be used to keep the waveforms from overlapping for easier view.
In the example below, channel 1 is displayed in the 0 to 30% zone, channel 2 in the 30 to 60% zone, and channel 3 in the 60 to 100% zone.

**Auto Zone (Release number 3 or later)**
You can divide the trend display area evenly between each channel in a group.
For operating instructions, see section 4.2.
• **Partial Expanded Display**

By compressing a section of the waveform display range, the rest of the section is expanded.

In the example below, 0 V (boundary value) is moved to the 30% position of the display range (new boundary position). The 30% area below the boundary corresponds to “–6 V to 0 V” and 70% area above the boundary corresponds to “0 V to 6 V.”

![Diagram showing partial expanded display](image)

For the setting procedure, see section 5.9.

• **Alarm Indication**

Alarm mark, alarm type, and measured value are displayed as follows according to the alarm status. When you use the alarm annunciator function (release number 3 or later), the alarm mark follows the annunciator sequence.

<table>
<thead>
<tr>
<th>Alarm mark</th>
<th>Occurrence</th>
<th>Release</th>
<th>When indication is set to non-hold</th>
<th>When indication is set to hold</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>Red</td>
<td>None</td>
<td>Blinking blue</td>
<td>Blinking red</td>
</tr>
<tr>
<td>Red</td>
<td>Red</td>
<td>None</td>
<td>Blinking red</td>
<td>Blinking red</td>
</tr>
<tr>
<td>Green</td>
<td>None</td>
<td>None</td>
<td>Blinking green</td>
<td>Blinking green</td>
</tr>
<tr>
<td>Blinking red</td>
<td>Red</td>
<td>None</td>
<td>Blinking red</td>
<td>Blinking red</td>
</tr>
<tr>
<td>Blinking green</td>
<td>None</td>
<td>None</td>
<td>Blinking green</td>
<td>Blinking red</td>
</tr>
<tr>
<td>Measured value</td>
<td>Blue</td>
<td>Red</td>
<td>Blue</td>
<td>Red</td>
</tr>
<tr>
<td>Blue</td>
<td>Red</td>
<td>Blue</td>
<td>Blue</td>
<td>Red</td>
</tr>
<tr>
<td>Red</td>
<td>None</td>
<td>None</td>
<td>Red</td>
<td>None</td>
</tr>
<tr>
<td>None</td>
<td>Red</td>
<td>None</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Red</td>
<td>Red</td>
<td>None</td>
<td>Red</td>
<td>None</td>
</tr>
<tr>
<td>Green</td>
<td>Red</td>
<td>None</td>
<td>Green</td>
<td>None</td>
</tr>
<tr>
<td>Blue</td>
<td>Red</td>
<td>None</td>
<td>Blue</td>
<td>None</td>
</tr>
<tr>
<td>Red</td>
<td>Red</td>
<td>None</td>
<td>Red</td>
<td>None</td>
</tr>
<tr>
<td>None</td>
<td>Red</td>
<td>None</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Red</td>
<td>Red</td>
<td>None</td>
<td>Red</td>
<td>None</td>
</tr>
<tr>
<td>Green</td>
<td>Red</td>
<td>None</td>
<td>Green</td>
<td>None</td>
</tr>
<tr>
<td>Blue</td>
<td>Red</td>
<td>None</td>
<td>Blue</td>
<td>None</td>
</tr>
<tr>
<td>Red</td>
<td>Red</td>
<td>None</td>
<td>Red</td>
<td>None</td>
</tr>
<tr>
<td>None</td>
<td>Red</td>
<td>None</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Red</td>
<td>Red</td>
<td>None</td>
<td>Red</td>
<td>None</td>
</tr>
<tr>
<td>Green</td>
<td>Red</td>
<td>None</td>
<td>Green</td>
<td>None</td>
</tr>
<tr>
<td>Blue</td>
<td>Red</td>
<td>None</td>
<td>Blue</td>
<td>None</td>
</tr>
<tr>
<td>Red</td>
<td>Red</td>
<td>None</td>
<td>Red</td>
<td>None</td>
</tr>
<tr>
<td>None</td>
<td>Red</td>
<td>None</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Red</td>
<td>Red</td>
<td>None</td>
<td>Red</td>
<td>None</td>
</tr>
<tr>
<td>Green</td>
<td>Red</td>
<td>None</td>
<td>Green</td>
<td>None</td>
</tr>
<tr>
<td>Blue</td>
<td>Red</td>
<td>None</td>
<td>Blue</td>
<td>None</td>
</tr>
<tr>
<td>Red</td>
<td>Red</td>
<td>None</td>
<td>Red</td>
<td>None</td>
</tr>
<tr>
<td>None</td>
<td>Red</td>
<td>None</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Red</td>
<td>Red</td>
<td>None</td>
<td>Red</td>
<td>None</td>
</tr>
<tr>
<td>Green</td>
<td>Red</td>
<td>None</td>
<td>Green</td>
<td>None</td>
</tr>
<tr>
<td>Blue</td>
<td>Red</td>
<td>None</td>
<td>Blue</td>
<td>None</td>
</tr>
<tr>
<td>Red</td>
<td>Red</td>
<td>None</td>
<td>Red</td>
<td>None</td>
</tr>
<tr>
<td>None</td>
<td>Red</td>
<td>None</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Red</td>
<td>Red</td>
<td>None</td>
<td>Red</td>
<td>None</td>
</tr>
<tr>
<td>Green</td>
<td>Red</td>
<td>None</td>
<td>Green</td>
<td>None</td>
</tr>
<tr>
<td>Blue</td>
<td>Red</td>
<td>None</td>
<td>Blue</td>
<td>None</td>
</tr>
<tr>
<td>Red</td>
<td>Red</td>
<td>None</td>
<td>Red</td>
<td>None</td>
</tr>
<tr>
<td>None</td>
<td>Red</td>
<td>None</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Red</td>
<td>Red</td>
<td>None</td>
<td>Red</td>
<td>None</td>
</tr>
<tr>
<td>Green</td>
<td>Red</td>
<td>None</td>
<td>Green</td>
<td>None</td>
</tr>
<tr>
<td>Blue</td>
<td>Red</td>
<td>None</td>
<td>Blue</td>
<td>None</td>
</tr>
<tr>
<td>Red</td>
<td>Red</td>
<td>None</td>
<td>Red</td>
<td>None</td>
</tr>
<tr>
<td>None</td>
<td>Red</td>
<td>None</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Red</td>
<td>Red</td>
<td>None</td>
<td>Red</td>
<td>None</td>
</tr>
<tr>
<td>Green</td>
<td>Red</td>
<td>None</td>
<td>Green</td>
<td>None</td>
</tr>
<tr>
<td>Blue</td>
<td>Red</td>
<td>None</td>
<td>Blue</td>
<td>None</td>
</tr>
<tr>
<td>Red</td>
<td>Red</td>
<td>None</td>
<td>Red</td>
<td>None</td>
</tr>
<tr>
<td>None</td>
<td>Red</td>
<td>None</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Red</td>
<td>Red</td>
<td>None</td>
<td>Red</td>
<td>None</td>
</tr>
<tr>
<td>Green</td>
<td>Red</td>
<td>None</td>
<td>Green</td>
<td>None</td>
</tr>
<tr>
<td>Blue</td>
<td>Red</td>
<td>None</td>
<td>Blue</td>
<td>None</td>
</tr>
<tr>
<td>Red</td>
<td>Red</td>
<td>None</td>
<td>Red</td>
<td>None</td>
</tr>
<tr>
<td>None</td>
<td>Red</td>
<td>None</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Red</td>
<td>Red</td>
<td>None</td>
<td>Red</td>
<td>None</td>
</tr>
<tr>
<td>Green</td>
<td>Red</td>
<td>None</td>
<td>Green</td>
<td>None</td>
</tr>
<tr>
<td>Blue</td>
<td>Red</td>
<td>None</td>
<td>Blue</td>
<td>None</td>
</tr>
<tr>
<td>Red</td>
<td>Red</td>
<td>None</td>
<td>Red</td>
<td>None</td>
</tr>
<tr>
<td>None</td>
<td>Red</td>
<td>None</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Red</td>
<td>Red</td>
<td>None</td>
<td>Red</td>
<td>None</td>
</tr>
<tr>
<td>Green</td>
<td>Red</td>
<td>None</td>
<td>Green</td>
<td>None</td>
</tr>
<tr>
<td>Blue</td>
<td>Red</td>
<td>None</td>
<td>Blue</td>
<td>None</td>
</tr>
<tr>
<td>Red</td>
<td>Red</td>
<td>None</td>
<td>Red</td>
<td>None</td>
</tr>
<tr>
<td>None</td>
<td>Red</td>
<td>None</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Red</td>
<td>Red</td>
<td>None</td>
<td>Red</td>
<td>None</td>
</tr>
<tr>
<td>Green</td>
<td>Red</td>
<td>None</td>
<td>Green</td>
<td>None</td>
</tr>
<tr>
<td>Blue</td>
<td>Red</td>
<td>None</td>
<td>Blue</td>
<td>None</td>
</tr>
<tr>
<td>Red</td>
<td>Red</td>
<td>None</td>
<td>Red</td>
<td>None</td>
</tr>
<tr>
<td>None</td>
<td>Red</td>
<td>None</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Red</td>
<td>Red</td>
<td>None</td>
<td>Red</td>
<td>None</td>
</tr>
<tr>
<td>Green</td>
<td>Red</td>
<td>None</td>
<td>Green</td>
<td>None</td>
</tr>
<tr>
<td>Blue</td>
<td>Red</td>
<td>None</td>
<td>Blue</td>
<td>None</td>
</tr>
<tr>
<td>Red</td>
<td>Red</td>
<td>None</td>
<td>Red</td>
<td>None</td>
</tr>
<tr>
<td>None</td>
<td>Red</td>
<td>None</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Red</td>
<td>Red</td>
<td>None</td>
<td>Red</td>
<td>None</td>
</tr>
<tr>
<td>Green</td>
<td>Red</td>
<td>None</td>
<td>Green</td>
<td>None</td>
</tr>
<tr>
<td>Blue</td>
<td>Red</td>
<td>None</td>
<td>Blue</td>
<td>None</td>
</tr>
<tr>
<td>Red</td>
<td>Red</td>
<td>None</td>
<td>Red</td>
<td>None</td>
</tr>
<tr>
<td>None</td>
<td>Red</td>
<td>None</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Red</td>
<td>Red</td>
<td>None</td>
<td>Red</td>
<td>None</td>
</tr>
<tr>
<td>Green</td>
<td>Red</td>
<td>None</td>
<td>Green</td>
<td>None</td>
</tr>
<tr>
<td>Blue</td>
<td>Red</td>
<td>None</td>
<td>Blue</td>
<td>None</td>
</tr>
<tr>
<td>Red</td>
<td>Red</td>
<td>None</td>
<td>Red</td>
<td>None</td>
</tr>
<tr>
<td>None</td>
<td>Red</td>
<td>None</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Red</td>
<td>Red</td>
<td>None</td>
<td>Red</td>
<td>None</td>
</tr>
<tr>
<td>Green</td>
<td>Red</td>
<td>None</td>
<td>Green</td>
<td>None</td>
</tr>
<tr>
<td>Blue</td>
<td>Red</td>
<td>None</td>
<td>Blue</td>
<td>None</td>
</tr>
<tr>
<td>Red</td>
<td>Red</td>
<td>None</td>
<td>Red</td>
<td>None</td>
</tr>
<tr>
<td>None</td>
<td>Red</td>
<td>None</td>
<td>None</td>
<td>None</td>
</tr>
</tbody>
</table>
Digital Display

Displays the measured data numerically using large numbers. For the operating procedure, see section 4.2.

![Digital Display Image]

**Note**

- **Numeric display of measurement channels**
  
  If a measured value of a measurement channel is over range (see below), the measured value is indicated as “+Over” or “–Over.” If a burnout is detected on a channel whose burnout detection function is enabled, the word “Burnout” is indicated. Otherwise, a numeric value is displayed.

- **Over range of measurement channels**
  
  - For DC voltage input, over range occurs when the measured value of the measurement channel exceeds ±5% of the measurable range. For example, the measurable range when the measurement range is 2 V is –2.000 to 2.000 V. If the measured value exceeds 2.200 V, + over range occurs; if the measured value falls below –2.200 V, – over range occurs.
  
  - For thermocouple or RTD input, over range occurs when the measured value exceeds approximately ±10°C of the measurable range. For example, the measurable range when the measurement range is R is 0.0 to 1760.0°C. If the measured value exceeds approximately 1770.0°C, + over range occurs; if the measured value falls below approximately –10.0°C, – over range occurs.
  
  - For channels that are linearly scaled, + over range occurs when the value exceeds 30000 excluding the decimal point; – over range occurs when the value falls below –30000. However, + over range can be changed to greater than or equal to 105% of the scale width and – over range to less than or equal to –5% of the scale width within ±30000. For the setting procedure, see section 3.11.

- **Numeric display of computation channels**
  
  See section 1.8, “Computation and Report Function (/M1 and /PM1 Options)

- **Alarm Indication**
  
  Alarm mark and measured value are displayed as follows according to the alarm status. When you use the alarm annunciator function (release number 3 or later), the alarm mark follows the annunciator sequence.

![Alarm Indication Image]
1.3 Display

Bar Graph Display

Waveform data is displayed in a bar graph. For the operating procedure, see section 4.2.

Bar graph base position is set to Center.

**Vertical**

- Tag or channel number
- Alarm mark
- Upper limit
- Scale marks
- See section 5.7
- Alarm point mark
- Bar (displayed with the set channel color)
- See section 5.11
- Unit of measurement and lower limit
- Measured value

**Horizontal**

- Bar graph base position is set to Center.
  - See section 5.11

**Updating of the Bar Graph**

The bar graph is updated at the same interval as numeric values.

**Alarm Indication**

Alarm mark, alarm point mark, and measured value are displayed as follows according to the alarm status. When you use the alarm annunciator function (release number 3 or later), the alarm marks and alarm point marks follow the annunciator sequence.

<table>
<thead>
<tr>
<th>Alarm mark</th>
<th>Occurrence</th>
<th>Release</th>
<th>When indication is set to non-hold</th>
<th>Alarm ACK</th>
<th>When indication is set to hold</th>
<th>Alarm ACK</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red</td>
<td>Green</td>
<td>Green</td>
<td>Blinking red</td>
<td>Blinking green</td>
<td>Blinking red</td>
<td>Blinking green</td>
</tr>
<tr>
<td>Red</td>
<td>Green</td>
<td>Green</td>
<td>Blinking red</td>
<td>Blinking green</td>
<td>Blinking red</td>
<td>Blinking green</td>
</tr>
<tr>
<td>Blue</td>
<td>Red</td>
<td>Blue</td>
<td>Blinking red</td>
<td>Blinking red</td>
<td>Blinking red</td>
<td>Blinking red</td>
</tr>
<tr>
<td>Blue</td>
<td>Red</td>
<td>Blue</td>
<td>Blinking red</td>
<td>Blinking red</td>
<td>Blinking red</td>
<td>Blinking red</td>
</tr>
<tr>
<td>Blue</td>
<td>Red</td>
<td>Blue</td>
<td>Blinking red</td>
<td>Blinking red</td>
<td>Blinking red</td>
<td>Blinking red</td>
</tr>
<tr>
<td>Blue</td>
<td>Red</td>
<td>Blue</td>
<td>Blinking red</td>
<td>Blinking red</td>
<td>Blinking red</td>
<td>Blinking red</td>
</tr>
</tbody>
</table>

**Alarm ACK**

Alarm ACK
Historical Trend Display
The waveform of the past measured data (display or event data) in the internal memory or external storage medium can be displayed. This function is called **Historical trend**.

- **Methods of Displaying the Historical Trend**
  There are four methods to display the historical trend of the measured data in the internal memory.
  - Display from the alarm summary. For the operating procedure, see section 4.6.
  - Display from the message summary. For the operating procedure, see section 4.7.
  - Display from the memory summary. For the operating procedure, see section 4.8.
  - Recall from the display selection menu. For the operating procedure, see section 4.3. Measured data on an external storage medium can also be displayed as historical trend. For the operating procedure, see section 6.8.

- **Displayed Contents**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm summary</td>
<td>Displays an alarm summary of the displayed data.</td>
</tr>
<tr>
<td>Message summary</td>
<td>Displays a message summary of the displayed data.</td>
</tr>
<tr>
<td>Data information</td>
<td>Shows information about the displayed data (file name, sample start time, end time, etc.).</td>
</tr>
</tbody>
</table>

*1 You can also view a digital display of just the value at the cursor position (release number 3 or later).
*2 You can also display the relative time from the start of recording (release number 3 or later).

**Half screen display**

- **Added Messages**
Added messages can be written. For the operating procedure, see section 5.4.
1.3 Display

- **Auto Span Display (Release number 3 or later)**
  The DX can automatically adjust the display span of the selected channel. It sets the span based on the maximum and minimum displayed historical data values. This setting is deactivated when you switch to another group.
  
  * Auto span affects channels that are in the same scale position as the selected channel.

  When the maximum or minimum values are outside of the set display span

  ![Diagram](image1)

  When the maximum or minimum values are within the set display span

  ![Diagram](image2)

  If the maximum or minimum data value falls outside the maximum selectable display span, the DX adjusts the display span to the maximum or minimum possible value. The DX responds in the same way when it encounters overflow data.

- **Top Channel Display (Release number 3 or later)**
  Displays the selected channel's historical trend waveform in front of all of the others. This setting is deactivated when you switch to another group.

- **Signature (Only on DXs with the /AS1 advanced security option)**
  See the Advanced Security Function (/AS1) User's Manual, IM 04L41B01-05EN.
Overview Display
Displays a list of the statuses of all channels.
You can move the cursor to select a channel and display the trend, digital, or bar graph of the group containing the selected channel.
For the operating procedure, see section 4.4.

- Alarm Indication
Channel display area, tag/channel number, alarm type, and measured value are displayed as follows according to the alarm status. When you use the alarm annunciator function (release number 3 or later), the displays of the previously listed items follow the annunciator sequence.
### 1.3 Display

**Alarm Summary**

Displays a list of the most recent alarms.

- Up to 1000 alarms can be displayed.
- You can select arbitrary alarm information and recall the historical trend of the display data or event data that contains the alarm information.

For the setting procedure, see section 4.6.

![Alarm Summary Table]

- **Cursor (selects an alarm)**
  - Alarm occurrence (blinks until the AlarmACK operation is carried out if Indicator is set to Hold.)
  - Alarm release
  - Alarm output release (when blinking is cleared through the AlarmACK operation)

The alarm information number displayed on the screen's bottom line and the internal memory alarm information number.

When you use the alarm annunciator function (release number 3 or later), the alarm occurrence mark follows the annunciator sequence. If the alarm sequence is no lock-in (ISA-A-4):

- The alarm occurrence mark does not blink.
- “ACK” is recorded when the alarm is released.
Message Summary
Displays a list of written messages and the time the messages were written.

- Up to 450 messages can be displayed.
- Up to 50 messages that are added to the past data section (added messages) can be displayed.
- You can select arbitrary message information and recall the historical trend of the display data or event data that contains the message.

For the setting procedure, see section 4.7.

**To the historical trend display**

**Number of the message displayed on the bottom line/number of messages in the internal memory**

**Switching of the Display Items**
You can switch between two sets of display contents.

- Message, time when the message was written, and group to which the message was written or second of the time when the message was written
- Message, user name that wrote the message
1.3 Display

Memory Summary
Displays the information pertaining to the display data and event data in the internal memory.

• By selecting the display data or event data, the historical trend display can be recalled.
• The number of manual sampled data and report data (/M1 and /PM1 options) in the internal memory is displayed.

For the operating procedure, see section 4.8.
• You can display file information (only on DXs with the /AS1 advanced security option).
  See the Advanced Security Function (/AS1) User’s Manual, IM 04L41B01-05EN.

- To the historical trend display
  Cursor (selects the file)
  Date/Time of memory start
  Date/Time of memory stop
  Sampling count
  Status
  Number of data points in the internal memory/maximum number of data points that can be recorded in the internal memory
  Date/Time of the most recent data
  Data type
  • Display data
  • Event data

Switching of the Display Items
You can switch between two display methods.
• Display the start and end times
• Display the file name

Saving the Data
The data in the internal memory can be saved to a CF card or USB flash memory (/USB1 option).
Report Data (/M1 and /PM1 Options)

Report data residing in the internal memory can be displayed. For the operating procedure, see section 4.5.

Stacked Bar Graph (/M1 and /PM1 options)

You can display the report data (that is stored in the internal memory) of each report group in a stacked bar graph. For operating instructions, see section 4.10. For information about report groups, see section 9.5.

• Types of Displayed Data

The type of data that is displayed is determined by the report type, which is set using the report function.

<table>
<thead>
<tr>
<th>Report Kind</th>
<th>Report Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hourly, Hourly + daily</td>
<td>Sums for each hour and sums for the day</td>
</tr>
<tr>
<td>Daily + weekly</td>
<td>Sums for each day and sums for the week</td>
</tr>
<tr>
<td>Daily, Daily + monthly</td>
<td>Sums for each day and sums for the month</td>
</tr>
</tbody>
</table>

Example: Hourly + daily display

- Daily sum of all channels and the daily sums of all report groups if you select a bar graph, the sum of the hour selected with the cursor is displayed.
- Sums for the day (bar graph)

• Display Modes

You can switch the bar graph between single graph and dual graph display.
1.3 Display

Status Display
The following displays are available.
For the operating procedure, see section 4.5.

- **Relay Status Display**
  Displays the status of the alarm output relay and internal switch.

- **Modbus Client Status Display and Modbus Master Status Display**
  Displays the command status.

- **Event Level Switch Status (Release number 3 or later)**
  Displays the status of the event level switches.

Log Display
Displays various logs (operation log).
For the operating procedure, see section 4.9.

<table>
<thead>
<tr>
<th>Log Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Login¹</td>
<td>Log of login/logout, log of time setting, and log of power failure</td>
</tr>
<tr>
<td>Error</td>
<td>Log of error messages</td>
</tr>
<tr>
<td>Communications</td>
<td>Log of communication commands</td>
</tr>
<tr>
<td>FTP transfer</td>
<td>Log of FTP transfers</td>
</tr>
<tr>
<td>WEB</td>
<td>Log of Web operations</td>
</tr>
<tr>
<td>E-mail transmission</td>
<td>Log of e-mail transmissions</td>
</tr>
<tr>
<td>SNTP</td>
<td>Log of accesses to the SNTP server</td>
</tr>
<tr>
<td>DHCP</td>
<td>Log of accesses to the DHCP server</td>
</tr>
<tr>
<td>MODBUS</td>
<td>Log of communications using Modbus client or Modbus master</td>
</tr>
<tr>
<td>Operation²</td>
<td>Log of operations</td>
</tr>
<tr>
<td>Change settings²</td>
<td>Log of setting changes</td>
</tr>
</tbody>
</table>

¹ Only on DXs without the /AS1 advanced security option
² Only on DXs with the /AS1 advanced security option

Other Useful Functions

- **Automatically Reverting to the Specified Display**
  Show a preset display when there is no operation for a specific time.
  For the setting procedure, see section 5.14.

- **Favorite Key**
  Register a frequently used display to the Favorite key and enable the display to be shown through simple operation.
  For the setting procedure, see section 5.15.

- **Customizing the Menus**
  Change the FUNC key menu that appears when the FUNC key is pressed and the screen menu that appears when the DISP/ENTER key is pressed.
  For the setting procedure, see section 5.17.
### Setting the Display Conditions of the LCD

The display conditions of the LCD can be configured.

<table>
<thead>
<tr>
<th>Display Attribute</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Background color of the operation display</td>
<td>The background color of the display can be set to white or black. The default value is <strong>White</strong>. For the setting procedure, see section 5.12.</td>
</tr>
<tr>
<td>Background color of the historical trend screen</td>
<td>You can select white, cream, black, or light gray for the background color of the screen. The default value is <strong>Black</strong>. For the setting procedure, see section 5.12.</td>
</tr>
<tr>
<td>LCD brightness</td>
<td>The brightness of the LCD can be set among eight levels. The default brightness is <strong>2</strong>. For the setting procedure, see section 2.7.</td>
</tr>
</tbody>
</table>
| Backlight saver                                        | The lifetime of the LCD backlight can be extended by automatically turning OFF or dimming the light when there is no key operation for a specified amount of time. The display returns to the original brightness with a key operation or an alarm occurrence. By default, the backlight saver is disabled. For the setting procedure, see section 2.7.
1.4 Data Storage Function

This section explains the types of data that the DX can record and how to store them. For information about the data storage function on DXs with the /AS1 advanced security option, see the Advanced Security Function (/AS1) User’s Manual, IM04L41B01-05EN.

Data Types

The types of data that the DX can record are as follows:

<table>
<thead>
<tr>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
</table>
| Display data                  | Waveform data displayed on the trend display. The measured data is recorded as a specified sampling interval. The sampling interval is specified using the trend interval.  
  • The minimum and maximum values among the measured data within the sampling interval are saved.  
  • A header string (common to other files) can be written in the file.  
  • The display data contains alarm and message information.  
  • Data format: Binary (Undisclosed) |
| Event data                    | Measured data that is recorded at a specified sampling interval. There are two modes. One mode starts recording when a trigger event occurs. The other mode records at all times.  
  • A header string (common to other files) can be written in the file.  
  • The event data contains alarm and message information.  
  • Data format: Binary (Undisclosed) |
| Manual sampled data           | Instantaneous value of the measured data when a manual sample operation is executed.  
  • A header string (common to other files) can be written in the file.  
  • Data format: Text |
| Report data (IM1 and /PM1 options) | Hourly, daily, weekly, and monthly report data. Report data is created at an interval that is determined by the report type (one hour for hourly reports, one day for daily reports, and so on).  
  • A header string (common to other files) can be written in the file.  
  • Data format: Text  
  • The data can be converted to XML spreadsheet data (release numbers 4 and later). |
| Snapshot data (screen image data) | The image data of the DX screen when the snapshot operation is executed.  
  • The data can be saved to a CF card.  
  • Data format: PNG |
| Setup data                    | The setup data of the DX.  
  • Data format: Binary (Undisclosed) |
| Custom Display Setup Data     | The custom display setup data of the DX.  
  • Data format: text |

- **Display data and event data**

  Display data can be likened to the conventional recording on the chart sheet and are useful for long-term recording. Event data is useful when you wish to record the measured data in detail.
Flow of Data Recording and Storage

Measured data is recorded once to the internal memory and then saved to the external storage medium.

Internal Memory
Display data and event data are held in files in the internal memory. The data area also stored on the external storage medium in files.
Recording Method of Display Data and Event Data

For the setting procedure, see section 6.1.

- **Types of Data to Be Acquired**
  Select display data only, display data and event data, or event data only.

**Deciding the Data to Be Recorded**
Record the data that suits your application. Refer to the following examples.

Example 1: Continuously record the waveform data as with the conventional chart recorder.
Record the display data.

Example 2: Record waveform data under normal conditions but record details around the point of alarm occurrence when alarms occur.
Continuously record display data and record event data when alarms occur.

Example 3: Only record the most-detailed data at all times.
Record event data by specifying the sampling interval.

Example 4: No need to continuously record data. Record data only when alarms occur.
Record event data only when alarms occur.

- **Internal Memory**
The recorded measured data is divided at a specific time interval and saved to files.
If the internal memory is full or if the number of display data files and event data files exceeds 400, files are overwritten from the oldest file.

**Recording Conditions of Display Data**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source channels</td>
<td>Select from measurement channels and computation channels.</td>
</tr>
<tr>
<td>Sampling interval</td>
<td>Specify the sampling interval with the trend interval (see the table below). You cannot specify a sampling interval that is faster than the scan interval.</td>
</tr>
<tr>
<td>File creation</td>
<td>Files are created at the specified file save interval.</td>
</tr>
<tr>
<td>Time adding data</td>
<td></td>
</tr>
</tbody>
</table>

Files are also created in the following cases.
- When a file is created manually.
- When the memory sampling is stopped.
- When file creation is executed with the event action function.
- After recovering from a power failure.

**Memory start/stop**
Press the START key to start recording (memory start) and the STOP key to stop the recording (memory stop).

Trend interval and the sampling interval of display data

<table>
<thead>
<tr>
<th>Trend interval</th>
<th>5 s (^1)</th>
<th>10 s (^1)</th>
<th>15 s (^2)</th>
<th>30 s</th>
<th>1 min</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample rate</td>
<td>125 ms</td>
<td>250 ms</td>
<td>500 ms</td>
<td>1 s</td>
<td>2 s</td>
</tr>
<tr>
<td>Trend interval</td>
<td>2 min</td>
<td>5 min</td>
<td>10 min</td>
<td>15 min</td>
<td>20 min</td>
</tr>
<tr>
<td>Sample rate</td>
<td>4 s</td>
<td>10 s</td>
<td>20 s</td>
<td>30 s</td>
<td>40 s</td>
</tr>
<tr>
<td>Trend interval</td>
<td>30 min</td>
<td>1 h</td>
<td>2 h</td>
<td>4 h</td>
<td>10 h</td>
</tr>
<tr>
<td>Sample rate</td>
<td>1 min</td>
<td>2 min</td>
<td>4 min</td>
<td>8 min</td>
<td>20 min</td>
</tr>
</tbody>
</table>

\(^1\) Selectable on the DX1002, DX1002N, DX1004, and DX1004N (release number 3 or later).
\(^2\) Selectable in fast sampling mode on the DX1006, DX1006N, DX1012, and DX1012N (release number 3 or later).
1.4 Data Storage Function

- **Recording Conditions of Event Data**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source channels</td>
<td>Same as the display data.</td>
</tr>
<tr>
<td>Sampling interval</td>
<td>Select from the available settings between 25 ms to 30 min. However, you cannot specify an interval that is faster than the scan interval.</td>
</tr>
</tbody>
</table>
| File creation         | A file is created when the specified data length is reached. Files are also created in the following cases.  
                          • When a file is created manually.  
                          • When the memory sampling is stopped.  
                          • When file creation is executed with the event action function.  
                          • After recovering from a power failure. |
| Mode                  | The available modes are **Free** (continuously record), **Single**, and **Repeat**. The recording operation varies depending on the mode as follows:  
                          - **Free**  
                            Press the START key to start recording (memory start) and the STOP key to stop the recording (memory stop). |
|                       | **Single**  
                            Pressing the START key places the DX in the trigger-wait state. When the trigger condition is met, the DX records data for a specified time (data length) and stops. From this point, the DX does not record even if the trigger condition is met. |
|                       | **Repeat**  
                            Pressing the START key places the DX in the trigger-wait state. When the trigger condition is met, the DX records data for a specified time (data length) and stops. The DX enters the trigger-wait state again and keeps recording the data for a specified time (data length) each time the trigger condition is met. To stop the recording of the event data, press the STOP key. |

- **Pretrigger of Event Data**

The pretrigger can be specified in trigger mode. This function is used to save the data before the point where the trigger condition is met as event data. This function is convenient when you wish to record the data before the occurrence of a certain event such as when an alarm occurs. Specify the pretrigger as a percentage (0%, 5%, 25%, 50%, 75%, 95%, or 100%) of the recording time (data length) of the event data. If set to 0%, the data after the trigger condition is met is recorded.

- **Trigger for Starting the Event Data Recording**

When set to trigger mode, you can set various conditions for starting the recording. Example: Key operation, alarm occurrence, specific time, or remote control.
1.4 Data Storage Function

- Creating Files through Key Operation
  Files can be created using keys.

For operating instructions, see “Saving the Display Data or Event Data during Memory Sampling through Key Operation” in section 6.4.

Manual Sampled Data
Manual sampled data is recorded to the internal memory. When the number of manual sampled data exceeds 400, the data is overwritten from the oldest data.

Report Data
Report data is recorded to the internal memory. When the number of report data exceeds 100, the data is overwritten from the oldest data.
1.4 Data Storage Function

Saving Data to the External Storage Medium
For the setting and operating procedure, see sections 6.2 and 6.4 respectively.

- Type of External Storage Medium
  - CF card (32 MB or more)
  - USB flash memory (USB1 option)

- Auto Save
  Have the CF card inserted in the slot at all times. The data in the internal memory is automatically saved to the CF card.

Auto Save Timing

<table>
<thead>
<tr>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display data</td>
<td>The file is saved when the file is created.</td>
</tr>
<tr>
<td>Event data</td>
<td>Same as the display data.</td>
</tr>
<tr>
<td>Manual sampled data</td>
<td>The first time manual sample is executed, a manual sampled data file is created on the CF card. The data is appended to this file for each subsequent manual sample operation. A new file is created after manual sampled data has been stored 100 times. For operating instructions, see section 6.5.</td>
</tr>
<tr>
<td>Report data</td>
<td>The first time report data is generated, a report data file is created on the CF card and report data is stored. The report data is appended to this file every time of report. Dividing of the report files The appending of the report data to the file is stopped at a specified time, and subsequent reports are saved to a new file. The file is divided in the unit shown in the table below. Also, when recording is stopped (memory stop), all report files are divided. Report Template (Release numbers 4 and later) When the report file is divided, a report data file of the format specified by the XML spreadsheet template is created. This function is disabled in the cases listed under “Sept2” below. For the setting procedure, see section 9.5.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Report Type</th>
<th>File for Each Type</th>
<th>One File</th>
<th>Report File</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hourly report</td>
<td>a file for each hour reports of a day</td>
<td>hourly reports of a day</td>
<td>hourly reports of a day</td>
</tr>
<tr>
<td>Daily report</td>
<td>a file for each day report</td>
<td>hourly reports of a day</td>
<td>hourly reports of a day</td>
</tr>
<tr>
<td>Hourly and daily</td>
<td>a file for each weekly report</td>
<td>daily reports for a week and daily reports</td>
<td>daily reports for a week</td>
</tr>
<tr>
<td>reports</td>
<td>report</td>
<td>report</td>
<td>report</td>
</tr>
<tr>
<td>Daily and weekly</td>
<td>a file for each weekly report</td>
<td>daily reports for a week and weekly reports</td>
<td>daily reports for a week</td>
</tr>
<tr>
<td>reports</td>
<td>report</td>
<td>report</td>
<td>report</td>
</tr>
<tr>
<td>Daily and monthly</td>
<td>a file for each monthly report</td>
<td>daily reports for a month and monthly report</td>
<td>daily reports for a month</td>
</tr>
<tr>
<td>reports</td>
<td>report</td>
<td>report</td>
<td>report</td>
</tr>
</tbody>
</table>

*1 Available for release numbers 4 and later.
*2 When media FIFO is enabled, files are divided at approximately every 100 KB.

Save Destination
CF card.

Data Save Destination Directory
You can set the data save destination directory name (DATA0 by default). The specified directory is created on the CF card, and the data is saved in the directory.

Save Operation (If Media FIFO Is Disabled)
The data in the internal memory can be saved only if there is sufficient free space on the CF card. Replace the CF card and save the data before the data in the internal memory is overwritten.
Save Operation (Constantly Retaining the Most Recent Data Files Using Media FIFO) (Release Number 2 or Later)
When saving the data files automatically, you can save the data so that the most recent data files are constantly retained in the CF card. This method allows you to use the DX continuously without having to replace the CF card.

- Operation

If not enough free space is available when saving a new data file to the CF card, files are deleted in order from the oldest data update date/time to save the new file. This operation is referred to as FIFO (First In First Out).

- The FIFO operation is carried out only when saving the following files automatically. It is not carried out when saving files to the save destination directory using another method. Display data files, event data files, report data files, manual sample data files, and snapshot data files
- Files that are deleted
  All the files in the save destination directory are applicable to be deleted. However, the following files are excluded. Hidden files, read-only files, files in the subdirectory within the save destination directory
- The most recent 1000 files are retained. If the number of files in the save destination directory exceeds 1000, the number of files is held at 1000 by deleting old files even if there is enough free space.
- If there are more than 1000 files already in the save destination directory, one or more files are always deleted before saving the new file. The number of files is not kept within 1000 in this case.

- Manual Save (Collectively Storing Unsaved Data)
Unsaved data in the internal memory is stored in unit of files to the external storage medium when an external storage medium is inserted and a given operation is carried out.

When using manual save, it is important that you save the data in the internal memory to the external storage medium before the data is overwritten. Determine the usage condition of the internal memory and save the data to the external storage medium at appropriate times.

Save Destination
You can select a CF card or USB flash memory (/USB1 option).

Data Save Destination Directory
You can set the data save destination directory name (DATA0 by default).
### 1.4 Data Storage Function

#### File Name

You can select the file name configuration from three types.

<table>
<thead>
<tr>
<th>Structure</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Date</strong></td>
<td><strong>Display data</strong>&lt;br&gt;Event data&lt;br&gt;Manual sampled data&lt;br&gt;SnapShot data</td>
</tr>
<tr>
<td>Date</td>
<td>Use a 7-digit, 6-digit number and 1-character delimiter.</td>
</tr>
<tr>
<td>7-digit</td>
<td>Used to store data.</td>
</tr>
<tr>
<td>Specified string</td>
<td>Contains up to 16 alphanumeric characters.</td>
</tr>
<tr>
<td>Date</td>
<td>Ex.: 000123_AAAAAAAAAAA050928_174633.DAD</td>
</tr>
<tr>
<td>Extension</td>
<td>Ex.: 000123_AAAAAAAAAAA050928_174633HD.DAR</td>
</tr>
<tr>
<td><strong>Serial</strong></td>
<td><strong>Display data</strong>&lt;br&gt;Event data&lt;br&gt;Manual sampled data&lt;br&gt;SnapShot data</td>
</tr>
<tr>
<td>Serial</td>
<td>Use a 7-digit, 6-digit number and 1-character delimiter.</td>
</tr>
<tr>
<td>7-digit</td>
<td>Used to store data.</td>
</tr>
<tr>
<td>Batch name</td>
<td>Ex.: 000123_BBBBBBBBBBBB.DAD</td>
</tr>
<tr>
<td><strong>Batch name</strong></td>
<td><strong>Display data</strong>&lt;br&gt;Event data&lt;br&gt;Manual sampled data&lt;br&gt;SnapShot data</td>
</tr>
<tr>
<td>Batch name</td>
<td>Use a 7-digit, 6-digit number and 1-character delimiter.</td>
</tr>
<tr>
<td>7-digit</td>
<td>Used to store data.</td>
</tr>
<tr>
<td>Batch name</td>
<td>Ex.: 000123_050928_174633.DAM</td>
</tr>
<tr>
<td><strong>Item</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>7-digit</td>
<td><strong>Date</strong>&lt;br&gt;YYMMDD_hhmmss</td>
</tr>
<tr>
<td>6-digit number</td>
<td>YY: Year (lower two digits), MM: Month, DD: Day</td>
</tr>
<tr>
<td>Date</td>
<td>hh: Hour, mm: Minute, ss: Second</td>
</tr>
<tr>
<td>Specified string</td>
<td>AAAAAAA              Up to 16 alphanumeric characters can be used</td>
</tr>
<tr>
<td>Batch name</td>
<td>BBBBBBBBBBBB            Up to 40 alphanumeric characters can be used</td>
</tr>
<tr>
<td>Extension</td>
<td>Display data :DAD&lt;br&gt;Event data :DAE&lt;br&gt;Manual sampled data :DAM&lt;br&gt;SnapShot data :PNG</td>
</tr>
</tbody>
</table>

#### Note

Differences from the File Names up to Now

- The “ID” item at the end of the file name is deleted and its functionality is included in the “Separator” of the 7-digit sequence.

Example

- DXs before release number 2: 000123_AAAAAAAAAAA050928_174633.DAD
  - The “ID” functionality has been shifted.

- DXs with release number 2 or later: 000123_AAAAAAAAAAA050928_174633.DAD
  - The sequence section of the display data and event data file names is changed to 7 digits, and the “ID” function is included in the “Separator” when using the “Batch name.”
1.4 Data Storage Function

**File Names on DXs before Release Number 2**

The table below shows the file name that is assigned when the measured data is saved to the CF card.

<table>
<thead>
<tr>
<th>Structure</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Date</strong></td>
<td></td>
</tr>
<tr>
<td>Display data</td>
<td>7-digit Specified string Date ID . Extension</td>
</tr>
<tr>
<td>Event data</td>
<td></td>
</tr>
<tr>
<td>Manual sampled data</td>
<td></td>
</tr>
<tr>
<td>Snapshot data</td>
<td></td>
</tr>
<tr>
<td>Report data</td>
<td></td>
</tr>
<tr>
<td>Ex.: 000123_AAAAAAAAAAAAA050928_1746330.DAD</td>
<td></td>
</tr>
<tr>
<td><strong>Serial</strong></td>
<td></td>
</tr>
<tr>
<td>Display data</td>
<td>7-digit Specified string ID . Extension</td>
</tr>
<tr>
<td>Event data</td>
<td></td>
</tr>
<tr>
<td>Manual sampled data</td>
<td></td>
</tr>
<tr>
<td>Snapshot data</td>
<td></td>
</tr>
<tr>
<td>Report data</td>
<td></td>
</tr>
<tr>
<td>Ex.: 000123_AAAAAAAAAAAAA0.DAD</td>
<td></td>
</tr>
<tr>
<td><strong>Batch name</strong></td>
<td></td>
</tr>
<tr>
<td>Display data</td>
<td>3-digit Batch name ID Extension</td>
</tr>
<tr>
<td>Event data</td>
<td></td>
</tr>
<tr>
<td>Manual sampled data</td>
<td></td>
</tr>
<tr>
<td>Snapshot data</td>
<td></td>
</tr>
<tr>
<td>Report data</td>
<td></td>
</tr>
<tr>
<td>Ex.: 123BBBBBBBBBBBBBBB0.DAD</td>
<td></td>
</tr>
</tbody>
</table>

**Item**          | **Description**               |
| Date             | YYMMDD_hhmmss Same as release number 2 and later. |
| 7-digit sequence | 000001 to 999999 Consists of a 6-digit number and an underscore as a separator. A sequence number in the order of occurrence. |
| 3-digit sequence | 001 to 999 A sequence number in the order of occurrence. |
| Type             | H_, D_, W_, M_, HD, DW, DM Report data type Same as release number 2 and later. |
| ID               | 0 to 9, A to Z When a file with the same name exists in the specified directory, the file is saved by changing the ID character to prevent overwriting. Example: If a file named “000123_AAAAA050907_1036480.DAD” already exists, the file is saved to the name “000123_AAAAA050907_1036481.DAD.” |
| Extension        | Except for xml, same as release numbers 2 and later. |
• Saving Data through Key Operation
You can carry out the following data save operations regardless of whether auto save or manual save is used.

<table>
<thead>
<tr>
<th>Data Storage</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All save</td>
<td>Collectively saves all the data in the internal memory.</td>
</tr>
<tr>
<td>Selective save</td>
<td>Saves the specified display data or event data file.</td>
</tr>
<tr>
<td>Manual sampled data save</td>
<td>Collectively saves all the manual sampled data in the internal memory.</td>
</tr>
<tr>
<td>Report data save</td>
<td>Collectively saves all the report data in the internal memory.</td>
</tr>
</tbody>
</table>

Save Destination
You can select a CF card or USB flash memory (/USB1 option).

Data Save Destination Directory
Creates a directory with the name of the data save destination directory name with the date/time added and saves the data.

Directory name: “Specified string”_YYMMDD_HHMMSS
Example: If the data is saved at 17 hours 6 minutes 42 seconds on September 30, 2005, the data is saved to a directory named “DATA0_050930_170642.” “DATA0” is the specified string.

Note
The number of directories that you can create on the external storage medium varies depending on the length of the directory names. If the length of the “specified string” is 5 characters, approximately 170 directories can be created. If it is 20 characters, approximately 120 directories can be created. An error occurs, if you try to create directories exceeding this limit.

Other Types of Data That Can Be Stored
• Setup Data
The setup data of the DX is saved to a CF card or USB flash memory (/USB1 option). The setup data is saved to the root directory.

Name of the setup data file

<table>
<thead>
<tr>
<th>Specified</th>
<th>PDL</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABCD10005.PDL</td>
<td></td>
</tr>
</tbody>
</table>

• Snapshot Data
The screen that the DX displays is saved to a CF card in PNG format. The data is saved to the same directory as the display data and event data. For the file name, see the previous page.

• Custom Display Setup Data
See the Custom Display User’s Manual, IM04L41B01-04E.

Saving Data via the Ethernet Network
Display data, event data, report data (I/M1 or I/PM1 option), and screen image data (snapshot data) can be automatically transferred and saved to an FTP server via the Ethernet network by using the FTP client function. Conversely, the DX can function as an FTP server. The DX can be accessed from a PC and the data files in the internal memory or the external storage medium can be retrieved to be stored on the PC.

See the Communication Interface User’s Manual IM 04L41B01-17E.
1.5 Batch Function

This section explains the DX batch function. For information about the multi batch function (/BT2 option), see the Multi Batch (/BT2) User’s Manual, IM04L41B01-03E.

Overview

You can add batch information to the display data and event data files. The files can be managed using the batch information. For the setting and operating procedure, see section 6.3.

Batch Information

- **Batch Number and Lot Number**
  Display data and event data files can be identified by their “batch number-lot number” (hereinafter referred to as batch name). The lot number does not have to be specified.
  - Batch number (up to 32 characters).
    - Lot number (up to 8 digits)

- **Automatic Increment of the Lot Number**
  The lot number can be automatically incremented when the memory sampling is stopped.

- **Text Field**
  You can enter text fields into a file. There are 24 available text fields (release number 3 or later). Each text field consists of the following:
  - Field title (up to 20 characters)
  - Field string (up to 30 characters)
  The text field can be shown on the DX screen through key operation.

- **Batch Comment**
  Three arbitrary comments can be entered in a file. A single comment can be entered while memory sample is in progress.
  - Comment 1, Comment 2, and Comment 3 (up to 50 characters each)

Using the Batch Function

See the figure below. For example, enter the operator and administrator in the text field.

![Diagram of batch function usage](image-url)
1.6 Event Action and Remote Control Functions (/R1 and /PM1 Options)

A specified action is carried out when an event occurs. This function is called event action. The remote control function (/R1 and /PM1 options) allows you to specify actions to be performed when the terminal receives a contact input or an open collector signal. The remote control function is configured using the event action function.

For the setting procedure, see section 7.1.

Events

- Events
  Select from the following events.

<table>
<thead>
<tr>
<th>Event</th>
<th>Level/Edge</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote</td>
<td>Level/Edge</td>
<td>ON/OFF of the remote control input.</td>
</tr>
<tr>
<td>Output relay</td>
<td>Level/Edge</td>
<td>Activated/Deactivated condition of the alarm output relay.</td>
</tr>
<tr>
<td>Relay-Off</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Internal switch</td>
<td>Level/Edge</td>
<td>The value, 0 (off) or 1 (on), of the internal switch.</td>
</tr>
<tr>
<td>Switch-Off</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Timer</td>
<td>Edge</td>
<td>Timer timeout.</td>
</tr>
<tr>
<td>Match time timer</td>
<td>Edge</td>
<td>When the time matches.</td>
</tr>
<tr>
<td>Alarm</td>
<td>Level/Edge</td>
<td>The state in which any alarm is occurring and the state in which no alarm is occurring.</td>
</tr>
<tr>
<td>Alarm-Off</td>
<td></td>
<td></td>
</tr>
<tr>
<td>USER key</td>
<td>Edge</td>
<td>The operation of pressing the USER key.</td>
</tr>
<tr>
<td>Event edge switch*2</td>
<td>Edge</td>
<td>Can be caused by:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The Edge Switch soft key in the FUNC key menu.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• A dedicated communication command or Modbus communication.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The custom display.</td>
</tr>
<tr>
<td>Event level switch*2</td>
<td>Level</td>
<td>You can view the status of the switch in the event level switch status display. Can be caused by:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• A dedicated communication command or Modbus communication.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The custom display.</td>
</tr>
</tbody>
</table>

*1 For a description of level and edge, see “Miscellaneous” in this section.

*2 This function is available for release numbers 3 and later.

*3 This function is available for release numbers 4 and later.

- Output Relay, Internal Switch, Alarm, Event Level Switch

The output relay, internal switch, alarm, and event level switch have two states, state A and state B, which are explained in the table below. In explanations, “Output relay” and similar states are referred to as “ON events,” and “Relay-Off” and similar states are referred to as “OFF events.”

<table>
<thead>
<tr>
<th>Event</th>
<th>State A</th>
<th>State B</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output relay</td>
<td>Deactivated</td>
<td>Activated</td>
</tr>
<tr>
<td>Internal switch</td>
<td>OFF</td>
<td>ON</td>
</tr>
<tr>
<td>Alarm</td>
<td>No alarms</td>
<td>At least one alarm</td>
</tr>
<tr>
<td>Event level switch</td>
<td>OFF</td>
<td>ON</td>
</tr>
</tbody>
</table>

When Edge Is Selected

An ON event occurs when state A changes to state B. An OFF event occurs when state B changes to state A.

When Level Is Selected

If the action states that correspond to states A and B during an ON event are called “state 2” and “state 1,” respectively, the action states that correspond to states A and B during an OFF event will be state 1 and state 2, respectively.

See “Miscellaneous” and “Level and Edge” in this section.
1.6 Event Action and Remote Control Functions (/R1 and /PM1 Options)

- **Timers**
  Four timers are available. The timers are also used with the TLOG computation function (/M1 and /PM1 options).

<table>
<thead>
<tr>
<th>Timer Type</th>
<th>Absolute timer</th>
<th>Relative timer</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Set the timer</td>
<td>Set the timer</td>
</tr>
<tr>
<td></td>
<td>Ref. time</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Time</td>
<td>Time</td>
</tr>
<tr>
<td></td>
<td>A: Interval</td>
<td>B: Interval</td>
</tr>
<tr>
<td></td>
<td>A</td>
<td>A</td>
</tr>
<tr>
<td></td>
<td>A</td>
<td>A</td>
</tr>
<tr>
<td></td>
<td>A</td>
<td>A</td>
</tr>
<tr>
<td></td>
<td>...</td>
<td>...</td>
</tr>
<tr>
<td></td>
<td>Timeout</td>
<td></td>
</tr>
</tbody>
</table>

- **Absolute Time Mode**
  The timer expires at the times determined by the reference time and the interval. The reference time is set on the hour (00 to 23).
  
  Example: Reference time: 00:00
  Interval: 10 min
  The timer expires at 0 hour, 0 hour 10 min, 0 hour 20 min, ... 23 hour 40 min, and 23 hour 50 min. For example, if the timer is set at 9 hour 36 min, the timer expires at 09 hour 40 min, 09 hour 50 min, 10 hour, and so on.

- **Relative Time Mode**
  The timer is started when the timer is set, and the timer expires every specified interval. In this mode, the timer stops when a power failure occurs.
  
  Example: Interval: 00:15
  The timer expires every 15 minutes.

- **Match Time**
  You can set the time matching conditions for the four match time timers. Specify the date/time using the method described below. For each condition, you can select whether to use the condition once or continuously. The timers are also used with the TLOG computation function (/M1 and /PM1 options)

<table>
<thead>
<tr>
<th>Specified Date/Time</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Y hour of the X day of the Z year</td>
<td>The condition is met once a year. This function is available for release numbers 3 and later.</td>
</tr>
<tr>
<td>Y hour of the X day</td>
<td>The condition is met once a month.</td>
</tr>
<tr>
<td>Y hour of the X day of the week</td>
<td>The condition is met once a week.</td>
</tr>
<tr>
<td>Y hour</td>
<td>The condition is met once a day.</td>
</tr>
</tbody>
</table>
### Action

Select from the following actions.

<table>
<thead>
<tr>
<th>Action</th>
<th>Level/Edge</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory start/stop</td>
<td>Level</td>
<td>Starts/stops memory sampling.</td>
</tr>
<tr>
<td>Memory start</td>
<td>Edge</td>
<td>Starts the memory sampling.</td>
</tr>
<tr>
<td>Memory stop</td>
<td>Edge</td>
<td>Stops the memory sampling.</td>
</tr>
<tr>
<td>Event trigger*4</td>
<td>Edge</td>
<td>Applies a trigger for starting the event data recording.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>This is valid when recording event data in trigger mode. See the next page.</td>
</tr>
<tr>
<td>Alarm acknowledge</td>
<td>Edge</td>
<td>Releases the alarm output.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>This is valid when the use of the alarm ACK operation is enabled.</td>
</tr>
<tr>
<td>Computation start/stop*2</td>
<td>Level</td>
<td>It is used to start/stop the computation.</td>
</tr>
<tr>
<td>Computation start*2</td>
<td>Edge</td>
<td>Starts the computation.</td>
</tr>
<tr>
<td>Computation stop*2</td>
<td>Edge</td>
<td>Stops the computation.</td>
</tr>
<tr>
<td>Computation reset*2</td>
<td>Edge</td>
<td>Resets the computed values on all computation channels.</td>
</tr>
<tr>
<td>Save display data</td>
<td>Edge</td>
<td>The display data being recorded is saved to the internal memory as a file.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>This is the same function as the data save operation using the FUNC key.</td>
</tr>
<tr>
<td>Save event data</td>
<td>Edge</td>
<td>The event data being recorded is saved to the internal memory as a file.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>This is the same function as the data save operation using the FUNC key.</td>
</tr>
<tr>
<td>Message</td>
<td>Edge</td>
<td>Writes a message.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>This action can be executed while memory sampling is in progress.</td>
</tr>
<tr>
<td>Snapshot</td>
<td>Edge</td>
<td>Saves the screen image data.</td>
</tr>
<tr>
<td>Switch the display rate</td>
<td>Level</td>
<td>Toggles between the trend interval and the secondary trend interval.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>This action is valid when the DX is configured to use trend interval switching.</td>
</tr>
<tr>
<td>Manual sample</td>
<td>Edge</td>
<td>Executes manual sampling.</td>
</tr>
<tr>
<td>Reset the relative timer</td>
<td>Edge</td>
<td>Resets the relative timer. The timer restarts from that point.</td>
</tr>
<tr>
<td>Switch the display group</td>
<td>Edge</td>
<td>Switches the display group when the trend, digital, or bar graph is displayed.</td>
</tr>
<tr>
<td>Flag*</td>
<td>Level</td>
<td>The flag is zero for normal conditions and 1 when an event occurs.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>When the event is an edge operation, the value alternates between 0 and 1 whenever an event occurs. The flag can be written in a calculation expression of a computation channel.</td>
</tr>
<tr>
<td>Load the setup*</td>
<td>Edge</td>
<td>Loads the setup data file in the root directory of the CF card into the DX and updates the DX settings. See below.</td>
</tr>
<tr>
<td>Adjust the time</td>
<td>Edge</td>
<td>Synchronizes the time to the nearest hour. See the next page.</td>
</tr>
<tr>
<td>Display comment*3</td>
<td>Edge</td>
<td>Displays a preset text string (comment text block). For information about how to set comment text blocks, see section 5.18.</td>
</tr>
<tr>
<td>Show favorite display*3</td>
<td>Edge</td>
<td>Shows the display that is registered to the Favorite key. For information about how to register a display to the Favorite key, see section 5.15.</td>
</tr>
<tr>
<td>Reset alarm display*4</td>
<td>Edge</td>
<td>An operation for when you are using a double lock-in sequence (ISA-M) with the alarm annunciator function. Resets the alarm display. For information about annunciator settings, see section 3.12.</td>
</tr>
</tbody>
</table>

*1 For a description of level and edge, see “Miscellaneous” in this section.

*2 This is an option.

*3 This function is available for release numbers 3 and later.

*4 This action is not available on models with the /AS1 advanced security option.
1.6 Event Action and Remote Control Functions (/R1 and /PM1 Options)

Resetting the Relative Timer
If the event is set to output relay, internal switch, match time timer, or alarm, the resetting of the timer is not considered a timeout. (The action is not executed even if the timer is used as an event.)

Loading the Setup
Can be specified as an action only when the event is set to remote control input. Loads the setup data file, LOAD1.PDL, LOAD2.PDL, or LOAD3.PDL, in the root directory of the CF card into the DX and updates the DX settings. You must create a setup file and save it to the CF card in advance.

Event Trigger Operation
When the event is set to output relay, internal switch, or alarm
If the output relay is activated, the internal switch is 1, or the alarm is occurring during memory sampling, the event trigger is always activated. However, the number of times the trigger is activated depends on the event data mode (single or repeat).

Time Adjustment
Time adjustment can be specified as an action only when the event is set to remote control input. The internal clock of the DX is adjusted to the nearest hour through remote control input.

- Operation When Memory Sampling Is Stopped

<table>
<thead>
<tr>
<th>Difference from the Nearest Hour</th>
<th>Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>00 min 00 s to 01 min to 59 s</td>
<td>Truncates the minutes and seconds. Example: 10 hours 01 min 50 s becomes 10 hours 00 min 00 s.</td>
</tr>
<tr>
<td>02 min 00 s to 57 min to 59 s</td>
<td>The time is not changed.</td>
</tr>
<tr>
<td>58 min 00 s to 59 min to 59 s</td>
<td>Rounds up the minutes and seconds. Example: 10 hours 59 min 50 s becomes 11 hours 00 min 00 s.</td>
</tr>
</tbody>
</table>

- Operation during Memory Sampling
If the time difference between the time the remote control signal is applied and the nearest hour is within the preset time, the time is gradually corrected. Otherwise, the time is corrected immediately. For details, see section 10.1.

On DXs with the /AS1 Advanced Security Option and Release Number 4 or Later

<table>
<thead>
<tr>
<th>Event</th>
<th>Conditions for Execution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output relay, internal switch, timer, match time timer, and alarm</td>
<td>When these events occur, their corresponding actions are performed regardless of the user privilege settings and whether users are logged in.</td>
</tr>
<tr>
<td>User Key</td>
<td>The same as the key operation itself. In setting mode, memory start cannot be performed.</td>
</tr>
<tr>
<td>Event edge switch and event level switch</td>
<td>The same as the key operations themselves. Even in setting mode, memory start cannot be performed.</td>
</tr>
<tr>
<td>Remote</td>
<td>When a remote control signal is received, the corresponding action is performed regardless of the user privilege settings and whether users are logged in. In setting mode, memory start cannot be performed.</td>
</tr>
</tbody>
</table>
1.6 Event Action and Remote Control Functions (/R1 and /PM1 Options)

**Miscellaneous**

- **Limitations on the Combinations of Events and Actions**
  The combinations that are checked in the table below can be used.

<table>
<thead>
<tr>
<th>Action</th>
<th>Event</th>
<th>Remote</th>
<th>Output</th>
<th>Internal</th>
<th>Timer</th>
<th>Match</th>
<th>Time</th>
<th>Alarm</th>
<th>User</th>
<th>Event</th>
<th>Edge</th>
<th>Switch</th>
<th>Event</th>
<th>Level</th>
<th>Switch</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm ACK</td>
<td>✅</td>
<td></td>
<td>✅</td>
<td></td>
<td>✅</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✅</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reset the relative timer</td>
<td>✅</td>
<td>✅</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Load the settings</td>
<td>✅</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Adjust the time</td>
<td></td>
<td>❏</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reset the alarm display</td>
<td>✅</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Other actions</td>
<td></td>
<td>❏</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- **Level and Edge**
  The combinations of events and actions are summarized in the figure below.

**Event Action Example**

The following is an example for when the event is Internal switch (Level or Edge) and the action is Memory start/stop (Level) or Manual sample (Edge).

**Level and Edge of the Remote Control Input Signal**

For contact inputs, the remote signal rises when the contact switches from open to closed and falls when the contact switches from closed to open. For open collector signals, the remote signal rises when the collector signal (voltage level of the remote terminal) goes from high to low and falls when the collector signal goes low to high. You can reverse the above operations (see section 7.3 for details).
1.7 Security Function

This section explains the DX security functions.

For information about the security functions on DXs with the /AS1 advanced security option, see the Advanced Security Function (/AS1) User’s Manual, IM04L41B01-05EN.

Key Lock Function

Key lock is a function that prohibits key operations. You enter a password to release the key lock.

For the setting procedure, see section 8.1.

<table>
<thead>
<tr>
<th>Key Lock Items</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keys</td>
<td>The following keys can be locked independently.</td>
</tr>
<tr>
<td></td>
<td>START key, STOP key, MENU key, USER key, DISP/ENTER key (prohibits switching the operation screen), and Favorite key.</td>
</tr>
<tr>
<td>Access to the storage medium</td>
<td>Prohibits all operations listed below.</td>
</tr>
<tr>
<td></td>
<td>• Manually save the data</td>
</tr>
<tr>
<td></td>
<td>• Load the display data and event data files</td>
</tr>
<tr>
<td></td>
<td>• Save/Load setup data files</td>
</tr>
<tr>
<td></td>
<td>• List the files on the storage medium</td>
</tr>
<tr>
<td></td>
<td>• Delete the files on the storage medium</td>
</tr>
<tr>
<td></td>
<td>• Format the storage medium</td>
</tr>
<tr>
<td>Setup loading</td>
<td>Prevents external storage medium access for the purpose of loading setup files (release number 3 or later).</td>
</tr>
<tr>
<td>Function operation</td>
<td>The following FUNC key operations can be locked independently.</td>
</tr>
<tr>
<td></td>
<td>• [Alarm ACK], [Alarm DispRST]1</td>
</tr>
<tr>
<td></td>
<td>• [Message], [Free message], [Batch], [Add Message], [Add Free Message]</td>
</tr>
<tr>
<td></td>
<td>[Text field]</td>
</tr>
<tr>
<td></td>
<td>• [Math start],2 [Math stop],2 [Math reset],2</td>
</tr>
<tr>
<td></td>
<td>[Math ACK]2</td>
</tr>
<tr>
<td></td>
<td>• [Save display], [Save event], [Manual sample], [Trigger], [Snap shot], [Timer reset], [Save stop], [Edge Switch],1 [Match T Reset]1</td>
</tr>
<tr>
<td></td>
<td>• [E-Mail start], [E-Mail stop], [E-Mail test], [FTP test], Operations to [Request] or [Release] network information</td>
</tr>
<tr>
<td></td>
<td>• [SNTP], time setting (operation in the setting mode)</td>
</tr>
<tr>
<td></td>
<td>• [Favorite regist], [Standard display], [Second speed], [Normal speed], [Builder]1</td>
</tr>
</tbody>
</table>

*1 Available for release numbers 3 and later.
*2 Optional.
Login Function

Only registered users can operate the DX. Access from communication functions can also be limited to users registered here.

For the setting and operating procedure, see sections 8.2 and 8.3 respectively.

- **Login and Logout**
  You enter your user name and password to log into the DX in the following cases.

<table>
<thead>
<tr>
<th>Method of Accessing the DX</th>
<th>Login Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keys</td>
<td>• When the power is turned ON</td>
</tr>
<tr>
<td></td>
<td>• When logging in after exiting the basic setting mode</td>
</tr>
<tr>
<td></td>
<td>• When logging in after logging out</td>
</tr>
<tr>
<td>Communication</td>
<td>When accessing the setting/measurement server, FTP server, maintenance/test server, or Web server.</td>
</tr>
</tbody>
</table>

**Auto Logout (When Logged in Using Keys)**
When logged in using keys, you are automatically logged out when there is no key operation for a specified time. If you are automatically logged out from the setting mode, the setting changes are cancelled. You are not automatically logged out during basic setting mode.

**Operations That Can Be Carried Out When Logged Out**
When logged out, you can switch the operation screen using the DISP/ENTER key, arrow keys and Favorite key.

- **User Levels**
  A user can be an “administrator” or a “user.”

**Administrator**
Administrators can perform all operations on the DX. At least one administrator must be registered to use the login function.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of users that can be registered</td>
<td>5</td>
</tr>
<tr>
<td>Range of operations</td>
<td>All operations.</td>
</tr>
<tr>
<td>Login method</td>
<td>Select key operation, via communication, or Web server login.</td>
</tr>
<tr>
<td>ID information</td>
<td>User name and password</td>
</tr>
</tbody>
</table>

**User**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of users that can be registered</td>
<td>30</td>
</tr>
<tr>
<td>Range of operations</td>
<td>Key operations</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Operation</th>
<th>Limitation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic setting mode</td>
<td>Not allowed</td>
</tr>
<tr>
<td>Setting mode</td>
<td>Customize menus, Not allowed</td>
</tr>
<tr>
<td>Other</td>
<td>Specified by user privileges</td>
</tr>
<tr>
<td>Operation mode</td>
<td>Key operation, Specified by user privileges</td>
</tr>
</tbody>
</table>

- **User privileges**
  You can set operation privileges for each user. The privileges are the same as with the key lock function.

**Operations via communication**
See the Communications Interface User’s Manual.

| Login method | Select key operation, via communication, or Web server login. |
| ID information | User name and password |

1.7 Security Function
1.8 Computation and Report Function (/M1 and /PM1 Options)

Computation Function

Equations can be defined in computation channels by using the measured data or computed data as variables. The result of the computation can be displayed or stored. For the setting procedure, see section 9.1.

- Channels Dedicated to Computations

<table>
<thead>
<tr>
<th>Model</th>
<th>Number of Channels</th>
<th>Channel Numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>DX1002, DX1004, DX1002N, DX1004N</td>
<td>12</td>
<td>101 to 112</td>
</tr>
<tr>
<td>DX1006, DX1012, DX1006N, DX1012N</td>
<td>24</td>
<td>101 to 124</td>
</tr>
</tbody>
</table>

- Computation Types

In the table below, [001] represents the measured value of channel 001.

<table>
<thead>
<tr>
<th>Type</th>
<th>Example</th>
<th>Description of the Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Four arithmetic</td>
<td>001+002</td>
<td>Determines the sum of [001] and [002].</td>
</tr>
<tr>
<td>operation</td>
<td>001-002</td>
<td>Determines the difference between [001] and [002].</td>
</tr>
<tr>
<td></td>
<td>001*002</td>
<td>Determines the product of [001] and [002].</td>
</tr>
<tr>
<td></td>
<td>001/002</td>
<td>Divides [001] by [002].</td>
</tr>
<tr>
<td>Power</td>
<td>001**002</td>
<td>Determines [001] to the power of [002]. $y = \text{X}^\text{n}$</td>
</tr>
<tr>
<td>Square root</td>
<td>SQR(001)</td>
<td>Determines the square root of [001].</td>
</tr>
<tr>
<td>Absolute value</td>
<td>ABS(001)</td>
<td>Determines the absolute value of [001].</td>
</tr>
<tr>
<td>Common logarithm</td>
<td>LOG(001)</td>
<td>Determines the common logarithm of [001]. $y = \log_{10}x$</td>
</tr>
<tr>
<td>Natural logarithm</td>
<td>LN(001)</td>
<td>Determines the natural logarithm of [001]. $y = \ln x$</td>
</tr>
<tr>
<td>Exponent</td>
<td>EXP(001)</td>
<td>Determines $e$ to the power of [001]. $y = e^x$</td>
</tr>
<tr>
<td>Relational</td>
<td>001.LT.002</td>
<td>The result is 1 when [001] is less than [002] or 0 otherwise.</td>
</tr>
<tr>
<td>computation</td>
<td>001.LE.002</td>
<td>The result is 1 when [001] is less than equal to [002] or 0 otherwise.</td>
</tr>
<tr>
<td></td>
<td>001.GT.002</td>
<td>The result is 1 when [001] is greater than [002] or 0 otherwise.</td>
</tr>
<tr>
<td></td>
<td>001.GE.002</td>
<td>The result is 1 when [001] is greater than equal to [002] or 0 otherwise.</td>
</tr>
<tr>
<td></td>
<td>001.EQ.002</td>
<td>The result is 1 when [001] is equal to [002] or 0 otherwise.</td>
</tr>
<tr>
<td></td>
<td>001.NE.002</td>
<td>The result is 1 when [001] is not equal to [002] or 0 otherwise.</td>
</tr>
<tr>
<td>Logical computation</td>
<td>001AND002</td>
<td>The result is 1 when [001] and [002] are nonzero or 0 otherwise.</td>
</tr>
<tr>
<td></td>
<td>001OR002</td>
<td>The result is 1 when [001] or [002] or both are nonzero or 0 otherwise.</td>
</tr>
<tr>
<td></td>
<td>001XOR002</td>
<td>The result is 0 when [001] and [002] are nonzero or 1 otherwise.</td>
</tr>
<tr>
<td></td>
<td>NOT001</td>
<td>The result is 1 when [001] is zero or 0 otherwise.</td>
</tr>
<tr>
<td>TLOG computation*</td>
<td>TLOG.SUM(001)</td>
<td>Determines the sum of [001].</td>
</tr>
<tr>
<td></td>
<td>TLOG.MAX(001)</td>
<td>Determines the maximum value of [001].</td>
</tr>
<tr>
<td></td>
<td>TLOG.MIN(001)</td>
<td>Determines the minimum value of [001].</td>
</tr>
<tr>
<td></td>
<td>TLOG.AVE(001)</td>
<td>Determines the average value of [001].</td>
</tr>
<tr>
<td></td>
<td>TLOG.P-P(001)</td>
<td>Determines the difference between the maximum value and minimum value of [001].</td>
</tr>
</tbody>
</table>

* See “Usage of TLOG Computations” in this section.
1.8 Computation and Report Function (/M1 and /PM1 Options)

<table>
<thead>
<tr>
<th>Type</th>
<th>Example</th>
<th>Description of the Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>CLOG computation</td>
<td>CLOG.SUM(001.002.003)</td>
<td>Determines the sum of [001], [002], and [003].</td>
</tr>
<tr>
<td></td>
<td>CLOG.MAX(001.002.003)</td>
<td>Determines the maximum value among [001], [002], and [003].</td>
</tr>
<tr>
<td></td>
<td>CLOG.MIN(001.002.003)</td>
<td>Determines the minimum value among [001], [002], and [003].</td>
</tr>
<tr>
<td></td>
<td>CLOG.AVE(001.002.003)</td>
<td>Determines the average value of [001], [002], and [003].</td>
</tr>
<tr>
<td></td>
<td>CLOG.P-P(001.002.003)</td>
<td>Determines the difference between the maximum value and the minimum value among [001], [002], and [003].</td>
</tr>
<tr>
<td>Special computation</td>
<td>PRE(001)</td>
<td>Determines the previous value of [001].</td>
</tr>
</tbody>
</table>

101=HOLD(001.GT.K01).TLOG.SUM(001)

Under normal conditions, TLOG.SUM(001) is carried out to derive the computed value. When [001] exceeds K01, the previous computed value is held.

Description

K01

HOLD(a):b

When a is zero, b is carried out to derive the computed value. Otherwise, the previous computed value is held.

RESET(101.GT.K01):TLOG.SUM(001)

Under normal conditions, TLOG.SUM(001) is carried out to derive the computed value. When [101] exceeds K01, the previous computed value is reset, and TLOG.SUM(001) is carried out.

Description

K01

RESET(a):b

When a is zero, b is carried out to derive the computed value. Otherwise, the previous computed value is reset, and b is carried out to derive the computed value.

CARRY(K01):TLOG.SUM(001)

Under normal conditions, TLOG.SUM(001) is carried out to derive the computed value. When the computed value is greater than or equal to K01, the computed result is the excess (computed value – K01).

Description

K01

CARRY(a):b

Only TLOG.SUM can be specified for b. If the computed value X of b is less than a, the computed result is X. If X is greater than or equal to a, the computed result is the excess (X – a).

Conditional equation [001.GT.K01?001:001+002]

When [001] is greater than K01, the computed value is set to the value of [001]. Otherwise, the computed value is set to the value of [001] + [002].

Description

[a?b:c]

If the computed result of a is nonzero, b is carried out. Otherwise, c is carried out.
1.8 Computation and Report Function (/M1 and /PM1 Options)

### Data That Can Be Used in Equations

The data listed below can be used.

<table>
<thead>
<tr>
<th>Data</th>
<th>Notation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Measurement channel data</td>
<td>001, etc.</td>
<td>Specify the computed data using a channel number.</td>
</tr>
<tr>
<td>Computation Channel data</td>
<td>101, etc.</td>
<td>Specify the computed data using a channel number.</td>
</tr>
<tr>
<td>Constant</td>
<td>K01 to K60</td>
<td>A value.</td>
</tr>
<tr>
<td>Communication input data</td>
<td>C01 to C24</td>
<td>Data set through communications.</td>
</tr>
<tr>
<td>Status of the remote control input</td>
<td>D01 to D08</td>
<td>The value is 1 when the remote control input is ON or 0 when it is OFF.</td>
</tr>
<tr>
<td>Pulse input</td>
<td>P01 to P08</td>
<td>Counts the number of pulses per scan interval.</td>
</tr>
<tr>
<td>Communication input data</td>
<td>Q01 to Q08</td>
<td>Counts the number of pulses per second.</td>
</tr>
<tr>
<td>Internal switch status</td>
<td>S01 to S30</td>
<td>1 or 0.</td>
</tr>
<tr>
<td>Alarm output relay status</td>
<td>I01 to I06</td>
<td>The value is 1 when activated or 0 when deactivated.</td>
</tr>
<tr>
<td>Flag</td>
<td>F01 to F08</td>
<td>1 or 0. Set the flag using the event action function (see section 1.6).</td>
</tr>
<tr>
<td>Recording (memory sample) status</td>
<td>M01 to M06</td>
<td>The value is 1 when recording is taking place and 0 when recording is stopped. When the multi batch function is not being used (release number 3 or later; /BT2 option), M01 indicates the recording (memory sample) status. When the multi batch function is being used, M01 to M06 indicate the recording (memory sample) statuses of each batch. The recording status of an inactive batch group is 0. This function is available for release numbers 3 and later.</td>
</tr>
</tbody>
</table>

*1 An option.

*2 Values such as 01 are terminal numbers.

Only the data that are checked in the table below can be used in TLOG, CLOG, and PRE.

<table>
<thead>
<tr>
<th>Comp. Type</th>
<th>Data</th>
<th>Meas. Channel</th>
<th>Comp. Channel</th>
<th>Constant</th>
<th>Comm. Input</th>
<th>Remote</th>
<th>Pulse</th>
<th>Internal Switch</th>
<th>Relay</th>
<th>Flag</th>
<th>Record status</th>
</tr>
</thead>
<tbody>
<tr>
<td>TLOG</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>CLOG</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>PRE</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Other computations</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

Example: TLOG.SUM(S01), CLOG.AVE(001.002.K01), and PRE(S01) are not allowed.

### Processing Order of Computation

Computation is processed in order from the smallest event action number for each scan interval.

Example: If you specify 102 = 101 + 103, the value of the previous scan interval is used for the 103 value.

### Handling of the Unit in Computations

In computations, measured values are handled as values without units. For example, if the measured data from channel 001 is 20 mV and the measured data from channel 002 is 20 V, the computed result of 001 + 002 is 40.

### Displaying the Computed Data

The computed data is displayed by setting a measurement span for each computation channel. Computation channels can be displayed on various operation screens in the same fashion as the measurement channels.

For the setting procedure, see section 9.3.

### Alarm

Up to 4 alarms can be assigned to each computation channel. The alarm types are high limit alarm (H), low limit alarm (L), delay high limit alarm (T), and delay low limit alarm (t).

### Saving Computed Data

As with the measured data, the computed data can be saved to display data, event data, manual sampled data, and report data.
• **Computation Data Dropout**
  A computation data dropout occurs if the computation is not completed within the scan interval. For the operating procedure, see section 9.4.
  • The computation icon in the status display section turns yellow.
  • When a computation data dropout occurs, the computed data of the scan interval in which the dropout occurred is set to the data immediately before the dropout.
  • If computation data dropout occurs frequently, lessen the load on the CPU by reducing the number of computation channels or setting a longer scan interval.

• **Numeric Display and Recording**
  The range of displayed values of computed data is from –9999999 to 99999999 excluding the decimal point. The decimal place corresponds to the decimal place of the lower limit span of the computation channel. On the numeric display, values are displayed if the computed result is within the above range regardless of the upper and lower limits of span. The following table indicates special displays.

<table>
<thead>
<tr>
<th>Display/Recording</th>
<th>Computed Data Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>+Over</td>
<td>• +Display over: When the computed result exceeds 99999999</td>
</tr>
<tr>
<td></td>
<td>• +Computation over: When the value exceeds approximately 3.4×10^38 in the middle of the computation</td>
</tr>
<tr>
<td></td>
<td>• When a computation error* occurs (select +Over or –Over.)</td>
</tr>
<tr>
<td>–Over</td>
<td>• –Display over: When the computed result is less than –9999999</td>
</tr>
<tr>
<td></td>
<td>• –Computation over: When the value is less than approximately –3.4×10^38 in the middle of the computation</td>
</tr>
<tr>
<td></td>
<td>• When a computation error* occurs (select +Over or –Over.)</td>
</tr>
</tbody>
</table>

* Computation error occurs when the following computation is carried out.
  • X/0, SQR(–X), or LOG(–X)
  • If a channel number set to skip or Off is used in the equation

• **Rolling Average**
  The rolling average of the computed result of the equation specified for the computation channel is determined, and the result is the computed data for that channel. The number of samples and the sampling interval can be specified for each computation channel. The rolling average is applied over the time corresponding to “the number of data samples × the sampling interval.” The maximum sampling interval is 1 hour, and the maximum number of samples is 1500.

• **Starting the Computation**
  You can configure the DX to start the computation when you press the START key.

• **Usage of TLOG Computations**
  TLOG computation determines the sum, maximum, minimum, average, or the difference between the maximum and minimum of a specific channel for each interval determined by a timer.

**Timers That Are Used**
The timer that is used is assigned to each channel.

**Unit of Sum Computation**
Set the sum scale when using sum computation (TLOG.SUM). Select Off, /s, /min, or /h. For details, see the next page.
1.8 Computation and Report Function (/M1 and /PM1 Options)

Resetting the TLOG Computed Value
You can select whether to reset the TLOG computed value at each interval. The figure below illustrates the reset operation for sum computation (TLOG.SUM).

Example: Result of the TLOG.SUM computation

<table>
<thead>
<tr>
<th>Timer timeout</th>
<th>1</th>
<th>2</th>
<th>3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reset: On</td>
<td>Reset</td>
<td>Reset</td>
<td>Reset</td>
</tr>
<tr>
<td>Reset: Off</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

When reset is On, the sum value is calculated over each interval. When set to Off, the sum value from computation start is calculated.

Power Failure Operation, Handling of Error Data, and Handling of Overflow Data
See "Special Data Handling" in this section.
Report Function

This function is used to create hourly, daily, weekly, and monthly reports.

- **Report Data Types**
  You can select from four types among maximum value, minimum value, average value, sum value, and instantaneous value.

- **Report Type**

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hourly report</td>
<td>Creates report data every hour on the hour for the previous one hour.</td>
</tr>
<tr>
<td>Daily report</td>
<td>Creates report data every day at a specified time for the previous one day.</td>
</tr>
<tr>
<td>Weekly report</td>
<td>Creates report data every week at a specified time at a specified day of the week for the previous one week.</td>
</tr>
<tr>
<td>Monthly report</td>
<td>Creates report data every month at a specified time at a specified day for the previous one month.</td>
</tr>
</tbody>
</table>

- **Combinations of Reports That Can Be Created**
  You can select from hourly reports only, daily reports only, hourly and daily reports, daily and weekly reports, and daily and monthly reports.

- **Source Channels**
  You can select from measurement channels and computation channels. The report data are not created for channels that are set to **Skip** or **Off**.

<table>
<thead>
<tr>
<th>Model</th>
<th>Number of channels</th>
</tr>
</thead>
<tbody>
<tr>
<td>DX1002, DX1004, DX1002N, DX1004N</td>
<td>12</td>
</tr>
<tr>
<td>DX1006, DX1012, DX1006N, DX1012N</td>
<td>24</td>
</tr>
</tbody>
</table>

- **Unit of Sum Computation**
  In the sum computation, data are summed over the scan interval. However, for flow values that have units /s, /min, /h, or /day a simple summation results in the actual value not matching the computed result, because the scan interval and the unit of the input values are different. In such cases, set the sum scale to match the unit of the input value. In effect, the sum value with the same unit as that of the input value is calculated.

  For example, if the scan interval is 2 s, and the input value is 100 m³/min, a simple summation would add 100 every 2 s resulting in 3000 after one minute. However, if the sum scale is set to /min, then 2 s/60 s is multiplied every scan interval before the value is added giving a result that has an m³/min unit.

  The following converting equations are used to compute the sum. The unit of the scan interval is seconds.

  - Off: $\Sigma$ (measured data every scan interval)
  - /s: $\Sigma$ (measured data every scan interval) $\times$ scan interval
  - /min: $\Sigma$ (measured data every scan interval) $\times$ scan interval/60
  - /h: $\Sigma$ (measured data every scan interval) $\times$ scan interval/3600
  - /day: $\Sigma$ (measured data every scan interval) $\times$ scan interval/86400

- **Displaying the Report Data**
  You can display the report data using keys.

  For the operating procedure, see section 4.5.

- **Saving the Report Data**
  See section 1.4, “Data Storage Function.”

- **Numeric Display and Recording**
  The numeric range of the report data is from –9999999 to 99999999 excluding the decimal point (except –3.4×1038 to 3.4×1038 for sum values).

  For the data handling of special cases, see “Special Data Handling” in this section.

  For details on the report file format, see appendix 3.
1.8 Computation and Report Function (/M1 and /PM1 Options)

Special Data Handling
This section explains the handling of special data in TLOG computation, CLOG computation, and reports.

- **Power Failure Operation (TLOG and Reports)**
  If a power failure occurs when the report function is enabled or in the middle of the TLOG computation, the report operation and TLOG computation resume when the DX recovers from the power failure. The operation varies depending on whether the DX recovers from the power failure before or after the time to create a report or TLOG data.

<table>
<thead>
<tr>
<th>Time of Recovery</th>
<th>Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>After the time to create the data</td>
<td>The report or TLOG data is created immediately after the DX recovers. The measured data up to the time of the power failure is used. At the time the next report or TLOG data is created, the data after the recovery is used.</td>
</tr>
<tr>
<td>Before the time to create the data</td>
<td>After the DX recovers, report or TLOG data is created at the normal time to create the data. The measured data excluding the power failure period is used.</td>
</tr>
</tbody>
</table>

- **Error Data Handling (TLOG, CLOG, and Reports)**
  If an error occurs in the channel data, the error data is discarded, and the computation continues. If all the data are in error, an error results. The following types of data are considered error data.
  - Channels set to skip or Off.
  - The measured result on a measurement channels is error (A/D converter failure, etc.).
  - The input of the measurement channel is in a burnout condition.
  - The computed result on a computation channel is error.

- **Handling of Overflow Data**
  - Refers to over range on a measurement channel and computation overflow on a computation channel.

For TLOG, CLOG, and Reports
When the channel data is overflow data, the DX handles the data as follows:

<table>
<thead>
<tr>
<th>Computation Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average value or sum value</td>
<td>Set the handling to ERROR, SKIP, or LIMIT.</td>
</tr>
<tr>
<td></td>
<td>ERROR: Considers the data to be a computation error.</td>
</tr>
<tr>
<td></td>
<td>SKIP: Discards the overflow data and continues the computation.</td>
</tr>
<tr>
<td></td>
<td>LIMIT: Replaces the data with the limit value and continues the computation. The limit value is the span upper or lower limit or the scale upper or lower limit of the channel.</td>
</tr>
<tr>
<td>Maximum, minimum, Maximum – minimum</td>
<td>Set the handling to OVER or SKIP.</td>
</tr>
<tr>
<td></td>
<td>OVER: Computes by using the overflow data.</td>
</tr>
<tr>
<td></td>
<td>SKIP: Discards the overflow data and continues the computation.</td>
</tr>
</tbody>
</table>

For Multiplication and Relation Computation EQ and NE

<table>
<thead>
<tr>
<th>Computation Type</th>
<th>Computation</th>
<th>Computed Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multiplication</td>
<td>0*(+Over)</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>0*(–Over)</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>(+Over)*0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>(–Over)*0</td>
<td>0</td>
</tr>
<tr>
<td>.EQ.</td>
<td>(+Over).EQ.(+Over)</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>(–Over).EQ.(–Over)</td>
<td>0</td>
</tr>
<tr>
<td>.NE.</td>
<td>(+Over).NE.(+Over)</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>(–Over).NE.(–Over)</td>
<td>1</td>
</tr>
</tbody>
</table>
**Report Template (Release numbers 4 and later)**

You can create report templates and use them to automatically create custom report files.

Use Microsoft Office Excel (hereinafter referred to as “Excel”) to create report template files. Load a report template file that you have created into the DX internal memory. The DX will automatically create report files using the report template file.

For the setting procedure, see section 9.5.
To create a report template, see section 9.6.
To load or save a report template, see section 6.10.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Format, extension</td>
<td>XML spreadsheet format. The file name extension is .xml (lowercase).</td>
</tr>
<tr>
<td>File name</td>
<td>You can specify a file name.</td>
</tr>
<tr>
<td>Type</td>
<td>You need to create different report templates for each report file type.</td>
</tr>
<tr>
<td></td>
<td>The different report file types are hourly, daily, weekly, monthly, hourly</td>
</tr>
<tr>
<td></td>
<td>+ daily, daily + weekly, and daily + monthly.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Template-Based Report File</th>
</tr>
</thead>
<tbody>
<tr>
<td>Format, extension</td>
</tr>
<tr>
<td>File name</td>
</tr>
<tr>
<td>Type</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Creating Template-Based Report Files</th>
</tr>
</thead>
<tbody>
<tr>
<td>Template-based report files are created (the creation of template-based report files will hereinafter be referred to as “template conversion”) in the following cases.</td>
</tr>
</tbody>
</table>

**Auto Save**

When a report file is created (when file division occurs), template conversion is performed, and the report file is saved to the CF card. Template conversion is also performed when recording stops (memory stop).

**Manual Save (Collectively storing unsaved data)**

When you save a report file manually, template conversion is performed on the report files in the internal memory that have not yet been converted. Converted files are saved to the external storage medium.

**Collective Storing of Data through Key Operations**

When you execute ALL SAVE or REPORT SAVE, template conversion is performed on all the report files in the internal memory. Converted files are saved to the external storage medium.
1.9  FAIL/Status Output Function (/F1 Option)

Output Relay Operation Assignment (Release numbers 4 and later)
For this function, there are relays labeled “FAIL” and “Status” on the rear panel.
You can assign the operations explained below to these two relays. On a relay that has
been set to “Status relay,” you must also set the DX status that will be relayed.

FAIL Output
When a failure occurs in the CPU of the DX, a relay contact signal (1 signal) is output.
The relay is energized when the CPU is normal and de-energizes when a CPU failure
occurs. Therefore, relay output is carried out also when the power is turned OFF (including
a power failure). You cannot change this behavior.

<table>
<thead>
<tr>
<th>Relay Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>NO</td>
</tr>
<tr>
<td>During normal operation</td>
</tr>
<tr>
<td>NO</td>
</tr>
<tr>
<td>When a failure occurs</td>
</tr>
<tr>
<td>NO</td>
</tr>
<tr>
<td>When power is turned OFF</td>
</tr>
</tbody>
</table>

If a failure occurs, contact your nearest YOKOGAWA dealer for repairs.

Memory Sample Relay (Only on DXs with the /AS1 advanced security option)
The relay is energized at memory start and de-energized at memory stop. You cannot
change this behavior.
When the multi batch function (/BT2 option) is being used, memory start is when memory
start occurs for any of the batches, and memory stop is when memory stop occurs for all
the batches.

<table>
<thead>
<tr>
<th>Relay Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>NO</td>
</tr>
<tr>
<td>Memory sampling stopped</td>
</tr>
<tr>
<td>NO</td>
</tr>
<tr>
<td>Memory sampling</td>
</tr>
<tr>
<td>NO</td>
</tr>
<tr>
<td>When power is turned OFF</td>
</tr>
</tbody>
</table>

Invalid User Relay (Only on DXs with the /AS1 advanced security option)
The relay is energized when the user is invalid and de-energized when you execute the
Locked ACK command. You cannot change this behavior.

<table>
<thead>
<tr>
<th>Relay Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>NO</td>
</tr>
<tr>
<td>Normal</td>
</tr>
<tr>
<td>NO</td>
</tr>
<tr>
<td>Invalid user</td>
</tr>
<tr>
<td>NO</td>
</tr>
<tr>
<td>When power is turned OFF</td>
</tr>
</tbody>
</table>

User Login Status Relay (Only on DXs with the /AS1 advanced security option)
The relay is energized when a user is logged in (through key operations or communication commands) to the DX. You cannot change this behavior.

<table>
<thead>
<tr>
<th>Relay Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>NO</td>
</tr>
<tr>
<td>Not logged in</td>
</tr>
<tr>
<td>NO</td>
</tr>
<tr>
<td>Logged in</td>
</tr>
<tr>
<td>NO</td>
</tr>
<tr>
<td>When power is turned OFF</td>
</tr>
</tbody>
</table>
1.9 FAIL/Status Output Function (/F1 and /F2 Options)

Status Output

Outputs the status below with a relay contact signal (1 relay). You can select whether each status is output to the relay. The relay is energized when the status occurs. You cannot change this behavior.

For the setting procedure, see section 2.9.

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status of the internal memory or CF card</td>
<td>Error in the internal memory.</td>
<td>Contact your nearest YOKOGAWA dealer for repairs.</td>
</tr>
</tbody>
</table>

**When the auto save function to the CF card is On.**

- The free space on the CF card dropped to 10% of the total size (only when the media FIFO (see section 1.4) is disabled).
  - Replace the CF card.
- Error in the CF card.
  - Replace the CF card with a normal one.
  - Format the CF card on the DX (the data on the CF card will be erased).

However, the status of the internal memory is output when the CF card is not inserted.
- 10 MB or less of available space* remaining in internal memory.
- The number of files in internal memory for which Auto Save to the CF card has not been completed has exceeded 390.
  - Insert a CF card.

**When the auto save function to the CF card is Off.**

- 10 MB or less of available space* remaining in internal memory.
- The number of files in internal memory for which Manual Save has not been completed has exceeded 390.
  - Save the data in the internal memory to the CF card.

Measurement error
- Error in the A/D converter. Burnout is detected.
  - Contact your nearest YOKOGAWA dealer for repairs.
  - Replace the thermocouple that has burned out.

Communication error
- A Modbus master or Modbus client communication error occurred.
  - Check the error in the Modbus master or Modbus client screen and carry out the corrective action.
- A PROFIBUS-DP communication error occurred.
  - Contact your nearest YOKOGAWA dealer for repairs.

Memory stop
- When the memory sampling is stopped.
  - Start the data acquisition.

Alarm occurrence
- An alarm has occurred.
  - Check the alarm.

* The internal memory’s “available space” refers to the following quantities.
  - Unused regions
  - Regions of data for which Auto Save or Manual Save (see page 1-31) has been completed.

Relay Operation

During normal operation | When specified status occurs | When power is turned OFF
---|---|---
1.10 Other Functions

Time Related Functions

• Time Correction
The DX internal clock can be changed in the following manner.

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Key operation</td>
<td>Sets the DX internal clock to the specified time.</td>
</tr>
<tr>
<td>Event action function</td>
<td>Synchronizes the DX internal clock to the nearest hour.</td>
</tr>
<tr>
<td>SNTP client function</td>
<td>Sets the DX internal clock to the time retrieved from an SNTP server.</td>
</tr>
</tbody>
</table>

Time Correction Operation
The time correction operation varies depending on whether the memory sampling is in progress or not.

<table>
<thead>
<tr>
<th>Status</th>
<th>Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory sampling stopped</td>
<td>The DX internal clock is changed immediately.</td>
</tr>
<tr>
<td>Memory sampling</td>
<td>The DX internal clock is gradually corrected. While the time is being gradually adjusted, the date/time in the status display section is displayed in yellow.</td>
</tr>
</tbody>
</table>

Operation of Gradually Correcting the Internal Clock
If the time deviation between the time of the DX internal clock and the correct time (the specified time) is within a specified value, the DX clock is adjusted gradually at 40 ms for each second. Otherwise, the clock is corrected immediately. The maximum value of time deviation (tm in the figure below) can be selected in the range of 10 s to 5 min.

Example: When changing the time to 12 hours 55 minutes 35 seconds when the internal clock is 12 hours 55 minutes 32 seconds
The time deviation of 3 seconds is adjusted 40 ms per second. The internal clock will be synchronized to the specified time 75 seconds later.

• Date Format
For the setting procedure, see section 2.4.

• Time Zone
Set the time difference between the location where the DX is used and GMT.
For the setting procedure, see section 2.2.

• DST (Daylight Saving Time)
If you are using the DX in an area with daylight saving time, enter the daylight saving time starting and ending dates, and the DX will automatically change the time accordingly.
For the setting procedure, see section 2.1.
System Display
Displays the total number of inputs on the DX, the size of the internal memory, the communication functions, the external storage drive, the options, the remote controller ID, the operation of the devices connected to the USB ports (/USB1 option), the MAC address, and the firmware version number.
For the operating procedure, see section 2.5.

Language
The displayed language can be set to English, Japanese, German, French, or Chinese.
For the setting procedure, see section 2.6.

24 VDC Power Supply for Transmitter (/TPS2 or /TPS4 Option)
Provides 24-VDC power supply to up to two (/TPS2) or four (/TPS4) two-wire system transmitters. The measured values of the transmitter correspond to a current signal of 4 to 20 mA on the same cable. Therefore, the signal can be connected to the DX input terminal and displayed.

Easy Text Entry Option (/KB1 and /KB2 Options)
You can control the DX using the keys on the remote control terminal.
• Set the remote controller ID on the DX and the ID number on the remote control terminal to the same value.
• You can set a value between 0 and 31 for the remote controller ID and ID number.
• By changing the ID number on the remote control terminal, you can control DXs with different remote controller IDs from a single remote control terminal.
For the operating procedure, see section 2.10.
1.10 Other Functions

**USB Interface (/USB1 option)**
You can connect keyboards, barcode readers, or USB flash memory to two USB ports, one on the front and one on the back of the DX.
- You can operate the DX using a keyboard or barcode reader.
- You can save measured data and setup data to the USB flash memory and also load from it.
For the operating procedure, see sections 2.11 and 2.12.

**Temperature Unit**
You can set the unit when measuring temperature with the thermocouple or RTD to °C or °F.
For the setting procedure, see section 3.3.

**Custom Display (Release numbers 3 and later)**
You can create a custom operation screen.
See the Custom Display User’s Manual, IM04L41B01-04E.

**Multi Batch Function (/BT2 option; release numbers 3 and later)**
You can use this function to simultaneously record the measured data from multiple batches.
See the Multi Batch (/BT2) User’s Manual, IM04L41B01-03E.

**Advanced Security Function (/AS1 option; release numbers 4 and later)**
The advanced security option strengthens measurement security with login, audit trail, digital signature, and other functions.
See the Advanced Security Function (/AS1) User’s Manual, IM 04L41B01-05EN.
2.1 Setting the Date/Time

Set the date/time. If you are using the DX in a region that uses DST, specify the date/time for switching between DST and standard time.

**Setup Screen**

- **Date/Time**
  Press MENU (to switch to setting mode), and select the Menu tab > Date/Time > Time Settings

- **DST**
  Press MENU (to switch to setting mode), and select the Menu tab > Date/Time > Daylight Saving Time

**Setup Items**

- **Time set**
  Enter the date and time, select ENT, and press DISP/ENTER.

- **Daylight savings time > Use/Not**
  To set a daylight saving time period, select Use.

- **Daylight savings time > Start time**
  Specify the date and time when daylight saving time starts.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Month</td>
<td>Specify the month.</td>
</tr>
<tr>
<td>Day order (week order)</td>
<td>Specify the week within the month. Specify [Last] for the last week in the month.</td>
</tr>
<tr>
<td>Day of the week</td>
<td>Specify the day of the week.</td>
</tr>
<tr>
<td>Hour of the day</td>
<td>Specify the hour using a value from 0 to 23.</td>
</tr>
</tbody>
</table>

- **Daylight savings time > End time**
  Specify the date and time when daylight saving time ends. The settings here are the same as those for Start time.
2.2 Setting the Time Difference from GMT

Set the time zone of the region in which the DX will be used. Make sure to set this value if you are using the Internet network functions or the DST function.

**Setup Screen**

Press **MENU** (to switch to setting mode), hold down **FUNC** for 3 s (to switch to basic setting mode), and select the **Menu** tab > Time Settings

**Setup Items**

- **Time settings > Time zone(HHMM)**
  Set the time zone of the region in which the DX will be used in terms of the time difference from GMT. Specify a value in the range of –1300 to 1300 (where the first two digits denote the hour and the last two digits denote the minute). A negative value indicates that the local time is behind the GMT.
  Example: The standard time in Japan is ahead of the GMT by 9 hours. In this case, enter “900.”
2.3 Setting the Time Correction Operation during Memory Sampling

This function gradually corrects the time when the time is changed while Memory Sampling is in progress.

For a description of the time correction operation, see section 1.10.

**Setup Screen**

Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic setting mode), and select the Menu tab > Time Settings.

**Setup Items**

- **Time settings > Time deviation limit**

  When the time deviation between the time on the DX and the specified time is within ±(the value specified here), the time on the DX is gradually corrected. Otherwise, the clock is corrected immediately.

<table>
<thead>
<tr>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>10 s to 5 min</td>
<td>The time deviation limit.</td>
</tr>
<tr>
<td>Off</td>
<td>Disables the function that gradually corrects the time.</td>
</tr>
</tbody>
</table>

Example: If **Time deviation limit** is set to 10s and the time on the DX is 10 hours 21 minutes 15 seconds, the time on the DX is gradually corrected if the specified time is between 10 hours 21 minutes 5 seconds and 10 hours 21 minutes 25 seconds.
2.4 Setting the Date Format

Select the display format of the date.

**Setup Screen**

Press **MENU** (to switch to setting mode), hold down **FUNC** for 3 s (to switch to basic setting mode), and select the **Menu tab > Time Settings**

**Setup Items**

- **Time settings > Date format**

<table>
<thead>
<tr>
<th>Settings</th>
<th>Display Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>D/M/Y</td>
<td>30/11/2005 30/11 08</td>
</tr>
<tr>
<td>D.M.Y</td>
<td>30.11.2005 30.11 08</td>
</tr>
</tbody>
</table>

* Only if the trend interval is set greater than or equal to 1 h/div. A function available on DXs with release number 2 or later.

**Applied Range**

The format is applied to the date displayed on the screen. It does not change the date format on the setup screen of the date/time, the date in the output data via communications, the date saved along with the data, and the date used in the data file names.
2.5 Viewing the DX Information

Show the DX information on the system information screen and the network information screen.

Procedure

- **Displaying System Information Screen**
  1. In the operation mode, press **FUNC**.
     The FUNC key menu appears.
  2. Press the **System info soft key**.
     The system information screen is displayed.

- **Displaying Network Information Screen**
  1. In the operation mode, press **FUNC**.
     The FUNC key menu appears.
  2. Press the **Network info soft key**.
     The network information screen is displayed.

Explanation

- **System Information Screen**

  The following items are displayed:
  - Number of measurement channels.
  - Number of computation channels.
  - Internal memory size
  - Options
  - Remote controller ID (/KB1 and /KB2 options)
  - Connected USB HID devices (/USB1 option)
  - MAC address
  - Firmware version

  (C) denotes the clamped input terminals (/H2 option).
  (/M1 and /PM1 options)
  (/KB1 and /KB2 options)
  /USB1 option)
2.5 Viewing the DX Information

- **Network Information Screen**

There are two pages of network information. Use the left and right arrow keys to switch the screen. The following items are displayed:
  - IP address
  - Subnet mask IP address
  - Default gateway IP address
  - MAC address
  - DNS server IP address
  - Host name
  - Domain name
  - The server function setting conditions listed below.
    FTP, Web, Modbus, SNTP, and EtherNet/IP
  - PROFINET-DP information (/CP1 option)
  - Node address and serial number (maintenance information)
2.6 Changing the Displayed Language

Set the displayed language.

**Setup Screen**

Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic setting mode), and select the Environment tab > Operating Environment

![Operating Environment Screen]

**Setup Items**

- Operating environment > Language
  Set the displayed language to English, Japanese, German, French, or Chinese.
2.7 Setting the LCD Brightness and Backlight Saver

Change the LCD brightness. In addition, set the backlight saver function to prolong the service life of the LCD backlight.

Setup Screen

Press MENU (to switch to setting mode), and select the Menu tab > Display > LCD

Setup Items

- **LCD > Brightness**
  Select a value from 1 to 8 (2 by default). Larger the value, brighter the display becomes.

- **LCD > Backlight saver > Mode**
  
<table>
<thead>
<tr>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Disables the backlight saver.</td>
</tr>
<tr>
<td>Dimmer</td>
<td>Dims the display if there is no operation for a given time.</td>
</tr>
<tr>
<td>Timeoff</td>
<td>Turns the backlight OFF if there is no operation for a given time.</td>
</tr>
</tbody>
</table>

- **LCD > Backlight saver > Saver time**
  Select a value from 1 min to 1 h. If the specified time elapses without any key operation or alarm occurrence, the LCD backlight switches to the specified mode.

- **LCD > Backlight saver > Restore**
  
<table>
<thead>
<tr>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Key</td>
<td>The backlight returns to the original brightness when a key is pressed.</td>
</tr>
<tr>
<td>Key+Alm</td>
<td>The backlight returns to the original brightness when a key is pressed or when an alarm occurs.</td>
</tr>
</tbody>
</table>

**Note**

- If the backlight is dimmed or turned OFF by the backlight saver function, pressing any key on the DX causes the backlight to return to the original brightness. In this operation, the key does not perform its intended function.
- The degradation of the brightness and the discoloration of the screen (become yellowish) tend to progress faster as the brightness is set higher. Extended use at an unnecessary high setting should be avoided. It is also recommended that you use the backlight saver function.
2.8 Initializing Settings and Clearing the Internal Memory

Initialize the settings to default values. In addition, clear the data in the internal memory. For the default settings, see the DX1000/DX1000N Operation Guide (IM04L41B01-02E).

**Setup Screen**

Press **MENU** (to switch to setting mode), hold down **FUNC** for 3 s (to switch to basic setting mode), and select the **File/Initialize** tab > **Initialize**

On DXs without the /AS1 advanced security option

```
<table>
<thead>
<tr>
<th>Basic Setting Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initialize</td>
</tr>
<tr>
<td>Mind</td>
</tr>
<tr>
<td>Clear 3</td>
</tr>
<tr>
<td>Clear</td>
</tr>
<tr>
<td>Initialize contents</td>
</tr>
<tr>
<td>Basic Settings</td>
</tr>
<tr>
<td>Login Info</td>
</tr>
<tr>
<td>Other Settings</td>
</tr>
<tr>
<td>Settings</td>
</tr>
<tr>
<td>Measurement and Bath Data</td>
</tr>
<tr>
<td>Display Data</td>
</tr>
<tr>
<td>Loss Data</td>
</tr>
</tbody>
</table>
```

Clear 1 Clear 2 Clear 3

On DXs with the /AS1 advanced security option

```
<table>
<thead>
<tr>
<th>條件設定模式</th>
</tr>
</thead>
<tbody>
<tr>
<td>パターン化</td>
</tr>
<tr>
<td>染絵</td>
</tr>
<tr>
<td>適合</td>
</tr>
<tr>
<td>Clear 3</td>
</tr>
<tr>
<td>Clear</td>
</tr>
<tr>
<td>パターン化内容</td>
</tr>
<tr>
<td>基本設定値</td>
</tr>
<tr>
<td>設定</td>
</tr>
<tr>
<td>設定</td>
</tr>
<tr>
<td>設定</td>
</tr>
<tr>
<td>設定</td>
</tr>
<tr>
<td>設定</td>
</tr>
<tr>
<td>設定</td>
</tr>
<tr>
<td>設定</td>
</tr>
<tr>
<td>設定</td>
</tr>
<tr>
<td>明細/設定値の</td>
</tr>
<tr>
<td>明細/設定値の</td>
</tr>
<tr>
<td>明細/設定値の</td>
</tr>
<tr>
<td>明細/設定値の</td>
</tr>
</tbody>
</table>
```

Clear 1 Clear 2 Clear 3 Clear 4
2.8 Initializing Settings and Clearing the Internal Memory

Setup Items

- **Initialize**

**On DXs without the /AS1 advanced security option**

<table>
<thead>
<tr>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear 1</td>
<td>Clears and initializes the data in the internal memory in the manner indicated on the screen.</td>
</tr>
<tr>
<td>Clear 2</td>
<td></td>
</tr>
<tr>
<td>Clear 3</td>
<td></td>
</tr>
</tbody>
</table>

**Internal Memory Data That Is Initialized or Cleared**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic Settings</td>
<td></td>
</tr>
<tr>
<td>Login Info</td>
<td>The “Authority of user” settings in basic setting mode are initialized.</td>
</tr>
<tr>
<td>Other Settings</td>
<td>All settings in basic setting mode other than the “Authority of user” settings are initialized.</td>
</tr>
<tr>
<td>Settings</td>
<td>The setting mode settings are initialized.</td>
</tr>
<tr>
<td>Measurement and Math Data</td>
<td>Display, event, manual sampling, and report (/M1 and /PM1 options) data is cleared.</td>
</tr>
<tr>
<td>Display Data</td>
<td>The custom display screen setup data is cleared.</td>
</tr>
<tr>
<td>Log Data</td>
<td>All the log data is cleared.</td>
</tr>
</tbody>
</table>

**On DXs with the /AS1 advanced security option**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear 1</td>
<td>Clears and initializes the data in the internal memory in the manner indicated on the screen.</td>
</tr>
<tr>
<td>Clear 2</td>
<td></td>
</tr>
<tr>
<td>Clear 3</td>
<td></td>
</tr>
<tr>
<td>Clear 4</td>
<td></td>
</tr>
</tbody>
</table>

**Internal Memory Data That Is Initialized or Cleared**

See the explanation for DXs without the /AS1 advanced security option.

**Procedure**

1. **Press the Clear 1, Clear 2, Clear 3, or Clear 4 soft key.**
2. **Press DISP/ENTER.**
   - A confirmation window opens.
3. **Select Yes and press DISP/ENTER.**
   - The specified operation is executed, and the DX returns to the operation mode.
   - If you do not want to initialize, select No and press DISP/ENTER.
2.9 Outputting the DX Status via the Relay Contact (/F1 Option)

A signal is output to a dedicated relay when an error occurs in the DX CPU. In addition, a signal is output to a different relay when a specified status occurs.

For a description of the FAIL/status output function, see section 1.7.

Setup Screen

- **Assigning Relay Operations**
  
  Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic setting mode), and select the Menu tab > Status relay > Relay Action.

On DXs without the /AS1 advanced security option

![Basic Setting Node](image1)

On DXs with the /AS1 advanced security option

![Basic Setting Node](image2)
2.9 Outputting the DX Status via the Relay Contact (/F1 and /F2 Options)

• **Status Relay Details**
  Press **MENU** (to switch to setting mode), hold down **FUNC** for 3 s (to switch to basic setting mode), and select the **Menu** tab > **Status Relay** > **Status Relay Details**.

<table>
<thead>
<tr>
<th>Basic Setting Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status relay</td>
</tr>
<tr>
<td>Memory/Media status</td>
</tr>
<tr>
<td>Measurement error</td>
</tr>
<tr>
<td>Communication error</td>
</tr>
<tr>
<td>Memory stop</td>
</tr>
<tr>
<td>Alarm</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fail</td>
<td>Outputs a fail relay.</td>
</tr>
<tr>
<td>Status relay</td>
<td>Outputs a status relay. Even if you set both relays to “Status relay,” you cannot make them output different statuses.</td>
</tr>
</tbody>
</table>

On DXs with the /AS1 advanced security option

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fail</td>
<td>Outputs a fail relay.</td>
</tr>
<tr>
<td>Status relay</td>
<td>Outputs a status relay. Even if you set both relays to “Status relay,” you cannot make them output different statuses.</td>
</tr>
<tr>
<td>Mem. sample*</td>
<td>Relay output continues from memory start until memory stop.</td>
</tr>
<tr>
<td>Invalid user</td>
<td>Relay output continues from when a user is determined to be invalid until a Locked ACK command is executed.</td>
</tr>
<tr>
<td>Login</td>
<td>Relay output occurs whenever a user is logged in.</td>
</tr>
</tbody>
</table>

* When the multi batch function (/BT2 option) is being used, relay output starts when memory start occurs for any of the batches, and relay output stops when memory stop occurs for all the batches.

• **Status Relay Details** > **Memory/Media status**
  On: The status of the internal memory and the CF card is relayed.

• **Status Relay Details** > **Measurement error**
  On: A relay signal is output when a measurement error occurs.

• **Status Relay Details** > **Communication error**
  On: A relay signal is output when a communication error occurs.

• **Status Relay Details** > **Memory stop**
  On: A relay signal is output when memory sampling stops.
  * When the multi batch function (/BT2 option) is being used, relay output starts when recording stops for all the batches.

• **Status Relay Details** > **Alarm (Release numbers 3 and later)**
  On: Outputs a relay signal when one or more alarms occur. Alarms whose indications are hidden (see section 3.6 for details) do not cause relay signal output. Relay output ceases after all alarms are released (if no other relay output conditions are met).
2.9 Outputting the DX Status via the Relay Contact (/F1 and /F2 Options)

Procedure

- **FAIL Output**
  There are no operations that are required. A signal is output to the relay contact when a CPU error is detected. A signal is also output to the relay contact when the DX is turned OFF.

- **Status Relay**
  A signal is output to the relay contact when a specified status occurs.
2.10 Controlling the DX with the Remote Control Terminal (/KB1 and /KB2 Options)

Handling Precautions

- If the infrared signal output section of the remote control terminal or the light-receiving section on the DX becomes dirty or receives scratches, it can hinder the transmission/reception of the infrared signal. Clean the infrared signal output section of the remote control terminal or the light-receiving section on the DX.
- When cleaning, wipe using a dry soft cloth. Do not use chemicals such as benzene or thinner, since these may cause discoloring and deformation.
- Do not apply shock to the remote control terminal.
- Do not operate the remote control terminal with wet hands.
- The transmission/reception sensitivity of the infrared signal may deteriorate if used in the following types of locations.
  - Location where the receiver of the DX is exposed to direct sunlight or fluorescent lamp.
  - Near magnetic field sources such as a transceiver.
- If you carry the remote control unit in your pocket, for example, keys may be pressed unintentionally and cause the DX to be controlled. Handle the remote control terminal properly so that keys are not pressed inadvertently.
- When you are near the DX, press the keys on the remote control terminal only when controlling the DX. If you are going to press the keys on the remote control terminal but do not wish to control the DX, take measures so that the signal does not reach the DX such as by covering the infrared signal output section of the remote control terminal.
- The distance at which the DX can be controlled using the remote control terminal varies depending on the operating environment such as the battery voltage and the presence or absence of external light.
- There is a possibility that DXs with the same remote controller ID be controlled simultaneously. It is recommended that different remote controller IDs be set on each DX.

Preparing the DX

Set the remote controller ID.

- **Setup Screen**
  Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic setting mode), and select the Environment tab > Operating Environment

  ![](image)

  - Operating environment > Remote Controller ID
    Select the remote controller ID from 0 to 31. When not using the remote control terminal, select Off.

  - Checking the Remote Controller ID
    You can check the DX remote controller ID on the system information screen. See section 2.5.
Preparing the Remote Control Terminal

• Names of Parts

   - Infrared signal output section
   - Keys
   - Battery cover

• Loading Batteries

   1. While pressing the projection on the battery cover, open the cover.
   2. Load the batteries.
   3. Close the battery cover.

• Setting the ID Number

Set the ID number of the remote control terminal to match the remote controller ID of the DX that you are to operate.

The ID number of the remote control terminal is not displayed anywhere. If you are not sure which ID number the remote control terminal is set to, set the appropriate ID number according to the following procedure.

1. Press ID.
2. Enter the ID number (0 to 31) by pressing the keys from 1 (A1) to 0 (N0).
   Example For ID number “16” Operation: Press 1 (A1) and 6 (G6).
3. Press ID.

Note

• If you enter an ID number other than 0 through 31, the ID number retains the original setting.
• Pressing the ID key once causes the remote control terminal to enter the ID number setup mode. If none of the keys on the remote control terminal is pressed for 8 s, the remote control terminal automatically exits from the ID number setup mode. In this case, the ID number of the remote control terminal retains the original setting.
• If you remove the batteries, the ID number is reset to 0. After loading the batteries, set the appropriate ID number again.

• Affixing the ID Number Label

If you are using the remote control terminal with a fixed ID number (such as when there is a one-to-one correspondence between the DX to be controlled and the remote control terminal), you can enter the ID number on the label and affix the label on the remote control terminal.

Affix the ID number label on the battery cover of the remote control terminal.
2.10 Controlling the DX with the Remote Control Terminal (/KB1 and /KB2 Options)

Controlling the DX

Control the DX by pointing the infrared output section of the remote control terminal to the light-receiving section on the DX. Control the DX while checking the results on the DX screen.

Note

- The remote control terminal cannot be used to control the Favorite key.
- When a specific key operation is possible on the DX, the corresponding key on the remote control terminal is activated. For example, the operation for entering a character string is activated when a window for entering a character string is displayed on the DX screen.
- You cannot control the DX using the remote control terminal, if the remote control terminal is in the ID number setup mode.
- On models with the /M1 math option or /PM1 pulse input option, use the keys on the DX to enter the computing equation of the computation channel. Computing elements are not assigned to the keys on the remote control terminal.

Correspondence with the DX Keys

- Character input keys
- Up arrow key
- User key
- DISP/ENTER key
- Right arrow key
- Down arrow key
- MENU key
- Soft keys
- Character input keys
- Character type switch key for character input keys (see the next page)
- STOP key
- Delete key
- SPACE key
- START key

The diagram shows the layout of the remote control terminal with labels for each key. The keys include ESC, Left arrow, FUNC, Character input keys, User, DISP/ENTER, Right arrow, Down arrow, MENU, Soft keys, Character input keys, Character type switch key, STOP, Delete, Space, and START keys. Each key is labeled with its function.
• Entering Strings
When a character input window is displayed on the DX screen, pressing the A/a/1 key switches the character type assigned to the character input keys as shown in the following figure.

![Character Input Window]

- Uppercase alphabet characters and symbols
- Lowercase alphabet characters and symbols
- Numbers

• Uppercase Alphabet Characters and Symbols/Lowercase Alphabet Characters and Symbols

![Alphabet Keys]

Press the MARK key to cycle through the following symbols:

<table>
<thead>
<tr>
<th>Number of times the key is pressed</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>10</th>
<th>11</th>
<th>12</th>
<th>13</th>
</tr>
</thead>
<tbody>
<tr>
<td>Symbol</td>
<td>%</td>
<td>#</td>
<td>*</td>
<td>@</td>
<td>_</td>
<td>(</td>
<td>)</td>
<td>[</td>
<td>]</td>
<td>+</td>
<td>*</td>
<td>/</td>
<td></td>
</tr>
</tbody>
</table>

• Numbers

![Number Keys]

- Number (1 to 9 and 0)
- Decimal point

However, when setting a constant to be used in the computation on the DX with the /M1 or /PM1 option, the display switches in the order “.”, “+”, and “E” each time the key is pressed. The display switches in a cyclic pattern.

- Minus sign
Troubleshooting

The DX does not react when you try to control it using the remote control terminal.

- **Are the correct batteries loaded in the remote control terminal?**
  Check the voltage and polarity of the batteries.

- **Are the batteries flat?**
  Replace the batteries with new ones.

- **Does the ID number of the remote control terminal match the remote controller ID of the DX that you are trying to control?**
  Check the remote controller ID on the DX, and set the ID number of the remote control terminal to the same value.

- **Is the remote control terminal in ID number setup mode (condition in which the ID key is pressed once)?**
  Wait 8 seconds without pressing any keys to exit from ID number setup mode.

- **Is the remote control terminal too far away from the DX?**
  Get closer to the DX. Control from as close to the front of the DX as possible.

- **Is a strong light hitting the light-receiving section of the DX?**
  Take measures to prevent strong light from hitting the light-receiving section of the DX.

- **Is there a magnetic field source such as a transceiver nearby?**
  Move the magnetic field source away from the DX.

- **Is the infrared output section of the remote control terminal or the light-receiving section on the DX dirty?**
  Clean them.

- **Is the DX in a condition that allows the relevant key operation?**
  Check the condition of the DX, and start from an operation that is possible.
2.11 Controlling the DX with a Keyboard or Barcode Reader (/USB1 option)

This section explains how to connect and use a USB keyboard or barcode reader. Barcode readers can be used if the DX release number is 3 or later.

Connecting and Disconnecting a Keyboard or Barcode Reader

- **Connection**
  1. Connect the keyboard or barcode reader to a DX USB port. A display appears asking whether you have connected a keyboard or a barcode reader.

- **Removal**
  Remove the keyboard or barcode reader cable from the DX USB port.

**Note**
- You can connect and remove keyboards and barcode readers at any time, regardless of the display and whether the DX is on or off.
- You can only connect one human interface device (HID) to the DX. You cannot use a keyboard and a barcode reader at the same time.
- Use a keyboard that matches the DX language setting.
- The statuses of the Caps Lock and Num Lock keys are retained even if the USB keyboard is removed (release number 2 and later). However, if a barcode reader is connected, the key statuses will be initialized to off.
- The device that is currently connected is indicated in the system information display (see section 2.5 for details).
2.11 Controlling the DX with a Keyboard or Barcode Reader (/USB1 option)

Operating from the Keyboard
Use the keyboard while watching the DX screen. An operation that can be carried out on the DX can be carried out from the keyboard.

Example: Switch to setting mode
When the DX is in the operation mode, press Ctrl+M.
The DX switches to setting mode, and the setting menu appears.

- Mapping of the Keys on the DX to the Keys on the Keyboard

<table>
<thead>
<tr>
<th>Keys on the DX</th>
<th>Keys on the Keyboard 104 Keyboard (US)for the PC</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter</td>
<td>DISP/ENTER</td>
</tr>
<tr>
<td>←</td>
<td>Left arrow key</td>
</tr>
<tr>
<td>↑</td>
<td>Up arrow key</td>
</tr>
<tr>
<td>↓</td>
<td>Down arrow key</td>
</tr>
<tr>
<td>→</td>
<td>Right arrow key</td>
</tr>
<tr>
<td>Num Enter</td>
<td>DISP/ENTER</td>
</tr>
<tr>
<td>Esc</td>
<td>ESC</td>
</tr>
<tr>
<td>F1 to 5</td>
<td>Soft key 1 to soft key 5</td>
</tr>
<tr>
<td>F9</td>
<td>FUNC</td>
</tr>
<tr>
<td>F12</td>
<td>Hold down FUNC for 3 seconds</td>
</tr>
<tr>
<td>Left-Windows</td>
<td>MENU</td>
</tr>
<tr>
<td>Right-Windows</td>
<td>MENU</td>
</tr>
<tr>
<td>Application</td>
<td>Favorite key</td>
</tr>
<tr>
<td>Ctrl+S</td>
<td>START</td>
</tr>
<tr>
<td>Ctrl+F</td>
<td>STOP</td>
</tr>
<tr>
<td>Ctrl+U</td>
<td>USER</td>
</tr>
<tr>
<td>Ctrl+M</td>
<td>MENU</td>
</tr>
<tr>
<td>Tab, Shift+Tab</td>
<td>Arrow keys*</td>
</tr>
</tbody>
</table>

* Press Tab to move the cursor to the next item, or Shift+Tab to move to the previous item. However, this does not work in the following screens:
Operation screens, Menu screens for Setting mode and Basic setting mode, screens for entering values and characters, “Menu customize” and “Save/Load” screens in Setting mode, and “Load setting, Initialize” screen in Basic setting mode

- Entering Alphabets, Numbers, and Symbols
When alphabets, numbers, and symbols can be entered on the DX, you can enter them from the keyboard. The operation is the same as with normal keys. However, symbols that cannot be used on the DX are invalid.

Symbols That Can Be Entered Using the Keyboard
The symbols below can be entered. However, symbols that cannot be used on the DX are invalid. For example, the characters &, *, /, :, and ? cannot be used in the data save destination directory name.

```
#  %  &  (  )  *  +  -  .  /  :  ?  @  [  ]  ^  _
```

* Press “^” on the keyboard to enter the temperature degree symbol.
• Invalid Keys
Keys enclosed in frames are invalid.

The 104 Keyboard for a PC (US)
Barcode Reader Operations (Release number 3 or later)

When you scan communication commands with a barcode reader, the DX will respond as follows.

- The DX will accumulate key codes until it reaches a terminator. Then it will execute the accumulated character string. The terminator is the enter key code.
- The DX can accumulate up to 200 characters, not including the terminator. The DX will process a character string when it reaches 200 characters in length.
- The DX can read ASCII characters (128 characters: numbers, symbols, and uppercase and lowercase letters of the alphabet).

**Note**

- Barcode reader operations are treated as key operations.
- Barcode reader operations except the operation using UD command are limited by the settings of the key lock and login functions.

**Barcode Reader Settings**

Configure the barcode reader to the settings in the table below.

<table>
<thead>
<tr>
<th>USB host parameter</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>USB device type</td>
<td>HID keyboard simulation</td>
</tr>
<tr>
<td>USB keyboard type</td>
<td>English (U.S.) standard USB keyboard</td>
</tr>
</tbody>
</table>
2.11 Controlling the DX with a Keyboard or Barcode Reader (/USB1 option)

- **How to Use**
  Follow the standard operating procedure for the barcode reader that you are using. Operate the barcode reader while checking the status of the DX. An operation can be carried out using the barcode reader when it can be carried out on the DX.

- **Commands**
  Scan the communication commands encoded in bar codes to operate the DX with a barcode reader. The communication commands that you can use are listed in the table below. For information about communication command syntax, see the Communication Interface User’s Manual (IM 04L41B01-17E).

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>KE</td>
<td>Performs key operations</td>
</tr>
<tr>
<td>PS</td>
<td>Starts or stops memory sampling</td>
</tr>
<tr>
<td>EV</td>
<td>Starts manual sampling &lt;br&gt;Causes triggers to occur &lt;br&gt;Takes snapshots &lt;br&gt;Saves display data &lt;br&gt;Saves event data</td>
</tr>
<tr>
<td>MS</td>
<td>Writes messages</td>
</tr>
<tr>
<td>TL</td>
<td>Starts or stops computation &lt;br&gt;Resets computation &lt;br&gt;Clears the computation data dropout display</td>
</tr>
<tr>
<td>IR</td>
<td>Resets the relative timer</td>
</tr>
<tr>
<td>AK</td>
<td>Releases alarm output (alarm ACK)</td>
</tr>
<tr>
<td>CV</td>
<td>Switches the trend interval</td>
</tr>
<tr>
<td>EM</td>
<td>Starts or stops e-mails</td>
</tr>
<tr>
<td>BU</td>
<td>Manually recovers the Modbus master or client</td>
</tr>
<tr>
<td>BV</td>
<td>Writes free messages</td>
</tr>
<tr>
<td>BT</td>
<td>Inserts characters</td>
</tr>
<tr>
<td>BU</td>
<td>Sets batch names</td>
</tr>
<tr>
<td>BU</td>
<td>Sets batch comments</td>
</tr>
<tr>
<td>CL</td>
<td>Executes manual SNTP</td>
</tr>
<tr>
<td>LO</td>
<td>Reads the setting mode setup data</td>
</tr>
<tr>
<td>LI</td>
<td>Saves setup data</td>
</tr>
<tr>
<td>MA</td>
<td>Resets the single match time timer</td>
</tr>
<tr>
<td>YC</td>
<td>Clears measured and computed data and initializes setup data</td>
</tr>
<tr>
<td>EJ</td>
<td>Changes login passwords</td>
</tr>
<tr>
<td>YO</td>
<td>Loads setup files (for basic setting mode)</td>
</tr>
<tr>
<td>UD</td>
<td>Switches the screen</td>
</tr>
<tr>
<td>MH</td>
<td>Writes batch text fields (release numbers 4 and later)</td>
</tr>
<tr>
<td>BP</td>
<td>Enters login information (/AS1 option; release numbers 4 and later)</td>
</tr>
<tr>
<td>BQ</td>
<td>Invalid user ACK operation (/AS1 option; release numbers 4 and later)</td>
</tr>
<tr>
<td>EC</td>
<td>Initialization (/AS1 option; release numbers 4 and later)</td>
</tr>
</tbody>
</table>

**Command Example**
The command to write message number 8 in group 1 is: MS8,GRPUP,1. There must be a terminator (an enter key code) at the end.

**Note**
- You can read multiple commands (as many as 10) by putting sub delimiters (semicolons) between them. Example: PS0;MS8,GRPUP,1
- When you enter commands using bar codes, you can enter them separated or all at once. You can separate commands however you want to. For example, you can separate the command to write message number 8 in group 1, MS8,GRPUP,1, into the following components: MS > 8 > , > GRPUP > , > 1 > ENTER key code.
- If you use a barcode reader that automatically attaches a footer and a header to every transmission, the result will be the same if MS is set to the header, the enter key code is set to the footer, and you scan 8,GRPUP,1.
- When the DX receives an unsupported key code, it clears all of the key codes that it has accumulated so far.
2.12 Using the USB Flash Memory (/USB1 Option)

Connecting/Removing a USB Flash Memory

- **Connecting a USB Flash Memory**
  
  If you are using the multi batch function (/BT2 option), see the *DX1000/DX1000N/DX2000 Multi Batch (/BT2) User’s Manual, IM04L41B01-03E*.

  1. Connect a USB flash memory to the USB port on the DX.
  2. In operation mode, possible operations are shown. Select the desired operation using the arrow keys and press **DISP/ENTER**.

When set to auto save

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save Manual</td>
<td>Saves unsaved data in the internal memory to a USB flash memory device.</td>
</tr>
<tr>
<td>DATA SAVE MODE</td>
<td>Switches to the DATA SAVE MODE display. For the procedure to save the internal memory data, see section 4.8. This item only appears when the DX is configured to display DATA SAVE MODE in the display menu (release number 2 and later). You can change the item that is displayed here with the menu customize function.</td>
</tr>
</tbody>
</table>
| Load Settings | Moves to the setup load display of setting mode. For the procedure to load the setup data, see section 6.9. Load Settings will not be displayed:  
  - When Media/USB loading is locked (see chapter 8 for details).  
  - When the DX is accessing storage media (formatting, saving, or FTP communication). |
| Cancel        | Closes the operation selection window.                                       |

When set to manual save

- **Removing the USB Flash Memory**
  
  1. In the operation mode, press **FUNC**. The FUNC key menu appears.
  2. Press the **Media eject** soft key and then the **USB** soft key. A message "Media can be removed safely." appears.
  3. Remove the USB flash memory.

**Note**

- One USB flash memory can be connected.
- Be sure to carry out the procedure above when removing the USB flash memory. If you remove the USB memory without performing the above procedure, the data stored on it could be damaged.
2.12 Using the USB Flash Memory (/USB1 Option)

Saving and Loading Data

The following data save/load and file operations can be carried out.

- Save/Load setup data files (see section 6.9).
- Save display data and event data files (see sections 4.8 and 6.4).
- Load display data and event data files (see section 6.8).
- List files and delete files (see section 6.7).
- Format (see section 6.7).
2.13 Setting the Decimal Point Type (Release number 3 or later)

You can set the decimal point type for the display and files saved in text format.

**Setup Screen**

MENU (to switch to setting mode), hold down **FUNC** for 3 s (to switch to basic setting mode), and select the **Environment** tab > **Operating Environment**

---

**Setup Items**

- **Decimal Point Types**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Display Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Point</td>
<td>1234.56</td>
</tr>
<tr>
<td>Comma</td>
<td>1234,56</td>
</tr>
</tbody>
</table>

---

**Explanation**

- **Decimal Point Types**

  The decimal point type setting affects the following kinds of files and displays. The decimal point of any file or setting not listed below (the setup screen for example) is displayed using a period.

<table>
<thead>
<tr>
<th>Type</th>
<th>Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>File output</td>
<td>Manual sampled data file</td>
</tr>
<tr>
<td></td>
<td>Report file</td>
</tr>
<tr>
<td>Display</td>
<td>Trend display</td>
</tr>
<tr>
<td></td>
<td>Digital display</td>
</tr>
<tr>
<td></td>
<td>Bar graph display</td>
</tr>
<tr>
<td></td>
<td>Overview display</td>
</tr>
<tr>
<td></td>
<td>Historical trend</td>
</tr>
<tr>
<td></td>
<td>Report data display</td>
</tr>
<tr>
<td></td>
<td>Custom display</td>
</tr>
<tr>
<td>Webpage</td>
<td>All channel display</td>
</tr>
<tr>
<td>E-mails</td>
<td>The instantaneous value data in alarm e-mails and</td>
</tr>
<tr>
<td></td>
<td>scheduled e-mails.</td>
</tr>
<tr>
<td></td>
<td>The report data in report e-mails.</td>
</tr>
</tbody>
</table>
2.14 Showing or Hiding the Menu Item for Switching from Setting Mode to Basic Setting Mode (Release number 3 or later)

Set whether or not to display a menu item in the setting mode menu for switching to basic setting mode.

**Setup Screen**

MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic setting mode), and select the Environment tab > Operating Environment

<table>
<thead>
<tr>
<th>Operating environment</th>
<th>Tag/Channel</th>
<th>Language</th>
<th>Remote Controller ID</th>
<th>Decimal Point Type</th>
<th>Basic setting mode</th>
<th>Menu display</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>On/Off</td>
</tr>
</tbody>
</table>

**Setup Items**

- **Basic Setting Mode > Menu display**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td>Displays “Basic setting mode” in the setting mode menu.</td>
</tr>
<tr>
<td>Off</td>
<td>Basic setting mode is not displayed in the setting mode menu.</td>
</tr>
</tbody>
</table>

**Operations**

When “Basic setting mode” appears in the setting mode menu, you can perform the following operation:

1. Press MENU and select the Menu tab > Basic setting mode. Then press DISP/ENTER.
   
   A confirmation window opens.

2. Select Yes, and press DISP/ENTER.
   
   The basic setting mode menu appears.

**Note**

Regardless of this setting, you can switch from setting mode to basic setting mode by holding down the FUNC key for 3 seconds.
3.1 Setting the Scan Interval and the Integration Time of the A/D Converter

Select the scan interval and the integration time of the A/D converter.

For a description of the scan interval and the integration time of the A/D converter, see section 1.1.

**Setup Screen**

Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic setting mode), and select the Menu tab > A/D, Memory

**Setup Items**

- **Scan interval > Scan mode**
  
  Normal: Measures at the normal mode scan interval.
  
  * The scan mode is fixed at Normal on DXs equipped with external input channels (/MC1 option) and when the multi batch function (/BT2 option; release numbers 3 and later) is being used.

  FAST: Measures at a scan interval of 25 ms (DX1002, DX1004, DX1002N, and DX1004N) or 125 ms (DX1006, DX1012, DX1006N, and DX1012N).

- **Scan interval > Scan interval**
  
  The selectable settings appear.

- **Scan interval > A/D integrate**
  
  When the scan mode is set to **Normal**, select the A/D integration time as necessary.

  Only the selectable settings are displayed.

<table>
<thead>
<tr>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto</td>
<td>The DX automatically detects the power supply frequency and sets the integration time to 16.7 ms and 20 ms for 60 Hz and 50 Hz, respectively. Fixed to 20 ms on /P1 models that use the 24 VDC power supply.</td>
</tr>
<tr>
<td>50Hz</td>
<td>Sets the integration time to 20 ms.</td>
</tr>
<tr>
<td>60Hz</td>
<td>Sets the integration time to 16.7 ms.</td>
</tr>
<tr>
<td>100ms</td>
<td>Sets the integration time to 100 ms (when the scan interval is 2 s or 5 s).</td>
</tr>
<tr>
<td>600Hz</td>
<td>The A/D integration time for fast sampling mode. You cannot change this value.</td>
</tr>
</tbody>
</table>
3.2 Setting the Burnout Detection and the Reference Junction Compensation of the Thermocouple Input

Set the function that detects burnouts in the sensor for thermocouple input and 1-5V input and the reference junction compensation method of the thermocouple.

**Setup Screen**

Press **MENU** (to switch to setting mode), hold down **FUNC** for 3 s (to switch to basic setting mode), and select the **Menu** tab > **Burnout, RJC**

**Basic Setting Mode**

<table>
<thead>
<tr>
<th>First-CH</th>
<th>Last-CH</th>
<th>Burnout set</th>
<th>RJC Mode</th>
<th>Volt</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Off</td>
<td>Internal</td>
<td>0 µV</td>
</tr>
</tbody>
</table>

**Setup Items**

- **First-CH, Last-CH**
  Select the target channels.

- **Burnout set**
  Detects thermocouple and 1-5V input sensor burnouts.

<table>
<thead>
<tr>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Does not detect burnouts in the sensor.</td>
</tr>
<tr>
<td>Up</td>
<td>When the sensor burns out, the measured result is set to +over range. The measured value displays “Burnout.” For 1-5V input, the DX assumes that the sensor has burned out when the measured value exceeds the scale upper limit by 10% of the scale width. (Example: When the measured value is greater than 110 when the scale is from 0 to 100)</td>
</tr>
<tr>
<td>Down</td>
<td>When the sensor burns out, the measured result is set to – over range. The measured value displays “Burnout.” For 1-5V input, the DX assumes that the sensor has burned out when the measured value falls below the scale upper limit by 5% of the scale width. (Example: When the measured value is less than –5 when the scale is from 0 to 100)</td>
</tr>
</tbody>
</table>

- **RJC > Mode**
  Sets the reference junction compensation method of the thermocouple input. Select **Internal** or **External**.

<table>
<thead>
<tr>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internal</td>
<td>Uses the reference junction compensation function of the DX.</td>
</tr>
<tr>
<td>External</td>
<td>Uses an external reference junction compensation function. When set to <strong>External</strong>, Volt is displayed.</td>
</tr>
</tbody>
</table>

- **RJC > Volt**
  The compensation voltage to be added to the input. Set the value in the range of –20000 µV to 20000 µV.
3.3 Setting the Input Range

Set the input range for each channel.

**Setup Screen**

- **Temperature Unit**
  Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic setting mode), and select the Environment tab > Operating Environment

- **Input Range for Each Channel**
  Press MENU (to switch to setting mode), and select the Menu tab > Meas channel > Range, Alarm

**Setup Items**

- **Temperature**
  Select the temperature unit. The setting is applied to all temperature measurement channels.

<table>
<thead>
<tr>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>C</td>
<td>Use Celsius</td>
</tr>
<tr>
<td>F</td>
<td>Use Fahrenheit</td>
</tr>
</tbody>
</table>
3.3 Setting the Input Range

- **First-CH, Last-CH**
Select the target channels.

- **Range > Mode**

<table>
<thead>
<tr>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Skip</td>
<td>Not measured.</td>
</tr>
</tbody>
</table>

| Volt, TC, RTD, DI, 1-5V | Input type. Represents DC voltage, thermocouple, RTD, ON/OFF input, and 1-5V inputs, respectively. |
| Delta, Scale, Sqrt | Difference computation, linear scaling, and square root computation. |

Set the items with check marks in the table below according to the mode value.

<table>
<thead>
<tr>
<th>Setup Item</th>
<th>Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Volt</td>
<td>✓</td>
</tr>
<tr>
<td>TC</td>
<td>✓</td>
</tr>
<tr>
<td>RTD</td>
<td>✓</td>
</tr>
<tr>
<td>DI</td>
<td>✓</td>
</tr>
<tr>
<td>Delta</td>
<td>✓</td>
</tr>
<tr>
<td>Scale</td>
<td>✓</td>
</tr>
<tr>
<td>Sqrt</td>
<td>✓</td>
</tr>
<tr>
<td>1-5V</td>
<td>✓</td>
</tr>
<tr>
<td>Skip</td>
<td>✓</td>
</tr>
</tbody>
</table>

- **Range > Type**
Input type when Mode is Delta or Scale. See the description on Mode above.

- **Range > Range**
Input type details.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Input Type</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>20mV</td>
<td>–20.000 mV to 20.000 mVDC</td>
<td>Standard</td>
</tr>
<tr>
<td>60mV</td>
<td>–60.00 mV to 60.00 mVDC</td>
<td>60mV –60.00 mV to 60.00 mVDC</td>
</tr>
<tr>
<td>200mV</td>
<td>–200.00 mV to 200.00 mVDC</td>
<td>200mV –200.00 mV to 200.00 mVDC</td>
</tr>
<tr>
<td>2V</td>
<td>–2.000 V to 2.000 VDC</td>
<td>2V –2.000 V to 2.000 VDC</td>
</tr>
<tr>
<td>6V</td>
<td>–6.000 V to 6.000 VDC</td>
<td>6V –6.000 V to 6.000 VDC</td>
</tr>
<tr>
<td>20V</td>
<td>–20.000 V to 20.000 VDC</td>
<td>20V –20.000 V to 20.000 VDC</td>
</tr>
<tr>
<td>20V</td>
<td>–50.00 V to 60.00 VDC</td>
<td>20V –50.00 V to 60.00 VDC</td>
</tr>
<tr>
<td>Pt</td>
<td>Pt100</td>
<td>JPt/JPt100</td>
</tr>
<tr>
<td>JPt</td>
<td>JP100</td>
<td>JPt/JPt100</td>
</tr>
<tr>
<td>Level</td>
<td>ON/OFF(Voltage)</td>
<td>Option</td>
</tr>
<tr>
<td>Contact</td>
<td>ON/OFF(Contact)</td>
<td>Option</td>
</tr>
<tr>
<td>1-5V</td>
<td>0.800V to 5.200V</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Setting</th>
<th>Input Type</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Kp</td>
<td>Kp vs Au/Fe</td>
<td>N3 option</td>
</tr>
<tr>
<td>PLAT1</td>
<td>PLATINEL</td>
<td></td>
</tr>
<tr>
<td>PR</td>
<td>PR40-20</td>
<td></td>
</tr>
<tr>
<td>NiMo</td>
<td>NiNiMo</td>
<td></td>
</tr>
<tr>
<td>W/WRe</td>
<td>W/WRe26</td>
<td></td>
</tr>
<tr>
<td>N2</td>
<td>Type N (AWG14)</td>
<td></td>
</tr>
<tr>
<td>XX</td>
<td>XX GOST†1</td>
<td></td>
</tr>
<tr>
<td>Pi50</td>
<td>Pi50</td>
<td></td>
</tr>
<tr>
<td>Pi150</td>
<td>Pi150</td>
<td></td>
</tr>
<tr>
<td>Ni1</td>
<td>Ni100 (SAMA)</td>
<td></td>
</tr>
<tr>
<td>Ni2</td>
<td>Ni100 (DIN)</td>
<td></td>
</tr>
<tr>
<td>Ni3</td>
<td>Ni120</td>
<td></td>
</tr>
<tr>
<td>J263</td>
<td>J263*6</td>
<td></td>
</tr>
<tr>
<td>Cu53</td>
<td>Cu53</td>
<td></td>
</tr>
<tr>
<td>Cu100</td>
<td>Cu100: a = 0.00425 at 0°C</td>
<td></td>
</tr>
<tr>
<td>Pt25</td>
<td>Pt25</td>
<td></td>
</tr>
<tr>
<td>Pt100G</td>
<td>Pt109 GOST†1</td>
<td></td>
</tr>
<tr>
<td>Cu100G</td>
<td>Cu109 GOST†1</td>
<td></td>
</tr>
<tr>
<td>Cu50G</td>
<td>Cu50 GOST†1</td>
<td></td>
</tr>
<tr>
<td>Cu10G</td>
<td>Cu10G26</td>
<td></td>
</tr>
<tr>
<td>Pt45G</td>
<td>Pt45 GOST†1</td>
<td></td>
</tr>
<tr>
<td>Pt200W</td>
<td>Pt200(WEED)²</td>
<td></td>
</tr>
</tbody>
</table>

*1 A function available on DXs with release number 3 or later.
*2 This function is available for release numbers 4 and later.
3.3 Setting the Input Range

- **Range > Span_L, Span_U**
  Input range. The selectable range is displayed on the screen.

  **Note**
  - You cannot set the same value to Span Lower and Span Upper.
  - When the Mode is 1-5V or Sqrt, Span Lower must be less than Span Upper.

- **Range > Scale_L, Scale_U**
  Input range after converting the unit.
  The selectable range is from –30000 to 30000. The decimal place is determined by the Scale Lower setting. It can be set to the following positions: “X.XXX,” “XX.XXX,” “XXX.XX,” “XXXX.X,” or “XXXXX.”

  **Note**
  - The DX converts the measured value to a value obtained by removing the decimal point from the value span specified by Scale Lower and Scale Upper. For example, if the scale setting is “–5 to 5,” the value is converted to a value within the span of “10”; if the scale setting is “–5.0 to 5.0,” the value is converted to a value within a span of “100.” In this case, the resolution of the value converted to a span of “10” is lower than the value converted to a span of “100.” To prevent the display from becoming rough, it is recommended that the scale be set so that this value is greater than 100.
  - You cannot set the same value to Scale Lower and Scale Upper.
  - When the Mode is 1-5V or Sqrt, Scale Lower must be less than Scale Upper.

- **Range > Unit**
  Set the unit (up to 6 characters, A a # 1).

- **Range > Ref. CH**
  The reference channel for difference computation.

- **Range > Low-cut**
  Select On to use the low-cut function.
  - The low-cut value for 1 to 5 V input is fixed to 0% value of the input span.

- **Range > Value**
  On a square root computation channel, set the low-cut value in the range of 0.0% to 5.0% of the input span.
3.4 Setting the Moving Average of the Input

Set the moving average function of the measurement channel. This function suppresses the effects of noise.

For a description of the function, see section 1.1.

**Setup Screen**

Press **MENU** (to switch to setting mode), and select the **Menu** tab > **Meas channel** > **Moving average**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>First-CH</td>
<td>01</td>
</tr>
<tr>
<td>Last-CH</td>
<td>001</td>
</tr>
<tr>
<td>Moving average</td>
<td>On</td>
</tr>
<tr>
<td>Count</td>
<td>2</td>
</tr>
</tbody>
</table>

**Setup Items**

- **First-CH, Last-CH**
  Select the target channels.

- **Moving average > On/Off**
  To use moving average, select **On**.

- **Moving average > Count**
  Set the number of data points of the moving average in the range of 2 to 400.
3.5 Setting the Auxiliary Alarm Function

**Setup Screen**

Press **MENU** (to switch to setting mode), hold down **FUNC** for 3 s (to switch to basic setting mode), and select the **Menu** tab > **Alarm** > **Basic settings**: **Switch, Relay**; or **Hystersis**.

- **Basic settings**
  - **Basic Setting Mode**
    - **Basic settings**
      - **Refresh**
        - **Decrease**
      - **Increase**
      - **Indicator**
    - **Basic Setting Mode**
      - **Switch**
        - **Relay**
          - **Hysteresis**

- **Hystersis**
  - **Basic Setting Mode**
    - **Hysteresis**
      - **Rate of change**
        - **High/Low**
      - **Delta High/Low**
      - **Math CH**
        - **High/Low**

**Setup Items**

**Basic settings > Reflash**

To set the reflash operation on the alarm output relay, select **On**. The reflash function is set on the first three output relays.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Reflash is not used.</td>
</tr>
<tr>
<td>On</td>
<td>Reflash is used. The relays are deactivated for approximately 500 ms.</td>
</tr>
<tr>
<td>On-1s</td>
<td>Reflash is used. The relays are deactivated for approximately 1 s.</td>
</tr>
<tr>
<td>On-2s</td>
<td>Reflash is used. The relays are deactivated for approximately 2 s.</td>
</tr>
</tbody>
</table>

**Basic settings > Rate of change**

- **Decrease**
  
  Set the interval for the rate-of-change calculation of the low limit on rate-of-change alarm in terms of the number of sampled data points (1 to 32). The actual interval is obtained by multiplying the value specified here by the scan interval.

- **Increase**
  
  Set the interval for the rate-of-change calculation of the high limit on rate-of-change alarm in the same manner as the interval for the low limit on rate-of-change alarm.
3.5 Setting the Auxiliary Alarm Function

- **Basic setting > Indicator**
  You can choose to make the alarm displays behave in the following ways. When you use the alarm annunciator function (release number 3 or later), the setting follows the annunciator sequence.

<table>
<thead>
<tr>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nonhold</td>
<td>Clears the alarm indication when the alarm condition is released (returns to normal condition).</td>
</tr>
<tr>
<td>Hold</td>
<td>Holds the alarm indication until an alarm acknowledge operation is performed.</td>
</tr>
</tbody>
</table>

- **Switch, Relay**
  - **Internal Switch > AND**
    Select the internal switches that are to operate using AND logic. Set the range of internal switches (from the first internal switch) to take the AND logic. All subsequent switches will be set to OR logic.

- **Relay > AND**
  Select the relays that are to operate using AND logic. Set the range of relays (from the first alarm relay) to take the AND logic. All subsequent relays will be set to OR logic. Available settings are None, I01 (I01 only), I01-I02 (I01 and I02), I01-I03 (I01 to I03), etc. Only alarm output relays that are installed are valid.

  **Note**
  When reflash is turned ON, the operation of the first three output relays is fixed to OR logic. Specifying AND produces no effect.

- **Relay > Action**
  Select whether the alarm output relay is energized or de-energized when an alarm occurs. The setting applies to all alarm output relays.

- **Relay > Hold**
  You can choose to make the alarm output relays behave in the following ways. This setting applies to all relays. When you use the alarm annunciator function (release number 3 or later), the setting follows the annunciator sequence.

<table>
<thead>
<tr>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nonhold</td>
<td>Turns the output relay OFF when the alarm condition is released (returns to normal condition).</td>
</tr>
<tr>
<td>Hold</td>
<td>Holds the output relay at ON until an alarm acknowledge operation is performed.</td>
</tr>
</tbody>
</table>

  **Note**
  When reflash is turned ON, the operation of the first three output relays is set to nonhold. Specifying Hold produces no effect.
3.5 Setting the Auxiliary Alarm Function

- **Relay > Relay Action on Ack**
  You can select the relay output status that is enabled after the AlarmACK operation from the following two settings. When you use the alarm annunciator function (release number 3 or later), the setting follows the annunciator sequence.

<table>
<thead>
<tr>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal</td>
<td>The relay output is deactivated when the alarm ACK operation is executed. If the condition for activating the alarm output relay is met in the next scan interval, the relay output is activated. This operation is valid only when the alarm output relay is set to Hold.</td>
</tr>
<tr>
<td>Reset</td>
<td>The relay output is deactivated when the alarm ACK operation is executed. If a new condition for activating the alarm output relay is met, the relay is activated.</td>
</tr>
</tbody>
</table>

An example of the relay action when alarm ACK is executed is shown below. This example is for the case when the output relay AND item is set to None.

**Normal**

```
<table>
<thead>
<tr>
<th>Alarm output relay</th>
<th>Alarm 1</th>
<th>Alarm 2</th>
<th>Alarm ACK</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deactivated</td>
<td>Activated</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alarm occurrence</td>
<td></td>
<td></td>
<td>Alarm ACK</td>
</tr>
</tbody>
</table>
```

**Reset**

```
<table>
<thead>
<tr>
<th>Alarm output relay</th>
<th>Alarm 1</th>
<th>Alarm 2</th>
<th>Alarm ACK</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deactivated</td>
<td>Activated</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alarm occurrence</td>
<td></td>
<td></td>
<td>Alarm ACK</td>
</tr>
</tbody>
</table>
```

- **Hysteresis > Meas CH**
  - **High/Low**
    Sets the hysteresis width of the alarm occurrence/release of the high/low limit alarm specified on measurement channels.
    Selectable range: 0.0% to 5.0% of the span or scaling width
  - **Delta High/Low**
    Sets the hysteresis width of the alarm occurrence/release of the difference high/low limit alarm specified on measurement channels.
    Selectable range: 0.0% to 5.0% of the span

- **Hysteresis > Math CH (/M1 and /PM1 options)**
  Sets the hysteresis width of the alarm occurrence/release of the high/low limit alarm specified on computation channels.
  Selectable range: 0.0% to 5.0% of the measurement span
3.6 Hiding the Alarm Indication

Select whether to enable the alarm hide function.

**Setup Screen**

Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic setting mode), and select the Environment tab > Alarm > Action

**Setup Items**

- **Alarm action > No logging**
  
  To enable the function that turns off the alarm indicator and logging, select On. The Detect setup item is displayed in the alarm setting screen (see section 3.7).

  This function disables the alarm indicator and the logging of alarm events to the alarm summary. Alarms are also not displayed by the alarm annunciator (release number 3 or later).

- **Settings for Each Channel and Each Alarm**
  
  See section 3.7.
3.7 Setting Alarms on Channels

Set the alarms after setting the range. All alarm settings of a channel are cancelled in the following cases.

- When the input type (Volt, TC, etc.) is changed.
- When the input range is changed.
- When the upper or lower limit of the span or scale is changed on channels that are set to linear scale, square root computation, or 1-5 V (including changes in the decimal point position).

**Setup Screen**

- **Alarms for Each Channel**
  Press MENU (to switch to setting mode), and select the **Menu tab > Meas channel > Range, Alarm**

- **Alarm Delay Time**
  Press MENU (to switch to setting mode), and select the **Menu tab > Meas channel > Tag, Memory, Delay**

On DXs without the /AS1 advanced security option

On DXs with the /AS1 advanced security option
3.7 Setting Alarms on Channels

- Alarm Levels and Colors (Release number 3 or later)
  Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic setting mode), and select the Environment tab > Alarm > Alarm level/color
3.7 Setting Alarms on Channels

### Setup Items

- **First-CH, Last-CH**
  Select the target channels. The target channels are common with the other items that are displayed on the screen.

- **Alarm > 1, 2, 3, and 4**
  For each alarm, 1 to 4, select On to enable it.

- **Alarm > Type**
  Select the alarm type.

<table>
<thead>
<tr>
<th>Settings Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>H</td>
<td>High limit alarm –</td>
</tr>
<tr>
<td>L</td>
<td>Low limit alarm –</td>
</tr>
<tr>
<td>h</td>
<td>Difference high limit alarm Can be specified on channels set to difference computation.</td>
</tr>
<tr>
<td>l</td>
<td>Difference low limit alarm Can be specified on channels set to difference computation.</td>
</tr>
<tr>
<td>R</td>
<td>High limit on rate-of-change alarm –</td>
</tr>
<tr>
<td>r</td>
<td>Low limit on rate-of-change alarm –</td>
</tr>
<tr>
<td>T</td>
<td>Delay high limit alarm –</td>
</tr>
<tr>
<td>t</td>
<td>Delay low limit alarm –</td>
</tr>
</tbody>
</table>

Alarms on channels set to difference computation are inserted at the following positions.

![Input value](image)

- **Alarm > Value**
  Set the alarm value for the selected alarm type.

#### When the Mode of the Channel Is Set to Volt, TC, RTD, or DI

<table>
<thead>
<tr>
<th>Type</th>
<th>Value</th>
<th>Example of a Range of Alarm Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>H, L</td>
<td>Value in the measurable range</td>
<td>–2.0000 to 2.0000 V for 2 V range</td>
</tr>
<tr>
<td>R, r</td>
<td>1 digit to the upper limit of the width of the measurable range However, less than or equal to 30000 excluding the decimal point.</td>
<td>0.0001 to 3.0000 V for 2 V range</td>
</tr>
<tr>
<td>T, t</td>
<td>Same as H and L.</td>
<td>Same as H and L.</td>
</tr>
</tbody>
</table>

#### When the Mode of the Channel Is Set to Delta

<table>
<thead>
<tr>
<th>Type</th>
<th>Value</th>
<th>Example of a Range of Alarm Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>H, L</td>
<td>Value in the measurable range</td>
<td>–2.0000 to 2.0000 V for 2 V range</td>
</tr>
<tr>
<td>h, l</td>
<td>Value in the measurable range</td>
<td>–1760.0 to 1760.0°C for thermocouple type R</td>
</tr>
<tr>
<td>R, r</td>
<td>1 digit to the width of the measurable range However, less than or equal to 30000 excluding the decimal point.</td>
<td>0.0001 to 3.0000 V for 2 V range</td>
</tr>
<tr>
<td>T, t</td>
<td>Same as H and L.</td>
<td>Same as H and L.</td>
</tr>
</tbody>
</table>

#### When the Mode of the Channel Is Set to Scale, Sqrt, or 1-5V

<table>
<thead>
<tr>
<th>Type</th>
<th>Value</th>
<th>Example of a Range of Alarm Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>H, L</td>
<td>–5% to 105% of the scale width. However, within –30000 to 30000 excluding the decimal point.</td>
<td>–5.0 to 105.0 when the scale is 0.0 to 100.0</td>
</tr>
<tr>
<td>R, r</td>
<td>Within 1 to 30000 excluding the decimal point.</td>
<td>0.1 to 3000.0 when the scale is 0.0 to 100.0</td>
</tr>
<tr>
<td>T, t</td>
<td>Same as H and L.</td>
<td>Same as H and L.</td>
</tr>
</tbody>
</table>
3.7 Setting Alarms on Channels

- **Alarm > Relay**  
  Select whether to turn On or Off the relay output.

- **Alarm > No.**  
  Set the output relay number or internal switch number when performing relay output.

- **Alarm > Detect**  
  This item appears when the alarm hide function (see section 3.6) is turned On. Select whether to show or hide the alarm indication when an alarm occurs. If set to Off, a signal is output to the alarm output relay or internal switch when an alarm occurs, but it is not indicated on the screen. The alarm is also not recorded in the alarm summary, and alarms are not displayed by the alarm annunciator (release number 3 or later).

- **Alarm delay > Time (for delay high/low limit alarms)**  
  Set the alarm delay time using an integer in the range of 1 to 3600 s. On DXs with the /AS1 advanced security option, you can set the delay time to a value within the range of 1 to 3600 seconds or 1 to 24 hours.

  **Note**  
  - The alarm delay time takes on a value that is an integer multiple of the scan interval. For example, if the alarm delay time is set to 5 s when the scan interval is 2 s, the actual delay time is 6 s.
  - The delay alarm has the following special operations.  
    - If the computation is stopped in a condition in which the computed value is exceeding the alarm setting when a delay alarm is set on a computation channel, the alarm is turned On after the specified period (delay period) elapses.
    - The alarm detection operation is reset if a power failure occurs. The operation restarts after the power recovers.
    - If the alarm setting of the delay high limit alarm is changed when an alarm is already activated and the input is greater than or equal to the new setting, the alarm continues. For all other cases, the alarm detection operation starts at the new setting. This is also true for the delay lower limit alarm.

- **Alarm delay > Unit (For delay high/low limit alarms)**  
  This setting is only available on DXs with the /AS1 advanced security option. Set the unit of the alarm delay time. You can select seconds or hours.

- **Alarm display > Level (Release number 3 or later)**  
  When multiple alarms occur, the display of alarms with higher levels is given higher priority. This setting applies to all channels.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1&gt;2&gt;3&gt;4</td>
<td>The order of alarm level preference, from highest to lowest preference, is 1, 2, 3, 4.</td>
</tr>
<tr>
<td>1&gt;4&gt;2&gt;3</td>
<td>The order of alarm level preference, from highest to lowest preference, is 1, 4, 2, 3.</td>
</tr>
<tr>
<td>1&gt;4&gt;3&gt;2</td>
<td>The order of alarm level preference, from highest to lowest preference, is 1, 4, 3, 2.</td>
</tr>
</tbody>
</table>

- **Alarm display > Color (Release number 3 or later)**  
  Determines the alarm color for each alarm level. This setting applies to all channels.

<table>
<thead>
<tr>
<th>Item</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Sets the alarm level 1 color to red, orange, yellow, or pink.</td>
</tr>
<tr>
<td>2</td>
<td>Sets the alarm level 2 color.</td>
</tr>
<tr>
<td>3</td>
<td>Sets the alarm level 3 color.</td>
</tr>
<tr>
<td>4</td>
<td>Sets the alarm level 4 color.</td>
</tr>
</tbody>
</table>
3.8 Releasing the Alarm Output (Alarm ACK Operation)

This operation is valid when the DX is set as follows:

**DX with release number 3 or later**
- When Annunciator mode is set to On in the basic setting mode.
- When Annunciator mode is set to Off, the operation is the same as described for DX with release number 2 below.

**DX with release number 2**
- When Indicator is set to Hold in the basic setting mode.
- When Relay Hold is set to Hold and Relay action on ACK is set to Normal in the basic setting mode.
- When Relay action on ACK is set to Reset in the basic setting mode.

**DX before release number 2**
- When Indicator is set to Hold in the basic setting mode.
- When Relay Hold is set to Hold in the basic setting mode.

For the procedure to set the relay action, see section 3.5.

On a DX with advanced security (/AS1 option; release numbers 4 and later), you can perform separate alarm ACK operations on each alarm.
For information about individual alarm ACK operations, see section 4.4.

**Procedure**

This operation is carried out after an alarm occurs.

1. In the operation mode, press **FUNC**. The FUNC key menu appears.
2. Press the **AlarmACK** soft key. The alarm output is released.

**Explanation**

- **Alarm Acknowledge (ACK) Operation**
  When an alarm acknowledge operation is carried out, the indications and outputs (relays and switches) of all activated alarms are cleared.
  In annunciator mode (release number 3 or later), the alarm indications and outputs follow the annunciator sequence.
3.9 Performing Calibration Correction (/CC1 Option)

The input value is corrected using segments, and the result is used as a measured value. For a description of the function, see section 1.1.

**Setup Screen**

Press **MENU** (to switch to setting mode), and select the **Menu tab** > **Meas channel** > **Calibration correction**

**Setup Items**

- **First-CH, Last-CH**
  Select the target channels. You can set consecutive channels whose range is set to the same value as the first channel.

- **Number of set points**
  Select the number of points that make up the segments (including the start and end points) in the range of 2 to 16.
  To disable calibration correction, select **Off**.

- **Number of set points > MES val, True val**
  Press the **Input** soft key and enter the value.
  For the MES value, set a value that is greater than the previous value.
  Press the **Measure** soft key to set the measured value at that point to MES val. If you press the **Measure** soft key when setting multiple channels simultaneously, the measured value of the first channel are set to the MES val of all channels.

**Selective Range of MES and True Values**

- **Channels on which linear scaling is specified**
  –30000 to 30000 (the decimal place is the same setting as the scale value)

- **Other channels**
  Value in the measurable range of the selected range
  Example: –2.0000 to 2.0000 for 2 V range

**Note**

- The calibration correction setting is set to Off if you change the Mode or Range setting.
- Calibration correction cannot be specified on channels set to Skip.
3.10 Counting Pulses (/PM1 Option)

The pulses applied to the pulse input terminal are counted on a computation channel. For a description of the function, see section 1.1.

**Setup Screen**

Press MENU (to switch to setting mode), and select the **Menu tab > Math channel > Expression, Alarm**

**Setup Items**

- **First-CH, Last-CH**
  Select the target computation channels.

- **Math**
  Select On.

- **Math > Calculation expression**
  Enter the equation using symbols.
  
  Q01 to Q08: Displays the number of pulses per second.
  
  P01 to P08: Displays the number of pulses per scan interval.
  
  * The numbers 01 to 08 correspond to the pulse input terminal numbers.

  For the procedure to set the computation channels, see section 9.1.

The procedure is explained below using an example.

- **Example 1: Pulse Sum Value**

  Display the sum value of the pulse signal applied to pulse input terminal number 6.

  
  **Expression**
  Assign the computation channel and set the expression. Set the span lower/upper limit and unit according to the application.

<table>
<thead>
<tr>
<th>Channel</th>
<th>Equation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>101</td>
<td>TLOG.SUM(P6)</td>
<td>Sum of the number of pulses per scan interval</td>
</tr>
</tbody>
</table>
### Example 2: Number of Pulses per Minute

Count the pulse signal applied to pulse input terminal number 6 on the DX1002 (scan interval set to 250 ms), and calculate and display the number of pulses per minute.

- **Number of pulses per second**
  - **Channel**: 101
  - **Equation**: Q6
  - **Description**: Number of pulses per second

- **Number of pulses per minute**
  - **Channel**: 102
  - **Equation**: 101*K01
  - **Description**: Number of pulses per minute

**Expression**

Assign the computation channel as shown below and set the expressions. Set the span lower/upper limit and unit according to the application.

<table>
<thead>
<tr>
<th>Channel</th>
<th>Equation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>101</td>
<td>Q6</td>
<td>Number of pulses per second</td>
</tr>
<tr>
<td>102</td>
<td>101*K01</td>
<td>Number of pulses per minute</td>
</tr>
</tbody>
</table>

**Constant**

<table>
<thead>
<tr>
<th>Constant</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>K01</td>
<td>60</td>
<td>Coefficient for converting the number of pulses per second to the number of pulses per minute</td>
</tr>
</tbody>
</table>

**Channels**

The computation is performed in order from the channel with the smallest channel number in one scan interval.

Use a channel of a channel number larger than that of the channel counting the number of pulses per second for the computation channel that is to calculate the number of pulses per minute.

### Example 3: Reset When the Pulse Sum Value Exceeds a Certain Value

Reset the sum value when the pulse sum value exceeds a specified value (reset value) and carry over the value exceeding the reset value to the sum after the reset.

Count the number of resets and calculate the total sum value up to that point.

- **Expression**
  - **Channel**: 101
    - **Expression**: ((102+P01).GE.K01)+101
    - **Description**: Pulse sum value reset count
  - **Channel**: 102
    - **Expression**: CARRY(K01);TLOG.SUM(P01)
    - **Description**: Pulse sum value
  - **Channel**: 103
    - **Expression**: K01*101+102
    - **Description**: Total sum value

**Symbol**

- **P01**: Counts the number of pulses per scan interval.
- **K01**: Constant. The reset value. The sum value is reset when this value is exceeded.
### 3.10 Counting Pulses (/PM1 Option)

**Channel 101: Reset Count**
Calculates the number of times the pulse sum value is reset.
The expression "((102+P01).GE.K01)" is set to 1 when "the previous pulse sum value (102) + the current pulse count (P01)" is greater than the reset value (K01). Otherwise, the expression is set to 0. The value of channel 101 is incremented when the pulse sum value exceeds the reset value.

**Channel 102: Pulse Sum Value**
Calculates the pulse sum value.
Under normal conditions, the pulse sum value TLOG.SUM (P01) is calculated. When the pulse sum value is greater than or equal to the reset value (K01), the pulse sum value is set to the amount exceeding K01.

**Channel 103: Total Sum Value**
Multiplies the reset value (K01) by the reset count (101) and adds the pulse sum value (102) to derive the total sum value.

**Note**
- The computation is performed in order from the channel with the smallest channel number in one scan interval. If the channel number in the expression is greater than or equal to the channel number in which the expression is assigned, the previous computed result (previous value) is used for the channel in the expression.
- If the pulse input value of the scan interval is greater than the reset value, correct computation cannot be achieved.
3.11 Setting the Method of Detecting Over-Range Values of Linearly Scaled Measurement Channels

Setup Screen

Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic setting mode), and select the Environment tab > Input, Tag

![Basic Setting Mode](image)

- **Input > Value on over-range**

<table>
<thead>
<tr>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Free</td>
<td>The value is set to –over range if the value is less than –30000 and +over range if the value is greater than 30000 excluding the decimal point. The value is displayed as –Over and +Over, respectively.</td>
</tr>
</tbody>
</table>
| Over     | The value is set to –over range if the value is less than –5% of the scale and +over range if the value is greater than 105%. The value is displayed as –Over and +Over, respectively.  
  Example: If the scale is 0.0 to 200.0, the value is set to –over range if the value is less than –10.0 of the scale and +over range if the value is greater than 210.0. |

**Note**

For computations such as TLOG, CLOG, and report, the handling of the scale over-range value can be set in advance.

See section 9.1.
3.12 Using the Alarm Annunciator Function (Release number 3 or later)

This section explains how to use the alarm annunciator function. For a description of the function, see section 1.2.

Setup Screen

- **Annunciator Mode**
  Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic setting mode), and select the Environment tab > Alarm > Action.

- **Alarm Levels and Colors**
  See section 3.7.

- **Display**
  Press MENU (to switch to setting mode), and select the Menu tab > Display > Annunciator.

Setup Items

- **Alarm action > Annunciator mode**
  Select On to use the annunciator function.

- **Alarm action > Sequence**
  Select the annunciator sequence. For details about the annunciator sequence, see "Explanation" in this section.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ISA-A-4</td>
<td>A no lock-in sequence.</td>
</tr>
<tr>
<td>ISA-A</td>
<td>A lock-in sequence.</td>
</tr>
<tr>
<td>ISA-M</td>
<td>A double lock-in sequence.</td>
</tr>
</tbody>
</table>
3.12 Using the Alarm Annunciator Function (Release number 3 or later)

- **Alarm action > Time off color**
  The window display color when no alarms are activated. You can select white or green.

- **Levels and Colors**
  See section 3.7.

- **Annunciator position**
  The position of the annunciator window. See the explanation for the next item.

- **Annunciator position > On/Off**
  Set the annunciator position that you want to use to **On**.
  Starting with 1, consecutively set all annunciator positions that you want to use to On. After a position has been set to **Off**, all of the positions after it will also be turned off even if they are set to **On**. The annunciator display changes depending on how many annunciator windows you use. For details, see “Explanation.”

- **Annunciator position > Channel, Level**
  You can assign alarms to annunciator windows by specifying channel numbers and alarm levels.
  You can set **Level** to 1, 2, 3, 4, or **All**. If you select **All**, all of the alarms in the specified channel are assigned to the specified window.

- **Annunciator position > Comment txt block No.**
  You can select a text string (label) to display in the annunciator window by selecting a comment text block number.
  For information about how to set comment text blocks, see section 5.18.
3.12 Using the Alarm Annunciator Function (Release number 3 or later)

**Procedure**

- **Opening the Display**
  The annunciator display appears when you turn on the power. You can switch to the annunciator display from other displays by following the procedure below.
  1. Press **DISP/ENTER** to show the display selection menu.
  2. Use the **up and down arrow keys** to select **Annunciator**, and then press **DISP/ENTER**.

![Display Example](image)

The display appears. The example below is for when there are four annunciator windows.

- **Alarm ACK**
  Perform this operation after an alarm has occurred. This operation affects all alarms.
  1. In operation mode, press **FUNC**.
     The FUNC key menu appears.
  2. Press the **AlarmACK** soft key.
     The alarm indications and outputs are cleared according to the annunciator sequence. For details, see "Explanation."

- **Alarm Display Reset (When the annunciator sequence is set to ISA-M)**
  The alarm display reset operation will not take place unless the alarm ACK operation is performed first. The alarm display reset operation affects all alarms.
  1. In operation mode, press **FUNC**.
     The FUNC key menu appears.
  2. Press the **AlarmDispRST** soft key.
     The alarm displays are reset. They are reset according to the annunciator sequence. For details, see "Explanation."
**Explanation**

- **Display Window Layouts and Labels**
  The annunciator display layouts and labels change as indicated in the table below.

<table>
<thead>
<tr>
<th>Displayed Windows</th>
<th>Window Layout Vertical × Horizontal</th>
<th>Labels (max number of displayable characters) Lines</th>
<th>Characters</th>
<th>Font Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>2 × 2</td>
<td>5</td>
<td>26</td>
<td>6</td>
</tr>
<tr>
<td>6</td>
<td>3 × 2</td>
<td>5</td>
<td>26</td>
<td>6</td>
</tr>
<tr>
<td>8</td>
<td>4 × 2</td>
<td>4</td>
<td>26</td>
<td>6</td>
</tr>
<tr>
<td>10</td>
<td>5 × 2</td>
<td>3</td>
<td>26</td>
<td>6</td>
</tr>
<tr>
<td>12</td>
<td>6 × 2</td>
<td>3</td>
<td>26</td>
<td>6</td>
</tr>
<tr>
<td>16</td>
<td>8 × 2</td>
<td>2</td>
<td>26</td>
<td>6</td>
</tr>
<tr>
<td>20</td>
<td>5 × 4</td>
<td>3</td>
<td>13</td>
<td>6</td>
</tr>
<tr>
<td>24</td>
<td>8 × 3</td>
<td>2</td>
<td>17</td>
<td>6</td>
</tr>
</tbody>
</table>

**Display Positions**
Annunciator windows are assigned to positions starting with the left column.
Annunciator windows are assigned in ascending order. The example below is for an annunciator display with eight windows.

**Labels**
The number of characters that can be displayed varies depending on the number of annunciator windows.

**Window Colors**

<table>
<thead>
<tr>
<th>State</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>When an alarm is released</td>
<td>“Time off color” (green or white)</td>
</tr>
<tr>
<td>When an alarm is occurring</td>
<td>The alarm color. If multiple alarms are occurring, the window is</td>
</tr>
<tr>
<td></td>
<td>displayed using the color of the alarm with the highest priority.</td>
</tr>
<tr>
<td>Displayed windows not in use</td>
<td>Gray</td>
</tr>
</tbody>
</table>
3.12 Using the Alarm Annunciator Function (Release number 3 or later)

- Annunciator Sequence

Sequence diagram

ISA-A-4

Process

Sequence

Display

Relay output

Alarm icon

To abnormal

Return to normal

Return to normal

Process

Sequence

Display

Relay output

Alarm icon

Alarm ACK while abnormal

Process

Sequence

Display

Relay output

Alarm icon

Alarm ACK

Alarm

Display

Relay output

When multiple alarms have been assigned to a single annunciator window
- If multiple alarms are occurring, the window is displayed using the color of the alarm with the highest priority.

When two alarms have been assigned to a single relay
When the relay is set to OR logic

Alarm A

Occurrence

Release

Alarm B

Occurrence

Release

Relay

Activated

Deactivated

ACK

ACK

An alarm has occurred, and the relay has been activated.
3.12 Using the Alarm Annunciator Function (Release number 3 or later)

When the relay is set to AND logic:

- Alarm A Occurrence
- Release
- Alarm B Occurrence
- Release
- Relay Activated
- Deactivated

Alarm B has occurred, so now all alarms have occurred. This causes the relay to be activated.
3.12 Using the Alarm Annunciator Function (Release number 3 or later)

**Sequence diagram**

<table>
<thead>
<tr>
<th>Process</th>
<th>Sequence</th>
<th>Display</th>
<th>Relay output</th>
<th>Alarm icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abnormal</td>
<td>Acknowledged</td>
<td>On</td>
<td>Deactivated</td>
<td>On (red)</td>
</tr>
</tbody>
</table>

**Alarm ACK while abnormal**

<table>
<thead>
<tr>
<th>Process</th>
<th>Sequence</th>
<th>Display</th>
<th>Relay output</th>
<th>Alarm icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abnormal or normal</td>
<td>Alarm</td>
<td>Flashing</td>
<td>Activated</td>
<td>Blinking (red)</td>
</tr>
</tbody>
</table>

**Sequence pattern**

- If an alarm is released before the alarm ACK operation is performed, the annunciator blinks with the color that is displayed when no alarms are activated.
- If an alarm is released before the alarm ACK operation is performed, the alarm icon blinks green.

**When multiple alarms have been assigned to a single annunciator window**

- If multiple alarms are occurring, the window is displayed using the color of the alarm with the highest priority.

**When two alarms have been assigned to a single relay**

- When the relay is set to OR logic

  ![Sequence pattern diagram](image)

- An alarm has occurred so the relay has been activated.
3.12 Using the Alarm Annunciator Function (Release number 3 or later)

When the relay is set to AND logic

Alarm A Occurrence
Release

Alarm B Occurrence
Release

Relay Activated
Deactivated

ACK
ACK

Relay hold

Alarm B has occurred, so now all alarms have occurred.
This causes the relay to be activated.
3.12 Using the Alarm Annunciator Function (Release number 3 or later)

**Sequence diagram**

- **Process**: Normal or Abnormal
- **Sequence**: Normal or Acknowledged
- **Display**: Normal
- **Relay output**: Deactivated
- **Alarm icon**: On (normal)

**Alarm display reset while normal**

- **Process**: Abnormal or normal
- **Sequence**: Acknowledged
- **Display**: On
- **Relay output**: Deactivated
- **Alarm icon**: On (red)

**To abnormal**

- **Alarm ACK**

**Sequence pattern**

- **Alarm ACK**
- **Display reset**
- **Alarm ACK**
- **Display reset**

**Alarm**

**Display**

**Relay output**

- Even if an alarm is released before the alarm ACK operation is performed, the annunciator continues to blink with the color that is displayed when an alarm has occurred.
- Even if an alarm is released before the alarm display reset operation is performed, the annunciator continues to blink with the color that is displayed when an alarm has occurred.
- Even if an alarm is released before the alarm ACK operation is performed, the alarm icon continues to blink red.
- Even if an alarm is released before the alarm display reset operation is performed, the alarm icon stays red.

**When multiple alarms have been assigned to a single annunciator window**

- If multiple alarms are occurring, the window is displayed using the color of the alarm with the highest priority.

**When two alarms have been assigned to a single relay**

Same as for ISA-A.
3.13 Managing the Input Calibration Interval (/CC1 option; release numbers 4 and later)

Manage the input calibration interval to make sure that calibration is performed regularly. For a description of the function, see section 1.1.

**Setup Screen**

Press **MENU** (to switch to setting mode), hold down **FUNC** for 3 s (to switch to basic setting mode), and select the **Menu** tab > **Set Calibration**.

**Setup Items**

- **Set Calibration > Use/Not**
  Select whether to **Use** or **Not** use calibration management. When you select **Use**, the Set Calibration tab appears in setting mode.

- **Set Calibration > Notification (DayBfr)**
  You can specify how many days before the calibration due date you want to display the calibration notification screen. You can set the number of days to a value between 1 and 10.

- **Set Calibration > Renotification**
  You can specify the period at which to display the calibration notification screen. The calibration notification screen will continue to appear until calibration is completed.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>10min</td>
<td>The screen will appear every 10 minutes.</td>
</tr>
<tr>
<td>30min</td>
<td>The screen will appear every 30 minutes.</td>
</tr>
<tr>
<td>1h</td>
<td>The screen will appear every hour.</td>
</tr>
<tr>
<td>8h</td>
<td>The screen will appear every 8 hours.</td>
</tr>
<tr>
<td>24h</td>
<td>The screen will appear every 24 hours.</td>
</tr>
</tbody>
</table>
### 3.13 Managing the Input Calibration Interval (/CC1 option; release numbers 4 and later)

#### Procedure

- **Viewing the Calibration Notification Screen**

  ![calibration_notification_screen](image)

  The calibration notification screen only appears over operation screens. It will continue to appear until you perform calibration (Finish Calibration). You can close the calibration notification screen by pressing **ESC** or **DISP/ENTER**.

  **Operation Example**

  When Notification is set to 1 (DayBfr) and Renotification is set to 8h

  ![operation_example_diagram](image)

  **Note**

  - The calibration notification screen will close if you change screens while it is displayed.
  - If the calibration due date passes before you complete calibration, that information will be recorded in the login log (the operation log on DXs with the /AS1 option).
3.13 Managing the Input Calibration Interval (/CC1 option; release numbers 4 and later)

- Checking the Calibration Due Date
  Carry out the procedure below to show the display.
  Press MENU (to switch to setting mode) > Set Calibration tab
  ![](image1.png)
  The date on which the last calibration was completed
  Displayed according to the date format (see section 2.4)
  Due date for next calibration
  Displayed according to the date format (see section 2.4)

- Configuring Calibration
  Carry out the procedure below to show the display.
  Press MENU (to switch to setting mode) > Set Calibration tab > Calibration Correction
  ![](image2.png)
  The setup items are the same as in section 3.9, “Performing Calibration Correction.”
  For the setting procedure, see section 3.9.
3.13 Managing the Input Calibration Interval (/CC1 option; release numbers 4 and later)

- **Finishing Calibration**
  Set the next calibration due date.

1. Carry out the procedure below to show the display.
   - Press **MENU** (to switch to setting mode) > **Set Calibration** tab > **Finish Calibration**
   A window for setting the calibration due date appears.

2. Set the next calibration due date, and press **DISP/ENTER**.

<table>
<thead>
<tr>
<th>Soft Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input</td>
<td>Enter the date directly.</td>
</tr>
<tr>
<td>+1 Week</td>
<td>Set the date by adding weeks to the current calibration due date.</td>
</tr>
<tr>
<td>-1 Week</td>
<td>Set the date by subtracting weeks from the current calibration due date.</td>
</tr>
<tr>
<td>+1 Month</td>
<td>Set the date by adding months to the current calibration due date.</td>
</tr>
<tr>
<td>-1 Month</td>
<td>Set the date by subtracting months from the current calibration due date.</td>
</tr>
</tbody>
</table>

3. Use the arrow keys to select **Execute**, and press **DISP/ENTER**. Calibration is complete.

**Note**

- You cannot set the calibration due date to a date before the current day.
- Whenever you complete calibration, a log is added to the login log (the operation log on DXs with the /AS1 option).
4.1 Operations in Operation Mode

Switching the Screen with the DISP/ENTER Key and Arrow Keys

Press DISP/ENTER and arrow keys to show the display selection menu and sub menu to switch the display. The flow of operation is indicated below.

About tag display
Long tags may not fit into their display areas. When this is the case, they are displayed as follows:
- After the screen is displayed, the tag automatically scrolls through the display area once.
- Press ESC to scroll the tag through the display area again.
4.1 Operations in Operation Mode

Operations Using Other Keys

- Soft keys (see below)
- Favorite key (see section 5.15)
- FUNC key (see below)
- USER key (see section 7.1)
- START and STOP keys (see section 6.4)

Operation Using the FUNC Key

Press **FUNC** to display the FUNC key menu at the bottom of the screen. Press the **Next** soft key to switch the menu. Press the desired soft key.

**FUNC key menu**
(Select using the soft keys)
### 4.1 Operations in Operation Mode

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Refer to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm ACK</td>
<td>Section 3.8</td>
</tr>
<tr>
<td>Alarm DispRST</td>
<td>Section 3.12</td>
</tr>
<tr>
<td>Message</td>
<td>Section 5.4</td>
</tr>
<tr>
<td>Free message</td>
<td>Section 5.4</td>
</tr>
<tr>
<td>Media eject</td>
<td>Sections 6.4 and 2.12</td>
</tr>
<tr>
<td>Snap shot</td>
<td>Section 6.6</td>
</tr>
<tr>
<td>Manual sample</td>
<td>Section 6.5</td>
</tr>
<tr>
<td>Trigger</td>
<td>Section 6.4</td>
</tr>
<tr>
<td>Save display</td>
<td>Section 6.4</td>
</tr>
<tr>
<td>Save event</td>
<td>Section 6.4</td>
</tr>
<tr>
<td>Save stop</td>
<td>Section 4.8</td>
</tr>
<tr>
<td>Math start/stop</td>
<td>Section 9.4</td>
</tr>
<tr>
<td>Math reset</td>
<td>Section 9.4</td>
</tr>
<tr>
<td>Math ACK</td>
<td>Section 9.4</td>
</tr>
<tr>
<td>Edge Switch</td>
<td>Section 7.1</td>
</tr>
<tr>
<td>Timer reset</td>
<td>Section 7.1</td>
</tr>
<tr>
<td>Match T Reset</td>
<td>Section 7.1</td>
</tr>
<tr>
<td>Keylock</td>
<td>Section 8.1</td>
</tr>
<tr>
<td>Logout</td>
<td>Section 8.3</td>
</tr>
<tr>
<td>Locked ACK</td>
<td>IM04L41B01-05EN</td>
</tr>
<tr>
<td>Password change</td>
<td>Section 8.3</td>
</tr>
<tr>
<td>Normal speed/Second speed</td>
<td>Section 5.3</td>
</tr>
<tr>
<td>Batch</td>
<td>Section 6.3</td>
</tr>
<tr>
<td>Text field</td>
<td>Section 6.3</td>
</tr>
<tr>
<td>Builder</td>
<td>IM04L41B01-04</td>
</tr>
<tr>
<td>Favorite regist</td>
<td>Section 5.15</td>
</tr>
<tr>
<td>Standard display</td>
<td>Section 5.14</td>
</tr>
<tr>
<td>System info</td>
<td>Section 2.5</td>
</tr>
<tr>
<td>Network info</td>
<td>Section 2.5</td>
</tr>
<tr>
<td>SNTP</td>
<td>IM04L41B01-17E</td>
</tr>
<tr>
<td>E-Mail start/stop</td>
<td>IM04L41B01-17E</td>
</tr>
<tr>
<td>E-Mail test</td>
<td>IM04L41B01-17E</td>
</tr>
<tr>
<td>FTP test</td>
<td>IM04L41B01-17E</td>
</tr>
</tbody>
</table>

### Customizing the Menus

The display selection menu that appears when the DISP/ENTER key is pressed and the FUNC key menu that appears when the FUNC key is pressed can be changed. See section 5.17.
4.2 Displaying the Measured Data as Waveforms, Values, or Bar Graphs

This section explains how to use the trend, digital, and bar graph displays. For a description of the function, see section 1.3.

**Procedure**

- **Showing the Display**
  1. Press **DISP/ENTER** to show the display selection menu.
  2. Press the **arrow keys** to select **TREND**, **DIGITAL**, or **BAR**, and press **DISP/ENTER**.
     The selected display appears.

- **Changing the Display Contents**
  1. Press **DISP/ENTER** to show the display selection menu.
  2. Press the **right arrow key** to display the sub menu.
  3. Press the **up and down arrow keys** to select the sub menu item.

**Trend display sub menu**

- **Group name**: Displays the group
- **ALL CHANNEL**: Displays the waveforms of all channels
- **GROUP CHANNEL**: Displays the waveforms of the channels registered to groups
- **AUTO ZONE ON**: Displays trend waveforms separately by assigning each channel in the group to separate display areas (zones)
- **AUTO ZONE OFF**: Does not display waveforms in zones
- **SCALE ON**: Displays the scale
- **SCALE OFF**: Clears the scale
- **FINE GRID ON**: Displays the fine grid
- **FINE GRID OFF**: Clears the fine grid
- **TAG DETAIL ON**: When a tag does not fit into the typical tag display space, the alarm and measured values are covered so that the tag can be displayed completely.
  Priority is not given to tag display.
- **TAG DETAIL OFF**: Clear the numeric display section
- **DIGITAL OFF**: Clears the numeric display section
- **DIGITAL ON**: Displays the numeric display section
- **MESSAGE DISP1**: Displays the messages using display method 1
- **MESSAGE DISP2**: Displays the messages using display method 2
- **TREND SPACE ON**: Inserts a space at the right edge (horizontal display) or the top edge (vertical display) in the waveform display section.
  (Not displayed with the default settings. To display, see section 5.17.)
- **TREND SPACE OFF**: Does not insert a space.
- **AUTO SCROLL ON**: Automatically switches the displayed groups
- **AUTO SCROLL OFF**: Does not automatically switch the displayed groups
4.2 Displaying the Measured Data as Waveforms, Values, or Bar Graphs

Digital display sub menu

Group name: Displays the group

TAG DETAIL ON: When a tag does not fit into the typical tag display space, the alarm and measured values are covered so that the tag can be displayed completely.

TAG DETAIL OFF: Priority is not given to tag display.

AUTO SCROLL ON: Automatically switches the displayed groups

AUTO SCROLL OFF: Does not automatically switch the displayed groups

Bar graph display submenu

Group name: Displays the group

TAG DETAIL ON: When a tag does not fit into the typical tag display space, the alarm and measured values are covered so that the tag can be displayed completely.

TAG DETAIL OFF: Priority is not given to tag display.

AUTO SCROLL ON: Automatically switches the displayed groups

AUTO SCROLL OFF: Does not automatically switch the displayed groups

4. Press DISP/ENTER to change the displayed contents.
   To close the menu without changing the displayed contents, press the ESC key.

- Starting the Waveform Display of the Trend Display/Stopping the Waveform Updating
  Press START to start the waveform display of the trend display. Press STOP to stop the waveform updating.

- Writing Messages
  See section 5.4.

- Switching the Displayed Group Using Arrow Keys
  Press the right arrow key to switch the displayed group in ascending order. Press the left arrow key to switch the displayed group in reverse.

- Switching the Trend, Digital, and Bar Graph Displays Using the Arrow Keys
  Press the down arrow key while showing the trend, digital, or bar graph display to switch the display in the order trend, digital, bar graph, trend, and so on. Press the up arrow key to switch the display in reverse order.
4.2 Displaying the Measured Data as Waveforms, Values, or Bar Graphs

**Explanation**

- **ALL CHANNEL/GROUP CHANNEL on the Trend Display**
  On the group display, the channels that are assigned to the group are displayed. In all channel display, the waveforms of all channels that are configured to record data are displayed on the current group display. The waveforms of channels that are not assigned to the group are displayed in the waveform display area, but the scales, current value marks, and digital values of the channels are not displayed.

- **SCALE ON/OFF and DIGITAL ON/OFF on the Trend Display**
  Select whether to show or hide the scale and numeric display sections.

- **AUTO SCROLL ON/OFF**
  The displayed groups can be automatically switched at a specified interval by selecting AUTO SCROLL ON. The display switches in ascending group order. For the procedure to set the auto scroll interval of groups, see section 5.13.

- **MESSAGE DISP 1 and MESSAGE DISP 2 on the Trend Display**
  Switches the message display method.

- **AUTO ZONE (Release number 3 or later)**
  Displays trend waveforms separately by evenly dividing display areas (zones) among a group’s channels.

- **FINE GRID (Release number 3 or later)**
  Display the fine grid when the normal grid is too wide for reading measured values. The fine grid can be used in the trend and historical trend displays. The fine grid places an additional four lines between the normal grid lines.
4.2 Displaying the Measured Data as Waveforms, Values, or Bar Graphs

- **TAG DETAIL ON/OFF (Release number 3 or later)**
  When TAG DETAIL is set to ON and a tag does not fit into the typical tag display space, it covers the alarm and measured values so that it can be displayed completely. Depending on display space limitations, it may not be possible to display the entire tag. If the tag comment and number do not fit within a display area, they can be scrolled. The TAG DETAIL setting made in one display affects the settings in all of the other displays.

  The figure below shows an example for when six channels are being displayed.

- **When the Tag Number Is Not Displayed**
  If TAG DETAIL is on, the tag comment is displayed as much as possible.

  **With TAG DETAIL OFF**

  **With TAG DETAIL ON**

  ![Example Display with and without TAG DETAIL](image-url)
4.2 Displaying the Measured Data as Waveforms, Values, or Bar Graphs

When the Tag Number Is Displayed
When TAG DETAIL is set to off, display priority is given to the tag number. If TAG DETAIL is on, the tag number and comment are displayed as much as possible.

With TAG DETAIL OFF

With TAG DETAIL ON

In the above digital value display example, because there is enough space for the tags, the display does not change whether TAG DETAIL is on or off.

In the above bar graph display example, because space is limited, the display does not change whether TAG DETAIL is on or off.

• TREND SPACE ON/OFF

With TREND SPACE ON
4.3 Displaying Past Measured Data (Historical Trend Display)

There are five methods to display the past measured data.
For a description of the function, see section 1.3.
Recall from the display selection menu (see this section).
Display from the alarm summary (see section 4.6).
Display from the message summary (see section 4.7).
Display from the memory summary (see section 4.8).
Show the measured data stored on an external storage medium (see section 6.8).

Procedure

- **Showing the Display**
  Carry out the procedure below while memory sampling is in progress.
  1. Press **DISP/ENTER** to show the display selection menu.
  2. Press the **arrow keys** to select **TREND HISTORY**, and press **DISP/ENTER**.
     The display appears.

- **Changing the Display Contents**
  1. Press **DISP/ENTER** to show the display selection menu.
  2. Press the **right arrow key** to display the sub menu.
  3. Press the **up and down arrow keys** to select the sub menu item.

Historical trend display sub menu

- **Group name**
  Displays the group

- **GROUP CHANNEL**
  Displays the waveforms of the channels registered to groups

- **AUTO ZONE ON**
  Displays trend waveforms separately by assigning each channel in the group to separate display areas (zones)

- **AUTO ZONE OFF**
  Does not display waveforms in zones

- **SCALE ON**
  Displays the scale

- **SCALE OFF**
  Clears the scale

- **FINE GRID ON**
  Displays the fine grid

- **FINE GRID OFF**
  Clears the fine grid

- **TAG DETAIL ON**
  When a tag does not fit into the typical tag display space, the alarm and measured values are covered so that the tag can be displayed completely.

- **TAG DETAIL OFF**
  Priority is not given to tag display.

- **MESSAGE DISP2**
  Displays the messages using display method 2

- **MESSAGE DISP1**
  Displays the messages using display method 1

- **CURSOR VALUE**
  With display data, shows the maximum data value at the cursor position. With event data, shows the data at the cursor position.

- **DIGITAL MAX/MIN**
  Displays the maximum and minimum values at the cursor position and the maximum and minimum values within the displayed data in the digital value display area

- **CURSOR TIME ON**
  Shows the time at the cursor position in the top right of the display

- **CURSOR TIME OFF**
  Displays the date/time of the data at the right edge of the screen

- **RELATIVE TIME**
  Displays the time that has elapsed since memory start

- **ABSOLUTE TIME**
  Displays the time when data was recorded
4.3 Displaying Past Measured Data (Historical Trend Display)

**Historical trend display sub menu**

- Switches to the specified display
- Returns to the display that was shown before the historical trend

Displays the alarm summary in the loaded data file
Displays the message summary contained in the loaded data file
Displays information about the loaded data file

Displays the trend waveform and scale markers of the selected channel in front of all the others. (List items like “ABC-1” are tags.)

Adjusts the display span of the selected channel. Select OFF to return to the original span. (List items like “ABC-1” are tags.)

Expands or reduces the time axis
4.3 Displaying Past Measured Data (Historical Trend Display)

Sub menu when the alarm summary is being displayed

INFORMATION: Shows information about the measured data that is currently displayed

For an explanation of the other menu items, see section 4.6.

Sub menu when the message summary is being displayed

INFORMATION: Shows information about the measured data that is currently displayed

For an explanation of the other menu items, see section 4.7.

4. Press DISP/ENTER to change the displayed contents.
To close the menu without changing the displayed contents, press the ESC key.
### 4.3 Displaying Past Measured Data (Historical Trend Display)

- **Moving the Cursor and Scrolling the Waveform**
  - Use the left and right arrow keys on the horizontal trend display.

- **Displaying the Continuing Data**
  - Approximately one screen of data is shown on the historical trend display. The continuing data can be shown as follows:
    - Move the cursor to the end of the waveform and continue to press the arrow key to shift a half a page and display the continuing data (release number 3 or later).
    - Use the left and right arrow keys on the horizontal trend display.

- **Specifying the Display Range**
  - Specify the display range. Items inside the parentheses are for the horizontal trend display.
    - When you clear the scale (see page 4-9), the screen switching icons appear in its place.
  1. Press the **right (up) arrow key**.
     - The waveform of the entire data range is displayed at the right (top) section of the screen.
  2. Press the **up and down (left and right) arrow keys** to set the display position by moving the frame that indicates the display range. If you hold down one of the arrow keys, the frame that indicates the display range will move continuously in the direction of the arrow that you hold down.
  3. Press the **left (down) arrow key**.
     - The specified range is displayed.
## 4.3 Displaying Past Measured Data (Historical Trend Display)

- **If the Data Does Not Fit in the All Data Display (Release Number 2 or Later)**
  
  Specify the range to be displayed in the all data display. Below is the procedure to display data that is older than the data displayed currently. Items inside the parentheses are for the horizontal trend display.

1. **Press the right (up) arrow key.**
   
   The waveform of all the data in the display memory is displayed at the right (top) of the screen. At the same time, the data area in the internal memory that can be loaded is displayed. In addition, the data position of 8 MB that is displayed in the all data display is indicated using a rectangular frame in the loadable data area.

2. **Press the down (left) arrow key** to move the frame indicating the display range to the edge of the all data display. If you press the down (left) arrow key again, the message "Overwrite old data?" appears.

3. **Select Yes and press DISP/ENTER** to replace 4 MB of data in the display memory.

4. **Press the up/down (left/right) arrow key** to move the frame indicating the display range to specify the range you want to display.

5. **Press the left (down) arrow key.**
   
   The specified range is displayed.

- **Dividing the Screen into Halves and Displaying the Current Trend and Historical Trend Simultaneously**
  
  This operation is possible only when the historical trend of the display data is being displayed. Items inside the parentheses are for the horizontal trend display.

* This operation is not possible when the scale is displayed.

Press the **left (down) arrow key.**

The current trend is displayed in the top half (right half), and the historical trend is displayed in the bottom half (left half) of the screen.

To revert to the original screen, press the **right (up) arrow key.**

- **Writing Add Messages**
  
  For the operating procedure, see section 5.4.
4.3 Displaying Past Measured Data (Historical Trend Display)

- Displaying Measured Data from the Specified Date and Time (Release number 3 or later)
  You can search for measured data from the specified date and time and display the results. You can search the display data or event data in the DX internal memory.

  1. Press DISP/ENTER to show the display selection menu.
  2. Select DATA SEARCH using the arrow keys, and then press DISP/ENTER.
     A calendar appears for the month of the data at the cursor position.

  3. Use the arrow keys and the soft keys to change the date, and then press DISP/ENTER.
     If there is display data and event data at that date, a data type selection window appears.

     Searchable Range
     You can search for data between the year 2000 and the year 2079.

     Appearance of “D” and “E”
     “D” appears when there is display data for the specified day and the DX is configured to record display data (see section 6.1 for details).
     “E” appears when there is event data for the specified day and the DX is configured to record event data (see section 6.1 for details).
4.3 Displaying Past Measured Data (Historical Trend Display)

4. Select Display or Event, and press DISP/ENTER.
   A search time input window appears.

5. Enter the time you want to search for, and press DISP/ENTER.
   If there is data for the time that you specify, the data appears in the historical trend display.

Display Example

Display Conditions
- The cursor is located at the time that you specify for the search.
- All other display conditions are the same as those of the display before the search.
- If there is no data at the date and time that you specify, data from a later time in the same day is displayed. If there is no such data, an error message appears.
- If the display group that was being displayed before the search does not exist in the data that you have specified, the display group in the data with the lowest number is displayed.
4.3 Displaying Past Measured Data (Historical Trend Display)

- You can configure the calendar so that weeks start with Sunday or Monday.

**Procedure**

Press **MENU** (to switch to setting mode), hold down **FUNC** for 3 s (to switch to basic setting mode), and select the **Menu** tab > **Time Settings** > **Calendar display**

- **1st weekday**

You can set the first weekday (the day that appears on the far left side of the calendar) to SUN (Sunday) or MON (Monday).

- **Signature (Only on DXs with the /AS1 advanced security option)**

  See the Advanced Security Function (/AS1) User's Manual, IM 04L41B01-05EN.
4.3 Displaying Past Measured Data (Historical Trend Display)

**Explanation**

- **ALL CHANNEL/GROUP CHANNEL**
  In the group display, the waveforms of the channels that are registered to the group are displayed. In the all channel display, the waveforms of all channels that have been set to be recorded are displayed on the current group display. The waveforms of channels that are not registered to the group are displayed, without any additional information, in the waveform display area.

- **AUTO ZONE**
  Displays trend waveforms separately by assigning display areas (zones) to the set channels.
  - With AUTO ZONE OFF
  - With AUTO ZONE ON

- **SCALE ON/OFF**
  Select whether to display the scale. The current value mark of the scale indicates the value at the cursor position.
  - With SCALE ON
  - With SCALE OFF

![Waveform displays](image-url)
4.3 Displaying Past Measured Data (Historical Trend Display)

- **FINE GRID**
  
  - With FINE GRID OFF
  
  - With FINE GRID ON

- **TAG DETAIL**
  
  When TAG DETAIL is set to ON and a tag does not fit into the typical tag display space, it covers the alarm and measured values so that it can be displayed completely. If the tag comment and number do not fit within a display area, they can be scrolled. The TAG DETAIL setting made in one display affects the settings in all of the other displays.
  
  The figure below shows an example for when six channels are being displayed.

  **When the Tag Number Is Not Displayed**
  
  If TAG DETAIL is on, the tag comment is displayed as much as possible.

  **When the Tag Number Is Displayed**
  
  When TAG DETAIL is set to off, display priority is given to the tag number. If TAG DETAIL is on, the tag number and comment are displayed as much as possible.
4.3 Displaying Past Measured Data (Historical Trend Display)

- **MESSAGE DISP 1, MESSAGE DISP 2**
  Switch between message displays.

- **CURSOR VALUE/DIGITAL MAX/MIN**
  Switch between numeric displays.
  
  **With DIGITAL MAX/MIN**
  The maximum and minimum measured values at the cursor position.
  The maximum and minimum waveform values in the current display.

  **With CURSOR VALUE**
  Display data: Shows the maximum value at the cursor position.
  Event data: Shows the measured value at the cursor position.

- **CURSOR TIME**
  With CURSOR TIME ON
  
  The time at the cursor position.

- **ABSOLUTE TIME/RELATIVE TIME**
  With ABSOLUTE TIME
  The time when the data was recorded.

  With RELATIVE TIME
  The time that has elapsed since memory start.
4.3 Displaying Past Measured Data (Historical Trend Display)

- TOP CHANNEL (Release number 3 or later)
  The following example is for when the top channel is set to channel 3. The displayed scale marker and grid are those of the channel selected as the top channel.
  If you switch from the trend history display to another display, the top channel setting is cleared. Channels other than the top channel are displayed in their assigned order within their group. (The order set by pressing MENU and then selecting the MENU tab > Group set, Trip line).

- AUTO SPAN (Release number 3 or later)
  Before AUTO SPAN   Using AUTO SPAN for channel ABC-1

- TIME AXIS > ZOOM+ and ZOOM-
  The time axis can be expanded or reduced around the cursor position.
  - Display data: 2 times the trend display to 1/60 minimum
  - Event data: Reduction only, up to 1/60 minimum
  The minimum magnification and the factor by which the display can be expanded or reduced with one operation vary depending on the trend interval for the display data and on the sampling interval for the event data. To expand or reduce further, repeat the procedure.

With TIME AXIS ZOOM+

With TIME AXIS ZOOM-
### 4.3 Displaying Past Measured Data (Historical Trend Display)

- **INFORMATION (Information on the Displayed Measured Data)**
  
  The following information is displayed.

  ![Display Sample](image)

  **Page switch mark**
  
  Use the left and right arrow keys to switch the page.

<table>
<thead>
<tr>
<th>Display</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File name</td>
<td>Data in the internal memory is displayed as “Memory.” For a file on the</td>
</tr>
<tr>
<td></td>
<td>external storage medium, the file name is displayed.</td>
</tr>
<tr>
<td>File type</td>
<td><strong>Display</strong> corresponds to display data, and <strong>Event</strong> corresponds to</td>
</tr>
<tr>
<td></td>
<td>event data.</td>
</tr>
<tr>
<td>Serial number</td>
<td>The serial number of the DX that was used.</td>
</tr>
<tr>
<td>Batch number, Lot number</td>
<td>Displayed when the file is created using the batch function.</td>
</tr>
<tr>
<td>Start time, End time</td>
<td>The start time and end time of recording.</td>
</tr>
<tr>
<td>User name</td>
<td>Name of the user who performed the operation. Displayed when the</td>
</tr>
<tr>
<td></td>
<td>login function or /AS1 advanced security option was used.</td>
</tr>
<tr>
<td>Comment</td>
<td>A comment (when the batch function is in use).</td>
</tr>
<tr>
<td>Text field</td>
<td>A text field (when the batch function is in use).</td>
</tr>
<tr>
<td>Signature</td>
<td>Signature data (when the /AS1 advanced security option is in use).</td>
</tr>
</tbody>
</table>

**Note**

When measured data on the external storage medium is displayed, the serial number corresponds to that of the DX that was used to save the data.

- **Background Color of the Historical Trend**
  
  You can change the background color of the historical trend.

  For the procedure to change the background color of the historical trend, see section 5.13.
4.4 Display the Statuses of All Channels on One Screen (Overview Display)

This section explains how to use the overview display. For a description of the function, see section 1.3.

**Procedure**

- **Showing the Display**
  1. Press DISP/ENTER to show the display selection menu.
  2. Press the arrow keys to select OVERVIEW, and press DISP/ENTER.

- **Changing the Displayed Contents**
  1. Press DISP/ENTER to show the display selection menu.
  2. Press the right arrow key to display the sub menu.
  3. Press the up and down arrow keys to select the sub menu item.

Overview display sub menu

- **JUMP TO TREND:** Switches to the trend display of the smallest group number that includes the channel selected with the cursor.
- **JUMP TO DIGITAL:** Switches to the digital display of the smallest group number that includes the channel selected with the cursor.
- **JUMP TO BAR:** Switches to the bar graph display of the smallest group number that includes the channel selected with the cursor.
- **JUMP TO ALM SUM:** Switches to the alarm summary.
- **TAG DETAIL ON:** When a tag does not fit into the typical tag display space, the alarm and measured values are covered so that the tag can be displayed completely.
- **TAG DETAIL OFF:** Priority is not given to tag display. (Appears when Tag Number is set to Use. See section 5.2 for details.)
- **CURSOR OFF:** Clears the cursor
- **CURSOR ON:** Displays the cursor (Not displayed with the default settings. To display, see section 5.17)
- **TAG DETAIL OFF:** Priority is not given to tag display. (Appears when Tag Number is set to Use. See section 5.2 for details.)

4. Press DISP/ENTER to change the displayed contents.

To close the menu without changing the displayed contents, press the ESC key.

- **Showing the Trend, Digital, Bar Graph Display Containing the Specified Channel**

  1. Press the arrow keys to move the cursor, and select a channel.

  ![Cursor (white Frame)](image)

  2. Switch to the trend, digital, or bar graph display according to the procedure described in "Changing the Displayed Contents."
4.4 Display the Statuses of All Channels on One Screen (Overview Display)

- Individual Alarm ACK Operation (Only on DXs with the /AS1 advanced security option)
  You can perform alarm ACK on individual alarms. This operation is referred to as “individual alarm ACK.” Individual alarm ACK can be performed when the settings are configured in the exact manner described below.
  - Basic setting > Indicator is set to Hold.
    For the setting procedure, see section 3.5.
  - Relay > Relay Action on Ack is set to Reset.
    For the setting procedure, see section 3.5 in the DX2000 User’s Manual.
  - Annunciator Mode is set to Off.
    For the setting procedure, see section 3.12 in the DX2000 User’s Manual.

1. Use the arrow keys to move the cursor to a channel with active alarms.
2. Press DISP/ENTER to show the display selection menu.
3. Press the right arrow key to display the submenu.
4. Use the arrow keys to select an alarm, and press DISP/ENTER.
   The alarm output is released.

Select a channel with active alarms.
Select the alarm that you want to acknowledge.
4.4 Display the Statuses of All Channels on One Screen (Overview Display)

- **TAG DETAIL**
  The same as the TAG DETAIL setting in other displays.
  The following example is for the DX1012 OVERVIEW display.

  **When the Tag Number Is Not Displayed (the TAG DETAIL does not appear)**
  Tag comments are displayed.

  ![Diagram showing tag number and comment display]

  **When the Tag Number Is Displayed**
  When TAG DETAIL is set to off, display priority is given to the tag number. If TAG DETAIL is on, the tag number and comment are displayed as much as possible.

  ![Diagram showing tag number and comment display]

With TAG DETAIL OFF  With TAG DETAIL ON
4.5 Displaying Various Information

This section explains how to display reports (M1 and PM1 options) and how to use the status display.
For a description of the function, see section 1.3.

**Procedure**

- **Showing the Display**
  1. Press DISP/ENTER to show the display selection menu.
  2. Press the up and down arrow keys to select INFORMATION.
  3. Press the right arrow key to display the sub menu.
  4. Press the up and down arrow keys to select the sub menu item.
     To close the menu without changing the displayed contents, press the ESC key.

**Information display submenu**

- **ALARM SUMMARY:** Displays an alarm summary  
  See section 4.6.
- **MESSAGE SUMMARY:** Displays a message summary  
  See section 4.7.
- **MEMORY SUMMARY:** Displays a memory summary  
  See section 4.8.
- **MODBUS CLIENT:** Displays the Modbus client status
- **MODBUS MASTER:** Displays the Modbus master status
- **RELAY:** Displays the relay status  
  (Not displayed with the default settings. To display, see section 5.17.)
- **REPORT DATA:** Displays report data
- **COLUMN BAR:** Displays report data using stacked bar graphs
- **EVENT SWITCH:** Displays the status of the event level switches.

5. Press DISP/ENTER.
   The display appears.

- **Displaying the Report**
  - **Switching the Displayed Report Data**
    The Index item on the report display shows "the number of the report data being displayed/the number of report data saved in the internal memory." The largest report data number corresponds to the most recent report data.

*Number of the report data being displayed*  
*Number of report data saved to the internal memory*
### 4.5 Displaying Various Information

Carry out the procedure below to switch the displayed report data.

**Up arrow key:** Report data being displayed + 1.

**Down arrow key:** Report data being displayed – 1.

**Left arrow key:** Report data being displayed + 10.

**Right arrow key:** Report data being displayed – 10.

**Note**

The display is not updated even if a new report is created while displaying the report data. Perform either of the operations below to display the most recent report data.

- Hold down the left arrow key until the latest report data is displayed.
- Press DISP/ENTER and display the report data again from the display selection menu.

**Switching the Report Channels**

Up to 12 report channels can be shown on one screen. If there are more than 12 report channels, you can switch the displayed report channels.

1. Press DISP/ENTER to show the display selection menu.
2. Press the right arrow key to display the sub menu.
3. Press the up and down arrow keys to select CHANGE REPORT CH.
4. Press DISP/ENTER.

The displayed report channels are switched.

**Relay Status Display**

Lists the statuses of the alarm output relays and internal switches. You cannot change the settings on this display.

**Modbus Status Display**

Lists the statuses of the Modbus client or Modbus master commands. For the operating procedure, see the Communication Interface User’s Manual (IM04L41B01-17E).
• **Event Level Switch Status Display (Release number 3 or later)**
  Displays the status of the event level switches. You cannot perform operations in this display.

<table>
<thead>
<tr>
<th>01</th>
<th>02</th>
<th>03</th>
<th>04</th>
<th>05</th>
<th>06</th>
<th>07</th>
<th>08</th>
<th>09</th>
<th>10</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="" /></td>
<td><img src="image" alt="" /></td>
<td><img src="image" alt="" /></td>
<td><img src="image" alt="" /></td>
<td><img src="image" alt="" /></td>
<td><img src="image" alt="" /></td>
<td><img src="image" alt="" /></td>
<td><img src="image" alt="" /></td>
<td><img src="image" alt="" /></td>
<td><img src="image" alt="" /></td>
</tr>
</tbody>
</table>

Red: On  
Green: Off
4.6 Using the Alarm Summary

This section explains how to use the alarm summary. For a description of the function, see section 1.3.

**Procedure**

- **Changing the Displayed Contents**
  1. Press **DISP/ENTER** to show the display selection menu.
  2. Press the **right arrow key** to display the sub menu.
  3. Press the **up and down arrow keys** to select the sub menu item.

![Sort symbol ▲ Ascending sort ▼ Descending sort]

**TAG DETAIL ON:** When a tag does not fit into the typical tag display space, the alarm and measured values are covered so that the tag can be displayed completely. Priority is not given to tag display.

**TAG DETAIL OFF:** Switches to the specified display

**Display name:** Switches to the display data historical trend display

**TO HISTORY (DISP):** Switches to the display data historical trend display

**TO HISTORY (EV):** Switches to the event data historical trend display

**TO OVERVIEW:** Switches to the overview display

**CHANGE SORT KEY:** Sorts alarm information by channel or alarm time

**ASCENDING ORDER:** Sorts in ascending order

**DESCENDING ORDER:** Sorts in descending order

4. Press **DISP/ENTER** to change the displayed contents.

To close the menu without changing the displayed contents, press the **ESC** key.

- **Moving the Cursor (▸) and Scrolling the Alarms**
  
  ![Moves the cursor up](up_icon)

  Scrolls the alarm information up by half a page

  ![Moves the cursor down](down_icon)

  Scrolls the alarm information down by half a page

- **Recalling the Historical Trend Display at the Point When the Alarm Occurred**
  1. Select an alarm with the cursor.
  2. Display the historical trend according to the procedure described in “Changing the Displayed Contents.”

**Explanation**

- **CHANGE SORT KEY, ASCENDING ORDER, and DESCENDING ORDER**
  The alarms are sorted in ascending or descending order by the following keys. The sort symbol is displayed next the sort item (see the figure above).
  
  - **Channel number:** Sorts the alarms by channel number even if tags are being used. Alarms in a channel are sorted by the alarm level number.
  - **Time of alarm occurrence/release**
4.6 Using the Alarm Summary

- **TAG DETAIL**
  The same as the TAG DETAIL setting in other displays.

**When the Tag Number Is Not Displayed**
When TAG DETAIL is on, tag comments are displayed in their entirety.

<table>
<thead>
<tr>
<th>With TAG DETAIL OFF</th>
<th>With TAG DETAIL ON</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tag comment</td>
<td>Tag comment</td>
</tr>
</tbody>
</table>

**When the Tag Number Is Displayed**
Tag numbers and comments are displayed.

---

IM 04L41B01-01E 4-29
4.7 Using the Message Summary

This section explains how to use the message summary.
For a description of the function, see section 1.3.

**Procedure**

- **Changing the Displayed Contents**
  1. Press DISP/ENTER to show the display selection menu.
  2. Press the right arrow key to display the sub menu.
  3. Press the up and down arrow keys to select the sub menu item.

  ![Display Selection Menu](image)

  - **Sort symbol**
    - Ascending sort
    - Descending sort
  - **Display name:** Switches to the specified display
  - **TO HISTORY (DISP):** Switches to the display data historical trend display
  - **TO HISTORY (EV):** Switches to the event data historical trend display
  - **DISP GROUP OFF:** Displays the second of the time when the messages were written
  - **DISP GROUP ON:** Displays the groups to which the messages were written
  - **CHANGE SORT KEY:** Sorts messages by message number, time, group, or user name
  - **ASCENDING ORDER:** Sorts in ascending order
  - **DESCENDING ORDER:** Sorts in descending order
  - **CHANGE DISP ITEM:** Switches between displaying message times and groups and displaying the message user names

  4. Press DISP/ENTER to change the displayed contents.
  To close the menu without changing the displayed contents, press the ESC key.

- **Moving the Cursor (↑) and Scrolling the Messages**

  ![Cursor Control](image)

  - Scrolls the messages up by half a page
  - Moves the cursor up
  - Scrolls the messages down by half a page
  - Moves the cursor down

- **Recalling the Historical Trend Display at the Point When the Message Was Written**
  1. Select a message with the cursor.
  2. Display the historical trend according to the procedure described in "Changing the Displayed Contents."
• **CHANGE DISP ITEM**
  Switches between the following two message display methods.
  • Message, time, and group, or the second of the date and time when the message was written
  • Message, user name

• **CHANGE SORT KEY, ASCENDING ORDER, and DESCENDING ORDER**
  The messages are sorted in ascending or descending order by the respective key. The sort symbol is displayed next the sort item (see the figure above).

• **DISP GROUP OFF/ON**
  You can select what is displayed on the right of the screen: the groups that the messages were written to or the second of the time when the messages were written.
4.8 Using the Memory Summary

This section explains how to use the memory summary. For a description of the function, see section 1.3.

Procedure

- **Changing the Displayed Contents**
  1. Press **DISP/ENTER** to show the display selection menu.
  2. Press the **right arrow key** to display the sub menu.
  3. Press the **up and down arrow keys** to select the sub menu item.

  ![Image of display selection menu]

  The displayed data type is indicated with a green mark.

  - **Display name:** Switches to the specified display
  - **TO HISTORY:** Switches to the historical trend display
  - **DATA SAVE MODE:** Switches to data save mode
  - **SELECT SAVE:** Saves the selected file
  - **M.SAMPLE SAVE:** Saves all manually sampled data.
    (Not displayed with the default settings. To display, see section 5.17.)
  - **REPORT SAVE:** Saves report data
  - **ALL SAVE:** Saves all data
  - **CHANGE DATA KIND:** Switches between display data and event data
  - **FILENAME DISPLAY:** Displays the file name
    For information about file names, see section 1.4.
  - **TIME DISPLAY:** Displays the times of the first and last items of data in the file

  4. Press **DISP/ENTER** to change the displayed contents.
     To close the menu without changing the displayed contents, press the **ESC** key.

- **Moving the Cursor (↑) and Scrolling the Memory Information**
  - Scrolls the memory information up by half a page
  - Moves the cursor up
  - Moves the cursor down
  - Scrolls the memory information down by half a page

- **Displaying the Historical Trend for the Data Specified by Memory Summary**
  1. Select the data with the cursor.
  2. Display the historical trend according to the procedure described in “Changing the Displayed Contents.”
### Saving the Data

Save the data in the internal memory to the CF card or the USB flash memory (/USB1 option).

For a description of the function, see section 1.4.

1. Press **DISP/ENTER** to show the display selection menu.
2. Press the **right arrow** key to display the submenu.
3. Select **DATA SAVE MODE** with the up and down arrow keys.
4. Press **DISP/ENTER**.

   The display switches to **DATA SAVE MODE**.

5. To save a specified file, select it with the cursor. This operation is not necessary in other cases.

   ![Cursor (move with the arrow keys)](image)

6. Press **DISP/ENTER** to show the display selection menu.

   ![Display Selection Menu](image)

7. Use the **up and down arrow keys** to select **SELECT SAVE**, **ALL SAVE**, **M. SAMPLE SAVE**, or **REPORT SAVE**.

8. Press **DISP/ENTER**.

   * If you are using a CF card and a USB flash memory (/USB1 option), the message “Which media do you want to save to?” appears. Select the destination medium using the **arrow keys**, and press **DISP/ENTER**.

   The measured data is saved.

---

**Note**

To abort the data saving operation in progress, carry out the procedure below.

Press **FUNC** and press the **Save Stop** soft key.
Progress Display When Saving All Data of the Internal Memory (Release Number 2 or Later)

If you carry out All Save* on the memory summary screen, a pop-up window appears showing the progress of the save operation.

* Function for saving all data in the internal memory to a CF card or USB flash memory.

Note

- The pop-up window appears only when the memory summary display is showing.
- If you press the ESC key, the pop-up window clears temporarily and reappears approximately 10 seconds later.
- The time estimate for saving all data is indicated in the table below (when the memory is full of data). It may take longer depending on the operating conditions of the DX.

<table>
<thead>
<tr>
<th>Save Destination</th>
<th>Time to Save All Data (Estimate)</th>
</tr>
</thead>
<tbody>
<tr>
<td>CF Card</td>
<td>Standard memory (internal memory size suffix code -3) 20 minutes</td>
</tr>
</tbody>
</table>

- To abort the data saving operation in progress, carry out the procedure below.
  Press FUNC and press the Save Stop soft key.

- Displaying File Information (Only on DXs with the /AS1 advanced security option)

  See the Advanced Security Function (/AS1) User's Manual, IM 04L41B01-05EN.

  Explanation

- Save directory
  - The data is saved by creating a directory each time the save operation is carried out.
  - Directory name: Specified string_YYMMDD_HHMMSS (where YY to SS is the date of operation)

- Display data or event data that is in the process of adding data cannot be saved.
- The save operation explained here merely copies the data in the internal memory. It does not save the unsaved data in the internal memory (see section 1.4).
- Data saving is aborted when there is insufficient free space on the storage medium. Use a storage medium with sufficient free space when saving data.
### 4.9 Displaying a List of Operation Logs

Displays the following operation logs.
Login log*, error log, communication log, FTP log, Web log, e-mail log, SNTP log, DHCP log, Modbus status log, operation log**, and change settings log**

* Only on DXs without the /AS1 advanced security option
** Only on DXs with the /AS1 advanced security option

#### Procedure

- **Displaying the Log**
  1. Press **DISP/ENTER** to show the display selection menu.
  2. Press the up and down arrow keys to select **LOG**.
      - To show **LOG** on the menu, see section 5.17.
  3. Press the right arrow key to display the sub menu.
  4. Press the up and down arrow keys to select the sub menu item.
      - To close the menu without changing the displayed contents, press the **ESC** key.
      - Sub menu items are **LOGIN**, **ERROR**, **COMMUNICATION**, **FTP**, **MAIL**, **WEB**, **SNTP**, **DHCP**, and **MODBUS**.
  5. Press **DISP/ENTER**.
     - The display appears.

#### Explanation

- **Login Log**
This log is only for DXs without the /AS1 advanced security option. DXs with the /AS1 advanced security option use the operation log.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Login</td>
<td>Login</td>
</tr>
<tr>
<td>Logout</td>
<td>Logout</td>
</tr>
<tr>
<td>NewTime</td>
<td>Time change while memory is stopped</td>
</tr>
<tr>
<td>TimeChg</td>
<td>Time change through key operation</td>
</tr>
<tr>
<td>PowerOff</td>
<td>Power OFF (power failure occurred)</td>
</tr>
<tr>
<td>PowerOn</td>
<td>Power ON (recovered from a power failure)</td>
</tr>
<tr>
<td>TrevStart</td>
<td>Start the operation of gradually adjusting the time</td>
</tr>
<tr>
<td>TrevEnd</td>
<td>End the operation of gradually adjusting the time</td>
</tr>
<tr>
<td>TimeDST</td>
<td>Switch the daylight savings time</td>
</tr>
<tr>
<td>SNTPtimset</td>
<td>Time change by SNTP</td>
</tr>
<tr>
<td>TimeDST</td>
<td>Switch to or out of daylight saving time</td>
</tr>
<tr>
<td>CCSetEnd</td>
<td>Completion of calibration correction</td>
</tr>
<tr>
<td>CCExpire</td>
<td>Passing of the calibration due date without calibration having been completed</td>
</tr>
</tbody>
</table>

The log number of the last line and the total number of logs

User name

Operation method (see the table below)

Operation (see the table below)

Date/time
4.9 Displaying a List of Operation Logs

<table>
<thead>
<tr>
<th>Factor</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>KEY</td>
<td>Key operation</td>
</tr>
<tr>
<td>COM</td>
<td>Operations via communication</td>
</tr>
<tr>
<td>REM</td>
<td>Operation through the remote control function</td>
</tr>
<tr>
<td>ACT</td>
<td>Operation through event action</td>
</tr>
<tr>
<td>SYS</td>
<td>Operation by the system</td>
</tr>
</tbody>
</table>

- **Error Log**

  ![Error Log Table]

  * Error message*
  * Error code*
  * Date/time

  * See section 10.1, “A List of Messages.”

- **Communication Log**

  ![Communication Log Table]

  * Message*
  * Input/output symbol (>: input, <: output)
  * User ID number (0: serial, 1 to 3: Ethernet)
  * Date/time

  * See the Communication Interface User’s Manual (IM04L41B01-17E).

- **FTP Log**

  ![FTP Log Table]

  * File Name*
  * FTP connection destination (P: primary, S: secondary)
  * Error message (detail code)*
  * Date/time

  * See section 10.1, “A List of Messages.”
### 4.9 Displaying a List of Operation Logs

#### Web Log

<table>
<thead>
<tr>
<th>Request</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Screen</td>
<td>Screen switch</td>
</tr>
<tr>
<td>Key</td>
<td>Key operation</td>
</tr>
<tr>
<td>Message</td>
<td>Message assignment/write</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TREND</td>
<td>Trend display</td>
</tr>
<tr>
<td>DIGIT</td>
<td>Digital display</td>
</tr>
<tr>
<td>BAR</td>
<td>Bar graph display</td>
</tr>
<tr>
<td>HIST</td>
<td>Historical trend display</td>
</tr>
<tr>
<td>OV</td>
<td>Overview display</td>
</tr>
<tr>
<td>DISP</td>
<td>DISP/ENTER key</td>
</tr>
<tr>
<td>UP</td>
<td>Up arrow key</td>
</tr>
<tr>
<td>DOWN</td>
<td>Down arrow key</td>
</tr>
<tr>
<td>LEFT</td>
<td>Left arrow key</td>
</tr>
<tr>
<td>RIGHT</td>
<td>Right arrow key</td>
</tr>
<tr>
<td>FAVOR</td>
<td>Favorite key</td>
</tr>
</tbody>
</table>

Messages: Character strings that have been written

Data Ref: Searches for data from a specific date and time and displays the data in the historical trend display.

---

#### E-mail Log

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm</td>
<td>Alarm mail</td>
</tr>
<tr>
<td>Time</td>
<td>Scheduled mail</td>
</tr>
<tr>
<td>Report</td>
<td>Report timeout mail</td>
</tr>
<tr>
<td>Fail</td>
<td>Power failure recovery mail</td>
</tr>
<tr>
<td>Full</td>
<td>Memory full mail</td>
</tr>
<tr>
<td>Test</td>
<td>Test mail</td>
</tr>
<tr>
<td>Error</td>
<td>Error message mail</td>
</tr>
<tr>
<td>User locked</td>
<td>Invalid user mail (only on DXs with the IAS1 advanced security option)</td>
</tr>
</tbody>
</table>

Recipient (mail address, message)
Recipient (1: recipient 1, 2: recipient 2)
Error code*
Event (see the table below)
Date/time

* See section 10.1, “A List of Messages.”
4.9 Displaying a List of Operation Logs

- **SNTP Log**

  - Error message (detail code)*
  - Error code*
  - Date/time

  * See section 10.1, “A List of Messages.”

- **DHCP Log**

  - Error message (detail code)*
  - Error code*
  - Date/time

  * See section 10.1, “A List of Messages.”

- **Modbus Status Log**

  - Command number, command type (R: read, W: write)
  - Communication status*
  - Communication type (C: client, M: master)
  - Date/time

  * See the Communication Interface User’s Manual (IM04L41B01-17E).
4.10 Displaying Stacked Bar Graphs (/M1 and /PM1 options; release number 3 or later)

- Operation Log (Only on DXs with the /AS1 advanced security option)

To switch displays, in the display selection menu, select LOG > CHANGE DISP ITEM, and press DISP/ENTER.

Detailed display

Additional information display

When you move the cursor to an item that has additional information, the Add.info. soft key appears at the bottom of the screen. Press the soft key to display the additional information. The additional information is displayed using the command syntax. See the Communication Manual, IM04L41B01-17E.

Press ESC to close the additional information display.

* See the Advanced Security Function (/AS1) User’s Manual, IM 04L41B01-05EN.

- Change Settings Log (Only on DXs with the /AS1 advanced security option)

<table>
<thead>
<tr>
<th>Operation type (see the table below)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>K</td>
<td>Key operations</td>
</tr>
<tr>
<td>C</td>
<td>Communication operations</td>
</tr>
</tbody>
</table>

Cursor (blue arrow)
Move the cursor with the arrow keys.

Operation type*
User name
Date and time
4.10 Displaying Stacked Bar Graphs (/M1 and /PM1 options; release number 3 or later)

This section explains how to use stacked bar graphs.

Procedure

- Changing the Displayed Contents
  1. Press DISP/ENTER to show the display selection menu.
  2. Press the right arrow key to display the submenu.
  3. Press the up and down arrow keys to select the sub menu item.

- Changing Groups, Selecting Bar Graphs, and Moving the Cursor
  The amount of data that the up and down arrow keys scroll through depends on the type of report data. For example, with an “H+D” report, you can use the arrows to scroll through the data one day at a time.

  - SELECT GROUP: Switches to the display for the report group with the next smallest number
  - SELECT COLUMN: Moves the bar graph selection cursor to the left
    Switches to the previous day, week, or month's data
  - SELECT GROUP: Switches to the display for the report group with the next highest number
  - SELECT COLUMN: Moves the bar graph selection cursor to the right
    Switches to the next day, week, or month's data

  - Display name: Switches to the specified display
  - SINGLE GRAPH: Displays a single graph
  - DUAL GRAPH: Displays two graphs
  - SELECT GROUP: Use the arrow keys to switch between displayed report groups.
  - SELECT COLUMN: Use the arrow keys to select a bar graph.
  - REPORT GROUP 1 through 6*: Select the report group that you want to display.
    * Varies according to the model. For information about report channels, see section 10.5.

  4. Press DISP/ENTER to change the display setting.
     To close the menu without changing the display contents, press ESC.
• **SINGLE GRAPH/DUAL GRAPH**

You can display one or two bar graphs. The sums of the first channel in a group and of all other channels that have the same unit as it are displayed.

• **SINGLE GRAPH**

![Display area 1 and Display area 2]

The report data displayed in display areas 1 and 2 varies depending on the report data type.

<table>
<thead>
<tr>
<th>Report Data Type</th>
<th>Display Area 1</th>
<th>Display Area 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hourly, H+D</td>
<td>Sums for each hour</td>
<td>Sums for the day</td>
</tr>
<tr>
<td>Day+Week</td>
<td>Sums for each day</td>
<td>Sums for the week</td>
</tr>
<tr>
<td>Daily, D+M</td>
<td>Sums for each day</td>
<td>Sums for the month</td>
</tr>
</tbody>
</table>

**Note**

In 4-panel display, the numeric display section only contains channel numbers or tags.

• **DUAL GRAPH**

Shows the data from two consecutive periods at the top and bottom of the display.

![Display area 1, Display area 2, Display area 3, Display area 4]

The report data displayed in display areas 1, 2, 3, and 4 varies depending on the report data type. Display areas 1 and 2 contain the same report data listed above for SINGLE GRAPH display.

<table>
<thead>
<tr>
<th>Report Data Type</th>
<th>Display Area 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hourly, H+D</td>
<td>The hourly and daily data of the day before the data in display area 3</td>
</tr>
<tr>
<td>Day+Week</td>
<td>The daily and weekly data of the week before the data in display area 3</td>
</tr>
<tr>
<td>Daily, D+M</td>
<td>The daily and monthly data of the month before the data in display area 3</td>
</tr>
</tbody>
</table>
4.10 Displaying Stacked Bar Graphs (/M1 and /PM1 options; release number 3 or later)

**Note**

The numbers on the vertical axis of display area 4 (the top display area) and the dates on the horizontal axis are abbreviated.

Display area 4 (the top bar graph) can only display the data from the period immediately preceding that of display area 3.

- **Selecting a Bar**
  When SINGLE GRAPH is selected, you can move the cursor to a bar that you want to check, and view the sums of each channel.

- **Power Failure and Time Adjustment Indications**
  - Indicates a power failure
    A "C" appears if more than one report has been filed for the same time period.
  - Power failure
    A "P" indicates when a power failure occurred and a report was supposed to be filed. A "P" also indicates when the DX recovered from a power failure and the next report was filed.
  - Time adjustment
    When a time adjustment causes a report to be filed twice because the time was moved back, the time adjustment is marked with a "C," and the bar graph of the report that was filed first is used.

If the data for a period does not exist because of a power failure or time adjustment, a bar graph for the period will not be displayed.
5.1 Setting Display Groups

Assign channels and set the group name for each display group. Set lines at specified positions in the waveform display range on the Trend display.

**Setup Screen**

Press MENU (to switch to setting mode), and select the Menu tab > Group set, Trip line

**Setup Items**

- **Group number**
  Select the target group number (1 to 10).

- **Group**
  - On/Off
    Turn On the groups you want to use.

- **Group name**
  Set the group name. (up to 16 characters, \[A-Z\] [a-z] [0-9])

- **CH set**
  Set up to six channels from measurement channels and computation channels (\(/M1\) and \(/PM1\) options).
  - Enter the channel number using two or three digits.
  - Separate each channel with a period.
  - To specify a range of consecutive channels numbers, use a hyphen.
    Example: To assign channels 1 and 5 to 8, enter "001.005-008."

**Note**

- The trend, digital, and bar graph displays are shown in the specified order.
- A channel can be assigned to multiple groups.
- The same channel cannot be assigned multiple times in a group.
5.1 Setting Display Groups

*Note*

The channel settings of a display group can be copied to another group on a DX with release number 2 or later.

**Procedure**

1. Select the copy source channel settings.
2. Press the *Copy* soft key.
3. Select the copy destination channel settings.
4. Press the *Paste* soft key. The channel settings are copied.

- **Trip line**
  Set lines at specified positions in the waveform display range on the Trend display.

- **On/Off**
  Turn *On* the trip lines you want to display.

- **Position**
  Set the position in the range of 0 to 100% of the display width.

- **Color**
  The default colors are red, green, blue, and yellow. If you want to change the color, select from the 24 available colors.

- **Width**
  Set the line width of the trip line in dots (1 to 3).
5.2 Displaying Tags or Channel Numbers

Display the channels using tags or channel numbers. On DX release numbers 3 and later, tags have tag numbers and tag comments. The tag number is a fixed number that corresponds to the measurement source. The tag comment can be used to list details about the channel. You can choose whether or not to use tag numbers.

**Setup Screen**

- **Tag/Channel**
  Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to the basic setting mode), and select **Environment > Operating Environment**

- **Tag Number Use/Not (Release number 3 or later)**
  Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic setting mode), and select the **Environment** tab > **Input, Alarm**

- **Tag**
  Press MENU (to switch to setting mode), and select the **Menu** tab > **Meas channel > Tag, Memory, Delay**
5.2 Displaying Tags or Channel Numbers

**Setup Items**

- **Operating environment > Tag/Channel**
  This setting applies to all channels.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tag</td>
<td>Displays tag numbers and comments.</td>
</tr>
<tr>
<td></td>
<td>• If an allotted display space is not large enough to display a tag number and a tag comment, priority is given to the tag number.</td>
</tr>
<tr>
<td></td>
<td>• Depending on display space limitations, it may not be possible to display the entire tag.</td>
</tr>
<tr>
<td></td>
<td>• If a channel is not configured to display tag numbers or comments, the channel number is displayed.</td>
</tr>
</tbody>
</table>

- **Channel**
  Displays channel numbers.

  * Tag numbers are available for release numbers 3 and later.

- **Tag Basic settings > Tag No. Use/Not (Release number 3 or later)**
  To display tag numbers, select “Use.” This setting applies to all channels.

- **First-CH, Last-CH**
  Set the target channels. The target channels are common with the other items that are displayed on the screen.

- **Tag > Comment**
  Sets the tag comment. On a DX with a release number of 3 or later, you can enter up to 32 characters. On a DX with a release number of 2 or earlier, you can enter up to 16 characters. The characters that can be entered are: A a # 1.

- **Tag > No. (Release number 3 or later)**
  This setting only appears when you have enabled the use of tag numbers. Sets the tag number. (Up to 16 characters: A a # 1)

- **Items Displayed for Different Tag and Channel Settings**
  Text is displayed depending on the tag and channel settings as shown in the figure below.

<table>
<thead>
<tr>
<th>Operating Environment</th>
<th>Tag Basic Settings</th>
<th>Tag</th>
<th>Displayed Text</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tag/Channel</td>
<td>Tag No. Use/Not</td>
<td>Tag No.</td>
<td>Tag Comment</td>
</tr>
<tr>
<td>Tag</td>
<td>Use</td>
<td>Input</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>Not input</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Input</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>Not input</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>—</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Not input</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>—</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Channel</td>
<td>Use</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td>Not input</td>
<td>—</td>
<td>—</td>
</tr>
</tbody>
</table>

  *“Yes” means that the item is displayed. “No” means that the item is not displayed.*

  *1 “Input” means that characters are input. “Not input” means that no characters are input.

  *2 Channel numbers are displayed instead of tag numbers.*
5.3 Setting the Trend Interval and Switching to the Secondary Trend Interval

Set the trend interval. Switch the trend interval to the secondary trend interval while the memory sampling is in progress. Automatically write messages when the trend interval is switched.

For a description of the function, see section 1.3.

Setup Screen

- **Switching the Trend Interval and Writing Messages (When Using the Secondary Trend Interval)**
  Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic setting mode), and select the Environment tab > View, Message.

<table>
<thead>
<tr>
<th>Basic Setting Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>View</td>
</tr>
<tr>
<td>Trend type</td>
</tr>
<tr>
<td>Partial</td>
</tr>
<tr>
<td>Trend rate switching</td>
</tr>
<tr>
<td>Message</td>
</tr>
<tr>
<td>Write group</td>
</tr>
<tr>
<td>Power-fail message</td>
</tr>
<tr>
<td>Change message</td>
</tr>
</tbody>
</table>

- **Trend interval [/div] and Secondary interval [/div]**
  Press MENU (to switch to setting mode), and select the Menu tab > Display > Trend/Save interval

<table>
<thead>
<tr>
<th>Trend / Save interval</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trend interval [/div]</td>
</tr>
<tr>
<td>Save interval</td>
</tr>
<tr>
<td>Second interval [/div]</td>
</tr>
</tbody>
</table>

**Setup Items**

- **View > Trend rate switching**
  On: Enables the function that switches the trend interval while the memory sampling is in progress. The “Second interval [/div]” item is displayed in the setting mode.
  * When the trend rate switching function is On, the DX cannot be configured to record both the display and event data (see section 6.1).

- **Message > Change message**
  On: Writes the time the interval is switched and the new trend interval as a message when the trend interval is switched.
  On DXs with the /AS1 advanced security option, a message is written even when the setting mode setup items are changed during memory sampling.

<table>
<thead>
<tr>
<th>Item</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm setting change</td>
<td>AlarmSet</td>
</tr>
<tr>
<td>Alarm delay time change</td>
<td>AimDlaySet</td>
</tr>
<tr>
<td>Calibration change</td>
<td>Calibration correction Setting</td>
</tr>
</tbody>
</table>
5.3 Setting the Trend Interval and Switching to the Secondary Trend Interval

- **Trend interval [/div] and Second interval [/div]**
  Select the time corresponding to 1 division of the time axis on the trend display from below: You cannot specify a trend interval that is faster than the scan interval.
  5s\(^{-1}\), 10s\(^{-1}\), 15s\(^{-1}\), 30s, 1min, 2min, 5min, 10min, 15min, 20min, 30min, 1h, 2h, 4h, and 10h

  *1 Selectable on the DX1002, DX1004, DX1002N, and DX1004N (release number 3 or later).
  *2 Selectable on the DX1006, DX1012, DX1006N, and DX1012N when the scan interval is set to fast sampling mode (release number 3 or later).

**Note**
If the trend interval is set greater than or equal to 1h/div on a DX with release number 2 or later, the month, day, and hour at the grid position are displayed on the screen. The display format can be changed by setting the date format.

- **Procedure**
  - **Switching the Trend Interval**
    1. In the operation mode, press **FUNC**.
       The FUNC key menu appears.
    2. Press the **Normal speed** soft key or **Second speed** soft key.
       The trend interval is switched. A message is written on the trend display (when the change message is turned ON).
       Display example: 10:53 1min/div

  - **Changing the Trend Display Time Axis While Recording (Memory sampling) Is in Progress (Release number 3 or later)**
    On a DX whose release number is 3 or later, you can change the secondary trend interval even while recording (memory sampling) is in progress. If you are using the secondary trend interval to display waveforms and you change it, the time axis will change immediately afterwards.

  **Note**
  Only the displayed time axis changes when you switch to the secondary trend interval.
5.4 Writing Messages

Write messages.

Setup Screen

- **Message Write Group**
  Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic setting mode), and select the Environment tab > View, Message.

- **Setting the Messages**
  Press MENU (to switch to setting mode), and select the Menu tab > Message.

Setup Items

- **Message**
  - **Write group**
    This setting applies only for messages that are written using keys.

<table>
<thead>
<tr>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Common</td>
<td>Write the message to all groups.</td>
</tr>
<tr>
<td>Separate</td>
<td>Write the message to the displayed group.</td>
</tr>
</tbody>
</table>

If you are using the multi batch function (BT2 option), see the DX1000/DX1000N/DX2000 Multi Batch (BT2) User’s Manual, IM04L41B01-03E.

- **Power-fail message**
  See section 5.16.

- **Change message**
  See section 5.3.
5.4 Writing Messages

- **Message No.**
  Select the message number (1 to 100). Messages 1 to 10 are common with free messages.* If a message is changed as a free message, the old message is overwritten.
  * Messages that are written by creating the message on the spot.

- **Message > Characters**
  Set the message. (up to 32 characters, Aa#1)

**Procedure**

- **Writing Messages**
  Messages cannot be written when the memory sampling is stopped.

  1. Display the group to write the message.
     - If a screen unrelated to a group such as the overview is displayed, messages are written to all groups even when **Write group** is set to **Separate**.
     - Messages are written to all groups regardless of the displayed screen when **Write group** is set to **Common**.

  2. Press **FUNC**.
     The FUNC key menu appears.

  3. Press the **Message** soft key.

  4. Press the soft key corresponding to the desired message number range (example: [1-10]).
     A list of messages is displayed.

  5. Press the soft key corresponding to the number of the message you want to write.
     A message mark, time, and message are shown on the trend display.
5.4 Writing Messages

- **Writing Free Messages**
  Create a message on the spot and write it.

  1. Display the group to write the message.
  2. Press **FUNC**.
     The FUNC key menu appears.
  3. Press the **Free message** soft key.
  4. Press a message number soft key.
     The message entry window appears.
  5. Enter the message. (up to 32 characters)
  6. Select **ENT** and press **DISP/ENTER**.
     A message mark, time, and message are shown on the trend display.

- **Writing Add Messages**
  Add messages to the past data positions. This operation can be carried out on the past section of the data that is currently being memory sampled.

  1. Carry out the procedure below to show the historical trend of the data that is currently being memory sampled.
     Press **DISP/ENTER** and select TREND HISTORY > (group name) > DISP/ENTER
  2. Press the arrow keys to move the cursor to the position you want to write the message.
  3. Write the message according to the procedure given in “Writing Messages” or “Writing Free Messages.” Use the **Add Message** or **Add Free Message** soft key.

- **Display Color of Messages**
  The message colors on the trend display are shown below. You cannot change them.

<table>
<thead>
<tr>
<th>No.</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>10</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color</td>
<td>Red</td>
<td>Green</td>
<td>Blue</td>
<td>Blue violet</td>
<td>Brown</td>
<td>Orange</td>
<td>Yellow-green</td>
<td>Light blue</td>
<td>Violet</td>
<td>Gray</td>
</tr>
</tbody>
</table>

The colors for messages 11 to 100 are repetitions of the colors above.

- **Add Message**
  - The message timestamp is the time that the message is written. It is not the time stamp of the data at the position where the message is written.

- Up to 50 messages can be written.
- Messages cannot be added to data in the internal memory that has already been saved to a file or data that has been loaded from the external storage medium.
5.5 Changing the Channel Display Colors

Change the channel display colors. The settings are applied to the trend and bar graph displays.

Setup Screen

Press MENU (to switch to setting mode), and select the Menu tab > Meas channel > Color

Setup Items

• Group of channel
  Select the target channels.

• Color
  To change the color, select from the following 24 colors.
  Red, green, blue, blue violet, brown, orange, yellow-green, light blue, violet, gray, lime, cyan, dark blue, yellow, light gray, purple, black, pink, light brown, light green, dark gray, olive, dark cyan, and spring green
5.6 Displaying Channels in Display Zones

Specify a waveform display zone for each channel so that waveforms do not overlap. For a description of the function, see section 1.3.

Setup Screen

Press MENU (to switch to setting mode), and select the Menu tab > Meas channel > Zone, Scale

Setup Items

- **First-CH, Last-CH**
  Select the target channels. The target channels are common with the other items that are displayed on the screen.

- **Zone > Lower, Zone > Upper**
  Sets the zone in which the waveform is displayed. You can set Lower and Upper as a position (%) when taking the maximum display width to be 100%. Set Upper greater than Lower, and the zone width (Upper – Lower) greater than or equal to 5%.
  Lower: 0 to 95%
  Upper: 5 to 100%
5.7 Displaying a Scale on the Trend Display

Display a scale on the trend display.
For a description of the function, see section 1.3.

**Setup Screen**

- **Scale Position and Number of Scale Divisions**
  Press **MENU** (to switch to setting mode), and select the **Menu tab > Meas channel > Zone, Scale**

  ![Scale Position and Number of Scale Divisions](image)

  - **Zone**
  - **Lower**
  - **Upper**
  - **Scale**
  - **Position**
  - **Division**

- **Number of Displayed Scale Digits and Current Value Indicator**
  Press **MENU** (to switch to setting mode), and select the **Menu tab > Display > Trend**

  ![Number of Displayed Scale Digits and Current Value Indicator](image)

- **Showing the Scales**
  To show scales on the trend display, press **DISP/ENTER** (show the display selection menu) > the **right arrow key** (show the sub menu), and select **SCALE ON** (see section 4.2).

**Setup Items**

- **First-CH, Last-CH**
  Select the target channels. The target channels are common with the other items that are displayed on the screen.

- **Scale > Position**
  Select the scale display position on the trend display from 1 to 6. Select **Off** if you do not wish to display the scale.
5.7 Displaying a Scale on the Trend Display

- **Scale > Division**
  Set the number of divisions to make with the main scale marks on the trend display to a value from 4 to 12 or C10.

  C10: The scale is equally divided into 10 sections by main scale marks, and scale values are indicated at 0, 30, 50, 70, and 100% positions on the trend display.

  The figure below is an example in which each scale is displayed with the position shifted.

  **Vertical Trend Display**

  ![Vertical Trend Display](image1.jpg)

  **Horizontal Trend Display**

  ![Horizontal Trend Display](image2.jpg)
5.7 Displaying a Scale on the Trend Display

**Note**

- If the scales of multiple channels are set to the same position, the scale of the channel assigned first to the group is displayed.
  Example: If the order of assignment of a group is **003.002.001**, and the scale display position of all channels is set to **1**, the scale of channel 3 is displayed at display position 1.
- Even if some of the scale display positions are skipped, the scale is packed towards display position 1.
  Example: Suppose the assignment of channels to a group is **001.002.003**, and the display positions of the scales are set to 1, 3, and 6, respectively. The scales are actually displayed at positions 1, 2, and 3, respectively.
- The scale is divided into 4 to 12 sections by the main scale marks. The section between the main scale marks is divided into 10 subsections by medium and small scale marks. However, small scale marks are not displayed in the following cases.
  - When the resolution of the input range is smaller than the total number of small scale marks.
  - When zone display is used.
  - When partial expanded display is used (numbers are displayed at the ends of the scale and at the boundary position).
- The scale values are displayed according to the following rules.
  - If the number of scale divisions is 4 to 7 for the vertical trend display7, values are displayed at all main scale marks. If the number of scale divisions is greater, the values are displayed at every other main scale marks.
  - Scale upper and lower limits are displayed at the ends of the scale.
  - Scale values are displayed up to 3 digits excluding the minus sign. However, if the integer part of values at the ends of the scale is both 1 digit or the integer part is zero, 2 digits are displayed.
    Example: If the scale is –0.05 to 0.50, the lower limit is “–0.0” and the upper limit is “0.5.”
  - If the integer part of either end of the scale is 2 or 3 digits, the fractional part is truncated.
    Example: If the scale is 0.1 to 100.0, the lower limit is “0” and the upper limit is “100.”
  - If the integer part of either end of the scale is 4 or more digits, the value is displayed using a 3-digit mantissa and exponent like “×10” or “×10²”.
    Example: If the scale is 10 to 2000, the lower limit is “1” and the upper limit is “200 × 10”.
  - The unit is displayed near the center of the scale. If partial expanded display is used, the display position is offset from the center. For the vertical trend display, the number of characters that can be displayed is up to six. For the horizontal trend display, the number of characters that can be displayed is up to three. However, if the scale digit display is set to Fine, up to four characters are displayed.

- **Trend > Scale > Digit**
  Fine: If the scale value is two-digit display, it can be changed to three digits. For example, if the scale range is “49.0 to 51.0,” the scale values are displayed using 3 digits as shown below.

- **Trend > Scale > Value indicator**
  The current value is displayed as a mark or a bar graph.
5.8 Displaying Alarm Point Marks and Color Scale Band on the Scale

Display alarm point marks on the scale. Display the specified range with a color band. For a description of the function, see section 1.3.

**Setup Screen**

Press **MENU** (to switch to setting mode), and select the **Menu** tab > **Meas channel** > **Alarm mark** or **Color scale band**

- **Alarm mark**

- **Color scale band**

**Setup Items**

- **First-CH, Last-CH**

Select the target channels. The target channels are common with the other items that are displayed on the screen.

- **Alarm mark**

Displays marks indicating the values of the high and low limit alarms, delay high and low limit alarms, and difference high and low limit alarms. This setting is common with the bar graph display.

- **Alarm mark > Mark kind**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
<th>Mark</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm</td>
<td>The alarm mark is green under normal conditions. It changes to the specified alarm color when an alarm occurs (release number 3 or later; see section 3.7 for details).</td>
<td></td>
</tr>
<tr>
<td>Fixed</td>
<td>Displays a fixed color.</td>
<td></td>
</tr>
</tbody>
</table>

- **Alarm mark > Indicate on Scale**

To display alarm point marks, select **On**.

- **Alarm mark color > Alarm 1, Alarm 2, Alarm 3, and Alarm 4**

If the **Mark kind** is set to **Fixed**, specify the color of the alarm point marks. If one of the colors under **Alarm mark color** is set to **Auto**, its corresponding point mark will appear in the specified alarm color (release number 3 or later; see section 3.7 for details).
5.8 Displaying Alarm Point Marks and Color Scale Band on the Scale

- **Color scale band**
  Displays a specified section of the measurement range using a color band on the scale. This setting is common with the bar graph display.

- **Color scale band > Band area**
<table>
<thead>
<tr>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>In</td>
<td>Displays the area inside using the color band.</td>
</tr>
<tr>
<td>Out</td>
<td>Displays the area outside using the color band.</td>
</tr>
<tr>
<td>Off</td>
<td>Disables the function.</td>
</tr>
</tbody>
</table>

- **Color scale band > Color**
  Set the display color.

- **Color scale band > Display position > Lower, Upper**
  Specify the display position. Set a value within the span or scale range.
  Lower: Lower limit of the area.
  Upper: Upper limit of the area.
5.9 Partially Expanding the Waveform

Partially expand a waveform (reduce the other sections) on the display. We recommend that you display the scale when viewing partially expanded channels. The numbers for the ends of the scale and the boundary position are displayed, and you can identify the expanded and reduced areas easily. However, numbers are not displayed for other scale marks.

For a description of the function, see section 1.3.

Setup Screen

- **Turning ON/OFF the Partial Expanded Display Function**
  Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic setting mode), and select the Environment tab > View, Message.

  ![Basic Setting Mode](image)

  ![View Trend type Partial Trend rate switching](image)

  Message
  - Write group
  - Power-fail message
  - Change message

- **Partially Expanded Display Method**
  Press MENU (to switch to setting mode), and select the Menu tab > Meas channel > Partial

  ![Setup Items](image)

  ![Partial Setup Items](image)

  **Setup Items**

  - **View > Partial**
    If you select On, the Partial setup item appears in the setting mode.

  - **First-CH, Last-CH**
    Select the target channels.

  - **Partial > On/Off**
    To enable partial expanded display, select On.

  - **Partial > Expand**
    Set the position where the value specified by Boundary is to be displayed within the display span in the range of 1 to 99.
5.9 Partially Expanding the Waveform

- **Partial > Boundary**
  Set the value that is to be the boundary between the reduced section and the expanded section in the range of “minimum span value + 1 digit to maximum span value − 1 digit.” For channels that are set to scaling, the selectable range is “minimum scale value + 1 digit to maximum scale value − 1 digit.”
  
  **Example:** Input range: –6 V to 6V. Expand: 30. Boundary: 0
  The –6 V to 0 V range is displayed in the 0% to 30% range, and the 0 V to 6 V range is displayed in the 30% to 100% range.
### 5.10 Changing the Display Layout, Clearing of the Waveform at Start, Message Display Direction, Waveform Line Width, and Grid

Change the display layout, clearing of the waveform at start, waveform line width, and grid.

For a description of the function, see section 1.3.

#### Setup Screen

Press MENU (to switch to setting mode), and select the **Menu** tab > **Display** > **Trend**.

#### Setup Items

- **Trend > Direction**
  Set the display direction of the trends to **Horizontal**, **Vertical**, **Wide**, or **Split**.

- **Trend > Trend clear**
  **Settings** | **Description**
  --- | ---
  On | Clears the displayed waveform when the memory sampling is started.
  Off | Does not clear the waveform when the memory sampling is started.

- **Trend > Message direction**
  Set the display direction of messages to **Horizontal** or **Vertical**. When the trend is set to **Vertical**, the message direction is fixed to **Horizontal**.

- **Trend > Trend line**
  Set the line width of the trend in dots (1 to 3).

- **Trend > Grid**
  Select the number of grids to be displayed in the waveform display area of the trend display.
  **Settings** | **Description**
  --- | ---
  4 to 12 | Displays a grid that divides the display width into 4 to 12 sections.
  Auto | Displays the same number of grids as the number of scale divisions of the first assigned channel of the group.
5.11 Changing the Bar Graph Display Method

Change the bar graph display method.
For a description of the function, see section 1.3.

**Setup Screen**

- **Display Direction**
  Press MENU (to switch to setting mode), and select the Menu tab > Display > Bar graph
  
  ![Display Direction](image1.png)

- **Base Position and the Number of Scale Divisions**
  Press MENU (to switch to setting mode), and select the Menu tab > Meas channel > Bar graph
  
  ![Base Position and Scale Divisions](image2.png)

**Setup Items**

- **Bar graph > Direction**
  Set the display direction of bar graphs to Horizontal or Vertical.

- **First-CH, Last-CH**
  Set the target channels. The target channels are common with the other items that are displayed on the screen.

- **Bar graph > Base position**
  Set the base position of bar graphs to Normal, Center, Lower,* or Upper.*
  The setting is applied when displaying the bar graph and when displaying the current value on the scale using the bar graph.

  * You can select Lower and Upper on DXs with release number 2.
5.11 Changing the Bar Graph Display Method

When the Display Direction of the Bar Graph Is Vertical

- **Normal**
  - Value at the bottom of the bar graph: Span lower limit or span upper limit (or scale lower limit or scale upper limit), whichever is less
  - Value at the top of the bar graph: Span lower limit or span upper limit (or scale lower limit or scale upper limit), whichever is greater
  - Starting point of the bar: Bottom edge

- **Center**
  - Value at the bottom of the bar graph: Same as with Normal.
  - Value at the top of the bar graph: Same as with Normal.
  - Starting point of the bar: Center

- **Lower**
  - Value at the bottom of the bar graph: Span lower limit (or scale lower limit)
  - Value at the top of the bar graph: Span upper limit (or scale upper limit)
  - Starting point of the bar: Bottom edge

- **Upper**
  - Value at the bottom of the bar graph: Same as with Lower.
  - Value at the top of the bar graph: Same as with Lower.
  - Starting point of the bar: Top edge

\[ \begin{align*}
\text{Normal} & : V_{L} \quad \text{Center} & : V_{L} \quad \text{Lower} & : V_{\text{upper}} \quad \text{Upper} & : V_{\text{upper}} \\
V_{S} & \quad \text{VL} & : V_{\text{lower}} \quad \text{VS} & : V_{\text{lower}} \quad \text{Vupper} : \text{Span upper limit (or scale upper limit)} \quad \text{Vlower} : \text{Span lower limit (or scale lower limit)} \quad \text{VL} : \text{Vlower or Vupper, whichever is greater} \quad \text{VS} : \text{Vlower or Vupper, whichever is less} \quad \text{Starting point of the bar} \end{align*} \]

Example: When the span lower and upper limits of the input range are 0.0 and –100.0, respectively
5.11 Changing the Bar Graph Display Method

When the Display Direction of the Bar Graph Is Horizontal
The span lower limit (or scale lower limit) becomes the left edge of the bar graph, and the span upper limit (or scale upper limit) becomes the right edge of the bar graph.

- Starting point of the bar
  - Normal: Left edge or right edge, whichever is less
  - Center: Center
  - Lower: Left edge
  - Upper: Right edge

V_{lower}: Span lower limit (or scale lower limit)
V_{upper}: Span upper limit (or scale upper limit)
\(\downarrow\): Starting point of the bar

Example: When the span lower and upper limits of the input range are 0.0 and –100.0, respectively

When Displaying the Current Value on the Scale Using the Bar Graph

- Bar graph > Division
  - Select the number of main scale marks from 4 to 12.
5.12 Changing the Background Color of the Display

Change the background color of the display. This setting is applied to the operation screens.

**Setup Screen**

Press **MENU** (to switch to setting mode), and select the **Menu** tab > **Display** > **Monitor**

**Setup Items**

- **Monitor > Background > Display**
  Set the background color of the operation screen to **White** (default setting) or **Black**.

- **Monitor > Background > Historical trend**
  Select the background color of the historical trend display from the following:
  Settings: **White**, **Black** (default setting), **Cream**, and **Lightgray**
5.13 Automatically Switching Display Groups

Automatically switch the displayed group at a specified interval.

**Setup Screen**

Press **MENU** (to switch to setting mode), and select the **Menu** tab > **Display** > **Monitor**

![Setup Screen Image]

**Setup Items**

- **Monitor > Scroll time**
  Set the switching interval from the available settings between 5 s and 1 min. The groups switch in ascending order.
  Select whether to automatically switch on the display selection menu.
  See section 4.2
5.14 Automatically Switching Back to the Default Display

Show a preset display when there is no operation for a specific time.

Setup Screen

Press MENU (to switch to setting mode), and select the Menu tab > Display > Monitor

Monitor

Setup Items

• Monitor > Jump default display
  Returns to a preset display if there is no key operation for a specific time.

<table>
<thead>
<tr>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1min to 1h</td>
<td>Time until switching the display.</td>
</tr>
<tr>
<td>Off</td>
<td>Disables the function.</td>
</tr>
</tbody>
</table>

Procedure

• Specifying the Display to be Shown
  1. Show the operation display you want to designate.
  2. In the operation mode, press FUNC.
     The FUNC key menu appears.
  3. Press the Standard display soft key.
     The display is registered.
5.15 Using the Favorite Key

Register a frequently used display to the Favorite key and enable the display to be shown through simple operation.

**Setup Screen**

- **FAVORITE Key action (Release number 3 or later)**
  Press MENU (to switch to setting mode), and select the Menu tab > Display > FAVORITE Key action

**Setup Items**

- **Action (Release number 3 or later)**
  
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>History</td>
<td>The historical trend of the currently displayed data appears when you press the favorite key.</td>
</tr>
<tr>
<td>Favorite</td>
<td>The displays that have been registered to the favorite key appear when you press the favorite key. Select Favorite when you want to register displays to the favorite key and use it to switch between them.</td>
</tr>
</tbody>
</table>

If you are using the multi batch function (/BT2 option), see the DX1000/DX1000N/DX2000 Multi Batch (/BT2) User’s Manual, IM04L41B01-03E.

- **Group display (Release number 3 or later)**
  Specify this setting when Action is set to Favorite.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current</td>
<td>Of the displays that have been registered to the favorite key, those that display groups (the trend, digital, bar graph, and historical trend displays) are displayed using the currently displayed group.</td>
</tr>
<tr>
<td>Saved</td>
<td>Registered displays are displayed as they were registered.</td>
</tr>
</tbody>
</table>

- **Time axis zoom (Release number 3 or later)**
  Specify this setting when Action is set to Favorite.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current</td>
<td>Historical trend displays that have been registered to the favorite key are displayed using the current time axis zoom.</td>
</tr>
<tr>
<td>Saved</td>
<td>Historical trends are displayed using the time axis zooms that they were registered with.</td>
</tr>
</tbody>
</table>


5.15 Using the Favorite Key

**Procedure**

- **Registering the Display**
  Up to 8 displays can be registered.
  1. In the operation mode, show the display you want to register.
  2. Press **FUNC**.
     The FUNC key menu appears.
  3. Press the **Favorite regist** soft key. Then, press a registration number soft key.
  4. Press the **Regist** soft key.
     A window appears for you to enter the display name.
     * To delete a registration, press the Delete soft key.
  5. Enter the display name (using up to 16 characters, "Aa#1").
  6. Select **ENT** and press **DISP/ENTER**.
     The display is registered.

- **Switching the Display**
  **When You Set Action to History**
  The historical trend of the currently displayed data appears when you press the favorite key. Press the key again to return to the previous display.

  **When You Set Action to Favorite**
  The displays change in the order that they were registered in each time you press the favorite key. Pressing the favorite key after the last registered display appears returns the display to what it was before the favorite key was pressed.
5.16 Writing a Message When the DX Recovers from a Power Failure

A message is written to the trend display when the DX recovers from a power failure while memory sampling is in progress.

Setup Screen

- **Power-fail message**

  Press **MENU** (to switch to setting mode), hold down **FUNC** for 3 s (to switch to basic setting mode), and select the **Environment tab > View, Message**

  ![Basic Setting Mode](image)

  **Setup Items**

  - **Message > Power-fail message**

    | Settings | Description |
    |----------|-------------|
    | On       | A message is written when the DX recovers from a power failure while memory sampling is in progress. Display example: 15:12 Power Off 2005/10/25 15:12:57 |
    | Off      | Disables the function. |

If you are using the multi batch function (/BT2 option), see the **DX1000/DX1000N/DX2000 Multi Batch (/BT2) User’s Manual, IM04L41B01-03E**.
5.17 Changing the FUNC Key Menu and Display Selection Menu

Change the FUNC key menu that appears when the FUNC key is pressed and the display selection menu that appears when the DISP/ENTER key is pressed.

If you are using the multi batch function (/BT2 option), see the DX1000/DX1000N/DX2000 Multi Batch (/BT2) User’s Manual, IM04L41B01-03E.

Setup Screen

- **FUNC Key Menu**
  Press MENU (to switch to setting mode), and select the Menu tab > Menu customize > Function menu

- **Display Menu**
  Press MENU (to switch to setting mode), and select the Menu tab > Menu customize > Display menu

Setup Items

- **Enabling/Disabling the FUNC Key Menu**
  Items whose menu name is white are shown.
  1. Press the arrow keys to select a menu item.
  2. Press the View or Hide soft key.
     If you press the Hide soft key, the menu name is displayed in gray, and does not appear in the FUNC key menu.

- **Changing the Display Order of the FUNC Key Menu**
  Menu items are displayed in order by number. In addition, menu items appear when the corresponding function can be used.
  1. Press the arrow keys to select a menu item.
  2. Press the Select soft key.
     The menu item is enclosed in a red frame.
  3. Press the arrow keys to select the destination.
  4. Press the Transfer soft key.
     The menu item moves to the selected number position.
5.17 Changing the FUNC Key Menu and Display Selection Menu

- **Description of the FUNC Key Menus**
  For a description of each item, see section 4.1.

- **Enabling/Disabling the Display Selection Menu and Sub Menu**
  Items whose menu name is white are shown.
  1. Press the **arrow keys** to select a menu item.
  2. Press the **View** or **Hide** soft key.
     If you press the Hide soft key, the menu name is displayed in gray, and does not appear in the display selection menu.

- **Changing the Display Selection Menu/Sub Menu Positions**
  1. Press the **arrow keys** to select a menu item.
  2. Press the **Select** soft key.
     The menu item is enclosed in a red frame.
  3. Press the **arrow keys** to select the destination.
  4. Press the **Transfer** soft key.
     The menu item moves to the selected position.

- **Showing/Hiding Separators**
  1. Press the **arrow keys** to select a menu item.
  2. Press the **Separate** soft key.
     A separator (line) is displayed between the current item and the lower item.
     If you select a menu item whose separator is already shown, this operation hides the separator.
     You can set up to three separators in the display selection menu and each sub menu.
### 5.17 Changing the FUNC Key Menu and Display Selection Menu

**Description of the Display Selection Menus and Sub Menus**

Items with asterisk (*) are set to **Hide** by default.

<table>
<thead>
<tr>
<th>Display Selection Menu</th>
<th>Sub Menu</th>
<th>Reference Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>TREND</td>
<td>GROUP 1 to GROUP 10</td>
<td>Section 4.2</td>
</tr>
<tr>
<td></td>
<td>ALL CHANNEL/GROUP CHANNEL</td>
<td>Section 4.2</td>
</tr>
<tr>
<td></td>
<td>SCALE ON/OFF</td>
<td>Section 4.2</td>
</tr>
<tr>
<td></td>
<td>DIGITAL OFF/ON</td>
<td>Section 4.2</td>
</tr>
<tr>
<td></td>
<td>MESSAGE DISP2/1</td>
<td>Section 4.2</td>
</tr>
<tr>
<td></td>
<td>* TREND SPACE ON/OFF</td>
<td>Section 4.2</td>
</tr>
<tr>
<td></td>
<td>AUTO SCROLL ON/OFF</td>
<td>Section 4.2</td>
</tr>
<tr>
<td></td>
<td>FINE GRID ON/OFF</td>
<td>Section 4.2</td>
</tr>
<tr>
<td></td>
<td>AUTO ZONE ON/OFF</td>
<td>Section 4.2</td>
</tr>
<tr>
<td></td>
<td>TAG DETAIL ON/OFF</td>
<td>Section 4.2</td>
</tr>
<tr>
<td>TREND HISTORY</td>
<td>GROUP 1 to GROUP 10</td>
<td>Section 4.3</td>
</tr>
<tr>
<td>DIGITAL</td>
<td>GROUP 1 to GROUP 10</td>
<td>Section 4.2</td>
</tr>
<tr>
<td></td>
<td>AUTO SCROLL ON/OFF</td>
<td>Section 4.2</td>
</tr>
<tr>
<td></td>
<td>TAG DETAIL ON/OFF</td>
<td>Section 4.2</td>
</tr>
<tr>
<td>BAR</td>
<td>GROUP 1 to GROUP 10</td>
<td>Section 4.2</td>
</tr>
<tr>
<td></td>
<td>AUTO SCROLL ON/OFF</td>
<td>Section 4.2</td>
</tr>
<tr>
<td></td>
<td>TAG DETAIL ON/OFF</td>
<td>Section 4.2</td>
</tr>
<tr>
<td>CUSTOM DISPLAY</td>
<td>INTERNAL 1 to INTERNAL 3, EXTERNAL 1 to EXTERNAL 25</td>
<td>IM04L41B01-04E</td>
</tr>
<tr>
<td></td>
<td>NEW</td>
<td>IM04L41B01-04E</td>
</tr>
<tr>
<td>OVERVIEW</td>
<td>CURSOR OFF/ON</td>
<td>Section 4.4</td>
</tr>
<tr>
<td></td>
<td>JUMP TO ALM SUM</td>
<td>Section 4.4</td>
</tr>
<tr>
<td></td>
<td>JUMP TO TREND</td>
<td>Section 4.4</td>
</tr>
<tr>
<td></td>
<td>* JUMP TO DIGITAL</td>
<td>Section 4.4</td>
</tr>
<tr>
<td></td>
<td>* JUMP TO BAR</td>
<td>Section 4.4</td>
</tr>
<tr>
<td></td>
<td>TAG DETAIL ON/OFF</td>
<td>Section 4.4</td>
</tr>
<tr>
<td></td>
<td>ACK ALARM 1*2</td>
<td>Section 4.4</td>
</tr>
<tr>
<td></td>
<td>ACK ALARM 2*2</td>
<td>Section 4.4</td>
</tr>
<tr>
<td></td>
<td>ACK ALARM 3*2</td>
<td>Section 4.4</td>
</tr>
<tr>
<td></td>
<td>ACK ALARM 4*2</td>
<td>Section 4.4</td>
</tr>
<tr>
<td>ANNUNCIATOR</td>
<td>—</td>
<td>Section 3.12</td>
</tr>
<tr>
<td>Display Selection Menu</td>
<td>Sub Menu</td>
<td>Reference Section</td>
</tr>
<tr>
<td>------------------------</td>
<td>----------</td>
<td>-------------------</td>
</tr>
<tr>
<td>INFORMATION</td>
<td>ALARM SUMMARY</td>
<td>Section 4.5</td>
</tr>
<tr>
<td></td>
<td>MESSAGE SUMMARY</td>
<td>Section 4.5</td>
</tr>
<tr>
<td></td>
<td>MEMORY SUMMARY</td>
<td>Section 4.5</td>
</tr>
<tr>
<td></td>
<td>TAG DETAIL ON/OFF</td>
<td>Section 4.6</td>
</tr>
<tr>
<td></td>
<td>* MODBUS CLIENT</td>
<td>Section 4.5</td>
</tr>
<tr>
<td></td>
<td>* MODBUS MASTER</td>
<td>Section 4.5</td>
</tr>
<tr>
<td></td>
<td>* RELAY</td>
<td>Section 4.5</td>
</tr>
<tr>
<td></td>
<td>EVENT SWITCH</td>
<td>Section 4.5</td>
</tr>
<tr>
<td></td>
<td>REPORT DATA</td>
<td>Section 4.5</td>
</tr>
<tr>
<td></td>
<td>COLUMN BAR</td>
<td>Section 4.10</td>
</tr>
<tr>
<td></td>
<td>TO HISTORY</td>
<td>Sections 4.6, 4.7, and 4.8</td>
</tr>
<tr>
<td></td>
<td>TO HISTORY(DISP)</td>
<td>Sections 4.6, 4.7, and 4.8</td>
</tr>
<tr>
<td></td>
<td>TO HISTORY(EV)</td>
<td>Sections 4.6, 4.7, and 4.8</td>
</tr>
<tr>
<td></td>
<td>TO OVERVIEW</td>
<td>Section 4.6</td>
</tr>
<tr>
<td></td>
<td>DISP GROUP OFF/ON</td>
<td>Section 4.7</td>
</tr>
<tr>
<td></td>
<td>CHANGE SORT KEY</td>
<td>Sections 4.6 and 4.7</td>
</tr>
<tr>
<td></td>
<td>ASCENDING ORDER/DESCENDING ORDER</td>
<td>Sections 4.6 and 4.7</td>
</tr>
<tr>
<td></td>
<td>DATA SAVE MODE</td>
<td>Section 4.8</td>
</tr>
<tr>
<td></td>
<td>SELECT SAVE</td>
<td>Section 4.8</td>
</tr>
<tr>
<td></td>
<td>* M.SAMPLE SAVE</td>
<td>Section 4.8</td>
</tr>
<tr>
<td></td>
<td>* REPORT SAVE</td>
<td>Section 4.8</td>
</tr>
<tr>
<td></td>
<td>ALL SAVE</td>
<td>Section 4.8</td>
</tr>
<tr>
<td></td>
<td>CHANGE DISP ITEM</td>
<td>Section 4.7</td>
</tr>
<tr>
<td></td>
<td>CHANGE DATA KIND</td>
<td>Section 4.8</td>
</tr>
<tr>
<td></td>
<td>FILENAME DISPLAY/TIME DISPLAY</td>
<td>Section 4.8</td>
</tr>
<tr>
<td></td>
<td>CHANGE REPORT CH</td>
<td>Section 4.5</td>
</tr>
<tr>
<td></td>
<td>SINGLE GRAPH/DUAL GRAPH</td>
<td>Section 4.10</td>
</tr>
<tr>
<td></td>
<td>SELECT COLUMN/SELECT GROUP</td>
<td>Section 4.10</td>
</tr>
<tr>
<td></td>
<td>REPORT GROUP 1 to 6</td>
<td>Section 4.10</td>
</tr>
</tbody>
</table>

| Log                   | LOGIN \(^1\) | Section 4.9       |
|                      | Operation \(^2\) | Section 4.9       |
|                      | ERROR | Section 4.9       |
|                      | COMMUNICATION | Section 4.9       |
|                      | FTP | Section 4.9       |
|                      | MAIL | Section 4.9       |
|                      | WEB | Section 4.9       |
|                      | SNTP | Section 4.9       |
|                      | DHCP | Section 4.9       |
|                      | MODBUS | Section 4.9       |
|                      | Change settings \(^2\) | Section 4.9       |
|                      | CHANGE DISP ITEM \(^2\) | Section 4.9       |

\(^1\) Only on DXs without the /AS1 advanced security option

\(^2\) Only on DXs with the /AS1 advanced security option
5.18 Displaying Comments (Release number 3 or later)

Register text strings to comment text fields and combine comment text fields to create comment text blocks.

- You can display the text from a comment text block when a certain event occurs (an alarm for example).
- You can use comment text block text for annunciator window labels (see section 3.12 for details).

**Setup Screen**

- **Entering Comments**
  Press **MENU** (to switch to setting mode), and select the **Menu tab > Message, Comment Text > Comment text fields**

- **Displaying Comments**
  Press **MENU** (to switch to setting mode), and select the **Menu tab > Timer, Event action > Event action**

See section 7.1.
5.18 Displaying Comments (Release number 3 or later)

**Setup Items**

- **Comment txt field no, Text info**
  You can register a comment to a specified comment text field (field 1 to 100).
  Text info: you can enter up to 32 characters (A a # 1).

- **Comment txt block no, Comment txt field no**
  You can register a comment to a specified comment text block (block 1 to 50).
  Register comments to comment text blocks by combining up to 5 comment text fields.
  The text from the selected comment text fields appears on the right of the screen.

- **Logic box number, Event, Action, Comment Ttxt Block No**
  Use the event action function to specify the event that will cause a comment to be displayed. For information about how to set the event action function, see section 7.1.
  Example: If even one alarm occurs, the text from comment text block 2 is displayed.

<table>
<thead>
<tr>
<th>Item</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event</td>
<td>Alarm</td>
</tr>
<tr>
<td>Action</td>
<td>CommentDisplay</td>
</tr>
<tr>
<td>Comment Ttxt Block No</td>
<td>2</td>
</tr>
</tbody>
</table>

A comment appears when an alarm occurs. Pressing any key makes the comment disappear.
6.1 Setting the Recording Conditions of the Measured Data

Set the method for recording the measured data. For a description of the function, see section 1.4.

**Setup Screen**

- **Data Type**
  Press **MENU** (to switch to setting mode), hold down **FUNC** for 3 s (to switch to basic setting mode), and select the **Menu tab > A/D, Memory**

- **Measurement Channels**
  Press **MENU** (to switch to setting mode), and select the **Menu tab > Meas channel > Tag, Memory, Delay**

- **File Save Interval (Display Data)**
  Press **MENU** (to switch to setting mode), and select the **Menu tab > Display > Trend/Save interval**
6.1 Setting the Recording Conditions of the Measured Data

- **Recording Conditions of Event Data**
  Press **MENU** (to switch to setting mode), and select the **Menu** tab > **Data save** > **Event data**

- **Setup Items**

  - **Memory > Data kind**
    | Settings | Description |
    | --- | --- |
    | Display | Records display data. |
    | E+D | Records display data and event data. This setting cannot be selected when the trend interval switching function is set to On. This setting cannot be selected when the multi batch function (/BT2 option) is being used or on DXs with the /AS1 advanced security option. |
    | Event | Records event data. |

  - **Memory sample > On/Off**
    Turn **On** the target channels.

  - **Trend/Save interval > Trend interval [div] (when recording display data)**
    See the table below. You can only set trend intervals that are longer than the scan interval you set in Basic Setting Mode.

  - **Trend/Save interval > Save interval (when recording display data)**
    Select the size of a record data file. The recorded data is divided by the file size specified here. The available settings vary depending on the **Trend interval** setting.

<table>
<thead>
<tr>
<th>Trend interval</th>
<th>5 s</th>
<th>10 s</th>
<th>15 s</th>
<th>30 s</th>
<th>1 min</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample rate</td>
<td>125 ms</td>
<td>250 ms</td>
<td>500 ms</td>
<td>1 s</td>
<td>2 s</td>
</tr>
<tr>
<td>Selectable range of auto save interval</td>
<td>10 min to 12 hours</td>
<td>10 min to 1 day</td>
<td>10 min to 3 days</td>
<td>10 min to 7 days</td>
<td>10 min to 14 days</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Trend interval</th>
<th>2 min</th>
<th>5 min</th>
<th>10 min</th>
<th>15 min</th>
<th>20 min</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample rate</td>
<td>4 s</td>
<td>10 s</td>
<td>20 s</td>
<td>30 s</td>
<td>40 s</td>
</tr>
<tr>
<td>Selectable range of auto save interval</td>
<td>10 min to 14 days</td>
<td>10 min to 31 days</td>
<td>10 min to 31 days</td>
<td>10 min to 31 days</td>
<td>1 hour to 31 days</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Trend interval</th>
<th>30 min</th>
<th>1 h</th>
<th>2 h</th>
<th>4 h</th>
<th>10 h</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample rate</td>
<td>1 min</td>
<td>2 min</td>
<td>4 min</td>
<td>8 min</td>
<td>20 min</td>
</tr>
<tr>
<td>Selectable range of auto save interval</td>
<td>1 hour to 31 days</td>
<td>1 hour to 31 days</td>
<td>2 hours to 31 days</td>
<td>4 hours to 31 days</td>
<td>8 hours to 31 days</td>
</tr>
</tbody>
</table>

*1 You cannot set a trend interval that corresponds to a sampling interval that is faster than the scan interval.

*2 Selectable on the DX1002, DX1002N, DX1004, and DX1004N (release number 3 or later).

*3 Selectable in fast sampling mode on the DX1006, DX1006N, DX1012, and DX1012N (release number 3 or later).

- **Trend/Save interval > Second interval [div]**
  See section 5.3.
### 6.1 Setting the Recording Conditions of the Measured Data

- **Event data (when recording event data)**
  - **Sample rate**
    Select the data recording interval. Use the table under "Data length" for reference.
  - **Mode**
    ```
    | Settings | Description |
    |----------|-------------|
    | Free     | Records data continuously. |
    | Single   | Records data when the trigger condition is met. |
    | Repeat   | Records data each time the trigger condition is met. |
    
    * This setting is fixed at "Free" when the multi batch function (/BT2 option) is being used and on DXs with the /AS1 advanced security option.
  
- **Data length**
  Select the size of a record data file. The recorded data is divided by the file size specified here. The available data lengths vary depending on the **Sample rate** setting.

<table>
<thead>
<tr>
<th>Sample rate</th>
<th>25 ms*2</th>
<th>125 ms</th>
<th>250 ms</th>
<th>500 ms</th>
<th>1 s</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selectable range of data length</td>
<td>10 min to 4 hours</td>
<td>10 min to 1 day</td>
<td>10 min to 2 days</td>
<td>10 min to 3 days</td>
<td>10 min to 7 days</td>
</tr>
<tr>
<td>Sample rate</td>
<td>2 s</td>
<td>5 s</td>
<td>10 s</td>
<td>30 s</td>
<td>1 min</td>
</tr>
<tr>
<td>Selectable range of data length</td>
<td>10 min to 14 days</td>
<td>10 min to 31 days</td>
<td>10 min to 31 days</td>
<td>1 hour to 31 days</td>
<td>1 hour to 31 days</td>
</tr>
<tr>
<td>Sample rate</td>
<td>2 min</td>
<td>5 min</td>
<td>10 min</td>
<td>15 min*4</td>
<td>20 min*4</td>
</tr>
<tr>
<td>Selectable range of data length</td>
<td>1 hour to 31 days</td>
<td>1 hour to 31 days</td>
<td>1 hour to 31 days</td>
<td>1 hour to 31 days</td>
<td>1 hour to 31 days</td>
</tr>
<tr>
<td>Sample rate</td>
<td>30 min*3</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Selectable range of data length</td>
<td>1 hour to 31 days</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*1 You cannot choose an interval that is faster than the scan interval.
*2 Selectable on the DX1002, DX1002N, DX1004, and DX1004N.
*3 Release number 3 or later.

- **Pre-trigger**
  Specify the range when recording data before the trigger condition is met. Select the range as a percentage of the data length from 0, 5, 25, 50, 75, 95, and 100%. If you do not want to record the data existing before the trigger condition is met, select 0%.

- **Trigger signal > Key**
  Select **On** if you want to activate the trigger using key operation.

**Note**
- Triggers can be applied using event action (see section 7.1).
- If the trigger condition is already met when you press START, recording starts.
6.2 Setting the Method for Saving the Data

Set the method for recording the measured data to the storage medium. For a description of the function, see section 1.4.

**Setup Screen**

- **Auto save**
  Press **MENU** (to switch to setting mode), hold down **FUNC** for 3 s (to switch to basic setting mode), and select the **Environment** tab > **Security, Media save**

  ![Auto save screen](image)

- **File header, Data file name**
  Press **MENU** (to switch to setting mode), and select the **Menu** tab > **Data save > File header, File name**

  ![File header, Data file name](image)

- **Save directory**
  Press **MENU** (to switch to setting mode), and select the **Menu** tab > **Data save > Save directory**

  ![Save directory](image)
6.2 Setting the Method for Saving the Data

**Setup Items**

- **Save > Auto save**
  - **Settings** | **Description**
  - On | Automatically saves the measured data to the CF card. Specify On to enable the media FIFO function.
  - Off | Does not automatically save the data. Save the measured data manually to the CF card or USB flash memory (/USB1 option).

- **Save > Media FIFO (Release Number 2 or Later)**
  This item appears if Auto save is set to On.
  - **Settings** | **Description**
  - On | Enable media FIFO. Constantly retains the most recent data files in the CF card.
  - Off | Disable media FIFO. Replace the CF card if the free space on the CF card drops low.

- **File header > Characters**
  Set the header comment to be written to the data file. (Up to 50 characters, \[A-Za-z0-9_\])

- **Data file name > Structure**
  Sets the structure of the file name when saving data.
  - **Settings** | **Description**
  - Date | Serial number + user-assigned character string + date
  - Serial | Serial number + user-assigned character string
  - Batch | Serial number + batch name (when using the batch function)

- **Data file name > Identified strings**
  Set the user-assigned section of the file name. (Up to 16 characters, \[A-Za-z0-9_\])
  Symbols that can be used: #, %, (, ), +, -, ., @, °, and _.
  For details on the data file name, see section 1.4.

- **Save directory > Directory name**
  Set the name of the directory on the storage medium for saving the data on the external storage medium. (Up to 20 characters, \[A-Za-z0-9_\])
  Symbols that can be used: #, %, (, ), +, -, ., @, °, and _.
  Strings that cannot be used: AUX, CON, PRN, NUL, CLOCK, COM1 to COM9, and LPT1 to LPT9.
6.3 Using the Batch Function

Set the batch function.  
For a description of the function, see section 1.5.

**Setup Screen**

- **Batch Function**
  Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic setting mode), and select the Environment tab > Batch.

  ![Batch Function Setup Screen](image)

- **Data file name**
  Press MENU (to switch to setting mode), and select the Menu tab > Data save > File header, File name

  ![Data File Name Setup Screen](image)

- **Text Field**
  Press MENU (to switch to setting mode), and select the Menu tab > Data save > Batch text

  ![Text Field Setup Screen](image)
6.3 Using the Batch Function

**Setup Items**

- **Batch > On/Off**
  Select On to use the batch function. For details on MultiBatch, see IM04L41B01-03E.

- **Batch > Lot-No. digit**
  Select the number of digits of the lot number from 4, 6, or 8. Select Off to disable the lot number.

- **Batch > Auto increment**
  
<table>
<thead>
<tr>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td>Automatically sets the lot number of the next measurement to “the lot number of the current measurement + 1.”</td>
</tr>
<tr>
<td>Off</td>
<td>Disables the operation described above.</td>
</tr>
</tbody>
</table>

- **Data file name > Structure**
  Batch: Sets the name of the display data files or event data files to “batch name.” For details on the data file name, see section 1.4.

- **Text field number**
  Select a number from 1 to 24 on a DX whose release number is 3 or later. Select a number from 1 to 8 on a DX whose release number is 2 or earlier.

- **Text field > Title of field or Characters**
  Set the string.
  Title of field: (Up to 20 characters, [A-Za-z0-9_])
  Characters: (Up to 30 characters, [A-Za-z0-9_])

**Procedure**

- **Setting the Batch Name (Batch number + lot number) and Comment**
  1. In the operation mode, press FUNC. The FUNC key menu appears.
  2. Press the Batch soft key. A window appears for you to enter the batch name and comment.
  3. Set the batch number. (Up to 32 characters, [A-Za-z0-9_]) Symbols that can be used: #, %, (, ), +, -, ., @, °, and _.
    If you are using the lot number, set the lot number.
  4. Set batch comments 1, 2, and 3. (Up to 50 characters each, [A-Za-z0-9_])
  5. Press DISP/ENTER.

**Note**

- Batch numbers and lot numbers cannot be changed after memory start.
- You can change the comment as many times as you wish before executing memory start. After memory start, only the comments that are not specified can be entered. You can change the comment as many times as you wish while the window for setting the comment is displayed. The last specified comment is valid.
- The comment is cleared when memory stop is executed.
- The batch number, lot number, and comments are saved to the display data file or event data file. They are not saved to the setup file.
6.3 Using the Batch Function

- **Displaying the Text Field Settings**
  If you are using the multi batch function (/BT2 option), see the DX1000/DX1000N/DX2000 Multi Batch (/BT2) User’s Manual, IM04L41B01-03E.

  1. In the operation mode, press **FUNC**.
     The FUNC key menu appears.
  2. Press the Text field soft key.
     The text field settings are displayed.

    ![Image](image1)

    Page switch mark (release number 3 and later)
    Eight text fields are displayed on a single page. Use the left and right arrow keys to switch the page.

    The text field contents are displayed on page 3. Use the left and right arrow keys to switch pages (release number 3 or later).

- **Starting Recording (Memory start)**
  1. Press **START** to open the start recording screen (release number 3 or later).
     * On DXs with the /AS1 advanced security option, recording will not start, even if you press START in setting mode.
  2. Enter the batch number, lot number, and comments.
     To edit the contents of a text field, proceed to step 3.
3. Select Input, and press DISP/ENTER. The text field screen appears (release numbers 4 and later).

The settings that you made in setting mode appear here.

Select a text field number, enter text, and press DISP/ENTER. The start recording screen will appear.

The text fields that you specify here will only be saved to the measured data file whose recording you are starting. The text fields that you set in setting mode (see page 6-6) will not change.

4. After setting a batch number (Batch name-No.), a lot number (Lot No.), and comments, move the cursor (blue) to START, and then press DISP/ENTER.

The internal memory icon in the status display section changes from the icon that indicates that memory sampling is stopped to the icon that indicates that memory sampling has started.

- If you are recording display or event data in Free mode, recording will start.
- If you are recording event data in a trigger mode (Single or Repeat), the DX will enter a trigger-wait state.

• Stopping Recording (Memory stop)

1. Press STOP. A confirmation window opens.

2. Select Yes, and press DISP/ENTER.

If the DX is equipped with computation functions (/M1 and /PM1 options), select Mem+Math or Memory and press DISP/ENTER.

On DXs with the /AS1 advanced security option, if there are alarms upon which the alarm ACK operation has not been performed, a confirmation message will appear. Perform the alarm ACK operation as necessary.

The internal memory icon in the status display section changes to the icon that indicates that memory sampling is stopped.
6.4 Starting/Stopping the Recording and Saving the Measured data

Start the recording and save the measured data to the external storage medium. For a description of the function, see section 1.4.

Procedure

• **Starting the Recording (Memory Start)**
  Press START. The internal memory icon in the status display section changes from the stop icon to memory sampling icon.
  • When recording display data or event data in free mode, recording starts.
  • When recording event data in trigger mode, the DX enters the trigger-wait condition.
    * On DXs with the /AS1 advanced security option, recording will not start, even if you press START in setting mode.
    * For the procedures when using the batch function, see section 6.3. If you are using the multi batch function (BT2 option), see the DX1000/DX1000N/DX2000 Multi Batch (BT2) User’s Manual, IM04L41B01-03E.

• **Applying a Trigger to Start the Recording**
  Carry out the procedure below when the DX is waiting for a trigger.

  **Trigger through Key Operation**
  The procedure below can be carried out when recording event data in trigger mode and the DX is configured so that the start trigger is applied through key operation.
  1. Press FUNC.
     The FUNC key menu appears.
  2. Press the Trigger soft key.
     The recording starts.

  **Trigger by an Event (Event action function must be configured. See section 7.1.)**
  Recording starts when an event occurs.

• **Automatically Saving Measured Data**
  Automatic saving takes place when Auto save is set to On (see section 6.2 for details).
  The save destination is the CF card.

  Have the CF card inserted in the slot at all times. While the memory sampling is in progress, the measured data recorded in the internal memory is automatically saved to the CF card.

  Action when Media FIFO is not enabled: If data storage to the storage medium is not complete such as due to insufficient free space, the unsaved data is saved the next time the data is automatically saved.

**Saving the Display Data or Event Data during Memory Sampling through Key Operation**

The save destination is the CF card.

This operation can be carried out when recording display data or when recording event data in Free mode. Unsaved measured data is saved to the CF card.

* If this operation is carried out when auto save is Off, the data in the internal memory is divided, and a file is created.

1. In the operation mode, press FUNC.
   The FUNC key menu appears.

2. Press the Save display or Save event soft key.
   The display data or event data is saved to the CF card.

![Save operation diagram](image-url)
6.4 Starting/Stopping the Recording and Saving the Measured data

• Saving Measured Data Manually (Collectively Storing Unsaved Data)
  Automatic saving takes place when Auto save is set to Off (see section 6.2 for details). You can save to a CF card or to USB flash memory (/USB1 option). The procedure for saving unsaved data to a CF card is described below.
  For the procedure to save data to the USB flash memory, see section 2.12.
  1. Insert the CF card.
     A confirmation window containing the message “There is data which is not saved to media. Do you want to store to media?” appears.
  2. Select Yes and press DISP/ENTER.
     The unsaved data in internal memory will be saved to the CF card.
  3. Follow these steps to remove the CF card.
     Press FUNC (to display the FUNC key menu) > Media eject soft key > CF soft key
     When the message “Media can be removed safely” appears, remove the CF card.

  Note
  • If there is not enough free space on the storage medium, the message “Not enough free space on media” appears, and the data is not saved. If this message appears, replace the storage medium. Then, carry out the procedure again.
  • You cannot abort the data save operation while it is in progress.

• Stopping the Recording (Memory Stop)
  * For the procedures when using the batch function, see section 6.3.
  1. Press STOP. A confirmation window is displayed.
     2. Select Yes using the arrow keys and press DISP/ENTER.
        On models with the computation function (/M1 or /PM1 option), select Mem+Math or Memory, and press DISP/ENTER.
        On DXs with the /AS1 advanced security option, if there are alarms upon which the alarm ACK operation has not been performed, a confirmation message will appear. Perform the alarm ACK operation as necessary.
        The internal memory icon in the status display section changes to the stop icon.

• Saving the Data in the Internal Memory Collectively or Selectively through Key Operation
  See section 4.8.
6.4 Starting/Stopping the Recording and Saving the Measured data

**Explanation**

- **Operations That Start Simultaneously with Memory Start**
  - Waveform display updating on the trend display.
  - Report (/M1 and /PM1 options)
  - The computation function (/M1 and /PM1 options) can be configured to start simultaneously with memory start.
    See section 9.4.

- **Operations That Stop Simultaneously with Memory Stop**
  - Waveform display updating on the trend display.
  - Report (/M1 and /PM1 options)
  - Computation function (/M1 and /PM1 options): When selected in the procedure described above.

- **Performance While Data Is Being Saved**
  If the internal memory or external storage medium is continuously accessed, the following phenomena may occur. When such phenomena occur, the storage medium access indicator frequently illuminates.
  - Files being saved to the external storage medium drop out.
  - Accessing the DX through communications takes a long time
    In such case, take the following measures.
    - If you are creating data files at short intervals consecutively using the event action function, increase the data file save interval.
    - If you are creating numerous files in a single directory on the external storage medium, change the destination directory name at approximately every 1000 files.
• **Changing Settings and Performing File Operations during Recording**

(Memory sampling)

If you are using the multi batch function (/BT2 option), if even one batch group is being recorded, the DX is recording (memory sampling).

**On DXs without the /AS1 advanced security option**

You can change all settings except for the ones listed below.

- Basic settings
- Input range
- Memory sampling on/off
- Computation channel calculation expressions and constants
- TLOG
- Trend interval
- File save interval
- Timer and match time timer

**On DXs With the /AS1 Advanced Security Option**

You can change the following settings and perform the following file operations. The administrator can perform all operations. Users can only perform operations that have been permitted. The setting menu that appears varies depending on the operations that can be performed.

**Setting Changes**

- Date and time settings
- Alarm settings
- Alarm delay time settings
- Calibration settings
- Destination directory settings
- Administrator settings*
- User settings*

* See the Advanced Security Function (/AS1) User’s Manual, IM 04L41B01-05EN.

**File Operations**

- Loading display data files
- Loading event data files
- Listing the files on the external storage medium
6.5 Manually Saving the Measured Data (Manual Sample)

Save the instantaneous values of all channels (excluding those set to Skip or Off) through key operation.
For a description of the function, see section 1.4.

**Procedure**

1. In the operation mode, press **FUNC**. The FUNC key menu appears.

**Explanation**

- **Number of Manual Sampled Data Set in the Internal Memory**
  The number of manual sampled data set in the internal memory is displayed on the memory summary display (see section 1.9)

- **Saving Manual Sampled Data**
  - If auto save is **On**, the manual sampled data is saved to the CF card when you carry out manual sampling.
  - If auto save is **Off**, save the manual sampled data to the CF card according to the procedure for manually saving the data (see section 6.4).
  - The manual sampled data can be saved manually to a CF card or USB flash memory (USB1 option) regardless of whether the auto save function is set to On/Off. For the manual save operation, see section 4.8.
6.6 Saving the Screen Image Data (Snapshot)

Save the current screen image data to the CF card. This operation is called snapshot, and the screen image data file is called snapshot data file. For a description of the function, see section 1.4.

Procedure

1. In the operation mode, press FUNCTION.
   - The FUNCTION key menu appears.
2. Press the Snapshot soft key.
   - The snapshot data file is saved to the CF card.
   - Image of the soft keys and the message window are not saved.

Note

If you assign the snapshot function to the USER key, you can carry out snapshots in all modes (operation mode, setting mode, and basic setting mode). However, error messages are not saved.

Explanation

• File Format
  - The snapshot data file is in PNG format.

• File Name
  - See section 1.4.
6.7 Managing the Files on the Storage Medium

This section explains how to display a list of files on the storage medium, check the free space, delete files and directories, and format the storage medium.

**Procedure**

- **Displaying a List of Files on the Storage Medium, Deleting Files, and Checking the Free Space**
  
  Carry out the procedure below to show the display.

  Press **MENU** (to switch to setting mode), and select the **File** tab > **File list, delete** > press the **CF** or **USB** soft key* > and press **DISP/ENTER**.

  * When a CF card and a USB flash memory (/USB1 option) are being used.

- **Displaying a List of Files in a Directory and Checking the Free Space**
  
  Press the **arrow keys** to select a directory, and press **DISP/ENTER**. The files in the directory are displayed. The root directory is denoted by `/`

- **Sorting Files and Directories (Release Number 2 or Later)**
  
  The files and directories can be sorted by the update date/time.

  Each time you press the Sort soft key, the files and directories are sorted in order from the oldest or the latest update date/time. A mark indicating the sort order is displayed by Date/Time.

  **If the File Name Does Not Fit in the Display Space (Release Number 2 or Later)**

  Press the **soft key once to shift the file name to the left by a character.**

  Press the **soft key once to shift the file name to the right by a character.**
6.7 Managing the Files on the Storage Medium

Deleting a File
Press the **arrow keys** to select the file to be deleted, and press the **Delete** soft key. A confirmation window appears. Select **Yes**, and press **DISP/ENTER**.
The file is deleted.
This operation cannot be performed on DXs with the /AS1 advanced security option.

Deleting a Directory
First, delete all the files in the directory.
Select the directory you want to delete. The rest of the procedure is the same as deleting a file.
This operation cannot be performed on DXs with the /AS1 advanced security option.

Checking the Free Space
The free space on the storage medium is shown at the lower right of the screen.

• Formatting the Storage Medium
Formatting will remove the contents of the storage media.
This operation cannot be performed on DXs with the /AS1 advanced security option.

1. Carry out the procedure below to show the display.
   Press **MENU** (to switch to setting mode), and select the **File** tab > **Format**. Press the **CF** or **USB** soft key*, and then press **DISP/ENTER**.
   * When a CF card and a USB flash memory (/USB1 option) are being used.

2. Enter the volume name and press **DISP/ENTER**. (Up to 11 characters, \text{\texttt{AT}})
   A confirmation window opens.
3. Select Yes and press **DISP/ENTER**.
The storage media is formatted.

**Explanation**

• Format Type

<table>
<thead>
<tr>
<th>Size</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Storage medium smaller than or equal to 512 MB</td>
<td>FAT16</td>
</tr>
<tr>
<td>Storage medium greater than 512 MB</td>
<td>FAT32</td>
</tr>
</tbody>
</table>
6.8 Loading and Displaying the Measured Data in the Storage Medium

Load the display or event data file saved on the external storage medium and display the waveform. The loaded data is shown on the historical trend display.

For the operations on the historical trend display, see section 4.3.

Procedure

• Loading a File

1. Carry out the procedure below to show the display.

   Press MENU (to switch to setting mode), and select the File tab > Load display data or Load event data. Press the CF or USB soft key*, and then press DISP/ENTER.

   * When a CF card and a USB flash memory (/USB1 option) are being used.

2. Press the arrow keys to select a directory, and press DISP/ENTER. The files in the directory are displayed. The root directory is denoted by [/].

3. Press the arrow keys to select a file, and press DISP/ENTER.

   The file is loaded, and the waveform is displayed in the historical trend.

Note

• As shown in the table below, the display data and event data file name extensions change depending on whether or not the /AS1 advanced security option is installed.

<table>
<thead>
<tr>
<th>Advanced Security</th>
<th>Display Data Files</th>
<th>Event Data Files</th>
</tr>
</thead>
<tbody>
<tr>
<td>Not installed</td>
<td>.DAD</td>
<td>.DAE</td>
</tr>
<tr>
<td>Installed</td>
<td>.DSD</td>
<td>.DSE</td>
</tr>
</tbody>
</table>

• For details on how to use the Sort, ▶, and ◂ soft keys, see section 6.7.
6.9 Saving/Loading the Setup Data

Save the setup data to the external storage medium or load the setup data from the external storage medium.

Procedure

• Saving the Setup Data

1. Carry out the procedure below to show the display.

Press MENU (to switch to setting mode), and select the File tab > Save settings. Press the CF or USB soft key*, and then press DISP/ENTER.

* When a CF card and a USB flash memory (/USB1 option) are being used.

2. Set the file name. (Up to 32 characters, #, %, (,), +, -, ., @, °, and _)

Symbols that can be used: #, %, (,), +, -, ., @, °, and _.

Strings that cannot be used: AUX, CON, PRN, NUL, CLOCK, COM1 to COM9, and LPT1 to LPT9.

To cancel the operation, press ESC.

3. Press DISP/ENTER.

The setup data is saved.

• Loading the Setup Data for the Setting Mode

1. Carry out the procedure below to show the display.

Press MENU (to switch to setting mode), and select the File tab > Load settings.

Press the CF or USB soft key*, and then press DISP/ENTER.

* Setup data files are stored in the root directory [/].

To cancel the operation, press ESC.

2. Use DISP/ENTER and arrow keys to select the setup file to be loaded.

* Setup data files are stored in the root directory [/].

To cancel the operation, press ESC.

3. Press DISP/ENTER.

The setup data is loaded.

Note

For details on how to use the Sort, ▲, and ▼ keys, see section 6.7.
6.9 Saving/Loading the Setup Data

- Loading the Setup Data for the Setting Mode and Basic Setting Mode

1. Carry out the procedure below to show the display.
   - On DXs without the /AS1 advanced security option
     - Press **MENU** (to switch to setting mode), hold down **FUNC** for 3 s (to switch to basic setting mode), and select the **File/Initialize** tab > **Load settings**. Press the **CF** or **USB** soft key*, and then press **DISP/ENTER**.
     * When you are using a CF card and USB flash memory (/USB1 option).

   - On DXs with the /AS1 advanced security option
     - Press **MENU** (to switch to setting mode), hold down **FUNC** for 3 s (to switch to basic setting mode), and select the **File/Initialize** tab > **Load settings** > **All settings, Login info only, or Other settings**. Press the **CF** or **USB** soft key*, and then press **DISP/ENTER**.
     * When you are using a CF card and USB flash memory (/USB1 option).

```
Basic Setting Mode

<table>
<thead>
<tr>
<th>File name</th>
<th>Date / Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>[file1]FL</td>
<td>07/03/13 16:47</td>
</tr>
<tr>
<td>[file2]FL</td>
<td>07/03/13 16:47</td>
</tr>
<tr>
<td>[file3]FL</td>
<td>07/03/13 16:47</td>
</tr>
</tbody>
</table>

Free space: 480/128 KBytes
```

2. Use **DISP/ENTER** and **arrow keys** to select the setup file to be loaded.
   * Setup data files are stored in the root directory [\].
   To cancel the operation, press **ESC**.

3. Press **DISP/ENTER**.
   The setup data is loaded.

**Note**

For details on how to use the Sort, ▶, and ◀ keys, see section 6.7.
6.9 Saving/Loading the Setup Data

**Explanation**

- **Setup Data File**
  - **On DXs without the /AS1 advanced security option**
    - The setup data file extension is .PDL.
    - The maximum setup data file size is approximately 250 KB.
    - The following settings are also saved.
      - Current monitor display conditions
      - Default display registration data
      - Favorite key registration data
  
  - **On DXs with the /AS1 advanced security option**
    - The setup data file extension is .PEL.
    - The maximum setup data file size is approximately 250 KB.
    - The following settings are also saved.
      - Current monitor display conditions
      - Default display registration data
      - Favorite key registration data

- **Loading Setup Data**
  - **On DXs without the /AS1 advanced security option**
    - Only the setup data of the setting mode is loaded in the setting mode. However, settings that contradict the setup data of the basic setting mode are not loaded.
    - The monitor display conditions, default display, and favorite keys are also loaded.
    - If the contents of the loaded setup data is invalid, check the error log (see section 4.9).
    - Operations through keys, communications, and remote control input are not executed while the setup data is being loaded.
  
  - **On DXs with the /AS1 advanced security option**
    - All settings, Login info only, and Other settings
      
      | Item             | Description                                                                 |
      |------------------|-----------------------------------------------------------------------------|
      | All settings     | The DX loads all setting mode and basic setting mode settings. However, the login password is not loaded. The password is set to the default password. |
      | Login info only  | The DX only loads the login settings. However, the login password is not loaded. The password is set to the default password. |
      | Other settings   | The DX loads all setting except for the login settings.                      |

  - In setting mode, only the setting mode settings are loaded. However, settings that contradict the basic setting mode settings are not loaded.
  - The monitor display conditions, default display, and favorite keys are also loaded.
  - If the loaded setup data is not applied, check the error log (see section 4.9).
  - While setup data is being loaded, key operations, communication operations, and remote control operations cannot be executed.
6.10 Loading and Saving Report Templates (/M1 and /PM1 options; release numbers 4 and later)

This section explains the procedures for loading a report template (.xml extension) from an external storage medium and for saving a report template from the internal memory to an external storage medium.

**Procedure**

- **Loading a Template File**
  1. Carry out the procedure below to show the display.
     - Press **MENU** (to switch to setting mode), and select the **File** tab > **Load template**. Press the **CF** or **USB** soft key*, and then press **DISP/ENTER**.
     * When you are using a CF card and USB flash memory (/USB1 option).

     ![Template File Status](image)

     Under Template File Status, the check boxes of the template files that are stored in the internal memory are selected.

     2. Press a **soft key** to select a report type, and press **DISP/ENTER**.
        The directories on the external storage medium appear. "/" is the root directory.

     3. Use the **arrow keys** to select a directory, and press **DISP/ENTER**.
        The files in the directory will appear in a list.

     ![Directory Content](image)

     4. Use the **arrow keys** to select the file that you want to load, and press **DISP/ENTER**.
        The report template file is loaded, and the screen from step 1 appears. The check boxes that are selected under Template File Status will match the file type that you loaded.

        If the DX fails to load the file, it will display an error message.
6.10 Saving and Loading Report Templates (/M1 and /PM1 options; release numbers 4 and later)

- **Saving a Template File**
  1. Carry out the procedure below to show the display.
     Press **MENU** (to switch to setting mode), and select the **File** tab > **Save template**.
     Press the **CF** or **USB** soft key*, and then press **DISP/ENTER**.
     * When you are using a CF card and USB flash memory (/USB1 option).

     ![Template File Status]

     Under Template File Status, the check boxes of the template files that are stored in the internal memory are selected.

  2. Press a **soft key** to select a report type, and press **DISP/ENTER**.
     The directories on the external storage medium appear. "/" is the root directory.

  3. Use the **arrow keys** to select a directory, and press **DISP/ENTER**.

  4. Enter the file name (up to 32 characters, A a # 1).
     Symbols that can be used: #, %, (, ), +, –, ., @, °, and _.
     Strings that cannot be used: AUX, CON, PRN, NUL, CLOCK, COM1 to COM9, and LPT1 to LPT9.
     To cancel the operation, press **ESC**.

  5. Press **DISP/ENTER**.
     The report template file is saved.
6.10 Loading and Saving Report Templates (/M1 and /PM1 options; release numbers 4 and later)

**Explanation**

- **Report Template Files**
  - The report template file name extension is .xml.
  - The DX can only handle template files that are 400 KB or smaller.

- **Report Types and Templates Used**

<table>
<thead>
<tr>
<th>Report Settings</th>
<th>Template Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report kind</td>
<td>File type</td>
</tr>
<tr>
<td>Hour</td>
<td>Combine/Separate</td>
</tr>
<tr>
<td>Daily</td>
<td>Combine/Separate</td>
</tr>
<tr>
<td>Hour+Day</td>
<td>Separate</td>
</tr>
<tr>
<td>Day+Week</td>
<td>Separate</td>
</tr>
<tr>
<td>Day+Month</td>
<td>Separate</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>File type</th>
<th>Template Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Combine/Separate</td>
<td>The hourly report template</td>
</tr>
<tr>
<td>Combine/Separate</td>
<td>The daily report template</td>
</tr>
<tr>
<td>Separate</td>
<td>The hourly report and daily report templates</td>
</tr>
<tr>
<td>Combine/Separate</td>
<td>The hourly + daily report template</td>
</tr>
<tr>
<td>Separate</td>
<td>The daily report and weekly report templates</td>
</tr>
<tr>
<td>Combined</td>
<td>The daily + weekly report template</td>
</tr>
<tr>
<td>Separate</td>
<td>The daily report and monthly report templates</td>
</tr>
<tr>
<td>Combine/Separate</td>
<td>The daily + monthly report template</td>
</tr>
</tbody>
</table>
7.1 Setting the Event Action Function (Including the remote control function of the /R1 and /PM1 options and the USER key)

A specified action is carried out when an event occurs. This function is called event action. The remote control function (/R1 option) and the USER key are set by the event action.

For a description of the function, see section 1.6.

**Setup Screen**

- **Event and Action**
  Press MENU (to switch to setting mode), and select the **Menu tab > Timer, Event action > Event action**

- **Timer**
  Press MENU (to switch to setting mode), and select the **Menu tab > Timer, Event action > Timer**

  - When set to relative time
  - When set to absolute time

- **Match Time**
  Press MENU (to switch to setting mode), and select the **Menu tab > Timer, Event action > Match time timer**
7.1 Setting the Event Action Function (Including the remote control function of the /R1 and /PM1 options and the USER key)

- **Logic box number**
  You can set up to 40.

- **Event action > Event**
  The condition to execute the action.

<table>
<thead>
<tr>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>Not use.</td>
</tr>
<tr>
<td>Remote</td>
<td>Select the remote control input terminal number.</td>
</tr>
<tr>
<td>Relay</td>
<td>Select the alarm output relay number. During Edge operation, a change from deactivated to activated is an event.</td>
</tr>
<tr>
<td>Relay-Off*2</td>
<td>Select the alarm output relay number. During Edge operation, a change from activated to deactivated is an event. During Level operation, the action states that correspond to &quot;activated&quot; and &quot;deactivated&quot; are the opposite of when you select &quot;Relay.&quot;</td>
</tr>
<tr>
<td>Switch</td>
<td>Select the internal switch number. During Edge operation, a change from off to on is an event.</td>
</tr>
<tr>
<td>Switch-Off*2</td>
<td>Select the internal switch number. During Edge operation, a change from on to off is an event. During Level operation, the action states that correspond to &quot;on&quot; and &quot;off&quot; are the opposite of when you select &quot;Switch.&quot;</td>
</tr>
<tr>
<td>Timer</td>
<td>Select the timer number.</td>
</tr>
<tr>
<td>Matchtime</td>
<td>Select the match timer number.</td>
</tr>
<tr>
<td>Alarm</td>
<td>During Edge operation, a change from &quot;no alarms are active&quot; to &quot;at least one alarm is active&quot; is an event.</td>
</tr>
<tr>
<td>Alarm-Off*2</td>
<td>During Edge operation, a change from &quot;at least one alarm is active&quot; to &quot;no alarms are active&quot; is an event. During Level operation, the action states that correspond to &quot;at least one alarm is active&quot; and &quot;no alarms are active&quot; are the opposite of when you select &quot;Alarm.&quot;</td>
</tr>
<tr>
<td>UserKey -</td>
<td></td>
</tr>
<tr>
<td>Edge*1</td>
<td>Select the event switch number (1 to 30). This function is available for release numbers 3 and later.</td>
</tr>
<tr>
<td>Level*1</td>
<td>Select the event switch number (1 to 30). During Edge operation, a change from off to on is an event.</td>
</tr>
<tr>
<td>LevelOff*2</td>
<td>Select the event switch number (1 to 30). During Edge operation, a change from on to off is an event. During Level operation, the action states that correspond to &quot;on&quot; and &quot;off&quot; are the opposite of when you set the event to &quot;Level.&quot;</td>
</tr>
</tbody>
</table>

*1 Available for release numbers 3 and later.
*2 Available for release numbers 4 and later.
### 7.1 Setting the Event Action Function (Including the remote control function of the /R1 and /PM1 options and the USER key)

#### Event action > Action
The action to be executed when an event occurs.

<table>
<thead>
<tr>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory</td>
<td>-</td>
</tr>
<tr>
<td>Start</td>
<td>-</td>
</tr>
<tr>
<td>Stop</td>
<td>-</td>
</tr>
<tr>
<td>Trigger*</td>
<td>Can be specified when the DX is configured to record event data.</td>
</tr>
<tr>
<td>AlarmACK</td>
<td>Cannot be specified when the event is set to Relay, Switch, or Alarm.</td>
</tr>
<tr>
<td>Math</td>
<td>Can be specified on /M1 and /PM1 options.</td>
</tr>
<tr>
<td>MathStrt</td>
<td>Start computation. Can be specified on /M1 and /PM1 options.</td>
</tr>
<tr>
<td>MathStop</td>
<td>Stop computation. Can be specified on /M1 and /PM1 options.</td>
</tr>
<tr>
<td>Math rst</td>
<td>Reset computation. Can be specified on /M1 and /PM1 options.</td>
</tr>
<tr>
<td>SaveDisp</td>
<td>Can be specified when the DX is configured to record display data.</td>
</tr>
<tr>
<td>SaveEvt</td>
<td>Can be specified when the DX is configured to record event data.</td>
</tr>
<tr>
<td>Message</td>
<td>Set the message number to write the message and the destination. Set the message destination to all groups (All) or a group number.</td>
</tr>
<tr>
<td>Snap</td>
<td>Snapshot</td>
</tr>
<tr>
<td>Rate1/2</td>
<td>Can be specified when the function for switching between the trend interval and the secondary trend interval is enabled.</td>
</tr>
<tr>
<td>M sample</td>
<td>Manual sampling</td>
</tr>
<tr>
<td>TimerRst</td>
<td>Cannot be specified when the event is set to Timer.</td>
</tr>
<tr>
<td>Group</td>
<td>Specify the number of the group to be displayed.</td>
</tr>
<tr>
<td>Flag</td>
<td>Can be specified on /M1 and /PM1 options.</td>
</tr>
<tr>
<td>Time adj</td>
<td>Can be specified only when the event is set to Remote.</td>
</tr>
<tr>
<td>PnlLoad*</td>
<td>Can be specified only when the event is set to Remote.</td>
</tr>
<tr>
<td>Comment</td>
<td>Specify the comment text block number to display. This function is available for release numbers 3 and later.</td>
</tr>
<tr>
<td>Favorite</td>
<td>Choose which registered display to switch to. This function is available for release numbers 3 and later.</td>
</tr>
</tbody>
</table>

#### Setting > Description

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Key</td>
<td>Performs the same operation as pressing the favorite key.</td>
</tr>
<tr>
<td>Select&gt;Favorite Screen No</td>
<td>Displays the specified favorite screen.</td>
</tr>
</tbody>
</table>

*If you configure the settings so that the Favorite action and the Group action occur at the same time, only the action whose event action number is largest will be executed.

| AlarmRst                  | This action can only be specified when the event is Remote, UserKey, or Edge. This function is available for release numbers 3 and later. |

*This action is not available on DXs with the /AS1 advanced security option.
7.1 Setting the Event Action Function (Including the remote control function of the /R1 and /PM1 options and the USER key)

- **Timer**
  Timer used by event action. Used also in the TLOG computation of the computation function.
  * The timer cannot be changed while memory sampling or computation is in progress.

- **Timer No.**
  Up to four timers (1 to 4) can be set.

**When Using an Absolute Timer**

- **Mode**
  Select **Absolute**.

- **Interval**
  Select the interval from the available settings between 1min to 24h.

- **Ref.time**
  Set the time in the range of hour 0 to hour 23.

**When Using a Relative Timer**

- **Mode**
  Select **Relative**.

- **Interval**
  Set the interval in the range of 00:01 (1 min) to 24:00 (24 hours).

- **Reset at Math Start**
  On: Resets the timer when computation is started. The resetting of the timer is not considered to be a timeout. Even if the timer is used as an event, the action is not executed.

- **Match Time Timer**
  Set the time match condition used in event action.
  * The condition cannot be changed while memory sampling or computation is in progress.

- **Timer number**
  You can set up to four match time conditions (1 to 4).
7.1 Setting the Event Action Function (Including the remote control function of the /R1 and /PM1 options and the USER key)

- **Kind**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Day</td>
<td>The condition is matched once a day.</td>
</tr>
<tr>
<td>Week</td>
<td>The condition is matched once a week.</td>
</tr>
<tr>
<td>Month</td>
<td>The condition is matched once a month.</td>
</tr>
<tr>
<td>Year</td>
<td>The condition is matched once a year. This function is available for release numbers 3 and later.</td>
</tr>
</tbody>
</table>

Set the items with check marks in the following table depending on the Kind setting.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Day</td>
</tr>
<tr>
<td>Month</td>
<td></td>
</tr>
<tr>
<td>Day</td>
<td>✓</td>
</tr>
<tr>
<td>Day of week</td>
<td>✓</td>
</tr>
<tr>
<td>Hour:Minute</td>
<td>✓</td>
</tr>
</tbody>
</table>

- **Month**

Specify the month.

- **Day**

Set the day.

- **Day of the week**

Set the day of the week.

- **Hour:Minute**

Set the time in the range of 00:00 to 23:59.

- **Timer action**

<table>
<thead>
<tr>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single</td>
<td>Executes the action once when the condition is met.</td>
</tr>
<tr>
<td>Repeat</td>
<td>Executes the action at every specified time.</td>
</tr>
</tbody>
</table>

**Procedure**

- **Resetting the Relative Timer**

  1. In the operation mode, press **FUNC**. The FUNC key menu appears.
  2. Press the **Timer reset** soft key.
  3. Press the **soft key** corresponding to timer you want to reset. Select **All** to reset all timers.

The relative timer is reset.

- **Operating Event Switches (Release number 3 or later)**

  **Operating Event Level Switches**

  You can operate an event level switch using:
  - A custom display switch.
  - A communication command.

  **Operating Event Edge Switches**

  You can operate an event edge switch using:
  - The **FUNC** key (the procedure for operating the switch with the **FUNC** key is described below).
  - A custom display push button.
  - A communication command.

  **Operating the Event Edge Switch Using the **FUNC** Key**

  1. In operation mode, press **FUNC**. The FUNC key menu appears.
  2. Press the **Edge Switch** soft key.
  3. Press the switch number soft key. The switch will turn on briefly and then turn off again.
7.1 Setting the Event Action Function (Including the remote control function of the /R1 and /PM1 options and the USER key)

- **Displaying an Event Level Switch Status List (Release number 3 or later)**
  Display the status of the event level switch. For the operating procedure, see section 4.5.

- **Resetting the Match Time Timer (Release number 3 or later)**
  Operation ends when a match time timer whose timer action is set to single expires.
  To use such a match time timer again, you must reset it.
  1. In operation mode, press **FUNC**.
     The FUNC key menu appears.
  2. Press the **Match T Reset** soft key.
     * This soft key appears when a match timer whose timer action is set to single has expired.
  3. Press the **soft key** with the match time timer number of the timer that you want to reset.
     The match time timer that you specify is reset.

**Explanation**

- **Resetting the Relative Timer**
  Restarts the timer.
  - The resetting of the timer is considered to be a timeout. (If the timer is used as an event, the action is executed.)
  - If the timer is used in TLOG computation on the /M1 or /PM1 math option and TLOG computed value reset at each interval is specified, the computed result is reset.

- **Resetting the Match Time Timer (Release number 3 or later)**
  This operation resets an expired match time timer so that it can operate again.
  - The resetting of a match time timer does not count as a timer expiration (and it will not count as an event action event).
  - This operation can be used with match time timers whose timer action is set to single.
  - If the timer is used in TLOG computation on the /M1 or /PM1 math option and TLOG computed value reset at each interval is specified, the computed result is reset.
7.2 Setup Examples of Event Action

Example 1: Starting/Stopping the Memory Sampling through Remote Control (/R1 Option)

Starts/ Stops the memory sampling when a signal is applied to remote control input terminal 2. Use logic box number 1.

- **Setup Screen and Setup Items**
  Press MENU (to switch to setting mode), and select the Menu tab > Timer, Event action > Event action

![Event Action Configuration](image)

- **Operation**
  If the input to the remote control input terminal 2 is turned ON when memory sampling is stopped, memory sampling starts. If the remote control input is turned OFF when memory sampling is in progress, memory sampling stops.

Example 2: Writing a Message When an Alarm Occurs

Write the message “Channel 1 Alarm” to group 1 when an alarm occurs on channel 1. Use logic box number 2.

- **Setup Screen and Setup Items**
  Press MENU (to switch to setting mode), and select the Menu tab > Timer, Event action > Event action

![Event Action Configuration](image)

- **Other Settings**
  - Set an alarm to channel 1 and output to internal switch 3.
  - Register “Channel 1 alarm” in message number 4.
  For the procedure to set the alarm, see section 3.7.
  For the procedure to set the message, see section 5.4.
Example 3: Saving the Data Every Day at Hour 17
Save the recorded data to the CF card every day at hour 17. Use logic box number 3.
Use match time condition 1.

- Setup Screen and Setup Items
Logic box number 3
Press MENU (to switch to setting mode), and select the Menu tab > Timer, Event action > Event action

Match Time Condition
Press MENU (to switch to setting mode), and select the Menu tab > Timer, Event action > Match time timer

<Other Settings>
Set the display data to be saved automatically. Set the file save interval to 1day or longer. If a file save interval shorter than 1day is specified, the data is also saved at the file save interval.
For the procedure to set the recording conditions of the display data, see section 6.1.
Example 4: Releasing the Alarm Output Using the USER Key (Alarm Acknowledge Operation)

Release the activated alarm output by pressing the USER key. Use logic box number 4.

- **Setup Screen and Setup Items**
  Press MENU (to switch to setting mode), and select the Menu tab > Timer, Event action > Event action

  ![Setup Screen Example]

  <Operation>
  Press the USER key to release the activated alarm indication and relay output.

  <Related Settings>
  Set the alarm indication and alarm output relay operation to Hold. For the procedure to set the alarm indication operation and alarm output relay operation, see section 3.5.
7.3 Changing the Response to Remote Contact Input Opening and Closing (/R1 and /PM1 options; release number 3 or later)

Set the remote contact input operation.

Setup Screen

MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic setting mode), and select the Environment tab > Remote.

<table>
<thead>
<tr>
<th>Remote Input</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>N.O</td>
<td>N.O</td>
<td>N.O</td>
<td>N.O</td>
<td>N.O</td>
<td>N.O</td>
<td>N.O</td>
<td>N.O</td>
</tr>
</tbody>
</table>

Note

On models with the pulse input option (/PM1), the remote control input terminals can be used for pulse input. When pulses are counted, the number of rising pulse edges is counted, regardless of the Remote Input setting.
8.1 Disabling the Key Operation (Key Lock Function)

Disable the key operation.
For a description of the function, see section 1.7.
This operation cannot be performed on DXs with the /AS1 advanced security option.

Setup Screen

- Selecting the Key Lock Function
  Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic setting mode), and select the Environment tab > Security, Media save

- Key Operation to Be Disabled
  Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic setting mode), and select the Menu tab > Keylock > Key Action, Media or Action of Function
  - Key action, Media
  - Action of Function

Setup Items

- Security > Key
  Select Keylock.
  
<table>
<thead>
<tr>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keylock</td>
<td>Enables the key lock function. The Keylock item is displayed in the basic setting mode menu.</td>
</tr>
<tr>
<td>Login</td>
<td>Enables the login function. See section 8.2.</td>
</tr>
</tbody>
</table>

- Keylock > Password
  The password used to release the key lock. (Up to 8 characters, A-Z,a-z,0-9) The password is displayed as "********" (release number 3 or later).
8.1 Disabling the Key Operation (Key Lock Function)

- **Key action, Media/USB or Action of Function**
  Select whether to lock each item.

<table>
<thead>
<tr>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Free</td>
<td>Key lock not applied.</td>
</tr>
<tr>
<td>Lock</td>
<td>Disables the operation.</td>
</tr>
</tbody>
</table>

**Procedure**

- **Locking the Keys**
  1. In the operation mode, press **FUNC**.
     The FUNC key menu appears.
  2. Press the **Keylock** soft key.
     The key lock is activated. The key lock icon appears in the status display section.

- **Releasing the Key Lock**
  1. In the operation mode, press **FUNC**.
     The FUNC key menu appears.
  2. Press the **Keylock** soft key.
     A window appears for you to enter the password.
  3. Enter the password and press **DISP/ENTER**.
     The key lock is released. The key lock icon in the status display section disappears.
     - The password that you entered is displayed as "********."
8.2 Enabling Only Registered Users to Operate the DX (Login Function)

Only registered users can operate the DX.
For a description of the function, see section 1.7.
For information about using this function on a DX with the /AS1 advanced security option, see the Advanced Security Function (/AS1) User’s Manual, IM04L41B01-05EN.

Setup Screen

- **Login Function**
  Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic setting mode), and select the Environment tab > Security, Media save

- **Logout Method**
  Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic setting mode), and select the Menu tab > Login > Basic settings

- **Registering Administrators**
  Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic setting mode), and select the Menu tab > Login > Admin settings
8.2 Enabling Only Registered Users to Operate the DX (Login Function)

- **Registering Users**
  Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic setting mode), and select the Menu tab > Login > User settings

<table>
<thead>
<tr>
<th>Basic Setting Mode</th>
<th>Login &gt; User settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>User number</td>
<td></td>
</tr>
<tr>
<td>Mode</td>
<td>Key</td>
</tr>
<tr>
<td>User name</td>
<td>Users</td>
</tr>
<tr>
<td>Password</td>
<td>cccccc</td>
</tr>
<tr>
<td>Authority of user</td>
<td>Off</td>
</tr>
</tbody>
</table>

- **User Privileges**
  Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic setting mode), and select the Menu tab > Login > Authority of user > Key Action, Media or Action of Function

<table>
<thead>
<tr>
<th>Basic Setting Mode</th>
<th>Authority of user</th>
</tr>
</thead>
<tbody>
<tr>
<td>Key</td>
<td>Free</td>
</tr>
<tr>
<td>STOP</td>
<td>Free</td>
</tr>
<tr>
<td>MENU</td>
<td>Free</td>
</tr>
<tr>
<td>USER</td>
<td>Free</td>
</tr>
<tr>
<td>DISP/ENTER</td>
<td>Free</td>
</tr>
<tr>
<td>FAVORITE</td>
<td>Free</td>
</tr>
<tr>
<td>Media/USB</td>
<td>Free</td>
</tr>
<tr>
<td>External media</td>
<td>Free</td>
</tr>
<tr>
<td>Used settings</td>
<td>Free</td>
</tr>
</tbody>
</table>

**Setup Items**

The login function can be set separately for login through keys and login through communications.

- **Security > Key**
  Select Login.

<table>
<thead>
<tr>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Login</td>
<td>Enables only registered users to operate the DX using keys. The Login item is displayed in the basic setting mode menu.</td>
</tr>
<tr>
<td>Keylock</td>
<td>Enables the key lock function. See section 8.1.</td>
</tr>
<tr>
<td>Off</td>
<td>Disables the security functions.</td>
</tr>
</tbody>
</table>

- **Security > Communication**

<table>
<thead>
<tr>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Login</td>
<td>Enables only registered users to operate the DX via communications. The Login item is displayed in the basic setting mode menu.</td>
</tr>
<tr>
<td>Off</td>
<td>Disables the security functions.</td>
</tr>
</tbody>
</table>

- **User basic settings > Auto logout**

<table>
<thead>
<tr>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Does not log out until the logout operation is executed.</td>
</tr>
<tr>
<td>1min to 10min</td>
<td>Automatically logs out when there is no key operation for a specified time.</td>
</tr>
</tbody>
</table>
8.2 Enabling Only Registered Users to Operate the DX (Login Function)

- **User basic settings > Operation without login**
  Sets the operation that the user can carry out when logged out.

<table>
<thead>
<tr>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Only login operation is available.</td>
</tr>
<tr>
<td>Display</td>
<td>Allows the user to switch the operation screen in addition to the login operation.</td>
</tr>
</tbody>
</table>

- **Admin number**
  Up to five administrators can be registered. Be sure to register at least one administrator. At least one administrator must be registered to use the login function.

- **Admin settings > Mode**
  The available settings vary depending on the Security setting.

<table>
<thead>
<tr>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Not register.</td>
</tr>
<tr>
<td>Key</td>
<td>Log into the DX using keys.</td>
</tr>
<tr>
<td>Comm</td>
<td>Log into the DX via communications.</td>
</tr>
<tr>
<td>Web</td>
<td>Log into the operator page and monitor page of the DX using a Web browser.</td>
</tr>
<tr>
<td>Key+Comm</td>
<td>Log into the DX using keys and via communications.</td>
</tr>
</tbody>
</table>

- **Admin settings > User name**
  Set the user name. (Up to 20 characters. [A-Za-z0-9])
  - You cannot register user names that are already registered.
  - You cannot register “quit” or a user name containing all spaces.

- **Admin settings > Password**
  Set the password. (Release numbers 3 and later: up to 8 characters. Release numbers 4 and later: up to 20 characters. [A-Za-z0-9])
  Unregistered password is displayed as “??????????.” An entered password is displayed as “********.”
  - You cannot register “quit” or a password containing all spaces.

- **User number**
  Up to 30 users can be registered.

- **User settings > Mode**
  The available settings vary depending on the Security setting.

<table>
<thead>
<tr>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Not register.</td>
</tr>
<tr>
<td>Key</td>
<td>Log into the DX using keys.</td>
</tr>
<tr>
<td>Comm</td>
<td>Log into the DX via communications.</td>
</tr>
<tr>
<td>Web</td>
<td>Log into the monitor page of the DX using a Web browser.</td>
</tr>
<tr>
<td>Key+Comm</td>
<td>Log into the DX using keys and via communications.</td>
</tr>
</tbody>
</table>

- **User settings > User name, Password**
  See the explanation for the administrator user name and password.

- **Authority of user**

<table>
<thead>
<tr>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>No limitations on the operation.</td>
</tr>
<tr>
<td>1 to 10</td>
<td>Registration number of the operation limitation.</td>
</tr>
</tbody>
</table>

- **Authority of user > Key action, Media/USB, Action of Function**
  Select the “authority of user” preset number from 1 to 10.
  See section 8.1.
8.3 Logging in and Logging Out

This section explains the procedure to log into the DX using keys. For the procedure to log into the DX via communications, see the Communication Interface User’s Manual (IM04L41B01-17E).

For information about using this function on a DX with the /AS1 advanced security option, see the Advanced Security Function (/AS1) User’s Manual, IM04L41B01-05EN.

**Procedure**

- **Logging In**
  1. In the operation mode, press **FUNC**. A list of registered user names appears.
  2. Press the arrow keys to select a user name, and press **DISP/ENTER**. A window appears for you to enter the password.
  3. Enter the password* and press **DISP/ENTER**. The DX is ready to be operated using keys. The name of the user that is logged in is displayed in the status display section.

* The password that you enter is displayed as “********.”

- **Logging Out**
  **Using Keys**
  1. In the operation mode, press **FUNC**. The FUNC key menu appears.
  2. Press the **Logout** soft key. You are logged out from the DX. The user name in the status indication section disappears.

- **Auto Logout**
  If auto logout is enabled, you are automatically logged out if there is no key operation for a specified time.
• Changing the Password
 Using Keys

1. In the operation mode, press **FUNC**.
   The FUNC key menu appears.

2. Press the **Password change** soft key.
   A window appears for you to enter the current password.

3. Enter the current password, select **ENT**, and press **DISP/ENTER**.
   A window appears for you to enter the new password.

4. Enter the new password, select **ENT**, and press **DISP/ENTER**.
   A window appears for you to enter the new password again.

5. Enter the new password, select **ENT**, and press **DISP/ENTER**.
   The window closes, and the new password is activated.
9.1 Setting the Expression, Measurement Range, Alarm, Tag, and Data Storage on Computation Channels

This section explains how to set a computation channel's expression, measurement range, tag, alarm, and recording On/Off. You cannot set expressions or constants while memory sampling or computation is in progress.

For a description of the function, see section 1.8.

Setup Screen

- **Expression and Alarm**
  Press MENU (to switch to setting mode), and select the **Menu** tab > **Math channel** > **Expression, Alarm**

- **Constants Used in Expressions**
  Press MENU (to switch to setting mode), and select the **Menu** tab > **Math channel** > **Constant**

- **Tag, Memory Sampling On/Off, and Alarm Delay Time of Computation Channels**
  Press MENU (to switch to setting mode), and select the **Menu** tab > **Math channel** > **Tag, Memory, Delay**
• Conditions of TLOG Computation and Rolling Average
Press MENU (to switch to setting mode), and select the Math tab > Math channel > TLOG, Rolling average

• Display for Computation Errors and Handling of Overflow Data in Statistical Computation
Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic setting mode), and select the Environment tab > Math

**Setup Items**

• First-CH/Last-CH
Set the target channels.

• Expression/Span
  • Math On/Off
Select On for channels to be used.

• Calculation expression
Enter the expression using up to 120 characters.
Pressing the Input soft key displays a window used to enter the expression.
Press the M1/M2 soft key to switch between a screen used to enter values and characters and a screen used to enter operators and functions.
Use soft keys, arrow keys, and DISP/ENTER to enter an expression.

For details on how to write expressions, see section 9.2.

**Note**
You cannot use both the USB keyboard (/USB1 option) and the DX keys to enter the equation.
If you press a DX soft key, for example, while you are entering an equation from the USB keyboard, the entered equation is cleared.
9.1 Setting the Expression, Measurement Range, Alarm, Tag, and Data Storage on Computation Channels

- **Span_L, Span_U**
  Set the measurement range.
  Selectable range of values: –9999999 to 99999999
  Selectable decimal places: X.XXXX, XX.XX, XXX.X, XXXX.X

- **Unit**
  Set the unit of the computed value (Up to 6 characters, [A-Za-z0-9]).

- **Alarm**
  The available alarm types are high limit alarm, low limit alarm, delay high limit alarm, and delay low limit alarm.
  The range of alarm values is as follows:

<table>
<thead>
<tr>
<th>Type</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>H, L, T, t</td>
<td>Within –9999999 to 99999999 excluding the decimal point</td>
</tr>
</tbody>
</table>

For details on setting alarms, see section 3.7.
* If the Math On/Off or calculation expression is changed, the alarms for that channel are turned Off.

- **Alarm delay > Time**
  Set the alarm delay time using an integer in the range of 1 to 3600 s.

- **Tag > Comment**
  Sets the tag comment. On a DX with a release number of 3 or later, you can enter up to 32 characters. On a DX with a release number of 2 or earlier, you can enter up to 16 characters. The characters that can be entered are: [A-Za-z0-9].

- **Tag > No. (Release number 3 or later)**
  This setting only appears when you have enabled the use of tag numbers.
  Sets the tag number. (Up to 16 characters: [A-Za-z0-9]).

- **Constant**
  - **Number of constant**
    Select the constant (K01 to K60) to set.
  - **Value**
    The selectable range is as follows:
    –9.9999E+29 to –1.0000E–30, 0, 1.0000E–30 to 9.9999E+29
    The number of significant digits of a constant is five. When specifying the constant using exponential notation, set the mantissa less than or equal to 5 digits and the exponent less than or equal to 2 digits.

- **TLOG**
  - **Timer type**
    You can set the timer type to Timer or Match T (match time timer).
  - **Timer No.**
    Select the timer number to use.
    For details on setting the timer, see section 7.1.
    For match time timer setting instructions, see section 7.1.
  - **Sum scale**
    Set the sum scale to /s to /h to match the unit of the measured value.
    Example: If the unit of the measured value is “m³/min,” select /min.
    Off: Sums as-is the measured data per scan interval.
  - **Reset**
    To reset the TLOG computed value at each interval, select On.
9.1 Setting the Expression, Measurement Range, Alarm, Tag, and Data Storage on Computation Channels

- **Rolling average**
  - **On/Off**
    To take the rolling average of the measured results, select **On**.
  - **Interval**
    Select the sampling interval when taking the rolling average from the following: The sampling interval takes on a value that is an integer multiple of the scan interval. For example, if the sampling interval is set to 5 s when the scan interval is 2 s, the actual sampling interval is 6 s.
  - **Number of samples**
    Set the number of samples for the rolling average using an integer between 1 and 1500. The rolling average time is equal to the sampling interval × the number of samples.

  **Note**
  - If the number of data points to be averaged has not reached the specified number of samples immediately after computation is started, the average of the available data is calculated.
  - Computation error data is excluded from the rolling average computation.
  - If the computed data exceeds the upper or lower limit, the data is clipped at the upper or lower limit, and the rolling average is computed. The upper and lower limit is “±100000000” excluding the decimal point. The decimal place is the same as that of the span lower limit.

- **Memory sample > On/Off**
  Select **On** to record the computed data of the target channels.

- **Math**
  - **Value on Error**
    Specify whether to set the display for a computation error to **+Over** or **–Over**.
  - **Value on Overflow > SUM, AVE**
    Specify how to handle overflow data when it is detected in the SUM or AVE computation of TLOG or CLOG. This setting is also applied to report generation.
    
    | Settings | Description |
    |----------|-------------|
    | Error    | Sets the computed result to computation error. |
    | Skip     | Discards the overflow data and continues the computation. |
    | Limit    | Uses a limit value in place of the overflow data and continues the computation. |

- **Value on Overflow > MAX, MIN, P-P**
  Specify how to handle overflow data when it is detected in the MAX, MIN, or P-P computation of TLOG or CLOG. This setting is also applied to report generation.

    | Settings | Description |
    |----------|-------------|
    | Over     | Uses the overflow data as-is. |
    | Skip     | Discards the overflow data and continues the computation. |
9.2 Writing Expressions

This section explains the meaning and how to write expressions.

**Common Items**

Follow the rules below when writing expressions.

- Use up to 120 characters to write expressions.
- The precedence of computing terms can be specified using parentheses.
- Specify the channels in the expression using channel numbers.

**Example:** 1, 12, and 101

- The one-digit number of constants (K), communication input data (C), remote input terminal status (D), pulse input (P, Q), internal switch (S), alarm output relay status (I), flag (F), and recording (memory sample) status (M) in the expression can be denoted as in "01" and "1."

**Example:** K01, K1, C01, C1, D01, D1, P01, P1, Q01, Q1, S01, S1, I01, I1, F01, and F1.

- The data of the previous scan is used in the computation for its own channel number and channel numbers greater than its own channel number in the expression.
- Special computation (HOLD, RESET, and CARRY) and conditional expressions are written at the beginning of the expression.

**Order of Precedence in Computations**

The order of precedence of computation in expressions is as follows:

<table>
<thead>
<tr>
<th>Type</th>
<th>Computing Element</th>
</tr>
</thead>
<tbody>
<tr>
<td>(high order of precedence)</td>
<td>(h) ABS(), SQR(), LOG(), LN(), EXP(), TLOG.MAX(), TLOG.MIN(), TLOG.AVE(), TLOG.SUM(), CLOG.MIN(), CLOG.MAX(), CLOG.AVE(), CLOG.SUM(), CLOG.P-P()</td>
</tr>
<tr>
<td>Special computation and conditional expression</td>
<td>PRE, HOLD, RESET, CARRY, [a?b:c]</td>
</tr>
<tr>
<td>Power</td>
<td>**</td>
</tr>
<tr>
<td>Logical negation</td>
<td>NOT</td>
</tr>
<tr>
<td>Multiplication and division</td>
<td>*, /</td>
</tr>
<tr>
<td>Addition and subtraction</td>
<td>+, –</td>
</tr>
<tr>
<td>Greater than and less than</td>
<td>.GT., .LT., GE., LE.</td>
</tr>
<tr>
<td>Equal and not equal</td>
<td>.EQ., .NE.</td>
</tr>
<tr>
<td>Logical product</td>
<td>AND</td>
</tr>
<tr>
<td>Logical sum and exclusive logical sum</td>
<td>OR, XOR</td>
</tr>
<tr>
<td>(low order of precedence)</td>
<td>-------------------------------------------------------</td>
</tr>
</tbody>
</table>

**Limitations**

The following limitations exists in writing expressions.

<table>
<thead>
<tr>
<th>Type</th>
<th>Limitations</th>
</tr>
</thead>
<tbody>
<tr>
<td>TLOG</td>
<td>A computing element cannot be written inside the parentheses.</td>
</tr>
<tr>
<td></td>
<td>Only one TLOG computation can be specified in a single expression.</td>
</tr>
<tr>
<td>CLOG</td>
<td>A computing element cannot be written inside the parentheses.</td>
</tr>
<tr>
<td></td>
<td>Only one CLOG computation can be specified in a single expression.</td>
</tr>
<tr>
<td>PRE</td>
<td>A computing element cannot be written inside the parentheses.</td>
</tr>
<tr>
<td>HOLD(a):b</td>
<td>Can only be written at the beginning of an expression.</td>
</tr>
<tr>
<td></td>
<td>Only one HOLD computation can be specified in a single expression.</td>
</tr>
<tr>
<td>RESET(a):b</td>
<td>Can only be written at the beginning of an expression.</td>
</tr>
<tr>
<td></td>
<td>Only one RESET computation can be specified in a single expression.</td>
</tr>
<tr>
<td>CARRY(a):b</td>
<td>Can only be written at the beginning of an expression.</td>
</tr>
<tr>
<td></td>
<td>Only one CARRY computation can be specified in a single expression.</td>
</tr>
<tr>
<td></td>
<td>Only TLOG.SUM can be written in &quot;b.&quot; analysts can be combined (example: [a?b:c]+001). However, conditional equations can be specified for a, b, and c.</td>
</tr>
</tbody>
</table>
9.2 Writing Expressions

Four Arithmetic Operation

Expression Example
• Addition 001+002
(Determines the sum of the measured values of channel 1 and channel 2.)
• Subtraction 001–002
(Determines the difference of the measured values of channel 1 and channel 2.)
• Multiplication 001*K03
(Multiplies constant K03 to the measured value of channel 1.)
• Division 001/K02
(Divides the measured value of channel 1 by constant K02.)

Power and Other Computations

Expression Example
• Power 001**002
(Determines the measured value of channel 1 to the power of the measured value of channel 2.)
• Square root SQR(002)
(Determines the square root of the measured value of channel 2.)
• Absolute value ABS(002)
(Determines the absolute value of the measured value of channel 2.)
• Common logarithm LOG(001)
(Determines the common logarithm (log10) of the measured value of channel 1.)
• Natural logarithm LN(001)
(Determines the natural logarithm of the measured value of channel 1.)
• Exponent EXP(001)
(Determines e to the power of the measured value of channel 1.)

Relational Computation

Expression Example
002.LT.003
If the measured value of channel 2 is less than the measured value of channel 3, the computed result is “1.” Otherwise, the result is “0.”

002.GT.003
If the measured value of channel 2 is greater than the measured value of channel 3, the computed result is “1.” Otherwise, the result is “0.”

002.EQ.003
If the measured value of channel 2 is equal to the measured value of channel 3, the computed result is “1.” Otherwise, the result is “0.”

002.NE.003
If the measured value of channel 2 is not equal to the measured value of channel 3, the computed result is “1.” Otherwise, the result is “0.”

002.GE.003
If the measured value of channel 2 is greater than or equal to the measured value of channel 3, the computed result is “1.” Otherwise, the result is “0.”

002.LE.003
If the measured value of channel 2 is less than or equal to the measured value of channel 3, the computed result is “1.” Otherwise, the result is “0.”
Logical Computation

Checks whether the two data values, e1 and e2 (e1 only for NOT), are zeroes or non-zeroes, and computes according to the conditions.

AND

Logical product

(Syntax) e1ANDe2
(Condition) If the two data values e1 and e2 are both non-zeroes, the computed result is “1.” Otherwise, it is “0.”
(Explanation)

<table>
<thead>
<tr>
<th>e1</th>
<th>e2</th>
<th>e1ANDe2</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
</tbody>
</table>

OR

Logical sum

(Syntax) e1ORE2
(Condition) If the two data values e1 and e2 are both zeroes, the computed result is “0.” Otherwise, it is “1.”
(Explanation)

<table>
<thead>
<tr>
<th>e1</th>
<th>e2</th>
<th>e1ORE2</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
</tbody>
</table>

XOR

Exclusive OR

(Syntax) e1XORE2
(Condition) If the two data values e1 and e2 are zero and non-zero or non-zero and zero, the computed result is “1.” Otherwise, it is “0.”
(Explanation)

<table>
<thead>
<tr>
<th>e1</th>
<th>e2</th>
<th>e1XORE2</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>0</td>
</tr>
</tbody>
</table>

NOT

Logical negation

(Syntax) NOTe1
(Condition) The result is the inverse of the status of data e1 (zero or non-zero).
(Explanation)

<table>
<thead>
<tr>
<th>e1</th>
<th>NOTe1</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
</tr>
</tbody>
</table>

Expression Example

01-02OR03.GT.04

Determines the OR of the computed results of “01-02” and “03.GT.04.”
9.2 Writing Expressions

TLOG Computation

In the explanation below, an expression containing a computing element in e1, an internal switch (S), a relay (I), or flag (F) cannot be written. In addition, only one TLOG computation can be specified in a single computing equation.

TLOG.MAX( )
Maximum value
(Syntax) TLOG.MAX(e1)
(Condition) Determines the maximum value of channel e1.

TLOG.MIN( )
Minimum value
(Syntax) TLOG.MIN(e1)
(Condition) Determines the minimum value of channel e1.

TLOG.AVE( )
Average value
(Syntax) TLOG.AVE(e1)
(Condition) Determines the average value of channel e1.

TLOG.SUM( )
Sum value
(Syntax) TLOG.SUM(e1)
(Condition) Determines the sum of channel e1.

TLOG.P-P( )
Maximum - minimum value
(Syntax) TLOG.P-P(e1)
(Condition) Determines the maximum - minimum value of channel e1.

Expression Example
TLOG.MAX(01)+K01*SQR(02)

Examples of Equations That Are Not Allowed
TLOG.AVE(01)+TLOG.AVE(02)
Reason: TLOG appears twice in one equation.
TLOG.AVE(ABS(01))
Reason: A computing element is used inside the parentheses.
CLOG Computation

Only data of measurement channels and computation channels can be used in the CLOG computation. Up to 30 channels can be written in the parentheses.

In the explanation below, an expression containing a computing element cannot be written to e1, etc. In addition, only one CLOG computation can be specified in a single computing equation.

**CLOG.SUM( )**

Sum value

(Syntax) CLOG.SUM(e1,e2,e4-e6)

(Condition) Determines the sum of the data of channels e1, e2, e4, e5, and e6 that are measured at the same time.

**CLOG.MAX( )**

Maximum value

(Syntax) CLOG.MAX(e1,e2,e4-e6)

(Condition) Determines the maximum value among the data of channels e1, e2, e4, e5, and e6 that are measured at the same time.

**CLOG.MIN( )**

Minimum value

(Syntax) CLOG.MIN(e1,e2,e5,e7)

(Condition) Determines the minimum value among the data of channels e1, e2, e5, and e7 that are measured at the same time.

**CLOG.AVE( )**

Average value

(Syntax) CLOG.AVE(e1-e6)

(Condition) Determines the average value among the data of channels e1 to e6 that are measured at the same time.

**CLOG.P-P( )**

Maximum - minimum value

(Syntax) CLOG.P-P(e1,e2,e5,e7)

(Condition) Determines the difference between the maximum and minimum values among the data of channels e1, e2, e5, and e7 that are measured at the same time.

**Expression Example**

CLOG.MAX(001.002.I04-I06)+K01*SQR(002)

**Examples of Equations That Are Not Allowed**

CLOG.AVE(001.003.005)+CLOG.AVE(002.004.006)
Reason: CLOG appears twice in one equation.

CLOG.AVE(001.ABS(001))
Reason: A computing element is used inside the parentheses.
Special Computation

**PRE( )**
- **(Syntax)** PRE(e1)
- **(Condition)** Determines the previous value of e1.

**HOLD(a):b**
- **(Syntax)** HOLD(a):b
- **(Condition)** When a is zero, b is carried out to derive the computed value. Otherwise, the previous computed value is held.

**RESET(a):b**
- **(Syntax)** RESET(a):b
- **(Condition)** When a is zero, b is carried out to derive the computed value. Otherwise, the previous computed value of b is reset, and b is carried out to derive the computed value.

**CARRY(a):b**
- **(Syntax)** CARRY(a):b
- **(Condition)** Only TLOG.SUM can be specified for b. If the computed value X of b is less than a, the computed result is X. If X is greater than or equal to a, the computed result is the excess (X – a).
- **(Description)** When a value such as the flow rate is summed and the threshold value is reached or exceeded, the sum value is reset while carrying over the amount that exceeded the threshold value.

**Expression Example**
Expression that sums the values of channel 1 and resets the value when it reaches or exceeds 10000
K01 = 10000
CARRY(K01):TLOG.SUM(001)

**Examples of Equations That Are Not Allowed**
002+HOLD(K01):TLOS.SUM(001)
Reason: HOLD is not at the beginning of the expression.
RESET(101.GT.K01):TLOG.SUM(001)+RESET(101.GT.K01):002
Reason: RESET appears twice in one equation.

**Conditional Expression**

**[a?b:c]**
- **(Syntax)** [001.GT.K01?002:003]
- **(Condition)** If the measured value of channel 1 is greater than constant K01, the computed result is the measured value of channel 2. Otherwise, the computed result is the measured value of channel 3.

**Examples of Equations That Are Not Allowed**
[001.GT.K01?002:003]*K02
Reason: Used in combination with another computing element.

**Nested Conditional Expressions**
A conditional expression can be written to Expression1, Expression2, and Expression3 in the equation [Expression1?Expression2:Expression3]. For example, the following expression is allowed: [Equation1?Equation2:Equation3]:[Equation4:Equation3]
Expressions can be nested as long as the number of characters of the expression does not exceed 120 characters.
9.3 Displaying the Computation Channels

Computation channels can be assigned to groups and displayed in a similar manner to measurement channels. For a description of the function, see section 1.8.

**Setup Screen**

- **Color**
  Press **MENU** (to switch to setting mode), and select the **Menu** tab > **Math channel** > **Color**

- **Zone Display and Scale Display**
  Press **MENU** (to switch to setting mode), and select the **Menu** tab > **Math channel** > **Zone, Scale**

- **Bar Graph Display**
  Press **MENU** (to switch to setting mode), and select the **Menu** tab > **Math channel** > **Bar**
9.3 Displaying the Computation Channels

- **Partial Expanded Display**
  Press MENU (to switch to setting mode), and select the Menu tab > Math channel > Partial
  * The Partial command appears in the menu if you set Partial to On in Basic Setting Mode.

- **Alarm Marks**
  Press MENU (to switch to setting mode), and select the Menu tab > Math channel > Alarm mark

- **Color Scale Band**
  Press MENU (to switch to setting mode), and select the Menu tab > Math channel > Color scale band
Setup Items

- **Group of channel, First-CH, and Last-CH**
  Select the target channel range.

- **Color**
  See section 5.5.

- **Zone**
  See section 5.6.

- **Partial**
  See section 5.9.

- **Bar graph**
  See section 5.11.

- **Scale**
  See section 5.7.

- **Alarm mark color and Color scale band**
  See section 5.8.
9.4 Starting/Stopping Computation, Resetting Computation, and Releasing Computation Data
Dropout Display

Setup Screen

- Action Taken When the START Key Is Pressed
  Press MENU (to switch to setting mode), and select the Menu tab > Math channel > Math start action

Setup Items

- Math start action > Math start
  
<table>
<thead>
<tr>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Does not start the computation even when the START key is pressed.</td>
</tr>
<tr>
<td>Start</td>
<td>Starts the computation when the START key is pressed.</td>
</tr>
<tr>
<td>Rst+St</td>
<td>Resets the computed result up to then and starts the computation when the START key is pressed.</td>
</tr>
</tbody>
</table>

Procedure

- Starting the Computation
  - Starting the Computation Simultaneously with the Memory Sampling
    Press START. Computation starts simultaneously with the start of the memory sampling. The computation icon appears in the status display section.
    * Math start must be set to Start or Rst+St.

- Starting Only the Computation
  1. In the operation mode, press FUNC. The FUNC key menu appears.
  2. Press the Math start soft key.
    Computation starts, and the computation icon is displayed in the status display section.
9.4 Starting/Stopping Computation, Resetting Computation, and Releasing Computation Data Dropout Display

- **Stopping the Computation**
- **Stopping the Computation Simultaneously with the Memory Sampling**
  1. Press STOP.
     A confirmation dialog box appears.
  2. Select Mem+Math and press DISP/ENTER.
     The memory sampling and computation stop, and the computation icon in the status display section disappears.

- **Stopping Only the Computation**
  1. In the operation mode, press FUNC.
     The FUNC key menu appears.
  2. Press the Math stop soft key.
     The computation stops, and the computation icon in the status display section disappears.

  **Note**
  When the computation is stopped, the computed data of the computation channel is held at the value that existed immediately before the computation is stopped. When memory sampling is in progress, the held value is recorded.

- **Resetting the Computed Results on All Computation Channels**
  This operation can be carried out when the computation is stopped. You can carry out this operation even while the computation is in progress on DXs with release number 2 or later.
  1. In the operation mode, press FUNC.
     The FUNC key menu appears.
  2. Press the Math reset soft key.
     The computed results of all computation channels are reset.

- **Releasing the Computation Data Dropout Display**
  This operation can be carried out when a computation data dropout occurs. When a computation data dropout occurs, the computation icon turns yellow.
  1. In the operation mode, press FUNC.
     The FUNC key menu appears.
  2. Press the Math ACK soft key.
     The computation icon returns to white.
  
     *Math ACK* is displayed in the FUNC key menu only when a computation data dropout occurs.

  **Note**
  A computation data dropout occurs when the computation process cannot be completed within the scan interval. If computation data dropout occurs frequently, lessen the load on the CPU by reducing the number of computation channels or setting a longer scan interval. If a computation data dropout occurs during memory sampling, the data immediately before the dropout is recorded as the computed data of the scan interval in which the dropout occurred.
9.5 Creating Reports

Set how the reports are created.
For a description of the function, see section 1.8.

Setup Screen

- **Report Computation Type**
  Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic setting mode), and select the Environment tab > Report

- **Report Type and Time of Creation**
  Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic setting mode), and select the Menu tab > Report > Basic settings

- **Source Channels**
  Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic setting mode), and select the Menu tab > Report > Report settings
9.5 Creating Reports

**Setup Items**

- **Report > Report select > 1, 2, 3, and 4**
  Select the type of data to output as reports. The only data type that can be set more than once is Off. You cannot set 1 to Off.

<table>
<thead>
<tr>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Does not output reports.</td>
</tr>
<tr>
<td>Ave</td>
<td>Outputs the average value.</td>
</tr>
<tr>
<td>Max</td>
<td>Outputs the maximum value.</td>
</tr>
<tr>
<td>Min</td>
<td>Outputs the minimum value.</td>
</tr>
<tr>
<td>Sum</td>
<td>Outputs the sum value.</td>
</tr>
<tr>
<td>Inst</td>
<td>Outputs the instantaneous value.</td>
</tr>
</tbody>
</table>

- **Report > File type**
  Set this item when creating two types of reports such as daily report and monthly report.

<table>
<thead>
<tr>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Separate</td>
<td>Saves each type of report to a separate file. For information about how files are divided, see section 1.4.</td>
</tr>
<tr>
<td>Combine</td>
<td>Saves the report data of two types in a single file.</td>
</tr>
<tr>
<td>Seprt2</td>
<td>Saves each type of report to a separate file. For information about how files are divided, see section 1.4, or see section 1.2 in the Advanced Security Function (/AS1) User’s Manual. You cannot select Use Template when Seprt2 is selected.</td>
</tr>
</tbody>
</table>

When you change the setting from Combine or Separate to Seprt2, or vice versa, the report data in the internal memory is cleared.

- **Report > Use Template**
  When you want to use a report template to create reports, select Use. You cannot use this function when Report > File type is set to Seprt2. The setting is fixed at Not.

- **Report set > Report kind**
  Select the type of report to be created.

<table>
<thead>
<tr>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hour</td>
<td>Creates hourly reports.</td>
</tr>
<tr>
<td>Day</td>
<td>Creates daily reports.</td>
</tr>
<tr>
<td>H+D</td>
<td>Creates hourly and daily reports.</td>
</tr>
<tr>
<td>Day+Week</td>
<td>Creates daily and weekly reports.</td>
</tr>
<tr>
<td>D+M</td>
<td>Creates daily and monthly reports.</td>
</tr>
</tbody>
</table>

- **Report set > Date/Day of the week, Time (hour)**
  Set the date or day of the week and the time when the report is to be created. The specified date/time is when the report file is divided. Set the values in the range indicated below. Items with a dash are invalid.

<table>
<thead>
<tr>
<th>Report Type</th>
<th>Date</th>
<th>Day of Week</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hour</td>
<td>-</td>
<td>-</td>
<td>0 to 23</td>
</tr>
<tr>
<td>Day</td>
<td>1 to 28*</td>
<td>-</td>
<td>0 to 23</td>
</tr>
<tr>
<td>H+D</td>
<td>-</td>
<td>-</td>
<td>0 to 23</td>
</tr>
<tr>
<td>Day+Week</td>
<td>-</td>
<td>SUN to SAT</td>
<td>0 to 23</td>
</tr>
<tr>
<td>D+M</td>
<td>1 to 28*</td>
<td>-</td>
<td>0 to 23</td>
</tr>
</tbody>
</table>

* You cannot specify 29, 30, or 31.

**Report Time and Date/Time When the Report File Is Divided**

Example: When the Date of a daily report is set to 1 and the Time (hour) is set to 18:00
A daily report is created every day at hour 18.
The file storing the report is divided at 18:00 on day 1 of each month.
9.5 Creating Reports

- **Report channel number**
  The report is output in order by this number.

- **Report channel number > On/Off**
  Select **On** for the report channels to be used.

- **Report channel number > Channel**
  Set the channel to assign to the report channel. All channels can be assigned, but reports are not created for channels set to **Skip** or **Off** even if they are assigned.
  In the stacked bar graph display (see section 4.10 for details), report data is displayed in the following groups. However, only channels that have the same unit as the first channel in the group are displayed.

<table>
<thead>
<tr>
<th>Number</th>
<th>Report Groups (Fixed)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>R001 to R006</td>
</tr>
<tr>
<td>2</td>
<td>R007 to R012</td>
</tr>
<tr>
<td>3</td>
<td>R013 to R018</td>
</tr>
<tr>
<td>4</td>
<td>R019 to R024</td>
</tr>
</tbody>
</table>

- **Report channel number > Sum scale**
  Set the sum scale to /s to /day to match the unit of the measured value.
  Example: If the unit of the measured value is "m³/min," select /min.
  Off: Sums as-is the measured data per scan interval.

- **Handling of Overflow Data**
  Overflow data is handled in the same way as it is in statistical computations (TLOG and CLOG).
  See section 9.1.

### Procedure

- **Starting/Stopping the Report Function**
  Starting the memory sampling starts the report function. Likewise, stopping the memory sampling stops the report function.

- **Displaying the Reports**
  See section 4.5.

- **Saving the Reports**
  See section 1.4.
9.6 Creating a Report Template (Release numbers 4 and later)

This section explains how to make a report template.
To create a report template, you put keywords and text into cells in Excel.
Keywords specify the data that will be entered into a cell. Other text is included in the report as it is written. Save the report templates that you create in XML spreadsheet format. The report template file name extension is .xml.
For a description of the function, see section 1.8.
For the setting procedure, see section 9.5.
To load or save a report template, see section 6.10.

**Template Example**

<table>
<thead>
<tr>
<th>Channel Number</th>
<th>$\text{Ch(R01)}$</th>
<th>$\text{Ch(R02)}$</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Tank 1 temperature</td>
<td>Tank 1 pressure</td>
</tr>
<tr>
<td>Unit</td>
<td>$\text{Unit(R01)}$</td>
<td>$\text{Unit(R02)}$</td>
</tr>
<tr>
<td>$\text{Repeat}$</td>
<td>$\text{Repeat}$</td>
<td>$\text{Repeat}$</td>
</tr>
</tbody>
</table>

**Report Example**

<table>
<thead>
<tr>
<th>Channel Number</th>
<th>TIC-001</th>
<th>PIC-002</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Tank 1 temperature</td>
<td>Tank 1 pressure</td>
</tr>
<tr>
<td>Unit</td>
<td>°C</td>
<td>kPa</td>
</tr>
<tr>
<td>2010/04/01 00:00:00</td>
<td>76.5</td>
<td>45.6</td>
</tr>
<tr>
<td>2010/04/01 01:00:00</td>
<td>78.9</td>
<td>56.7</td>
</tr>
<tr>
<td>2010/04/01 02:00:00</td>
<td>77.7</td>
<td>50.8</td>
</tr>
</tbody>
</table>
Keywords are written by themselves or with parameters.

\$ Keyword(parameter)\$

Example:

\$ReportDataSum(Hour, R01, 00, 23)\$

### Basic Rules

- The dollar sign on the left indicates the start of a keyword, and the dollar sign on the right indicates the end of a keyword.
- You can only write keywords using letters of the alphabet, dollar signs, parentheses, commas, and spaces. You can put a space after an opening parenthesis, before and after a comma, and before a closing parenthesis. There is no distinction between uppercase and lowercase letters. You cannot use a dollar sign inside of a keyword.
- The maximum length of a keyword, including spaces, is 100 characters.

### Parameter Rules

- Parameters are enclosed in parentheses.
- Multiple parameters (up to 4) are separated by commas.
- Examples of how parameters can be omitted are shown below.

\$ReportDataSum(Hour, R01, ,23)\$
The third parameter is omitted.

\$ReportDataSum(Hour, R01, 01, )$ or

\$ReportDataSum(Hour, R01, 01)\$

### Rules That Relate to Excel

- Set the data format by setting the cell format.
- Set the proper format for each keyword’s cell in the cell’s Number properties.
- The keyword in a cell is only valid when the keyword name and parameters are all in the same format. When a keyword’s font size or some other property is not consistent, it is invalid.

\$ReportDataSum(Hour, R01, 00, 23)\$
The font size of “Hour” is different, so the keyword is invalid.

- When a single cell contains text and a keyword, only the format of the keyword has to be consistent. The format of the text can be different.

\$ReportDataSum(Hour, R01, 00, 23)\$
The format of the keyword is consistent, so it is valid.
Keyword Definitions

For examples of how to use the keywords, see “Report Template Examples.”

- **System Keywords**
  One keyword produces one item of data.

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Description</th>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time</td>
<td>Current time on the DX</td>
<td>Time</td>
</tr>
<tr>
<td>Date</td>
<td>Current date on the DX</td>
<td>Date</td>
</tr>
<tr>
<td>DateTime</td>
<td>Current date and time on the DX</td>
<td>Date</td>
</tr>
<tr>
<td>DateTimeString</td>
<td>Current date and time on the DX</td>
<td>Character string</td>
</tr>
<tr>
<td>Serial</td>
<td>DX serial number</td>
<td></td>
</tr>
<tr>
<td>FileHeader</td>
<td>DX file header</td>
<td></td>
</tr>
<tr>
<td>Ch</td>
<td>Channel number(^1)</td>
<td></td>
</tr>
<tr>
<td>Tag</td>
<td>Tag comments(^1)</td>
<td></td>
</tr>
<tr>
<td>Child</td>
<td>Tag number(^1)</td>
<td></td>
</tr>
<tr>
<td>Unit</td>
<td>Unit(^1)</td>
<td></td>
</tr>
</tbody>
</table>

\(^1\) The parameter is the report channel number (it cannot be omitted).

- **Report Data Keywords**
  One keyword produces multiple items of data.

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Description</th>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>ReportDataDate</td>
<td>Report creation date(^1)</td>
<td>Date</td>
</tr>
<tr>
<td>ReportDataTime</td>
<td>Report creation time(^1)</td>
<td>Time</td>
</tr>
<tr>
<td>ReportDataDateTime</td>
<td>Report creation date and time(^1)</td>
<td>Date</td>
</tr>
<tr>
<td>ReportDataDateTimeString</td>
<td>Report creation date and time(^1)</td>
<td>Character string</td>
</tr>
<tr>
<td>ReportDataStatus</td>
<td>Report data status(^2)</td>
<td>Character string</td>
</tr>
<tr>
<td>ReportDataSum</td>
<td>Report data sum(^2)</td>
<td>Number or character string(^3)</td>
</tr>
<tr>
<td>ReportDataInst</td>
<td>Instantaneous report data value(^2)</td>
<td></td>
</tr>
<tr>
<td>ReportDataAve</td>
<td>Average report data value(^2)</td>
<td></td>
</tr>
<tr>
<td>ReportDataMax</td>
<td>Maximum report data value(^2)</td>
<td></td>
</tr>
<tr>
<td>ReportDataMin</td>
<td>Minimum report data value(^2)</td>
<td></td>
</tr>
</tbody>
</table>

\(^1\) List the parameters in this order: report type (cannot be omitted), report start date and time (can be omitted), report end date and time (can be omitted).

\(^2\) List the parameters in this order: report type (cannot be omitted), report channel number (cannot be omitted), report start date and time (can be omitted), report end date and time (can be omitted).

\(^3\) The decimal point type (dot or comma) depends on whether the converted data is a value or character string.

  Whether the converted data is a value or character string depends on the format of the cell that the keyword is written in. When the cell format is numerical, the decimal point type is determined by the cell format. When the cell format is text, the decimal point type matches the format of the report data.

- **Special Keywords**

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Description</th>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Repeat</td>
<td>Specifies the output location of the data that</td>
<td>The same as the corresponding</td>
</tr>
<tr>
<td></td>
<td>corresponds to a report data keyword.</td>
<td>keyword.</td>
</tr>
<tr>
<td>Comment</td>
<td>Adds comments to the template. Nothing is</td>
<td>–</td>
</tr>
<tr>
<td></td>
<td>displayed after template conversion.</td>
<td></td>
</tr>
</tbody>
</table>
### 9.6 Creating a Report Template (Release numbers 4 and later)

#### Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Format</th>
<th>Range</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report kind</td>
<td>Hour</td>
<td>Hourly report</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Day</td>
<td>Daily report</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Week</td>
<td>Weekly report</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Month</td>
<td>Monthly report</td>
<td></td>
</tr>
<tr>
<td>Report channel number</td>
<td>Rx (xx are numerals)</td>
<td>R01 to R60 (varies by model)</td>
<td>DX report channel</td>
</tr>
<tr>
<td>Start date or time</td>
<td>xx</td>
<td>00 to 23</td>
<td>Specifies the start time</td>
</tr>
<tr>
<td>End date or time</td>
<td>xx</td>
<td>00 to 23</td>
<td>Specifies the end time</td>
</tr>
</tbody>
</table>

#### Starting and Ending Dates and Times

Use the start date and time and end date and time to specify the parts of the report file's report data that you will output to the file that you create with the template. You can specify the starting and ending dates (for daily reports) or times (for hourly reports).

Example when the report type is hourly and the report was created at 18:00.

Keyword: `$ReportDataSum(Hour,R01,20,22)$`
From the hourly data from 19:00:01 to 22:00:00, the report data (sums) of report channel R01 for 20:00, 21:00, and 22:00 is output.

Keyword: `$ReportDataSum(Hour,R01,16,19)$`
From the hourly data from 15:00:01 to 19:00:00, the report data (sums) of report channel R01 for 16:00, 17:00, and 18:00 is output. Because the report data for 19:00 is in another report file, it is not output.

Keyword: `$ReportDataSum(Hour,R01)$`
One file's worth (18:00:01 to 18:00:00) of data from report channel R01 is output, starting from 19:00.
When you omit the start and end times for an hourly report, the data for the hour after the report creation time until the 24th hour is output. For daily reports, the data for the day after the report creation time until the end of the month is output.

Keyword: `$ReportDataSum(Hour,R01,08)$`
From the hourly data from 07:00:01 to 18:00:00, the report data (sums) of report channel R01 for 08:00 to 18:00 is output.
Report Template Examples

- System Keyword Examples
  Mixing a keyword and text
  
  | File header: $FileHeader$ |  |
  | Date and time: $DateTime$ |  |
  | File header: DX2000 |  |
  | Date and time: 2010/01/01 12:00:00 |  |

  Mixing multiple keywords and text
  
  | Device number: $Serial$ File Header: $FileHeader$ |  |
  | Device number: ABCDEFG File Header: DX2000 |  |

- Report Data Keyword Examples
  The following examples are for when the hourly report data for report channel R01 is 101, 102, 103, 104, and 105 and the hourly report data for report channel R02 is 201, 202, 203, 204, 205, and 206.

  The $Repeat$ command applies to the closest keyword above the command in the same column.

  | $ReportDataInst(Hour,R01)$ | 101 |
  | $Repeat$ | 102 |
  | $Repeat$ | 103 |
  | $Repeat$ | 104 |
  | $ReportDataInst(Hour,R02)$ | 201 |
  | $Repeat$ | 202 |
  | $Repeat$ | 203 |
  | $Repeat$ | 204 |
  | $Repeat$ | 205 |

  The $Repeat$ command applies to the keyword above it in the same column, even when that keyword is not directly above the command.

  | $ReportDataInst(Hour,R01)$ | 101 | °C |
  | $Repeat$ | 102 | °C |
  | $Repeat$ | 103 | °C |
  | $Repeat$ | 104 | °C |

  You can mix system keywords, report data keywords, and text. If the data specified by a keyword does not exist, nothing is output.

  | $ReportDataInst(Hour,R01)$($Unit(R01)$) | 101(°C) |
  | $Repeat$ | 102 |
  | $Repeat$ | 103 |
  | $Repeat$ | 104(°C) |
  | $Repeat$ | 105(°C) |
Keywords in merged cells are affected by the leftmost cells above them.

When a keyword is written incorrectly or its formatting is wrong, the keyword will be output to the file as it is written.

*1 When there are multiple system keywords in the same cell, only the first keyword is valid.
There are cases in which error codes and messages are displayed on the screen during operation. A list of the possible error codes and messages are given in the table below. Communication error codes and messages are also listed. Error responses to communication commands are output in English.

### 10.1 A List of Messages

#### Errors Related to Parameter Settings

- **Setting Errors**

<table>
<thead>
<tr>
<th>Code</th>
<th>Message</th>
<th>Explanation/Countermeasures/Ref. section</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>System error.</td>
<td>Contact your nearest YOKOGAWA dealer.</td>
</tr>
<tr>
<td>2</td>
<td>Incorrect date or time setting.</td>
<td>Enter a correct value.</td>
</tr>
<tr>
<td>3</td>
<td>A disabled channel is selected.</td>
<td>Specify a channel that is not set to Skip or Off.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Specify a channel that is installed.</td>
</tr>
<tr>
<td>4</td>
<td>Incorrect function parameter.</td>
<td>See chapter 3 the communication manual.</td>
</tr>
<tr>
<td>5</td>
<td>The input numerical value exceeds the set range.</td>
<td>Enter a proper value.</td>
</tr>
<tr>
<td>6</td>
<td>Incorrect input character string.</td>
<td>Enter a proper character string.</td>
</tr>
<tr>
<td>7</td>
<td>Too many characters.</td>
<td>Enter the correct number of characters.</td>
</tr>
<tr>
<td>8</td>
<td>Incorrect input mode.</td>
<td>Specify a correct mode.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See section 3.3.</td>
</tr>
<tr>
<td>9</td>
<td>Incorrect input range code.</td>
<td>Specify a correct range code.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See section 3.3.</td>
</tr>
<tr>
<td>11</td>
<td>Range settings are not same within the selected channels.</td>
<td>Specify channels with the same range setting.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See section 3.9.</td>
</tr>
<tr>
<td>12</td>
<td>A disabled batch group is selected.</td>
<td>Set the last batch group greater than the first batch group.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See section 2.2 in IM04L41B01-03E.</td>
</tr>
<tr>
<td>13</td>
<td>Cannot set a trip line for a display group that is OFF.</td>
<td>Check the display group settings.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See section 5.1 and section 2.2 in IM04L41B01-03E.</td>
</tr>
<tr>
<td>21</td>
<td>Cannot set an alarm for a skipped channel.</td>
<td>Cannot be specified on channels set to Skip.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See sections 3.3 and 5.9.</td>
</tr>
<tr>
<td>22</td>
<td>The upper and lower span limits are equal.</td>
<td>Cannot be set to the same value.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See section 3.3.</td>
</tr>
<tr>
<td>23</td>
<td>The upper and lower scale limits are equal.</td>
<td>Cannot be set to the same value.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See section 3.3.</td>
</tr>
<tr>
<td>24</td>
<td>The lower limit of the span band is greater than the upper limit.</td>
<td>Set the lower limit less than the upper limit.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See section 3.3.</td>
</tr>
<tr>
<td>25</td>
<td>The lower limit of the scale band is greater than the upper limit.</td>
<td>Set the lower limit less than the upper limit.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See section 3.3.</td>
</tr>
<tr>
<td>30</td>
<td>The partial boundary value exceeds the range of the span.</td>
<td>Set the boundary value in the range of “the minimum span value + 1 digit” to “the maximum span value – 1 digit.”</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See section 5.9.</td>
</tr>
<tr>
<td>31</td>
<td>Partial-expansion display is set ON for a SKIPPED channel.</td>
<td>Cannot be specified on channels set to Skip.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See sections 3.3 and 5.9.</td>
</tr>
<tr>
<td>35</td>
<td>The upper and lower limits of the display band are equal.</td>
<td>Set the upper limit greater than the lower limit + 5.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See section 5.6.</td>
</tr>
<tr>
<td>36</td>
<td>The lower limit of the display band is greater than the upper limit.</td>
<td>Set the upper limit greater than the lower limit + 5.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See section 5.6.</td>
</tr>
<tr>
<td>37</td>
<td>The display band is narrower than 4% of the entire display.</td>
<td>Set the upper limit greater than the lower limit + 5.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See section 5.6.</td>
</tr>
<tr>
<td>40</td>
<td>Incorrect group set character string.</td>
<td>Check the syntax.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See section 5.1.</td>
</tr>
<tr>
<td>41</td>
<td>There is no specified input channel.</td>
<td>Specify a channel that is installed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Operation Guide and section 5.1.</td>
</tr>
<tr>
<td>42</td>
<td>Exceeded the number of channels which can be set.</td>
<td>Up to 6 channels per group.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See section 5.1.</td>
</tr>
<tr>
<td>Code</td>
<td>Message</td>
<td>Explanation/Countermeasures/Ref. section</td>
</tr>
<tr>
<td>------</td>
<td>---------</td>
<td>----------------------------------------</td>
</tr>
<tr>
<td>43</td>
<td>A channel number cannot repeat in a group.</td>
<td>Check that a channel is not registered twice. See section 5.1.</td>
</tr>
<tr>
<td>45</td>
<td>There is no character string saved in the clipboard.</td>
<td>Copy a character string to the clipboard.</td>
</tr>
<tr>
<td>46</td>
<td>The character string saved in the clipboard is too long.</td>
<td>Paste a character string with the specified number of characters.</td>
</tr>
<tr>
<td>47</td>
<td>Start and end time cannot match.</td>
<td>Check the starting and ending times. See section 2.1.</td>
</tr>
<tr>
<td>48</td>
<td>Invalid or missing DST time settings.</td>
<td>Check the starting and ending times. See section 2.1.</td>
</tr>
<tr>
<td>61</td>
<td>There is no channel specified by the MATH expression.</td>
<td>Check the channel number specified by the expression. See sections 1.8 and 9.1.</td>
</tr>
<tr>
<td>62</td>
<td>MATH expression grammar is incorrect.</td>
<td>Check that the expression grammar is correct. See section 9.2.</td>
</tr>
<tr>
<td>63</td>
<td>MATH expression sequence is incorrect.</td>
<td>Check that the operator used in the expression in relation to the applicable operands meets the grammar requirements. See section 9.2.</td>
</tr>
<tr>
<td>64</td>
<td>MATH upper and lower span values are equal.</td>
<td>Set the upper limit not equal to the lower limit. See section 9.1.</td>
</tr>
<tr>
<td>65</td>
<td>Too many operators for MATH expression.</td>
<td>The maximum number of operators in an expression has been exceeded. Reduce the number of operators, such as by splitting up the expression into multiple computation channels. See section 9.2.</td>
</tr>
<tr>
<td>70</td>
<td>Nonexistent constant specified in MATH expression.</td>
<td>Check the constant number specified by the expression. See section 9.1.</td>
</tr>
<tr>
<td>71</td>
<td>Set range of the MATH constant is exceeded.</td>
<td>Check the selectable range. See section 9.1.</td>
</tr>
<tr>
<td>80</td>
<td>This username is already registered.</td>
<td>Register another user name. See section 8.2.</td>
</tr>
<tr>
<td>81</td>
<td>All space or ‘quit’ string cannot be specified.</td>
<td>Change the character string. See section 8.2.</td>
</tr>
<tr>
<td>83</td>
<td>This user ID and password combination is already in use.</td>
<td>Change the user ID or the password. See section 2.1 in the advanced security manual.</td>
</tr>
<tr>
<td>84</td>
<td>The login password has not been set up.</td>
<td>Set a password. See section 8.2.</td>
</tr>
<tr>
<td>85</td>
<td>The login password is incorrect.</td>
<td>Check the password. If you lost the password, ask your administrator to reset it. See sections 8.2 and 8.3.</td>
</tr>
<tr>
<td>86</td>
<td>The key-lock release password is incorrect.</td>
<td>Check the password. If you lost the password, it must be reset. See section 8.1.</td>
</tr>
<tr>
<td>87</td>
<td>This key is locked.</td>
<td>Release the key lock. See section 8.1.</td>
</tr>
<tr>
<td>88</td>
<td>This function is locked.</td>
<td>Release the key lock. See section 8.1.</td>
</tr>
<tr>
<td>89</td>
<td>Press [FUNC] key to login.</td>
<td>Log in. See section 8.3.</td>
</tr>
<tr>
<td>90</td>
<td>No permission to enter to the SETUP mode.</td>
<td>Check the keylock or login settings. See sections 8.2 and 8.3.</td>
</tr>
<tr>
<td>91</td>
<td>Password is incorrect.</td>
<td>Enter the correct password. If you lost the password, it must be reset. See sections 8.2 and 8.3.</td>
</tr>
<tr>
<td>92</td>
<td>Press [ESC] key to change to the operation mode.</td>
<td>Press the ESC key.</td>
</tr>
<tr>
<td>93</td>
<td>String including space or all space cannot be specified.</td>
<td>Spaces are not allowed in the Web browser user name and password. See section 1.5 in the communication manual.</td>
</tr>
<tr>
<td>94</td>
<td>More than one address cannot be specified.</td>
<td>Only a single sender is allowed. See section 1.4 in the communication manual.</td>
</tr>
</tbody>
</table>
| 95   | Number entered exceeds channel number range. Use another command. | Check the syntax of the Modbus command. See sections 1.10 and 2.6 in the communication manual.
## 10.1 A List of Messages

<table>
<thead>
<tr>
<th>Code</th>
<th>Message</th>
<th>Explanation/Countermeasures/Ref. section</th>
</tr>
</thead>
<tbody>
<tr>
<td>96</td>
<td>This menu is locked.</td>
<td>Check the key lock setting. Release the key lock. See section 8.1.</td>
</tr>
<tr>
<td>97</td>
<td>This function is locked.</td>
<td>To use the function, login as a user who has permission to use it. See section 8.2 in the advanced security manual.</td>
</tr>
<tr>
<td>100</td>
<td>IP address doesn’t belong to class A, B, or C.</td>
<td>Check the IP address. See section 1.3 in the communication manual.</td>
</tr>
<tr>
<td>101</td>
<td>The result of the masked IP address is all 0s or 1s.</td>
<td>Check the subnet mask. See section 1.3 in the communication manual.</td>
</tr>
<tr>
<td>102</td>
<td>SUBNET mask is incorrect.</td>
<td>Check the subnet mask. See section 1.3 in the communication manual.</td>
</tr>
<tr>
<td>103</td>
<td>The net part of default gateway is not equal to that of IP address.</td>
<td>Check the IP address. See section 1.3 in the communication manual.</td>
</tr>
<tr>
<td>105</td>
<td>This port number is already in use. Please enter a different number.</td>
<td>Enter a different port number for each function. See section 6.1 in the communication manual.</td>
</tr>
<tr>
<td>110</td>
<td>This user name is not registered.</td>
<td>Log in as a registered user. See section 8.2 and section 2.1 in the advanced security manual.</td>
</tr>
<tr>
<td>111</td>
<td>The login user ID is incorrect.</td>
<td>Enter the correct user ID. See the advanced security manual.</td>
</tr>
<tr>
<td>112</td>
<td>Password must use more than 6 alphanumeric characters.</td>
<td>The password must be between 6 and 20 characters in length. See section 2.1 in the advanced security manual.</td>
</tr>
<tr>
<td>113</td>
<td>Password entered is incorrect.</td>
<td>Enter the correct password. See section 8.3 and section 2.2 in the advanced security manual.</td>
</tr>
<tr>
<td>114</td>
<td>This user name is invalid.</td>
<td>Have a system administrator clear the “invalid user” status. See the advanced security manual.</td>
</tr>
<tr>
<td>116</td>
<td>This user name cannot be specified.</td>
<td>The user name is reserved. See section 8.2 and the advanced security manual.</td>
</tr>
<tr>
<td>117</td>
<td>This password is not effective.</td>
<td>Because the wrong password has been entered consecutively for more than the permissible number of times, this user is invalid. Have an administrator clear the “invalid user” status. See section 2.2 in the advanced security manual.</td>
</tr>
<tr>
<td>119</td>
<td>This user name is unable to use this mode.</td>
<td>A user-level user cannot enter the Basic Setting mode. See section 8.2.</td>
</tr>
<tr>
<td>120</td>
<td>Measured value is incorrect. (in ascending order)</td>
<td>Set the calibration correction value to a value greater than the previous value. See section 3.9.</td>
</tr>
<tr>
<td>121</td>
<td>A user is already logged in.</td>
<td>Another user has logged in with the same name or is logging in. See section 1.3 in the advanced security manual.</td>
</tr>
<tr>
<td>122</td>
<td>Measured value exceeds the range setting.</td>
<td>Check the channel input or the channel range setting. See sections 3.3 and 3.9.</td>
</tr>
<tr>
<td>124</td>
<td>Password entry cannot be performed.</td>
<td>You cannot use bar codes to enter a password. See section 2.9 in the advanced security manual.</td>
</tr>
<tr>
<td>125</td>
<td>Character entry cannot be performed.</td>
<td>The DX is not showing a display used to enter character strings. See section 2.11.</td>
</tr>
<tr>
<td>126</td>
<td>You cannot use the same password.</td>
<td>Specify a different password. See section 8.3.</td>
</tr>
<tr>
<td>127</td>
<td>Report kind overlaps and cannot be set up.</td>
<td>Change the overlapped report data type. See section 9.5.</td>
</tr>
<tr>
<td>128</td>
<td>“Logout” cannot be set to “Hide”.</td>
<td>See sections 5.17 and 8.3.</td>
</tr>
<tr>
<td>129</td>
<td>IP address is not set.</td>
<td>Set the IP address of the DX. See section 1.3 in the communication manual.</td>
</tr>
<tr>
<td>131</td>
<td>You have exceeded the available channel capacity.</td>
<td>You cannot connect more than 240 channels. See section 1.10 in the communication manual.</td>
</tr>
</tbody>
</table>
### 10.1 A List of Messages

<table>
<thead>
<tr>
<th>Code</th>
<th>Message</th>
<th>Explanation/Countermeasures/Ref. section</th>
</tr>
</thead>
<tbody>
<tr>
<td>132</td>
<td>You have exceeded the available number of commands.</td>
<td>The maximum number of commands that can be sent is 16. The modules that can be set with a single command are consecutive modules that can be automatically set. Change the MW100 module configuration so that there are no empty slots. See section 1.10 in the communication manual.</td>
</tr>
<tr>
<td>133</td>
<td>External I/O auto setting information is not available.</td>
<td>Below are the possible causes. Check them. • The MW100 is in calibration mode. Change to the setting mode or measurement mode. • The measurement module may not have been detected. Perform system reconfiguration. • There are no modules that can be automatically set. Check the modules. • An IP address has not been assigned to the MW100. Set the IP address. • The Modbus server of the MW100 is turned OFF. Turn ON the server. See section 1.10 in the communication manual.</td>
</tr>
<tr>
<td>134</td>
<td>Auto setting has already been executed.</td>
<td>You cannot set an MW100 that has been automatically set. See section 1.10 in the communication manual.</td>
</tr>
<tr>
<td>135</td>
<td>External I/O cannot be found.</td>
<td>Check the Ethernet connection. See section 1.3 in the communication manual.</td>
</tr>
<tr>
<td>136</td>
<td>External I/O start cannot be executed.</td>
<td>The current MW100 settings do not allow the measurement to be started. Check the settings. See section 1.3 in the communication manual.</td>
</tr>
<tr>
<td>137</td>
<td>DNS for this device is not set.</td>
<td>Set the DNS of the DX. See section 1.3 in the communication manual.</td>
</tr>
<tr>
<td>138</td>
<td>Cannot create object. The maximum allowed number was exceeded.</td>
<td>This occurs when the custom display is generated. See section 2.2 in IM04L41B01-04E.</td>
</tr>
<tr>
<td>139</td>
<td>This dependency is not possible.</td>
<td>This occurs when the custom display is generated. See section 1.10 in IM04L41B01-04E.</td>
</tr>
<tr>
<td>140</td>
<td>You cannot set this while you are logged in.</td>
<td>You cannot change the registered settings of a user that is logged in. See the advanced security manual.</td>
</tr>
<tr>
<td>141</td>
<td>You cannot set multiple channels.</td>
<td>During memory sampling, you cannot configure settings for multiple consecutive channels at the same time. See section 1.5 in the advanced security manual.</td>
</tr>
<tr>
<td>142</td>
<td>Another user is configuring settings.</td>
<td>You can perform operations after the user who is in setting mode or basic setting mode logs out or returns to operation mode. See the section 1.3 in advanced security manual.</td>
</tr>
</tbody>
</table>
### Execution Errors

<table>
<thead>
<tr>
<th>Code</th>
<th>Message</th>
<th>Explanation/Countermeasures/Ref. section</th>
</tr>
</thead>
<tbody>
<tr>
<td>150</td>
<td>This action is not possible because sampling is in progress.</td>
<td>Stop the memory sampling and then execute. See section 6.4.</td>
</tr>
<tr>
<td>151</td>
<td>This action is not possible during sampling or calculating.</td>
<td>Stop the memory sampling and then execute. See sections 6.4 and 9.4.</td>
</tr>
<tr>
<td>152</td>
<td>This action is not possible because saving is in progress.</td>
<td>Wait until the saving is complete.</td>
</tr>
<tr>
<td>153</td>
<td>This action is not possible because formatting is in progress.</td>
<td>Wait until the formatting is complete.</td>
</tr>
<tr>
<td>154</td>
<td>Message not accepted because message limit was reached.</td>
<td>The limit is 50 messages.                 See section 5.4.</td>
</tr>
<tr>
<td>155</td>
<td>The message is not written because sampling is stopped.</td>
<td>Start the memory sampling and then execute. See section 6.4.</td>
</tr>
<tr>
<td>156</td>
<td>There are no channels to be saved to the memory.</td>
<td>Set the channels to be saved.             See sections 6.1 and 9.1.</td>
</tr>
<tr>
<td>157</td>
<td>This function is not possible at this time.</td>
<td>Check the DX status.</td>
</tr>
<tr>
<td>158</td>
<td>Exceeds time deviation setting.</td>
<td>When synchronizing the clock through remote control. See section 2.3.</td>
</tr>
<tr>
<td>159</td>
<td>It is outside the postscript message write-in range.</td>
<td>Add message can be written to the past section of the data being memory sampled. See section 5.4.</td>
</tr>
<tr>
<td>162</td>
<td>Data storage is already started.</td>
<td>Memory sampling is in progress on the batch group. See section 3.2 in IM04L41B01-03E.</td>
</tr>
<tr>
<td>163</td>
<td>Data storage is already stopped.</td>
<td>Memory sampling on the batch group has already been stopped. See IM04L41B01-03E.</td>
</tr>
<tr>
<td>164</td>
<td>This action is not possible because there is a bar code data error.</td>
<td>Check the text that the barcode reader scanned. See section 2.11.</td>
</tr>
<tr>
<td>170</td>
<td>End process can’t proceed, because setting file is not saved to Media.</td>
<td>When you switch from setting mode to operation mode or basic setting mode, the DX automatically saves the changed settings to the CF card. This message appears when the DX cannot save the changed settings. Check the CF card. See section 1.5 in the advanced security manual.</td>
</tr>
<tr>
<td>173</td>
<td>Data save is not possible because of insufficient media capacity.</td>
<td>Change the external storage medium.</td>
</tr>
<tr>
<td>174</td>
<td>Cannot execute because of failure to save unsaved setting file.</td>
<td>The DX cannot save an unsaved setting file to the CF card. Check the CF card. See the advanced security manual.</td>
</tr>
<tr>
<td>175</td>
<td>The calibration due date has not been set properly.</td>
<td>Check the year, month, and day of the calibration due date. See section 3.13</td>
</tr>
<tr>
<td>700</td>
<td>The specified command does not exist.</td>
<td>The command specified from the custom display is not registered. Register commands whose command type is “E-M,” and specify the numbers of those commands in the custom display. See section 1.10 in the communication manual. See section 2.32 in IM04L41B01-04E.</td>
</tr>
<tr>
<td>701</td>
<td>Saving data.</td>
<td>The previous transmission is not finished. See section 1.10 in the communication manual.</td>
</tr>
<tr>
<td>702</td>
<td>Failed to save data.</td>
<td>Check for communication errors or Modbus server errors. See section 1.10 in the communication manual.</td>
</tr>
<tr>
<td>760</td>
<td>Cannot find KDC server.</td>
<td>The KDC server cannot be found in the same domain. See section 1.14 in the communication manual.</td>
</tr>
<tr>
<td>761</td>
<td>KDC server connection error.</td>
<td>An error occurred while the DX was connecting to the KDC server. See section 1.14 in the communication manual.</td>
</tr>
<tr>
<td>764</td>
<td>Not supported by this machine.</td>
<td>Not supported by the DX.                  See section 1.14 in the communication manual.</td>
</tr>
<tr>
<td>765</td>
<td>Preauthentication failed.</td>
<td>Preauthentication failed. Check the information that you entered.</td>
</tr>
</tbody>
</table>
## 10.1 A List of Messages

<table>
<thead>
<tr>
<th>Code</th>
<th>Message</th>
<th>Explanation/Countermeasures/Ref. section</th>
</tr>
</thead>
<tbody>
<tr>
<td>766</td>
<td>The encryption type is not supported by this machine.</td>
<td>Use the same encryption method on the DX and the server.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See section 1.14 in the communication manual.</td>
</tr>
<tr>
<td>767</td>
<td>Failed to receive authentication from KDC server.</td>
<td>Check the DX and server settings.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See section 1.14 in the communication manual.</td>
</tr>
<tr>
<td>768</td>
<td>Change the password.</td>
<td>The password has expired.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See section 1.14 in the communication manual.</td>
</tr>
<tr>
<td>769</td>
<td>The time difference with the KDC server exceeds the limit.</td>
<td>There is a time difference of 5 minutes or more between the DX and the server. Eliminate this time difference.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See section 1.14 in the communication manual.</td>
</tr>
<tr>
<td>771</td>
<td>The host principal is not registered.</td>
<td>The DX account is not registered on the server.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See section 1.14 in the communication manual.</td>
</tr>
<tr>
<td>772</td>
<td>The host principal is invalid.</td>
<td>Check the DX account that is registered on the server.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See section 1.14 in the communication manual.</td>
</tr>
<tr>
<td>773</td>
<td>The host password is incorrect.</td>
<td>Make sure that the password set on the DX matches the server password.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See section 1.14 in the communication manual.</td>
</tr>
<tr>
<td>774</td>
<td>Preauthentication failed.</td>
<td>An internal error occurred during preauthentication.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Disable the server’s preauthentication function.</td>
</tr>
<tr>
<td>775</td>
<td>The realm is incorrect.</td>
<td>Set the correct realm name on the DX.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See section 1.14 in the communication manual.</td>
</tr>
<tr>
<td>Code</td>
<td>Message</td>
<td>Explanation/Countermeasures/Ref. section</td>
</tr>
<tr>
<td>------</td>
<td>--------------------------------------------------------------</td>
<td>----------------------------------------</td>
</tr>
<tr>
<td>200</td>
<td>Operation aborted because an error was found in media.</td>
<td>Use another storage medium or format it. See section 6.7.</td>
</tr>
<tr>
<td>201</td>
<td>Not enough free space on media.</td>
<td>There is not enough free space on media or the number of directories exceeded the limit. Use another storage medium. See section 1.4.</td>
</tr>
<tr>
<td>202</td>
<td>Media is read-only.</td>
<td>Make it writable.</td>
</tr>
<tr>
<td>210</td>
<td>Media has not been inserted.</td>
<td>Insert a storage medium into the drive.</td>
</tr>
<tr>
<td>211</td>
<td>Media is damaged or not formatted.</td>
<td>Remove the medium and set it again. If an error still occurs, replace or format the medium. See section 6.7.</td>
</tr>
<tr>
<td>212</td>
<td>Format error.</td>
<td>Try formatting again.                  See section 6.7.</td>
</tr>
<tr>
<td>213</td>
<td>The file is read-only.</td>
<td>Access another file or make the file writable.</td>
</tr>
<tr>
<td>214</td>
<td>There is no file or directory.</td>
<td>Specified a file in which data is being added. Tried to save a file which does not exists in the internal memory.</td>
</tr>
<tr>
<td>215</td>
<td>Exceeded the allowable number of directories or files.</td>
<td>Replace a storage medium. Delete unneeded files and directories. See section 6.7.</td>
</tr>
<tr>
<td>216</td>
<td>The file or directory name is incorrect.</td>
<td>Use alphanumeric characters and symbols. See section 6.2.</td>
</tr>
<tr>
<td>217</td>
<td>Unknown file type.</td>
<td>Check the extension.                   See section Appendix 2.</td>
</tr>
<tr>
<td>218</td>
<td>This directory or file now exists. Delete it or change the name.</td>
<td>See section 6.2.</td>
</tr>
<tr>
<td>219</td>
<td>Invalid file or directory operation.</td>
<td>Tried to delete multiple directory levels. Or, tried to delete a directory containing files. Delete the files and directories in the directory first before executing the operation. See section 6.7.</td>
</tr>
<tr>
<td>220</td>
<td>The file is already in use. Try again later.</td>
<td>Wait until the file is accessible.</td>
</tr>
<tr>
<td>221</td>
<td>This action is not possible because FTP transmission is in progress.</td>
<td>Execute after FTP data transfer is complete.</td>
</tr>
<tr>
<td>222</td>
<td>Media is not recognized.</td>
<td>Remove and reset the storage medium.</td>
</tr>
<tr>
<td>231</td>
<td>Abnormal setting exists in file.</td>
<td>Specify another file.</td>
</tr>
<tr>
<td>232</td>
<td>There is no available data.</td>
<td>Appears when displaying historical trends. Specify another file.</td>
</tr>
<tr>
<td>233</td>
<td>The specified historical data do not exist.</td>
<td>Appears when switching to historical trend from information display. See section 4.5.</td>
</tr>
<tr>
<td>234</td>
<td>The specified channel is not assigned to the display group.</td>
<td>Appears when switching to trend, digital, or bar graph from overview. See sections 4.4 and 7.6.</td>
</tr>
<tr>
<td>235</td>
<td>There is no data for the chosen date.</td>
<td>Select a day of the month that has “E” or “D” displayed. See section 4.3.</td>
</tr>
<tr>
<td>236</td>
<td>There is no data after the selected time for this day.</td>
<td>Select an earlier time.                Section 4.3.</td>
</tr>
<tr>
<td>237</td>
<td>The specified screen cannot be displayed</td>
<td>The DX display mode and the Web display mode are different, or a display group that does not exist has been specified from the Web. See IM04L41B01-03E.</td>
</tr>
<tr>
<td>240</td>
<td>You cannot sign this record because a signature is already present.</td>
<td>You cannot overwrite a signature. See section 1.6 in the advanced security manual.</td>
</tr>
<tr>
<td>245</td>
<td>This function cannot be used in the historical trend display.</td>
<td>Close the historical trend display.</td>
</tr>
<tr>
<td>246</td>
<td>This function cannot be used due to no data file saved in media.</td>
<td>Insert a storage medium. Make sure that the storage medium is formatted.</td>
</tr>
<tr>
<td>247</td>
<td>This function cannot be used in setting mode.</td>
<td>Exit setting mode.</td>
</tr>
<tr>
<td>249</td>
<td>You cannot sign, because some batch data is missing.</td>
<td>When the process type is batch, you cannot use the DX to sign the measured data unless everything from the start to the stop of measurement is contained in a single file. Use DAQSTANDARD to sign the data. See the advanced security manual.</td>
</tr>
</tbody>
</table>
## 10.1 A List of Messages

<table>
<thead>
<tr>
<th>Code</th>
<th>Message</th>
<th>Explanation/Countermeasures/Ref. section</th>
</tr>
</thead>
<tbody>
<tr>
<td>250</td>
<td>Failed to load template file.</td>
<td>The template file that you attempted to load is 400 KB or larger. Load a template file that is smaller than 400 KB.</td>
</tr>
<tr>
<td>251</td>
<td>There is no template file.</td>
<td>There is no template file in the internal memory. Load a template file.</td>
</tr>
<tr>
<td>252</td>
<td>The template file is incorrect.</td>
<td>Check the template file format.</td>
</tr>
<tr>
<td>Communication Application Errors</td>
<td>Errors Related to E-mail and Web Server</td>
<td></td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>----------------------------------------</td>
<td></td>
</tr>
<tr>
<td>260 IP address is not set or ethernet function is not available.</td>
<td>The IP address is not specified. Check the IP address. See section 1.3 in the communication manual.</td>
<td></td>
</tr>
<tr>
<td>261 SMTP server is not found.</td>
<td>Occurs when the SMTP server is specified by name. • Check the DNS setting. • Check the SMTP server name. See sections 1.3 and 1.4 in the communication manual.</td>
<td></td>
</tr>
<tr>
<td>262 Cannot initiate E-mail transmission.</td>
<td>• The host name of the DX is not correct. Check the host name. • The port number of the SMTP server is not correct. Check the port number. See sections 1.3 and 1.4 in the communication manual.</td>
<td></td>
</tr>
<tr>
<td>263 Sender's address rejected by the server.</td>
<td>Check the sender's address. Section 1.4 in the communication manual</td>
<td></td>
</tr>
<tr>
<td>264 Some recipients' addresses are invalid.</td>
<td>Check the recipients' addresses. See section 1.4 in the communication manual.</td>
<td></td>
</tr>
<tr>
<td>265 SMTP protocol error.</td>
<td>May occur if a network failure (cable problems, duplicate addresses, network device failure, and so on) occurs in the middle of the e-mail transmission.</td>
<td></td>
</tr>
<tr>
<td>266 Ethernet cable is not connected.</td>
<td>Check the cable connection. See section 1.3 in the communication manual.</td>
<td></td>
</tr>
<tr>
<td>267 Could not connect to SMTP server.</td>
<td>• Check to see that the SMTP server is connected to the network. • If the SMTP server name is specified using an IP address, check to see that the IP address is correct. See section 1.4 in the communication manual.</td>
<td></td>
</tr>
<tr>
<td>268 E-mail transmission request failed.</td>
<td>Contact your nearest YOKOGAWA dealer.</td>
<td></td>
</tr>
<tr>
<td>269 E-mail transfer error.</td>
<td>May occur if a network failure (cable problems, duplicate addresses, network device failure, and so on) occurs in the middle of the e-mail transmission.</td>
<td></td>
</tr>
<tr>
<td>270 Could not connect to POP3 server</td>
<td>Check the connection settings. See section 1.4 in the communication manual.</td>
<td></td>
</tr>
<tr>
<td>271 Not able to login to the POP3 server.</td>
<td>Check the login name and the password. See section 1.4 in the communication manual.</td>
<td></td>
</tr>
<tr>
<td>272 SMTP authentication failed.</td>
<td>Make sure that the user name and password that you are using for authentication are recognized by the server. See section 1.4 in the communication manual.</td>
<td></td>
</tr>
<tr>
<td>273 The server requested an unsupported authentication method.</td>
<td>Change the server configuration. See section 1.4 in the communication manual.</td>
<td></td>
</tr>
<tr>
<td>275 The current image cannot be output to the Web.</td>
<td>The setup display cannot be output to the Web browser. This message is displayed on the Web browser.</td>
<td></td>
</tr>
<tr>
<td>276 Image data currently being created. Unable to perform key operation.</td>
<td>Try again a little later. This message is displayed on the Web browser.</td>
<td></td>
</tr>
<tr>
<td>277 Could not output screen to Web.</td>
<td>Failed to create the image. This message is displayed on the Web browser.</td>
<td></td>
</tr>
<tr>
<td>278 Web control denied because a user has control.</td>
<td>You cannot control the DX from a browser when: • There is a user who is logging in or who has logged into the DX through key operations. • There is a user who has logged into the DX through communication commands. See section 1.5 in the communication manual.</td>
<td></td>
</tr>
</tbody>
</table>
10.1 A List of Messages

• Errors Related to FTP Client

For a description of the FTP client function of the DX, see the Communication Interface User’s Manual (IM 04L41B01-17E). The detail code does not appear in the error message on the screen. You can view the code on the FTP log display of the DX or using the FTP log output via communications.

<table>
<thead>
<tr>
<th>Code</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>280</td>
<td>IP address is not set or FTP function is not available. Further details are provided by the character string that appears after error code 280.</td>
</tr>
</tbody>
</table>

Character String and Details

HOSTADDR
An IP address has not been assigned to the DX.
Check the IP address.

DORMANT
Internal processing error.¹

LINK
Data link is disconnected.
Check the cable connection.

<table>
<thead>
<tr>
<th>Code</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>281</td>
<td>FTP mail box operation error. Further details are provided by the character string that appears after error code 281.</td>
</tr>
</tbody>
</table>

Character String and Details

MAIL
Internal processing error.¹

STATUS
Internal processing error.¹

TIMEOUT
Internal processing error.¹

PRIORITY
Internal processing error.¹

NVRAM
Internal processing error.¹

<table>
<thead>
<tr>
<th>Code</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>282</td>
<td>FTP control connection error. Further details are provided by the character string that appears after error code 282.</td>
</tr>
</tbody>
</table>

Character String and Details

HOSTNAME
Failed the DNS lookup (search the IP address corresponding to the host name).
Check the DNS setting and the destination host name.

TCPIP
Internal processing error.¹

UNREACH
Failed to connect to a control connection server.
Check the address setting and that the server is running.

OObINLINE
Internal processing error.¹

NAME
Internal processing error.¹

CTRL
The control connection does not exist.
Check that the server does not drop the connection and that it responds within the proper time period.

IAC
Failed to respond in the TELNET sequence.
Check that the server does not drop the connection and that it responds within the proper time period.

ECHO
Failed to transmit data on the control connection.
Check that the server does not drop the connection and that it responds within the proper time period.

Character String and Details

REPLY
Failed to receive data on the control connection.
## 10.1 A List of Messages

<table>
<thead>
<tr>
<th>Code</th>
<th>Message</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>10.1</td>
<td>A List of Messages</td>
<td></td>
</tr>
</tbody>
</table>
### 10.1 A List of Messages

<table>
<thead>
<tr>
<th>Code</th>
<th>Message</th>
<th>Further details are provided by the character string that appears after error code 285.</th>
</tr>
</thead>
<tbody>
<tr>
<td>285</td>
<td>FTP data connection error.</td>
<td>Character String and Details</td>
</tr>
<tr>
<td></td>
<td>SOCKET</td>
<td>Failed to create a socket for the transfer connection.²</td>
</tr>
<tr>
<td></td>
<td>BIND</td>
<td>Failed the transfer connection command.²</td>
</tr>
<tr>
<td></td>
<td>CONNECT</td>
<td>Failed the transfer connection.²</td>
</tr>
<tr>
<td></td>
<td>LISTEN</td>
<td>Failed the transfer connection reception.²</td>
</tr>
<tr>
<td></td>
<td>ACCEPT</td>
<td>Failed to accept the transfer connection.²</td>
</tr>
<tr>
<td></td>
<td>SOCKNAME</td>
<td>Internal processing error.¹</td>
</tr>
<tr>
<td></td>
<td>RECV</td>
<td>Failed to receive data over the transfer connection.²</td>
</tr>
<tr>
<td></td>
<td>SEND</td>
<td>Failed to send data over the transfer connection.²</td>
</tr>
</tbody>
</table>

| 286  | FTP file transfer error. |                                                                                           |
| 287  | FTP is failed because of file acquirement from external media. |                                                                                           |
| 290  | SNTP access failure. | Further details are provided by the character string that appears after error code 290. |
|      | DORMANT | Internal processing error.¹                                                               |
|      | LINK    | Data link is disconnected.                                                               |
|      |         | Check the cable connection.                                                             |

| 291  | SNTP server does not respond. | Further details are provided by the character string that appears after error code 291. |
|      | TIMEOUT | Check that the server is running.²                                                      |

| 292  | Incorrect SNTP server setting. | Further details are provided by the character string that appears after error code 292. |
|      | HOSTNAME | Failed the DNS lookup (search the IP address corresponding to the host name). |
|      | TCPPIP  | Check the DNS setting and the SNTP server name.                                          |
|      |         | Internal processing error.¹                                                               |

| 293  | Invalid SNTP server reply. | Further details are provided by the character string that appears after error code 293. |
|      | SEND    | A correct IP address has not been assigned to the DX.                                    |
|      | BROKEN  | There is a problem with the SNTP server.                                                |

If this error occurs even after executing SNTP manually several times, check the SNTP server.
<table>
<thead>
<tr>
<th>Code</th>
<th>Message</th>
<th>Detail</th>
</tr>
</thead>
<tbody>
<tr>
<td>294</td>
<td>No time correction because excess time deviation with SNTP server.</td>
<td>OVER  This error occurs when periodic SNTP is executed by the auto setting of the clock and the clock is not adjusted because the time difference between the DX and the SNTP server is greater than or equal to 10 minutes. Check the time on the DX and the SNTP server.</td>
</tr>
<tr>
<td>295</td>
<td>IP address was released because DHCP setting is invalid.</td>
<td>REJECT Address obtained by DHCP is inappropriate.</td>
</tr>
<tr>
<td>296</td>
<td>DHCP access failure.</td>
<td>ESEND Failed to transmit to the DHCP. ESERVER DHCP server not found. ESERVFAIL No response from the DHCP server. ERENEWED Address renewal rejected. EEXTENDED Address lease extension rejected. EEXPIRED Address lease period expired.</td>
</tr>
<tr>
<td>297</td>
<td>Registration of the hostname to the DNS server failed.</td>
<td>INTERNAL Failed to register the host name (transmission error, reception timeout, etc.). FORMERR Failed to register the host name (format error: DNS message syntax error). SERVFFAIL Failed to register the host name (server failure: DNS server processing error). NXDOMAIN Failed to register the host name (non existent domain). NOTIMP Failed to register the host name (not implemented). REFUSED Failed to register the host name (operation refused). YXDOMAIN Failed to register the host name (name exists). YXRRSET Failed to register the host name (RR set exists). NXRRSET Failed to register the host name (RR set does not exist). NOTAUTH Failed to register the host name (not authoritative for zone). NOTZONE Failed to register the host name (different from zone section). NONAME Host name not entered on the DX.</td>
</tr>
</tbody>
</table>
### 10.1 A List of Messages

<table>
<thead>
<tr>
<th>Code</th>
<th>Message Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>298</td>
<td>Deletion of the hostname to the DNS server failed. Further details are provided by the character string that appears after error code 298. <strong>Character String and Details</strong></td>
</tr>
<tr>
<td></td>
<td>INTERNAL</td>
</tr>
<tr>
<td></td>
<td>Failed to delete the host name (transmission error, reception timeout, etc.).</td>
</tr>
<tr>
<td></td>
<td>FORMERR</td>
</tr>
<tr>
<td></td>
<td>Failed to delete the host name (format error: DNS message syntax error).</td>
</tr>
<tr>
<td></td>
<td>SERVFAIL</td>
</tr>
<tr>
<td></td>
<td>Failed to delete the host name (server failure: DNS server processing error).</td>
</tr>
<tr>
<td></td>
<td>NXDOMAIN</td>
</tr>
<tr>
<td></td>
<td>Failed to delete the host name (non existent domain).</td>
</tr>
<tr>
<td></td>
<td>NOTIMP</td>
</tr>
<tr>
<td></td>
<td>Failed to delete the host name (not implemented).</td>
</tr>
<tr>
<td></td>
<td>REFUSED</td>
</tr>
<tr>
<td></td>
<td>Failed to delete the host name (operation refused).</td>
</tr>
<tr>
<td></td>
<td>YXDOMAIN</td>
</tr>
<tr>
<td></td>
<td>Failed to delete the host name (name exists).</td>
</tr>
<tr>
<td></td>
<td>YXRRSET</td>
</tr>
<tr>
<td></td>
<td>Failed to delete the host name (RR set exists).</td>
</tr>
<tr>
<td></td>
<td>NXRRSET</td>
</tr>
<tr>
<td></td>
<td>Failed to delete the host name (RR set does not exist).</td>
</tr>
<tr>
<td></td>
<td>NOTAUTH</td>
</tr>
<tr>
<td></td>
<td>Failed to delete the host name (not authoritative for zone).</td>
</tr>
<tr>
<td></td>
<td>NOTZONE</td>
</tr>
<tr>
<td></td>
<td>Failed to delete the host name (different from zone section).</td>
</tr>
<tr>
<td></td>
<td>NOTLINKED</td>
</tr>
<tr>
<td></td>
<td>Physical layer was disconnected when removing the host name.</td>
</tr>
<tr>
<td>700</td>
<td>The specified command does not exist.</td>
</tr>
<tr>
<td>701</td>
<td>Saving data.</td>
</tr>
<tr>
<td>702</td>
<td>Failed to save data.</td>
</tr>
</tbody>
</table>

*1 Contact your nearest YOKOGAWA dealer.  
*2 These errors may occur if the network experiences trouble during the data transmission (bad cable connection, duplicate addresses, network equipment failure).

**Note**  
- The FTP client function on the DX has a timer function that drops the connection if there is no data transfer for two minutes. If the server does not respond within this time period, the transfer fails.  
- The FTP client function on the DX overwrites files without a warning if files with the same name exist at the transfer destination unless the server returns a negative response.
### Communication Errors

For information regarding the communication function of the DX, see the *Communication Interface User’s Manual (IM 04L41B01-17E)*.

- **Errors during Setting and Basic Setting Modes, Output Communication Command Execution, and Setup Data Loading**

<table>
<thead>
<tr>
<th>Code</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>300</td>
<td>Command is too long.</td>
</tr>
<tr>
<td>301</td>
<td>Too many number of commands delimited with ‘:’.</td>
</tr>
<tr>
<td>302</td>
<td>This command has not been defined.</td>
</tr>
<tr>
<td>303</td>
<td>Data request command can not be enumerated with sub-delimiter.</td>
</tr>
<tr>
<td>350</td>
<td>Command is not permitted to the current user level.</td>
</tr>
<tr>
<td>351</td>
<td>This command cannot be specified in the current mode.</td>
</tr>
<tr>
<td>352</td>
<td>The option is not installed.</td>
</tr>
<tr>
<td>353</td>
<td>This command cannot be specified in the current setting.</td>
</tr>
<tr>
<td>354</td>
<td>This command is not available during sampling or calculating.</td>
</tr>
</tbody>
</table>

- **Memory Access Errors during Setting and Basic Setting Modes and Output Communication Command Execution**

An English error message is returned via the communication interface. It is not displayed on the screen.

<table>
<thead>
<tr>
<th>Code</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>362</td>
<td>There are no data to send ‘NEXT’ or ‘RESEND’.</td>
</tr>
<tr>
<td>363</td>
<td>All data have already been transferred.</td>
</tr>
</tbody>
</table>
10.1 A List of Messages

- **Maintenance and Test Communication Command Errors**
  An English error message is returned via the communication interface. It is not displayed on the screen.

<table>
<thead>
<tr>
<th>Code</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>390</td>
<td>Command error.</td>
</tr>
<tr>
<td>391</td>
<td>Delimiter error.</td>
</tr>
<tr>
<td>392</td>
<td>Parameter error.</td>
</tr>
<tr>
<td>393</td>
<td>No permission.</td>
</tr>
<tr>
<td>394</td>
<td>No such connection.</td>
</tr>
<tr>
<td>395</td>
<td>Use ‘quit’ to close this connection.</td>
</tr>
<tr>
<td>396</td>
<td>Failed to disconnect.</td>
</tr>
<tr>
<td>397</td>
<td>No TCP control block.</td>
</tr>
<tr>
<td>398</td>
<td>Format error.</td>
</tr>
</tbody>
</table>

- **Other Communication Errors**
  An English error message is returned via the communication interface. It is not displayed on the screen.

<table>
<thead>
<tr>
<th>Code</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>400</td>
<td>Input username. Enter the name of a user that is registered on the DX and that is allowed to log in to the DX through communication.</td>
</tr>
<tr>
<td>401</td>
<td>Input password. Enter the password.</td>
</tr>
<tr>
<td>402</td>
<td>Select username from ‘admin’ or ‘user’. Select “admin” or “user” to specify the user level to connect to.</td>
</tr>
<tr>
<td>403</td>
<td>Login incorrect, try again! The login failed. Enter the information again, starting with the user name.</td>
</tr>
<tr>
<td>404</td>
<td>No more login at the specified level is acceptable. Connecting would cause the maximum number of simultaneous connections (administrator: 1, normal user: 2 or setting: 1, monitoring: 2) to be exceeded. Connect to a different level, or exit by entering “quit.”</td>
</tr>
<tr>
<td>405</td>
<td>Input user ID. Enter a user ID.</td>
</tr>
<tr>
<td>406</td>
<td>Select function from ‘setting’ or ‘monitor’. Select “setting” (to connect to the setting function) or “monitor” (to connect to the monitoring function).</td>
</tr>
<tr>
<td>407</td>
<td>Password has expired. Please enter a new password. The password has expired. Enter a new password.</td>
</tr>
<tr>
<td>408</td>
<td>Enter password again for confirmation. Enter the password again for confirmation.</td>
</tr>
<tr>
<td>409</td>
<td>This password is not correct or was already used. The password is incorrect or has already been used.</td>
</tr>
<tr>
<td>410</td>
<td>Login successful. (The special user level) You have logged in to the administrator level.</td>
</tr>
<tr>
<td>411</td>
<td>Login successful. (The general user level) You have logged in to the user level.</td>
</tr>
<tr>
<td>420</td>
<td>Connection has been lost. The connection has been lost.</td>
</tr>
<tr>
<td>421</td>
<td>The number of simultaneous connections has been exceeded. The maximum number of simultaneous connections has been reached, so no further connections can be made.</td>
</tr>
<tr>
<td>422</td>
<td>Communication has timed-out. Communication timed out so the connection was closed.</td>
</tr>
<tr>
<td>450</td>
<td>This entry is incorrect. You cannot currently log in. This may happen for one of the following reasons: • The user name is not registered. • The user name is invalid. • The user ID is wrong.</td>
</tr>
<tr>
<td>451</td>
<td>Login prohibited because another user is logged in. Another user is already logged in. This may happen for one of the following reasons: • Someone has already logged in with the same user name. • When the multi-login function is not enabled and someone has logged in through key operations.</td>
</tr>
</tbody>
</table>
## 10.1 A List of Messages

<table>
<thead>
<tr>
<th>Code</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>452</td>
<td>This command must be used with LL command.</td>
</tr>
<tr>
<td></td>
<td>Use the LL command.</td>
</tr>
</tbody>
</table>
## Status Messages

<table>
<thead>
<tr>
<th>Code</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>500</td>
<td>Execution is complete.</td>
</tr>
<tr>
<td>501</td>
<td>Please wait a moment...</td>
</tr>
<tr>
<td>503</td>
<td>Data are being saved to media...</td>
</tr>
<tr>
<td>504</td>
<td>File is being loaded from media...</td>
</tr>
<tr>
<td>505</td>
<td>Formatting...</td>
</tr>
<tr>
<td>506</td>
<td>Memory save to media was interrupted.</td>
</tr>
<tr>
<td>508</td>
<td>There is no file or directory.</td>
</tr>
<tr>
<td>509</td>
<td>Press [DISP/ENTER] key to display file name.</td>
</tr>
<tr>
<td>510</td>
<td>Range cannot be changed during sampling or calculating.</td>
</tr>
<tr>
<td>511</td>
<td>MATH expression cannot be changed during sampling or calculating.</td>
</tr>
<tr>
<td>513</td>
<td>Post process in progress.</td>
</tr>
<tr>
<td>514</td>
<td>Now loading historical data.</td>
</tr>
<tr>
<td>515</td>
<td>Data save is completed.</td>
</tr>
<tr>
<td>516</td>
<td>Files are now being sorted.</td>
</tr>
<tr>
<td>520</td>
<td>Connecting to the line...</td>
</tr>
<tr>
<td>521</td>
<td>The data file is being transferred.</td>
</tr>
<tr>
<td>530</td>
<td>Media can be removed safely.</td>
</tr>
<tr>
<td>531</td>
<td>Media was removed compulsorily.</td>
</tr>
<tr>
<td>532</td>
<td>USB device has been connected.</td>
</tr>
<tr>
<td>533</td>
<td>USB device cannot be recognized.</td>
</tr>
<tr>
<td>534</td>
<td>There was no data which is not saved to media.</td>
</tr>
<tr>
<td>535</td>
<td>Media was recognized.</td>
</tr>
<tr>
<td>542</td>
<td>Media read error.</td>
</tr>
<tr>
<td>543</td>
<td>Flash write error.</td>
</tr>
<tr>
<td>550</td>
<td>The A/D calibration is being executed...</td>
</tr>
<tr>
<td>551</td>
<td>FTP test is being executed...</td>
</tr>
<tr>
<td>552</td>
<td>E-mail test is being executed...</td>
</tr>
<tr>
<td>553</td>
<td>Review and sign functions cannot be used when the file is divided.</td>
</tr>
<tr>
<td>554</td>
<td>Signature functions are being executed.</td>
</tr>
<tr>
<td>555</td>
<td>Login prohibited because software login is active.</td>
</tr>
<tr>
<td>556</td>
<td>Press [FUNC] key to login.</td>
</tr>
<tr>
<td>557</td>
<td>This user is not allowed to change a setting.</td>
</tr>
<tr>
<td>558</td>
<td>Setting changes are aborted while data is saved.</td>
</tr>
<tr>
<td>559</td>
<td>This command must be used with LL command.</td>
</tr>
<tr>
<td>560</td>
<td>Now connecting to SNTP server...</td>
</tr>
<tr>
<td>561</td>
<td>Now adjusting the time.</td>
</tr>
</tbody>
</table>
## 10.1 A List of Messages

<table>
<thead>
<tr>
<th>Code</th>
<th>Message</th>
<th>Further details are provided by the character string that appears after error code 562.</th>
</tr>
</thead>
<tbody>
<tr>
<td>562</td>
<td>Ethernet cable is disconnected.</td>
<td><strong>Character String and Details</strong>&lt;br&gt;ON&lt;br&gt;Detected that an Ethernet cable was connected.&lt;br&gt;OFF&lt;br&gt;Detected that an Ethernet cable was disconnected.</td>
</tr>
</tbody>
</table>

| 563  | The command is sent to DHCP. | **Character String and Details**<br>RENEW<br>Requesting address renewal to the DHCP server. |

| 564  | The response was received from DHCP. | **Character String and Details**<br>RENEWED<br>Address renewal complete.<br>EXTENDED<br>Address release extension request complete.<br>RELEASED<br>Address release complete. |

| 565  | IP address was set. | **Character String and Details**<br>IPCONFIG<br>Assigned the IP address. |

| 566  | It is a setting that doesn’t register hostname to the DNS server. | **Character String and Details**<br>NOREQUEST<br>Configured not to register the host name. |

| 567  | The hostname was registered to DNS server. | **Character String and Details**<br>UPDATE<br>Registered the host name to the DNS server. |

| 568  | The hostname was deleted from DNS server. | **Character String and Details**<br>REMOVE<br>Assigned the IP address.<br>OFF<br>Removed the host name from the DNS server. |

| 571  | Querying KDC server. |

| 572  | Saving template file. |

| 573  | Loading template file. |
### 10.1 A List of Messages

#### Warning Messages

<table>
<thead>
<tr>
<th>Code</th>
<th>Message</th>
<th>Ref. Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>600</td>
<td>Measured data and Settings have been initialized.</td>
<td>–</td>
</tr>
<tr>
<td>601</td>
<td>Measured data have been initialized.</td>
<td>–</td>
</tr>
<tr>
<td>610</td>
<td>This user name is already registered.</td>
<td>See section 8.2.</td>
</tr>
<tr>
<td>611</td>
<td>There is no user who can enter to the SETUP mode.</td>
<td>–</td>
</tr>
<tr>
<td>612</td>
<td>Please acknowledge all active alarms before stopping this record.</td>
<td>This message appears if you try to stop recording when there is an alarm that the alarm ACK operation has not been performed on. You can either stop recording or perform the alarm ACK operation and then stop recording. See the See sections 6.3 and 6.4 in the advanced security manual.</td>
</tr>
<tr>
<td>614</td>
<td>Calibration settings are reset because of range setting change.</td>
<td>See section 3.9.</td>
</tr>
<tr>
<td>615</td>
<td>Noise may influence measurement in test mode.</td>
<td>See section 3.1.</td>
</tr>
</tbody>
</table>

For information about messages whose codes are in the 700s, see page 11-5.

#### System Errors

Servicing is required when a system error occurs. If this happens, contact your nearest YOKOGAWA dealer for repairs.

<table>
<thead>
<tr>
<th>Code</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>901</td>
<td>ROM failure.</td>
</tr>
<tr>
<td>902</td>
<td>RAM failure.</td>
</tr>
<tr>
<td>910</td>
<td>A/D memory failure for all input channels.</td>
</tr>
<tr>
<td>921</td>
<td>Channel 1 A/D calibration value error.</td>
</tr>
<tr>
<td>925</td>
<td>A/D calibration error.</td>
</tr>
<tr>
<td>930</td>
<td>Memory acquisition failure.</td>
</tr>
<tr>
<td>940</td>
<td>The Ethernet module is down.</td>
</tr>
<tr>
<td>950</td>
<td>Incorrect number for the A/D calibration.</td>
</tr>
<tr>
<td>951</td>
<td>Failed to write A/D calibration value.</td>
</tr>
</tbody>
</table>
10.2 Troubleshooting

Does not function (nothing is displayed).

Is the power switch turned ON? Does the switch work properly?

NO → Turn ON the power properly. O.G.

YES

Is the power supply connected properly?

NO → Connect properly. O.G.

YES

Is the power supplied properly?

NO → Supply the power at the specified voltage and frequency. O.G.

YES

Contact your nearest YOKOGAWA dealer.

O.G.: Operation Guide
10.2 Troubleshooting

- Large measurement errors
- Trend or digital wave value fluctuation
- Trend going off the scale beyond either 0% or 100%

Does the input meet the specifications? NO → Change the input wiring to meet the specifications. 

YES → Are the range/span settings appropriate? NO → Adjust the span and range settings (section 3.3). If you use input calibration (/ICC1 option), check the set values for correction points (section 3.9). 

YES → Are you taking measures against noise? NO → Separate the input wiring from the noise source. Ground the recorder. Ground the measured object. Insulate the TC from the measured object. Use shielded cables for input. Change the integration time of the input A/D converter (section 3.1). Use the moving average of the input (section 3.4). 

YES → Are you keeping the environmental temperature constant (TC input)? NO → Attach the input terminal cover correctly. Protect the input terminal from fans and other sources of wind. Keep the temperature fluctuation near the input terminal to a minimum. 

YES → Is the input wiring correct? NO → Wire correctly (O.G.) Install the terminal block correctly. Fasten the terminal screws correctly. Insulate the RTD from the ground. If burnt, replace the TC. 

YES → Is the input wiring parallel with other equipment? NO → Stop the TC burnout upscale/downscale function of other equipment. Ground the DX and other equipment at one point. Disconnect parallel wiring (for example, use a double-element TC) 

YES → Is the RJC setting correct (TC input)? NO → Configure correctly. 

YES → Contact your nearest YOKOGAWA dealer to have your DX serviced.
10.2 Troubleshooting

Display and other functions do not work properly.

Taking measures against noise?

NO

• Move the input and communication wires away from the noise source.
• Ground the recorder.
• Use shielded cables for input and communication wires.
• Insert an isolation transformer into the power line.
• Insert a power line filter into the power line.
• If an inductive load is used in the alarm output line, insert a surge suppressor in the line.

Contact your nearest YOKOGAWA dealer.

YES

Items on the display selection menu or FUNC key menu are not displayed.

Are all of the typical conditions for displaying the item satisfied?

NO

• Make sure that the menu item is set to be displayed using the menu customize function. If the item is not set to be displayed, then set it to be displayed (see section 5.17).
• Confirm that the DX is equipped with the options required for that menu item.

YES

Contact your nearest YOKOGAWA dealer to have your DX serviced.
11.1 Periodic Inspection

Check the operation periodically to keep the DX in good working order. Perform the following checks and replace worn parts as needed.

- Is the display and storage functioning properly?
  If not, see chapter 11, “Troubleshooting” in the DX1000/DX1000N User’s Manual.
- Has the brightness of the LCD backlight deteriorated?
  If replacement is necessary, see “Recommended Replacement Periods for Worn Parts.”
11.2 Calibrating the DX

It is recommended that the DX be calibrated once a year to assure its measurement accuracy.
Calibration service is also provided by YOKOGAWA dealers.
For details, contact your nearest YOKOGAWA dealer.

Required Instruments
Calibration instruments with the following resolution are required for calibrating the DX.

Recommended Instruments
- DC voltage standard: Fluke 9100 or equivalent
  Main specifications
  Output accuracy: ±(0.005% + 1 µV)
- Decade resistance box: Yokogawa Meters & Instruments Model 2793-01 or equivalent
  Main specifications
  Accuracy of output range 0.1 to 500 Ω: ±(0.01% +2 mΩ)
  Resolution: 0.001 Ω
- 0°C standard temperature device: ZC-114/ZA-10 by Coper Electronics or equivalent
  Main specifications
  Standard temperature stability accuracy: ±0.05°C

For information on purchasing the calibration instruments, contact your nearest YOKOGAWA dealer.

Calibration Procedure
1. Wire the DX and the calibration instrument as shown in the following figure, and adequately warm up the instruments (the warm-up time of the DX is at least 30 minutes).
2. Check that the operating environment such as ambient temperature and humidity is within the standard operating conditions (see section 13.6).
3. Apply appropriate input signals corresponding to 0, 50, and 100% of the input range and calculate the errors from the readings.
   If the error does not fall within the accuracy range of the specifications, contact your nearest YOKOGAWA dealer.

Note
For thermocouple inputs, you must measure the temperature of the input terminal and apply a voltage taking into account the reference junction temperature.

DC Voltage Measurement (Example for the DX1012)
Temperature Measurement When Using an RTD (Example for the DX1012)

The resistance of three lead wires must be equal.

Decade resistance box
(Model 2793-01 from Yokogawa Meters & Instruments Corporation)

Temperature Measurement When Using a Thermocouple (Example for the DX1012)

Thermocouple wires or TC extension wires

RJC of TC Input

As the measurement terminal of the DX is generally at room temperature, the actual output of the thermocouple is different from the values given on the thermoelectromotive force table based on 0°C. The DX performs compensation by measuring the temperature at the input terminal and adding the corresponding thermoelectromotive force to the actual output of the thermocouple. Therefore, when the measurement terminal is shorted (equivalent to the case when the detector tip is 0°C), the measured value indicates the temperature of the input terminal.

When calibrating the DX, this compensation voltage (thermoelectromotive force of 0°C reference corresponding to the input terminal temperature) must be subtracted from the output of the standard generator before application. As shown in the figure, by using the 0°C standard temperature device to compensate the reference junction at 0°C, you can input the thermoelectromotive force of 0°C reference from the DC voltage standard and perform the calibration.
11.3 Pulling Out the Inner Instrument (DX1000N)

The inner instrument of the DX1000N can be pulled out. Because some areas inside the DX have high voltages, be sure to pull out the inner instrument correctly. For the procedure, see the Daqstation DX1000/DX1000N/DX2000 Service Manual (SM 04L41B01-01E).
# Chapter 12 Specifications

## 12.1 Signal Input and Alarm

### Measurement Input

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Number of inputs, scan interval, and A/D integration time</strong></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Model</th>
<th>Number of Inputs</th>
<th>Scan Interval</th>
<th>Normal Mode</th>
<th>Fast Sampling Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>DX1002, DX1002N</td>
<td>2</td>
<td>125 ms, 250 ms</td>
<td></td>
<td>25 ms</td>
</tr>
<tr>
<td>DX1004, DX1004N</td>
<td>4</td>
<td>125 ms, 250 ms</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DX1006, DX1006N</td>
<td>6</td>
<td>1 s, 2 s, 5 s</td>
<td></td>
<td>125 ms</td>
</tr>
<tr>
<td>DX1012, DX1012N</td>
<td>12</td>
<td>1 s, 2 s, 5 s</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A/D converter integration time</td>
<td></td>
<td>60 Hz/50 Hz</td>
<td>60 Hz/50 Hz/100 ms</td>
<td>600 Hz (fixed)</td>
</tr>
</tbody>
</table>

*When using the multi batch function (/BT2) the DX do not have a fast sampling mode.*

### Input Type

DC voltage, 1-5V, thermocouple (TC), resistance temperature detector (RTD), ON/OFF input (DI), and DC current (by adding an external shut resistor)

### Measurement range and measurable range

<table>
<thead>
<tr>
<th>Input Type</th>
<th>Range</th>
<th>Measurable Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>DC voltage</td>
<td></td>
<td></td>
</tr>
<tr>
<td>20 mV</td>
<td>–20.000 to 20.000 mV</td>
<td></td>
</tr>
<tr>
<td>60 mV</td>
<td>–60.00 to 60.00 mV</td>
<td></td>
</tr>
<tr>
<td>200 mV</td>
<td>–200.00 to 200.00 mV</td>
<td></td>
</tr>
<tr>
<td>2 V</td>
<td>–2.0000 to 2.0000 V</td>
<td></td>
</tr>
<tr>
<td>6 V</td>
<td>–6.000 to 6.000 V</td>
<td></td>
</tr>
<tr>
<td>20 V</td>
<td>–20.000 to 20.000 V</td>
<td></td>
</tr>
<tr>
<td>50 V</td>
<td>–50.00 to 50.00 V</td>
<td></td>
</tr>
<tr>
<td>1-5V</td>
<td>1 to 5 V%6</td>
<td>0.800 to 5.200 V</td>
</tr>
<tr>
<td>Thermocouple</td>
<td></td>
<td></td>
</tr>
<tr>
<td>R*1</td>
<td>0.0 to 1760.0°C</td>
<td>32 to 3200°F</td>
</tr>
<tr>
<td>S*1</td>
<td>0.0 to 1760.0°C</td>
<td>32 to 3200°F</td>
</tr>
<tr>
<td>B*1</td>
<td>0.0 to 1820.0°C</td>
<td>32 to 3300°F</td>
</tr>
<tr>
<td>K*1</td>
<td>–200.0 to 1370.0°C</td>
<td>–328 to 2498°F</td>
</tr>
<tr>
<td>E*1</td>
<td>–200.0 to 800.0°C</td>
<td>–328 to 4122°F</td>
</tr>
<tr>
<td>J*1</td>
<td>–200.0 to 1100.0°C</td>
<td>–328 to 720.0°F</td>
</tr>
<tr>
<td>T*1</td>
<td>–200.0 to 400.0°C</td>
<td>–328.0 to 752.0°F</td>
</tr>
<tr>
<td>N*1</td>
<td>–270.0 to 1300.0°C, on models with release numbers 3 and later</td>
<td>–454 to 2372°F, on models with release numbers 3 and later.</td>
</tr>
<tr>
<td></td>
<td>0.0 to 1300.0°C, on models with release numbers 2 and earlier.</td>
<td></td>
</tr>
<tr>
<td>W*2</td>
<td>0.0 to 2315.0°C</td>
<td>32 to 4199°F</td>
</tr>
<tr>
<td>L*3</td>
<td>–200.0 to 900.0°C</td>
<td>–328.0 to 1652.0°F</td>
</tr>
<tr>
<td>U*3</td>
<td>–200.0 to 400.0°C</td>
<td>–328.0 to 752.0°F</td>
</tr>
<tr>
<td>WRe*4</td>
<td>0.0 to 2400.0°C</td>
<td>32 to 4352°F</td>
</tr>
<tr>
<td>RTD</td>
<td>Pt (Pt100)*5</td>
<td>–328.0 to 1112.0°F</td>
</tr>
<tr>
<td></td>
<td>JPt (JPt100)*5</td>
<td>–328.0 to 1022.0°F</td>
</tr>
<tr>
<td>DI</td>
<td>Level</td>
<td></td>
</tr>
<tr>
<td></td>
<td>0: Less than 2.4 V. 1: 2.4 V or higher (judged at the 6 V range)</td>
<td></td>
</tr>
</tbody>
</table>

*2: W: W-5%Re/W-26%Re (Hoskins Mfg. Co.), ASTM E988
*3: L: Fe-CuNi, DIN43710, U: Cu-CuNi, DIN43710
*4: WRe: W-3%Re/W-25%Re (Hoskins Mfg. Co.)
| JPt100: JIS C1604-1989, JIS C1606-1989 |
| Measuring current: i = 1mA (Pt100, JPt100) |
| *6: The range for linear scaling of 1-5V inputs. Burnout detection and low-cut functions are available. |
| *7: The detected current value is approx. 10 µA. |

---

* Specifications for DX1002, DX1002N, DX1004, DX1004N, DX1006, DX1006N, DX1012, DX1012N models.*
### 12.1 Signal Input and Alarm

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
</table>
| Thermocouple burnout* | Burnout upscale/downscale selectable (for each channel).  
Normal: 2 kΩ or less,  
Burnout: 100 kΩ or more (parallel capacitance of 0.01 µF or less)  
Detection current: Approx. 10 µA |
| 1-5 range burnout* | Burnout upscale/downscale selectable (for each channel).  
Burnout detection: Greater than "scale upper limit + 10% of scale width" (upscale) or "scale lower limit – less than 5% of scale width" (downscale) |
| TC reference junction compensation | Internal reference junction compensation or external reference junction compensation |
| Filter function | Takes the moving average of the input values (for each channel). Moving average data points: 2 to 400 |
| Computation | Takes the square root of the input and apply linear scaling |
| Difference computation | Computable range: DC voltage, TC, RTD, and DI  
Scalable range: –30000 to 30000. The decimal place is within 4 digits to the right of the decimal point.  
Unit: 6 digits or less  
Over value detection: The value can be set to over value when ±5% of the scale range is exceeded. |
| Linear scaling | Computable range: DC voltage, TC, RTD, and DI  
Scalable range: –30000 to 30000. The decimal place is within 4 digits to the right of the decimal point.  
Unit: 6 digits or less  
Over value detection: The value can be set to over value when ±5% of the scale range is exceeded. |
| Square root computation | Takes the square root of the input and apply linear scaling  
Computable type: DC voltage  
Scalable range and unit: Same as linear scaling  
Low-cut: Set the low-cut value in the range of 0.0% to 5.0% of the span.  
Over value detection: Same as linear scaling |
| 1-5V | Computable range: 1-5  
Scalable range and unit: Same as linear scaling  
Low-cut: The low-cut point is fixed to the span lower limit.  
Over value detection: Same as linear scaling |

* In fast sampling mode, burnouts on all measurement channels cannot be detected within a scan interval. Burnout may not be detected until the number of measurements indicated below is carried out if measurement is started in a burnout condition or after a burnout occurs.

DX1002, DX1004, DX1002N and DX1004N: Up to 4 measurements. DX1006, DX1012, DX1006N and DX1012N: Up to 2 measurements.

### Alarms

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of alarms</td>
<td>Up to four alarms (level) for each measurement channels</td>
</tr>
<tr>
<td>Levels and colors</td>
<td>You can change the alarm colors and display order by setting priorities and colors for each alarm (release number 3 or later). The alarm level and color settings are shared by all channels.</td>
</tr>
<tr>
<td>Alarm type</td>
<td>High limit, low limit, difference high limit, difference low limit, high limit on rate-of-change alarm, low limit on rate-of-change alarm, delay high limit, and delay low limit</td>
</tr>
<tr>
<td>Alarm delay time</td>
<td>1 to 3600 s (for each channel)</td>
</tr>
<tr>
<td>Rate-of-change calculation interval of rate-of-change alarms</td>
<td>1 to 32 times the scan interval (common to all channels)</td>
</tr>
</tbody>
</table>
| Alarm output | Output to the internal switch  
Number of internal switches: 30  
Internal switch operation: AND/OR operation selectable |
| Hysteresis | High and low limit alarm: 0.0 to 5.0% of the span (common to all channels)  
Difference high and low limit alarms: 0.0 to 5.0% of the span (common to all channels) |
| Display | Displays the status on the respective operation screen and an alarm icon on the status display section when an alarm occurs.  
Display operation: Hold or not hold the display until the alarm acknowledge operation. |
| Alarm hide function (alarm no logging function) | Not display alarms nor record to the alarm summary (for each channel) |
| Alarm information | Displays a log of alarm occurrences on the alarm summary. |
| Alarm Annunciator function (release number 3 or later) | Alarm displays and relay output operations can be made to follow an alarm sequence. There are three supported alarm sequences: ISA-A-4, ISA-A, and ISA-M. First-out display function: none |
### 12.2 Display Function

#### Display

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display*</td>
<td>5.5-inch TFT color LCD (240 × 320 dots)</td>
</tr>
<tr>
<td>Brightness</td>
<td>8 levels</td>
</tr>
<tr>
<td>Backlight saver function</td>
<td>Dim or turn off the LCD backlight if there is no key operation for a specified time.</td>
</tr>
</tbody>
</table>

* A section of the LCD monitor may contain pixels that are always on or off. The brightness of the LCD may also not be uniform due to the characteristics of the LCD. This is not a malfunction.

#### Displayed Information

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display groups</td>
<td>Assign channels to groups on the trend display, digital display, and bar graph display and display.</td>
</tr>
<tr>
<td>Number of groups</td>
<td>10</td>
</tr>
<tr>
<td>Number of channels that can be assigned to each group</td>
<td>Up to six</td>
</tr>
<tr>
<td>Display color</td>
<td>Channel: Select from 24 colors</td>
</tr>
<tr>
<td></td>
<td>Background: Select white or black</td>
</tr>
<tr>
<td>Trend display (T-Y display)</td>
<td></td>
</tr>
<tr>
<td>Waveform line width</td>
<td>Select from 1, 2, and 3 dots</td>
</tr>
<tr>
<td>Display method</td>
<td>Orthogonal axis display with time axis (T) and measured value axis (Y)</td>
</tr>
<tr>
<td></td>
<td>Vertical, horizontal, wide, or split</td>
</tr>
<tr>
<td></td>
<td>Trend intervals: 5 s, 10 s, 15 s, 30 s, 1 min, 2 min, 5 min, 10 min, 15 min, 20 min, 30 min, 1 h, 2 h, 4 h, and 10 h/div for the DX1002, DX1002N, DX1004, and DX1004N.</td>
</tr>
<tr>
<td></td>
<td>15 s (only in fast sampling mode*), 30 s, 1 min, 2 min, 5 min, 10 min, 15 min, 20 min, 30 min, 1 h, 2 h, 4 h, and 10 h/div for the DX1006, DX1006N, DX1012, and DX1012N.</td>
</tr>
<tr>
<td></td>
<td>* release number 3 or later</td>
</tr>
<tr>
<td>Scale</td>
<td>Display a scale for each channel</td>
</tr>
<tr>
<td>Others</td>
<td>Current value bar graph, color scale band, and alarm point marks can be displayed on the scale.</td>
</tr>
<tr>
<td>Digital Display</td>
<td>Displays measured values numerically</td>
</tr>
<tr>
<td>Update rate</td>
<td>1 s (scan interval if the scan interval is greater than 1 s)</td>
</tr>
<tr>
<td>Bar graph display</td>
<td>Displays the measured value on a bar graph</td>
</tr>
<tr>
<td>Direction</td>
<td>Vertical or horizontal</td>
</tr>
<tr>
<td>Base position</td>
<td>End or center</td>
</tr>
<tr>
<td>Update rate</td>
<td>1 s (scan interval if the scan interval is greater than 1 s)</td>
</tr>
<tr>
<td>Scale</td>
<td>Display a scale for each channel</td>
</tr>
<tr>
<td>Historical trend display (T-Y display)</td>
<td></td>
</tr>
<tr>
<td>Display formats</td>
<td>Redisplays the display data or event data in the internal memory or external storage medium.</td>
</tr>
<tr>
<td></td>
<td>All screen or half screen (only when the display data is being redisplayed)</td>
</tr>
<tr>
<td></td>
<td>Top channel (release number 3 or later): Displays the specified channel in front of all the others.</td>
</tr>
<tr>
<td></td>
<td>Auto span display (release number 3 or later): Automatically adjusts the display span of the specified channel.</td>
</tr>
<tr>
<td></td>
<td>Auto zone display (release number 3 or later): Displays channels in different zones.</td>
</tr>
<tr>
<td>Time axis operation</td>
<td>The time axis can be reduced or expanded, and data can be displayed continuously. The time display can be switched from absolute to relative time (release number 3 or later).</td>
</tr>
<tr>
<td>Add message</td>
<td>Messages can be added</td>
</tr>
<tr>
<td>Background color</td>
<td>Select from white, cream, black, or light gray.</td>
</tr>
<tr>
<td>Data search</td>
<td>Waveforms from the internal memory can be displayed through the specification of a date and time (release number 3 or later).</td>
</tr>
<tr>
<td>Overview Display</td>
<td>Displays the measured values of all channels and the alarm statuses.</td>
</tr>
</tbody>
</table>
## 12.2 Display Function

<table>
<thead>
<tr>
<th>Information display</th>
<th>Displays a log of up to 1000 alarms. Specify an alarm with the cursor and jump to the corresponding section on the historical trend display.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Message summary display</td>
<td>Time and content of up to 450 messages (including 50 add messages) Specify a message with the cursor and jump to the corresponding section on the historical trend display.</td>
</tr>
<tr>
<td>Memory summary display</td>
<td>Displays the information of the data in the memory. Specify a file with the cursor and jump to the corresponding section on the historical trend display. Save the data in the internal memory to the external storage medium using keys.</td>
</tr>
<tr>
<td>Report (/M1 and /PM1)</td>
<td>Displays report data from the internal memory. Displays the report data of each report group in a stacked bar graph. Display formats: H+D (hourly data is used for the display), Day+Week (daily data is used for the display), D+M (daily data is used for the display). Report groups: Report channels are arranged in groups of sixes starting with the first channel (R001). The group arrangements are fixed. Scale/grid: Fixed at four divisions Update interval: 1 s The report data of the channels in the specified group is displayed in a stacked bar graph. However, only channels that have the same unit of measurement as the first channel in the group are displayed.</td>
</tr>
<tr>
<td>Stacked bar graph (/M1 and /PM1; Release number 3 or later)</td>
<td>Displays the communication status on the Modbus client Modbus master condition: Displays the communication status on the Modbus master Event switch display (release number 3 or later): Displays the status of the event level switches.</td>
</tr>
<tr>
<td>Status Display</td>
<td>Relay status display: Displays the ON/OFF status of the alarm output relay and internal switch. Modbus client status: Displays the communication status on the Modbus client Modbus master condition: Displays the communication status on the Modbus master Event switch display (release number 3 or later): Displays the status of the event level switches.</td>
</tr>
<tr>
<td>Log display</td>
<td>Displays the login log, error log, communication log, FTP log, Web log, e-mail log, SNTP log, DHCP log, Modbus log, operation log (/AS1 option; release numbers 4 and later), and change settings log (/AS1 option; release numbers 4 and later)..</td>
</tr>
<tr>
<td>Alarm annunciator display</td>
<td>Displays the ON/OFF status of the alarm output relay and internal switch. Modbus client status: Displays the communication status on the Modbus client Modbus master condition: Displays the communication status on the Modbus master Event switch display (release number 3 or later): Displays the status of the event level switches.</td>
</tr>
<tr>
<td>Custom display</td>
<td>Through operations such as size adjustments and attribute configurations, display components (such as the trend, digital, and bar graph displays) can be arranged to create a custom display. The display data that is created can be saved to internal memory or to an external medium (CF). The saved data can be loaded and displayed. Number of displays: 28 (3 in the internal memory and 25 in a CF card)</td>
</tr>
<tr>
<td>System information display</td>
<td>Displays the number of measurement and computation channels, options, remote controller ID, MAC address, firmware version, and internal memory capacity.</td>
</tr>
<tr>
<td>Network information display</td>
<td>Displays the DX network setup information.</td>
</tr>
</tbody>
</table>

12-4 IM 04L41B01-01E
## Other Displayed Information

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tag display</td>
<td>Tag numbers and comments can be displayed. Tag numbers (release number 3 or later) Up to 16 characters Displayable characters: Alphanumeric characters Tag numbers can be enabled or disabled. Tag comments 32 characters on a DX with a release number of 3 or later, 16 characters on a DX with a release number of 2 or earlier. Displayable characters: Alphanumeric characters</td>
</tr>
<tr>
<td>Message</td>
<td>Write messages to the trend display. Number of messages 100 Maximum number of saved messages 400 Character Up to 32 alphanumeric characters Write method Write a preset message or write an arbitrary message on the spot. Write destination Select only the displayed group or all groups. Auto message Write a message when the DX recovers from a power failure while memory sampling is in progress. Write a message when the trend interval is switched during memory sampling. Add message Write messages to the past data positions. Message The same as the “Message” item above Maximum number of saved messages 50</td>
</tr>
<tr>
<td>Status display section</td>
<td>Displays the DX status at the upper section of the display. Year, month, day, time, displayed group name/display name, user name (when using the login function), batch name (when using the batch function), internal memory status, external storage medium status, alarm status, and function usage status (key lock, computation function, and e-mail)</td>
</tr>
<tr>
<td>Auto switching of displayed groups</td>
<td>Switches the display group at a given interval. Interval: Select from the available settings between 5 s and 1 min.</td>
</tr>
<tr>
<td>Default display</td>
<td>Specify the display to be shown automatically when keys are not operated. Time until the display switches: Select from the available settings between 1 min and 1 h.</td>
</tr>
<tr>
<td>Favorite display</td>
<td>Register frequently used displays to the Favorite key and show them through simple operation. Up 8 displays can be registered.</td>
</tr>
<tr>
<td>Language</td>
<td>Select English, Japanese, German, French, or, Chinese.</td>
</tr>
<tr>
<td>Display selection menu customization</td>
<td>Show/hide and change the positions of each item in the display menus and sub menus Insert/delete separators.</td>
</tr>
<tr>
<td>FUNC key menu customization</td>
<td>Show/hide and change the display positions of each item.</td>
</tr>
<tr>
<td>Comments display (release number 3 or later)</td>
<td>Displays comments (from a comment text block) when events occur. Comment text blocks 50 Comment text block contents Comment text fields Comment text blocks consist of 5 comment text fields. 100 Characters: up to 32 characters Displayable characters: Alphanumeric characters</td>
</tr>
</tbody>
</table>
12.3 Data Saving Function

**Configuration**

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internal memory</td>
<td>Temporarily saves various types of data.</td>
</tr>
<tr>
<td>Medium</td>
<td>Flash memory</td>
</tr>
<tr>
<td>External storage</td>
<td>CF card (up to 2 GB)</td>
</tr>
<tr>
<td>Medium</td>
<td>CF card (up to 2 GB)</td>
</tr>
<tr>
<td>Format</td>
<td>FAT32 or FAT16</td>
</tr>
</tbody>
</table>

**Data Type**

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>DX data types and file extensions</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Data Type</th>
<th>Extension</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display data</td>
<td>.DAD</td>
<td></td>
</tr>
<tr>
<td>Event data</td>
<td>.DAE</td>
<td>/AS1, release numbers 4 and later</td>
</tr>
<tr>
<td>Manual sampled data</td>
<td>.DAM</td>
<td>/AS1, release numbers 4 and later</td>
</tr>
<tr>
<td>Screen image data</td>
<td>.PNG</td>
<td></td>
</tr>
<tr>
<td>Setup data</td>
<td>.PDL</td>
<td></td>
</tr>
<tr>
<td>Report data</td>
<td>.DAR</td>
<td>/M1 and /PM1, release numbers 4 and later</td>
</tr>
<tr>
<td>Custom display setup data</td>
<td>.CDC</td>
<td>Release numbers 3 and later</td>
</tr>
<tr>
<td>Change settings log data</td>
<td>.TXT</td>
<td>/AS1, release numbers 4 and later</td>
</tr>
</tbody>
</table>

**Display Data and Event Data**

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internal memory</td>
<td>400 MB (standard memory; release numbers 4 and later)</td>
</tr>
<tr>
<td>Number of files</td>
<td>Up to 400</td>
</tr>
<tr>
<td>Operation</td>
<td>FIFO (First In First Out)</td>
</tr>
<tr>
<td>Display data</td>
<td>Measurement/computation input channel</td>
</tr>
<tr>
<td>Target</td>
<td></td>
</tr>
<tr>
<td>Sampling intervals</td>
<td>Determined by the sample rate.</td>
</tr>
<tr>
<td>25 ms, 125 ms, 250 ms, 500 ms, 1 s, 2 s, 5 s, 10 s, 30 s, 1 min, 2 min, 5 min, 10 min, 15 min, 20 min and 30 min (15 min, 20min, and 30min are only available on releases 3 and later)</td>
<td></td>
</tr>
<tr>
<td>Description</td>
<td>Maximum or minimum value per sampling interval</td>
</tr>
<tr>
<td>Data size</td>
<td>Measurement input channel data: 4 bytes/data value. Computation channel data: 8 bytes/data value.</td>
</tr>
<tr>
<td>File size</td>
<td>Up to 8 MB</td>
</tr>
<tr>
<td>Data format</td>
<td>Binary</td>
</tr>
<tr>
<td>Recording</td>
<td>Records data at all times.</td>
</tr>
</tbody>
</table>

**Event data**

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target</td>
<td>Measurement/computation input channel</td>
</tr>
<tr>
<td>Sampling interval</td>
<td>Select from the available settings between 25 ms to 600 s.</td>
</tr>
<tr>
<td>Description</td>
<td>Data per sampling interval</td>
</tr>
<tr>
<td>Data size</td>
<td>Measurement input channel data: 2 bytes/data value. Computation channel data: 4 bytes/data value.</td>
</tr>
<tr>
<td>File size</td>
<td>Up to 8 MB</td>
</tr>
<tr>
<td>Data format</td>
<td>Binary</td>
</tr>
<tr>
<td>Mode</td>
<td>Free: Records data at all times.</td>
</tr>
<tr>
<td></td>
<td>Trigger: Starts recording data when a certain event occurs and records for the specified interval.</td>
</tr>
</tbody>
</table>

**Combinations of saved data**

Display data only, event data only, or display data and event data.

**File size**

See appendix 1.
### Manual Sampled Data

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item</td>
<td>Measured value at an arbitrary time</td>
</tr>
<tr>
<td>Maximum number of data values that the internal memory can store</td>
<td>400</td>
</tr>
<tr>
<td>Data format</td>
<td>Text</td>
</tr>
</tbody>
</table>

### Report Data (/M1)

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item</td>
<td>Report at each scheduled time of report</td>
</tr>
<tr>
<td>Maximum number of reports that the internal memory can store</td>
<td>100</td>
</tr>
<tr>
<td>Data format</td>
<td>Text or XML spreadsheet (release numbers 4 and later)</td>
</tr>
</tbody>
</table>

### Snapshot Data

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item</td>
<td>Displayed screen image data</td>
</tr>
<tr>
<td>Data format</td>
<td>PNG</td>
</tr>
<tr>
<td>Output destination</td>
<td>CF card or communication output</td>
</tr>
</tbody>
</table>

### Saving Data to the External Storage Medium

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Saving</td>
<td>Saves the data in the internal memory to the external storage medium.</td>
</tr>
<tr>
<td>Manual save</td>
<td>Saves when the external storage medium is inserted with a key operation.</td>
</tr>
<tr>
<td>Auto save</td>
<td>Display data: Every file save interval</td>
</tr>
<tr>
<td></td>
<td>Event data: Every data length</td>
</tr>
<tr>
<td></td>
<td>Manual sampled data: When manual sampling is executed.</td>
</tr>
<tr>
<td></td>
<td>Report data: When report is created.</td>
</tr>
<tr>
<td></td>
<td>Snapshot data: When a snapshot is taken</td>
</tr>
<tr>
<td>Auto save operation</td>
<td>Select “save data only if there is sufficient free space on the CF card” or “constantly retain the most recent data files in the CF card (media FIFO)” (release number 2 or later).</td>
</tr>
<tr>
<td>File name</td>
<td>Select from “sequence number+user-assigned string+date,” “sequence number+user-assigned string,” or “sequence number+batch name.”</td>
</tr>
<tr>
<td>Save destination</td>
<td>Auto save: CF card. Manual save: CF card or USB flash memory (/USB1)</td>
</tr>
<tr>
<td></td>
<td>Directory name: Specify using up to 20 characters.</td>
</tr>
</tbody>
</table>

### Change Settings Log Data (/AS1; release numbers 4 and later)

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item</td>
<td>Log of setting changes</td>
</tr>
<tr>
<td>Maximum number of data values that the internal memory can store</td>
<td>200</td>
</tr>
<tr>
<td>Data format</td>
<td>Text</td>
</tr>
<tr>
<td>Output destination (auto save)</td>
<td>SET0 directory on the CF card</td>
</tr>
<tr>
<td></td>
<td>A file name that includes the execution date is automatically attached.</td>
</tr>
</tbody>
</table>

### Setup Data

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item</td>
<td>DX setup data</td>
</tr>
<tr>
<td>Data format</td>
<td>Binary</td>
</tr>
<tr>
<td>File name</td>
<td>Specify using up to 32 characters.</td>
</tr>
<tr>
<td>Output/read destination (for saving/loading)</td>
<td>CF card or USB flash memory (/USB1)</td>
</tr>
<tr>
<td>Output destination (auto save; when the settings are changed on a DX with the /AS1 option)</td>
<td>SET0 directory on the CF card</td>
</tr>
<tr>
<td></td>
<td>A file name that includes the execution date is automatically attached.</td>
</tr>
</tbody>
</table>
### 12.3 Data Saving Function

#### Custom Display Setup Data

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contents</td>
<td>Custom display layout settings</td>
</tr>
<tr>
<td>Format</td>
<td>Text</td>
</tr>
<tr>
<td>File name</td>
<td>Up to 32 characters</td>
</tr>
<tr>
<td>Save/load destination</td>
<td>CF card</td>
</tr>
</tbody>
</table>

#### Data File Loading

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Function</td>
<td>Load and show the display data or event data in a CF card or USB flash memory (/USB1).</td>
</tr>
</tbody>
</table>

#### Miscellaneous

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Header comment</td>
<td>Add up to 50 characters of comment to display data, event data, manual sampled data, or report data file.</td>
</tr>
</tbody>
</table>
### 12.4 Other Standard Functions

#### Event Action Function

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event action</td>
<td>Execute a specified operation when a given event occurs.</td>
</tr>
<tr>
<td>Number of settings</td>
<td>40</td>
</tr>
<tr>
<td>Events</td>
<td>Remote control input, etc.</td>
</tr>
<tr>
<td>Timer</td>
<td>Number of timers: 4</td>
</tr>
<tr>
<td>Match time timer</td>
<td>Number of timers: 4</td>
</tr>
<tr>
<td>Action</td>
<td>Specify memory start/stop, alarm ACK, etc.</td>
</tr>
<tr>
<td></td>
<td>There are limitations on the combinations of events and actions.</td>
</tr>
</tbody>
</table>

#### Security Function

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Key lock function</td>
<td>Limitations to key operation, access to the external storage medium, and various operations</td>
</tr>
<tr>
<td>Login function</td>
<td>Only registered users can operate the DX.</td>
</tr>
<tr>
<td>System administrators</td>
<td>5 administrators</td>
</tr>
<tr>
<td>Users</td>
<td>30 users</td>
</tr>
</tbody>
</table>

#### Time Related Functions

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clock Accuracy</td>
<td>With a calendar function. Accuracy: ±10 ppm (0 to 50°C), excluding a delay (of 1 second, maximum) caused each time the power is turned on.</td>
</tr>
<tr>
<td>Time setting</td>
<td>Using key operation, communication command, event action function, or SNTP client function</td>
</tr>
<tr>
<td>Time adjustment method</td>
<td>While memory sampling: Corrects the time by 40 ms for each second. Limit in which the time is gradually adjusted: Select from the available settings between 10 s and 5 min. If the time is outside the limit, the time is immediately corrected. Cannot be used after hour 0 on January 1st, 2038. While memory is stopped: Immediately change the time.</td>
</tr>
<tr>
<td>DST</td>
<td>The date/time for switching between standard time and DST can be specified.</td>
</tr>
<tr>
<td>Time zone</td>
<td>Sets the time difference from GMT.</td>
</tr>
<tr>
<td>Date format</td>
<td>Select YYYY/MM/DD, MM/DD/YYYY, DD/MM/YYYY, or DD.MM.YYYY.</td>
</tr>
</tbody>
</table>

#### Types of Characters That Can Be Handled

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Characters</td>
<td>Alphabet characters, numbers, and symbols (limitation exists)</td>
</tr>
</tbody>
</table>

#### Miscellaneous

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Decimal point type</td>
<td>Period or comma</td>
</tr>
</tbody>
</table>
### Communication Functions

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Communication Functions</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Electrical and mechanical specifications</strong></td>
<td>Conforms to IEEE 802.3 (Ethernet frames conform to the DIX specification).</td>
</tr>
<tr>
<td><strong>Medium</strong></td>
<td>Ethernet (10BASE-T)</td>
</tr>
<tr>
<td><strong>Implemented protocols</strong></td>
<td>TCP, IP, UDP, ICMP, ARP, DHCP, HTTP, FTP, SMTP, SNTP, Modbus, and DX-dedicated protocols</td>
</tr>
<tr>
<td><strong>E-mail client</strong></td>
<td>Automatically send e-mail at specified times.</td>
</tr>
</tbody>
</table>
| **FTP client**                | Automatically transfer data files to the FTP server.  
|                               | Applicable files: Display data, event data, screen image data, and report data |
| **FTP Server**                | Transfer files, delete files, manipulate directories, and output file lists of the DX. |
| **Web server**                | Shows the DX display on a Web browser. |
| **SNTP client**               | Inquires the time to the SNTP server and sets the DX.  
|                               | Cannot be used after hour 0 on January 1st, 2036. |
| **SNTP server**               | Outputs the DX time.  
|                               | Time resolution: 5 ms  
|                               | Cannot be used after hour 0 on January 1st, 2036. |
| **DHCP client**               | Automatically obtain the network address settings from the DHCP server. |
| **Modbus client**             | Reads data from another device and writes to the registers. |
| **Modbus server**             | Loads measurement and computation channel data  
|                               | Loads and writes communication input data  
|                               | Some control commands such as memory start  
|                               | Modbus client register access limitations |
| **Setting/Measurement server**| Operate, set, and output data of the DX using a dedicated protocol. |
| **Maintenance/test server**   | Outputs connection information and network information. |
| **Instrument information server** | Outputs information (serial number, model name, etc.) of the connected DX. |
| **EtherNet/IP server**        | Can join an EtherNet/IP network as an adapter (server)  
|                               | Loads measurement and computation channel data  
|                               | Loads and writes communication input data |

### Batch Function

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Function</strong></td>
<td>Data management using batch names. Enter text fields and batch comments in the data file.</td>
</tr>
<tr>
<td><strong>Batch name</strong></td>
<td>Added to the file name of the display data and event data.</td>
</tr>
<tr>
<td><strong>Structure</strong></td>
<td>Batch number (up to 32 characters) + lot number (up to 8 digits)</td>
</tr>
<tr>
<td><strong>Text field</strong></td>
<td>Adds text to the display data and event data. There are 24 available text fields for release numbers 3 and later. There are 8 available text fields for release numbers 2 and earlier. Up to 20 title characters and 30 other characters can be entered per field.</td>
</tr>
<tr>
<td><strong>Batch comment</strong></td>
<td>Adds text to the display data and event data. Up to 3 comments with 50 characters or less.</td>
</tr>
</tbody>
</table>
12.5 Options

Alarm Output Relay (/A1, /A2, and /A3)

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action</td>
<td>Outputs relay contact signals from the terminals on the rear panel when alarms occur.</td>
</tr>
<tr>
<td>Number of outputs</td>
<td>2 outputs (/A1), 4 outputs (/A2), and 6 outputs (/A3)</td>
</tr>
<tr>
<td>Relay contact rating</td>
<td>250 VAC (50/60 Hz)/3 A, 250 VDC/0.1 A (for resistance load)</td>
</tr>
<tr>
<td>Output format</td>
<td>NO-C-NC</td>
</tr>
<tr>
<td>Relay operation</td>
<td>Energized/deenergized, AND/OR, hold/non-hold, and reflash settings are selectable.</td>
</tr>
</tbody>
</table>

RS-232 Interface (/C2) and RS-422/485 Interface (/C3)

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection</td>
<td>EIA RS-232(/C2) or EIA RS-422/485(/C3)</td>
</tr>
<tr>
<td>Protocol</td>
<td>Dedicated protocol or Modbus protocol</td>
</tr>
<tr>
<td>Synchronization</td>
<td>Start-stop synchronization</td>
</tr>
<tr>
<td>Transmission mode</td>
<td>Four-wire half-duplex multi-drop connection (1:N (N = 1 to 32))</td>
</tr>
<tr>
<td>Data rate</td>
<td>1200, 2400, 4800, 9600, 19200, or 38400 bps</td>
</tr>
<tr>
<td>Data length</td>
<td>7 or 8 bits</td>
</tr>
<tr>
<td>Stop bit</td>
<td>1 bit</td>
</tr>
<tr>
<td>Parity</td>
<td>Odd, even, or none</td>
</tr>
<tr>
<td>Handshaking</td>
<td>Off:Off, XON:XON, XON:RS, and CS:RS</td>
</tr>
<tr>
<td>Communication distance</td>
<td>Operation modes: Master or slave</td>
</tr>
</tbody>
</table>

FAIL/Status Output Relay (/F1)

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Relay operation assignment</td>
<td>You can select which operations to assign to the two relays (release numbers 4 and later).</td>
</tr>
<tr>
<td>FAIL output</td>
<td>Relay contact output on CPU error</td>
</tr>
<tr>
<td>Relay operation</td>
<td>Energized during normal operation and de-energized on system error.</td>
</tr>
<tr>
<td>Status output</td>
<td>Output a relay contact signal when a selected condition occurs.</td>
</tr>
<tr>
<td></td>
<td>A combination of the following conditions can be selected:</td>
</tr>
<tr>
<td></td>
<td>Low memory, memory failure, media error, A/D hardware error, burnout detection,</td>
</tr>
<tr>
<td></td>
<td>communication error (Modbus master or client communication error), alarm occurrence</td>
</tr>
<tr>
<td>Relay operation</td>
<td>Relay is energized when a condition occurs.</td>
</tr>
<tr>
<td>Relay contact rating</td>
<td>250 VAC (50/60 Hz)/3 A, 250 VDC/0.1 A (for resistance load)</td>
</tr>
</tbody>
</table>

Clamped Input Terminal (Detachable) (/H2)

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input terminal</td>
<td>Make the input section clamp input terminals (detachable).</td>
</tr>
<tr>
<td></td>
<td>Recommended wire size: 0.08 to 1.5 mm² (AWG 28 to 16)</td>
</tr>
</tbody>
</table>
### 12.5 Options

#### Desktop Type (/H5[ ])

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Construction</strong></td>
<td>With carrying handle. /H5D, /H5F, /H5R, /H5J, /H5H: Power Inlet connector. With a power cord. /H5: Can only be specified when /P1 is simultaneously specified. Screw type power terminal. Without power cord.</td>
</tr>
</tbody>
</table>

#### Computation Function (including the report function) (/M1)

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Number of computation channels</strong></td>
<td>DX1002, DX1004, DX1002N, and DX1004N: 12 channels (101 to 112)</td>
</tr>
<tr>
<td></td>
<td>DX1006, DX1012, DX1006N, and DX1012N: 24 channels (101 to 124)</td>
</tr>
<tr>
<td><strong>Operation</strong></td>
<td>General arithmetic operations: Four arithmetic operations, square root, absolute, common logarithm, natural logarithm, exponential, and power</td>
</tr>
<tr>
<td></td>
<td>Relational operations: &lt;, ≤, &gt;, ≥, =, and ≠</td>
</tr>
<tr>
<td></td>
<td>Logic operations: AND, OR, NOT, and XOR</td>
</tr>
<tr>
<td></td>
<td>Statistical operations: TLOG or CLOG</td>
</tr>
<tr>
<td></td>
<td>Special operations: PRE, HOLD, RESET, and CARRY</td>
</tr>
<tr>
<td></td>
<td>Conditional operation: [a?b:c]</td>
</tr>
<tr>
<td><strong>Computation accuracy</strong></td>
<td>Double-precision floating point</td>
</tr>
<tr>
<td><strong>Data that can be used</strong></td>
<td>Measurement and computation channels</td>
</tr>
<tr>
<td>Channel data</td>
<td>60 constants</td>
</tr>
<tr>
<td>Communication input data</td>
<td>Count the number of pulses (/PM1)</td>
</tr>
<tr>
<td>Constants</td>
<td>Internal switch, alarm output relay (/A[ ]), flags, and recording (memory sample) status (release number 3 or later)</td>
</tr>
<tr>
<td>Remote control input status</td>
<td>0/1 (/R1)</td>
</tr>
<tr>
<td>Pulse input</td>
<td>Performs moving average on the computed results.</td>
</tr>
<tr>
<td>Status input</td>
<td>adecimal place: 0 to 4 digits to the right of the decimal point</td>
</tr>
<tr>
<td><strong>Alarms</strong></td>
<td>High limit, low limit, delay high limit, and delay low limit</td>
</tr>
<tr>
<td><strong>Hysteresis</strong></td>
<td>High and low limit alarm: 0.0% to 5.0% of the span.</td>
</tr>
<tr>
<td><strong>Display</strong></td>
<td>Number of report channels: 12 or 24 (same as the number of computation channels)</td>
</tr>
<tr>
<td><strong>Data saving</strong></td>
<td>Number of report channels: Average, maximum, minimum, sum, or instantaneous value</td>
</tr>
<tr>
<td><strong>Report function</strong></td>
<td>Report types: Hourly, daily, hourly + daily, daily + weekly, daily + monthly</td>
</tr>
<tr>
<td></td>
<td>Report templates (report output according to templates in XML spreadsheet format; release numbers 4 and later).</td>
</tr>
</tbody>
</table>
### Cu10, Cu25 RTD Input/3 Leg Isolated RTD Input (/N1)

**Item** | **Specifications**
---|---
**Function** | In addition to the standard input, the DX can also receive Cu10 and Cu25 input. On the DX1006, DX1012, DX1006N, and DX1012N, all the RTD input terminals (A, B, and b) are isolated on each channel.

**Measurement/display accuracy** | Under standard operating conditions

<table>
<thead>
<tr>
<th>Input Type</th>
<th>Setting</th>
<th>Measurement Range</th>
<th>Accuracy Guaranteed Range</th>
<th>Measurement Accuracy</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cu10 (GE)</td>
<td>Cu1</td>
<td>–70.0 to 170.0°C</td>
<td>±(0.4% of rdg + 1.0°C)</td>
<td>16.7 ms or more</td>
</tr>
<tr>
<td>Cu10 (L&amp;N)</td>
<td>Cu2</td>
<td>–75.0 to 150.0°C</td>
<td>±(0.3% of rdg + 0.8°C)</td>
<td>1.67 ms</td>
</tr>
<tr>
<td>Cu10 (WEED)</td>
<td>Cu3</td>
<td>–200.0 to 260.0°C</td>
<td>±(0.8% of rdg + 5.0°C)</td>
<td>16.7 ms or more</td>
</tr>
<tr>
<td>Cu10:α=0.00392 at 20°C</td>
<td>Cu4</td>
<td>–70.0 to 170.0°C</td>
<td>±(0.4% of rdg + 1.0°C)</td>
<td>±(0.3% of rdg + 0.8°C)</td>
</tr>
<tr>
<td>Cu10:α=0.00393 at 20°C</td>
<td>Cu5</td>
<td>–75.0 to 150.0°C</td>
<td>±(0.3% of rdg + 0.8°C)</td>
<td>±(0.5% of rdg + 2.0°C)</td>
</tr>
<tr>
<td>Cu25:α=0.00425 at 0°C</td>
<td>Cu6</td>
<td>–200.0 to 300.0°C</td>
<td>±(0.5% of rdg + 2.0°C)</td>
<td></td>
</tr>
<tr>
<td>Cu25:α=0.00425 at 0°C</td>
<td>Cu25</td>
<td>–200.0 to 300.0°C</td>
<td>±(0.8% of rdg + 5.0°C)</td>
<td></td>
</tr>
</tbody>
</table>

* Measuring current i = 1 mA

**Input source resistance** | 1 Ω or less per wire (The resistance of all three wires must be equal).

**Ambient temperature influence** | (applies when the A/D integration time is 16.67 ms or greater)

±(0.2% of range + 2 digits) or less

**Input source resistance** | With variation of 1 Ω per wire (resistance of all three wires must be equal): ±(0.1% of rdg + 1 digit) or less

With maximum difference of 40 mΩ between wires: Approx. 1 °C
### 12.5 Options

#### 3 Leg Isolated RTD Input (/N2)

**Item Specifications**

**Input terminal**
All the RTD input terminals (A, B, and b) are isolated on each channel.
Applies to DX1006, DX1012, DX1006N, and DX1012N
Note: On the DX2004 and DX2008 standard models, all the terminals (A, B, and b) are already isolated on each channel.

#### Extended Input Type (/N3)

**Item Specifications**

**Measurement/display accuracy**
Under standard operating conditions

<table>
<thead>
<tr>
<th>Input Type</th>
<th>Measurement Range</th>
<th>Measurement Accuracy</th>
</tr>
</thead>
<tbody>
<tr>
<td>Kp vs Au7Fe</td>
<td>0 to 300.0 K</td>
<td>±(0.25% of rdg + 2.0°C)</td>
</tr>
<tr>
<td>PLATINEL</td>
<td>0 to 1400.0°C</td>
<td>±(0.25% of rdg + 8.0°C)</td>
</tr>
<tr>
<td>PR40-20</td>
<td>0 to 1900.0°C</td>
<td>±(0.25% of rdg + 2.0°C)</td>
</tr>
<tr>
<td>NiNiMo</td>
<td>0 to 1310.0°C</td>
<td>±(0.25% of rdg + 0.7°C)</td>
</tr>
<tr>
<td>WR626</td>
<td>0 to 2400.0°C</td>
<td>±(0.25% of rdg + 0.7°C)</td>
</tr>
<tr>
<td>Type N(AWG14)</td>
<td>0.0 to 1300.0°C</td>
<td>±(0.25% of rdg + 1.3°C)</td>
</tr>
<tr>
<td>P50</td>
<td>–200 to 550.0°C</td>
<td>±(0.3% of rdg + 0.6°C)</td>
</tr>
<tr>
<td>Cu100(SAMA)</td>
<td>–200 to 550.0°C</td>
<td>±(0.2% of rdg + 0.6°C)</td>
</tr>
<tr>
<td>Cu100(DIN)</td>
<td>–200 to 550.0°C</td>
<td>±(0.2% of rdg + 0.6°C)</td>
</tr>
<tr>
<td>Cu120</td>
<td>–200 to 550.0°C</td>
<td>±(0.2% of rdg + 0.6°C)</td>
</tr>
<tr>
<td>J263*B</td>
<td>0 to 300.0 K</td>
<td>±(15.0°C)</td>
</tr>
<tr>
<td>Cu53</td>
<td>–50.0 to 150.0°C</td>
<td>±(0.15% of rdg + 0.8°C)</td>
</tr>
<tr>
<td>Cu100</td>
<td>–30.0 to 150.0°C</td>
<td>±(0.2% of rdg + 1.0°C)</td>
</tr>
<tr>
<td>Pi25</td>
<td>–200.0 to 600.0°C</td>
<td>±(0.15% of rdg + 0.6°C)</td>
</tr>
<tr>
<td>Cu100GOST2</td>
<td>–200.0 to 600.0°C</td>
<td>±(0.2% of rdg + 1.0°C)</td>
</tr>
<tr>
<td>Cu50 GOST2</td>
<td>–200.0 to 600.0°C</td>
<td>±(0.15% of rdg + 0.6°C)</td>
</tr>
<tr>
<td>Cu10 GOST2</td>
<td>–200.0 to 600.0°C</td>
<td>±(1.5% of rdg + 3.0°C)</td>
</tr>
<tr>
<td>Pi46 GOST2</td>
<td>–200.0 to 600.0°C</td>
<td>±(0.3% of rdg + 0.8°C)</td>
</tr>
<tr>
<td>Pi200(WEED)</td>
<td>–100.0 to 450.0°C</td>
<td>±(0.3% of rdg + 0.6°C)</td>
</tr>
</tbody>
</table>

*1 Measuring current i = 1 mA
*2 Available for release numbers 3 and later.
*3 Available for release numbers 4 and later. Double the resistance of a 100 ohm Platinum (TCR = .003902 ohms/ohm/°C) Curve A resistor made by Weed Instrument.

**Input source resistance**
Thermocouple input: 2 kΩ or less
RTD input: 1 Ω or less per wire (The resistance of all three wires must be equal).

**Ambient temperature influence**
(Applies when the A/D integration time is 16.67 ms or greater)

| TC input | ±(0.1% of rdg + 0.05% of range) or less, excluding the error of reference junction compensation |
| RTD input | ±(0.2% of range + 2 digits) or less |

**Input source resistance**
With variation of +1 kΩ; ±10 μV or less

**With maximum difference of 100 mΩ between wires:** Approx. 1 °C
Remote Control (/R1)

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of input terminals</td>
<td>8</td>
</tr>
<tr>
<td>Input type</td>
<td>Isolated from the main circuitry through a photocoupler, built-in isolated power supply for the input terminals, and shared common.</td>
</tr>
<tr>
<td>Input type and signal level</td>
<td>Contact closed at 200 Ω or less and contact open at 100 kΩ or greater.</td>
</tr>
<tr>
<td>Voltage-free contact</td>
<td>The remote contact input operation can be set to normal open or normal close (release number 3 or later)</td>
</tr>
<tr>
<td>Open collector</td>
<td>ON voltage: 0.5 V or less (sink current 30 mA or more), leakage current when OFF: 0.25 mA or less</td>
</tr>
<tr>
<td>Allowable input voltage</td>
<td>5 VDC</td>
</tr>
<tr>
<td>Signal type</td>
<td>Level or edge (250 ms or more)</td>
</tr>
<tr>
<td>Action</td>
<td>Executes a specified action by applying a given signal to the remote signal input terminal.</td>
</tr>
<tr>
<td>Action assignment:</td>
<td>Set using the event action function</td>
</tr>
</tbody>
</table>

24 VDC Transmitter Power Supply (/TPS2 and /TPS4)

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of loops</td>
<td>2 (/TPS2) or 4 (/TPS4)</td>
</tr>
<tr>
<td>Output voltage</td>
<td>22.8 to 25.2 VDC (under rated load current)</td>
</tr>
<tr>
<td>Rated output current</td>
<td>4 to 20 mADC</td>
</tr>
<tr>
<td>Max. output current</td>
<td>25 mADC (overcurrent protection operation current: approx. 68 mADC)</td>
</tr>
<tr>
<td>Allowable conductor resistance</td>
<td>RL ≤ (17.8 – minimum transmitter operation voltage)/0.02 A</td>
</tr>
<tr>
<td>Max. length of wiring</td>
<td>2 km (when using the CEV cable)</td>
</tr>
<tr>
<td>Insulation resistance</td>
<td>20 MΩ or more at 500 VDC between output terminal and ground</td>
</tr>
<tr>
<td>Dielectric strength</td>
<td>500 VAC (50/60 Hz, I = 10mA) for one minute between output terminal and ground</td>
</tr>
<tr>
<td></td>
<td>500 VAC (50/60 Hz, I = 10mA) for one minute between output terminals</td>
</tr>
</tbody>
</table>

Easy Text Entry (/KB1 and /KB2)

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote control terminal</td>
<td>438227</td>
</tr>
<tr>
<td>Operating temperature range</td>
<td>0 to 40°C</td>
</tr>
<tr>
<td>Operation humidity range</td>
<td>20% to 80% RH (at 5 to 40°C no condensation)</td>
</tr>
<tr>
<td>Power supply</td>
<td>3 VDC AA dry batteries × 2</td>
</tr>
<tr>
<td>Weight</td>
<td>Approx. 60 g (excluding the batteries)</td>
</tr>
<tr>
<td>External dimensions</td>
<td>170 (H) × 50 (W) × 23.7 (D) mm</td>
</tr>
<tr>
<td>Signal</td>
<td>Infrared</td>
</tr>
<tr>
<td>Combination with the DX</td>
<td>Up to 32 units by setting the ID number</td>
</tr>
<tr>
<td>Number of units that can be controlled individually</td>
<td>Up to 8 m from the front of the light receiving section of the DX (reference value)*</td>
</tr>
<tr>
<td>Communication distance</td>
<td>See the figure below (reference characteristics)*</td>
</tr>
<tr>
<td>Directional characteristics</td>
<td>* Varies depending on the operating environment such as the battery voltage and the presence or absence of external light.</td>
</tr>
</tbody>
</table>

Standard accessories (/KB1)

Remote control unit, two alkaline dry batteries, and ID number label
# 12.5 Options

## USB Interface (/USB1)

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>USB port</td>
<td>Complies with Rev. 1.1 and host function</td>
</tr>
<tr>
<td>Number of ports</td>
<td>2 (one each on the front panel and rear panel)</td>
</tr>
<tr>
<td>Power supply</td>
<td>5 V, 500 mA (per port) Devices which need more than 500 mA total bus power for 2 ports can not be connected at the same time.</td>
</tr>
<tr>
<td>Connectable devices</td>
<td>Only connect the devices listed below to prevent damage to the devices.</td>
</tr>
<tr>
<td>Keyboard</td>
<td>Complies with HID Class Ver. 1.1 104 keyboard/89 keyboard (US) and 109 keyboard/89 keyboard (Japanese) Number connectable units: 1</td>
</tr>
<tr>
<td>External medium</td>
<td>USB flash memory (up to 2 GB) Does not guarantee the operation of all USB flash memories. External medium such as a hard disk, ZIP, MO, and optical discs are not supported. Number connectable units: 1</td>
</tr>
<tr>
<td>Barcode reader</td>
<td>USB HID Class Ver. 1.1 compatible English (U.S.) standard USB keyboard compatible</td>
</tr>
</tbody>
</table>

## Pulse Input (/PM1)

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pulse input</td>
<td></td>
</tr>
<tr>
<td>Number of inputs</td>
<td>3 (8 when using the remote control input terminals)</td>
</tr>
<tr>
<td>Input type</td>
<td>Isolated from the main circuitry through a photocoupler and built-in isolated power supply for the input terminals.</td>
</tr>
<tr>
<td>Input type and signal level</td>
<td>Voltage-free contact  Contact closed at 200 Ω or less and contact open at 100 kΩ or greater  ON voltage: 0.5 V or less (sink current 30 mA or more), leakage current when OFF: 0.25 mA or less</td>
</tr>
<tr>
<td>Counting</td>
<td>Counts the rising edges of pulses. For voltage-free contact input: Contact open to contact close  For open collector: Voltage level of the terminal H from high to low</td>
</tr>
<tr>
<td>Allowable input voltage</td>
<td>30 VDC</td>
</tr>
<tr>
<td>Max. sampling pulse period</td>
<td>100 Hz</td>
</tr>
<tr>
<td>Minimum detected pulse width</td>
<td>5 ms or more for both low (closed) and high (open)</td>
</tr>
<tr>
<td>Pulse detection period</td>
<td>Approx. 3.9 ms (256 Hz)</td>
</tr>
<tr>
<td>Pulse measuring accuracy</td>
<td>±1 pulse</td>
</tr>
<tr>
<td>Pulse count interval</td>
<td>Scan interval or 1 s</td>
</tr>
<tr>
<td>Miscellaneous</td>
<td>Pulse input terminals can be used as remote control input terminals, isolated from remote control input terminals</td>
</tr>
<tr>
<td>Remote control</td>
<td>Number of inputs: 5. Same as remote control (/R1) for the other specifications</td>
</tr>
<tr>
<td>Computation function</td>
<td>Same as the computation function (/M1)</td>
</tr>
</tbody>
</table>

## Calibration Correction (/CC1)

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calibration correction method</td>
<td>Corrects the measured value of each channel using segment linearizer approximation. Number of segment points: 2 to 16 (including the start and end points)</td>
</tr>
<tr>
<td>Calibration management</td>
<td>A function to make sure that calibration is performed regularly (release numbers 4 and later)</td>
</tr>
</tbody>
</table>
### DC/AC 24 V power supply (/P1)

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rated supply voltage</td>
<td>24 VDC and 24 VAC (50/60Hz)</td>
</tr>
<tr>
<td>Allowable power supply voltage range</td>
<td>21.6V to 26.4 VDC/AC</td>
</tr>
<tr>
<td>Insulation resistance</td>
<td>Between power terminal and earth: 20 MΩ or greater at 500 VDC.</td>
</tr>
<tr>
<td>Withstand voltage</td>
<td>Between power terminal and earth: 500 VAC at 50/60 Hz for one minute</td>
</tr>
<tr>
<td>Rated power supply frequency (for AC)</td>
<td>50/60 Hz</td>
</tr>
<tr>
<td>Allowable power supply frequency range (for AC)</td>
<td>50 Hz ±2%, 60 Hz ±2%</td>
</tr>
<tr>
<td>Power supply fluctuation (for AC)</td>
<td>With variation within 21.6 to 26.4 VDC/AC: ±1digit or less With variation of ±2 Hz from rated power supply frequency (at 24 VAC): ±(0.1% of rdg+1digit) or less</td>
</tr>
<tr>
<td>Rated power consumption</td>
<td>28 VA (for DC), 45 VA (for AC)</td>
</tr>
<tr>
<td>Power consumption</td>
<td>Supply voltage → LCD backlight off → Normal → Maximum</td>
</tr>
<tr>
<td>24 VDC</td>
<td>8 VA</td>
</tr>
<tr>
<td>24 VAC (50/60Hz)</td>
<td>15 VA</td>
</tr>
</tbody>
</table>

### Multi batch function (/BT2; release number 3 or later)

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Function</td>
<td>Individual recording start/stop and file generation operations can be performed for each batch. Equippable models: DX1006, DX1012, DX1006N, and DX1012N</td>
</tr>
<tr>
<td>Number of batches</td>
<td>2 to 6</td>
</tr>
<tr>
<td>Batch single operations</td>
<td>Recording start/stop, computation reset, message write</td>
</tr>
<tr>
<td>Batch overview operations</td>
<td>Computation start/stop, report start/stop, manual sampling, setup data save/load</td>
</tr>
<tr>
<td>Scan interval</td>
<td>Maximum speed of 1 s in normal mode only (same for all batches)</td>
</tr>
<tr>
<td>Data type</td>
<td>Display or event data only. Trigger mode cannot be used for event data.</td>
</tr>
<tr>
<td>Data recording interval</td>
<td>Same for all batches</td>
</tr>
<tr>
<td>Data files</td>
<td>Can be displayed or made into an event data file separately for each batch</td>
</tr>
<tr>
<td>Number of display groups</td>
<td>Up to six per batch The maximum number of channels per group is six Channels in a display group are sampled for display or event data.</td>
</tr>
<tr>
<td>Timers and match time timers</td>
<td>12 max.</td>
</tr>
<tr>
<td>Batch single settings</td>
<td>Group, trip line, file header, data file name, text field, batch number, and lot number</td>
</tr>
</tbody>
</table>

### PROFIBUS-DP (/CP1 option; release number 3 or later)

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Function</td>
<td>A PROFIBUS-DP master device can access internal data in the following ways: Load measurement channel data Load computation channel data Write to communication input data (for up to 32 channels)</td>
</tr>
<tr>
<td>Data mapping</td>
<td>Buffer → Description → Maximum Size</td>
</tr>
<tr>
<td>Input</td>
<td>Measurement channels are arranged at the start of the buffer. As many computation channels as can be placed into the buffer are inserted after the measurement channels. 128 bytes</td>
</tr>
<tr>
<td>Output</td>
<td>Up to 32 communication input data values are arranged. 128 bytes</td>
</tr>
<tr>
<td>Node address</td>
<td>0 to 125</td>
</tr>
<tr>
<td>Interface</td>
<td>PROFIBUS-DP-V0 Slave</td>
</tr>
<tr>
<td>Transmission medium</td>
<td>Two dedicated cables (one for each signal line)</td>
</tr>
<tr>
<td>Transmission speed/distance</td>
<td>9.6 kbps/1200 m to 12 Mbps/100 m</td>
</tr>
<tr>
<td>Terminator</td>
<td>No internal terminator (must be terminated externally)</td>
</tr>
</tbody>
</table>
### Advanced Security Function (/AS1; release numbers 4 and later)

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Login function</strong></td>
<td>Only registered users can operate the DX.</td>
</tr>
<tr>
<td>Administrators</td>
<td>5 administrators</td>
</tr>
<tr>
<td>Users</td>
<td>90 users</td>
</tr>
<tr>
<td>User identification</td>
<td>User name, user ID, and password</td>
</tr>
<tr>
<td><strong>Password management function</strong></td>
<td>Password management feature that uses Windows Server 2003 or 2008 Active Directory feature supports login authentication through a Kerberos authentication server</td>
</tr>
<tr>
<td><strong>Audit trail function</strong></td>
<td></td>
</tr>
<tr>
<td>Operation log storage</td>
<td>The operation history from the previous memory stop to the current memory stop is attached to a data file.</td>
</tr>
<tr>
<td>Change settings log and setup file storage</td>
<td>A setup file and change settings log are saved to the CF card when the settings are changed.</td>
</tr>
<tr>
<td><strong>Signature function (digital signature)</strong></td>
<td>Attaches approval information to measured data files.</td>
</tr>
<tr>
<td>Number of signatures</td>
<td>Up to 3 per file</td>
</tr>
<tr>
<td>Signature record</td>
<td>Can be set for each user</td>
</tr>
<tr>
<td>Applicable files</td>
<td>The attached approval information cannot be deleted or changed.</td>
</tr>
<tr>
<td>Measured Data File Protection</td>
<td>Measured data files are protected through operation logs, setup file storage, and encryption.</td>
</tr>
<tr>
<td>Data Formats and Extensions</td>
<td>Files that use this function have special extensions.</td>
</tr>
<tr>
<td>Miscellaneous (main differences from DXs without the /AS1 option)</td>
<td></td>
</tr>
<tr>
<td>Data types</td>
<td>Display or event data only. Trigger mode cannot be used for event data.</td>
</tr>
<tr>
<td>Individual alarm ACK</td>
<td>ACK operations can be performed on individual alarms.</td>
</tr>
<tr>
<td>Alarm delay time</td>
<td>Up to 24 h</td>
</tr>
<tr>
<td>Event Action</td>
<td>The “PnlLoad” action is not available</td>
</tr>
<tr>
<td>Key lock</td>
<td>No</td>
</tr>
<tr>
<td>Deletion of external storage medium files</td>
<td>Not allowed.</td>
</tr>
<tr>
<td>Formatting of external storage media</td>
<td>Not allowed.</td>
</tr>
<tr>
<td>Loading of setup files</td>
<td>You can choose whether or not to load login information.</td>
</tr>
<tr>
<td>FAIL/status output relay (/F1 and /F2 options)</td>
<td>You can choose from five operations to assign to the two output relays.</td>
</tr>
<tr>
<td>Automatic messages</td>
<td>A message is written when the setting mode setup items are changed during memory sampling.</td>
</tr>
<tr>
<td>Logs</td>
<td>There is no login log. There is an operation log and a change settings log.</td>
</tr>
</tbody>
</table>
12.6 General Specifications

### Construction

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mounting</td>
<td>Flush panel mounting (on a vertical plane) (excluding the desktop type)</td>
</tr>
<tr>
<td>Mounting angle</td>
<td>Inclined backward up to 30 degrees from a horizontal plane.</td>
</tr>
<tr>
<td>Mounting angle</td>
<td>Inclined backward up to 30 degrees from a horizontal plane.</td>
</tr>
<tr>
<td>Mounting angle</td>
<td>Inclined backward up to 30 degrees from a horizontal plane.</td>
</tr>
<tr>
<td>Allowable panel thickness</td>
<td>2 to 26 mm</td>
</tr>
<tr>
<td>Material</td>
<td>Case: Metal plate</td>
</tr>
<tr>
<td></td>
<td>Bezels and display cover: Polycarbonate</td>
</tr>
<tr>
<td>Color</td>
<td>Case: Grayish blue green (Munsell 2.0B5.0/1.7 or equivalent)</td>
</tr>
<tr>
<td></td>
<td>Bezels: Charcoal gray light (Munsell 10B3.6/0.3 or equivalent)</td>
</tr>
<tr>
<td>Front panel</td>
<td>Water and dust proof: Complies with IEC529-IP65 and NEMA No.250 TYPE 4</td>
</tr>
<tr>
<td></td>
<td>(except External Icing Test) (Style number 2 or later), except side-by-side mounting</td>
</tr>
<tr>
<td>External dimensions</td>
<td>144 (W) × 144 (H) × 229 (D) mm (D: depth from the panel mounting plane)</td>
</tr>
<tr>
<td>Weight</td>
<td>DX1000: Approx. 2.9 kg excluding options, DX1000N: Approx. 3.7 kg excluding options</td>
</tr>
</tbody>
</table>

### Normal Operating Conditions

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supply voltage</td>
<td>90 to 132, 180 to 250 VAC</td>
</tr>
<tr>
<td>Power supply frequency</td>
<td>50 Hz ± 2%, 60 Hz ± 2%</td>
</tr>
<tr>
<td>Ambient temperature</td>
<td>0 to 50°C</td>
</tr>
<tr>
<td>Ambient humidity</td>
<td>20 to 80%RH (at 5 to 40°C), 10 to 50% (at 40 to 50°C)</td>
</tr>
<tr>
<td>Vibration</td>
<td>10 to 60 Hz, 0.2 m/s²</td>
</tr>
<tr>
<td>Shock</td>
<td>Not allowed</td>
</tr>
<tr>
<td>Magnetic field</td>
<td>400 A/m or less (DC and 50/60 Hz)</td>
</tr>
<tr>
<td>Noise</td>
<td>Normal mode (50/60 Hz)</td>
</tr>
<tr>
<td></td>
<td>DC voltage The peak value including the signal must be less than 1.2 times the measuring range.</td>
</tr>
<tr>
<td></td>
<td>Thermocouple The peak value including the signal must be less than 1.2 times the measuring thermal electromotive force.</td>
</tr>
<tr>
<td></td>
<td>RTD 50 mV or less</td>
</tr>
<tr>
<td></td>
<td>Common mode noise 250 VACrms or less for all ranges (50/60 Hz)</td>
</tr>
<tr>
<td>Maximum noise voltage between channels</td>
<td>250 VACrms (50/60 Hz) or less</td>
</tr>
<tr>
<td>Mounting position</td>
<td>Can be inclined up to 30 degrees backward. Left and right horizontal.</td>
</tr>
<tr>
<td>Warm-up time</td>
<td>At least 30 minutes after power on</td>
</tr>
<tr>
<td>Installation location</td>
<td>Indoors</td>
</tr>
<tr>
<td>Operating altitude</td>
<td>2000 m or less</td>
</tr>
</tbody>
</table>

### Power Supply

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rated supply voltage</td>
<td>100 to 240 VAC</td>
</tr>
<tr>
<td>Allowable power supply voltage range</td>
<td>90 to 132, 180 to 264 VAC</td>
</tr>
<tr>
<td>Rated power supply frequency</td>
<td>50 Hz, 60 Hz</td>
</tr>
<tr>
<td>Power consumption</td>
<td><strong>Supply voltage</strong></td>
</tr>
<tr>
<td></td>
<td>100 VAC</td>
</tr>
<tr>
<td></td>
<td>240 VAC</td>
</tr>
<tr>
<td>Allowable interruption time</td>
<td>Less than 1 cycle of the power supply frequency</td>
</tr>
</tbody>
</table>

### Isolation

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insulation resistance</td>
<td>Between the Ethernet, RS-422/485, and insulation terminals and earth: 20 MΩ or greater at 500 VDC</td>
</tr>
<tr>
<td>Withstand voltage</td>
<td>Between the power terminal and earth: 2300 VAC at 50/60 Hz for one minute</td>
</tr>
<tr>
<td></td>
<td>Between the contact output terminal and earth: 1600 VAC at 50/60 Hz for one minute</td>
</tr>
<tr>
<td></td>
<td>Between the measurement input terminal and earth: 1500 VAC at 50/60 Hz for one minute</td>
</tr>
<tr>
<td></td>
<td>Mutually between measurement input terminals: 1000 VAC (50/60 Hz) for one minute (excluding the RTD input terminal of DX1006, DX1012, DX1006N and DX1012N)</td>
</tr>
<tr>
<td>Ground</td>
<td>Between the remote input terminal and earth: 1000 VDC for one minute</td>
</tr>
<tr>
<td>Ground</td>
<td>Between the pulse input terminal and earth: 1000 VDC for one minute</td>
</tr>
<tr>
<td>Ground</td>
<td>Grounding resistance: 100 Ω or less</td>
</tr>
</tbody>
</table>
12.6 General Specifications

**Transport and Storage Conditions**

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ambient temperature</td>
<td>–25 to 60°C</td>
</tr>
<tr>
<td>Ambient humidity</td>
<td>5 to 95%RH (no condensation)</td>
</tr>
<tr>
<td>Vibration</td>
<td>10 to 60 Hz, 4.9 m/s² maximum</td>
</tr>
<tr>
<td>Shock</td>
<td>392 m/s² maximum (in packaged condition)</td>
</tr>
</tbody>
</table>

**Supported Standards**

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSA</td>
<td>CSA22.2 No.61010.1, installation category II¹, pollution degree 2², and measurement category II³</td>
</tr>
<tr>
<td>UL</td>
<td>UL61010-1 (CSA NRTL/C)</td>
</tr>
<tr>
<td>CE</td>
<td>EN61326-1 compliance, Class A Table 2</td>
</tr>
<tr>
<td>EMC directive</td>
<td>EN61000-3-2 compliance</td>
</tr>
<tr>
<td></td>
<td>EN61000-3-3 compliance</td>
</tr>
<tr>
<td></td>
<td>EN55011 Class A Group 1</td>
</tr>
<tr>
<td>Low voltage directive</td>
<td>EN61010-1, installation category II¹, pollution degree 2², and measurement category II³</td>
</tr>
<tr>
<td>C-Tick</td>
<td>EN55011 compliance, Class A Group 1</td>
</tr>
</tbody>
</table>

¹ Installation category (overvoltage category) II: Describes a number which defines a transient overvoltage condition. Implies the regulation for impulse withstand voltage. "II" applies to electrical equipment which is supplied from the fixed installation like a distribution board.

² Pollution degree: Describes the degree to which a solid, liquid, or gas which deteriorates dielectric strength or surface resistivity adhering. "2" applies to normal indoor atmosphere. Normally, only non-conductive pollution occurs.

³ Measurement category II: Applies to measuring circuits connected to low voltage installation, and electrical instruments supplied with power from fixed equipment such as electric switchboards.
## Standard Performance

### Item Specifications

Measurement/display accuracy

Standard operating conditions:
- **Temperature:** 23 ± 2°C
- **Humidity:** 55% ± 10%RH
- **Power supply voltage:** 90 to 132 or 180 to 250 VAC
- **Power supply frequency:** 50/60 Hz ± 1%
- **Warm-up time:** At least 30 minutes.

Other ambient conditions such as vibration should not adversely affect the operation.

<table>
<thead>
<tr>
<th>Input Type</th>
<th>Range</th>
<th>Measurement Accuracy (Digital Display)</th>
<th>Max. Resolution of Digital Display</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>DC voltage</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>20 mV</td>
<td>±(0.05% of rdg + 12 digits)</td>
<td>±(0.1% of rdg + 40 digits)</td>
<td>1 μV</td>
</tr>
<tr>
<td>60 mV</td>
<td>±(0.05% of rdg + 3 digits)</td>
<td>±(0.1% of rdg + 15 digits)</td>
<td>10 μV</td>
</tr>
<tr>
<td>200 mV</td>
<td>±(0.05% of rdg + 12 digits)</td>
<td>±(0.1% of rdg + 40 digits)</td>
<td>100 μV</td>
</tr>
<tr>
<td>2 V</td>
<td>±(0.05% of rdg + 3 digits)</td>
<td>±(0.1% of rdg + 15 digits)</td>
<td>1 mV</td>
</tr>
<tr>
<td>1-5 V</td>
<td>±(0.05% of rdg + 3 digits)</td>
<td>±(0.1% of rdg + 15 digits)</td>
<td>1 mV</td>
</tr>
<tr>
<td>6 V</td>
<td>±(0.05% of rdg + 3 digits)</td>
<td>±(0.1% of rdg + 15 digits)</td>
<td>10 μV</td>
</tr>
<tr>
<td>20 V</td>
<td>±(0.05% of rdg + 3 digits)</td>
<td>±(0.1% of rdg + 15 digits)</td>
<td>1 mV</td>
</tr>
<tr>
<td>50 V</td>
<td>±(0.05% of rdg + 3 digits)</td>
<td>±(0.1% of rdg + 15 digits)</td>
<td>1 mV</td>
</tr>
<tr>
<td><strong>Thermocouple</strong> (Not including the accuracy of reference junction compensation; when burnout detection function is off.)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>R, S</td>
<td>0 to 100°C: ±0.7°C, 100 to 300°C: ±1.5°C, 400 to 600°C: ±2°C, 800 to 1200°C: ±3°C</td>
<td>±(0.15% of rdg + 0.7°C)</td>
<td>±(0.2% of rdg + 3.5°C)</td>
</tr>
<tr>
<td>K</td>
<td>±(0.15% of rdg + 0.7°C)</td>
<td>±(0.2% of rdg + 3.5°C)</td>
<td>R, S 0 to 100°C: ±0.7°C, 100 to 300°C: ±1.5°C, 400 to 600°C: ±2°C, 800 to 1200°C: ±3°C</td>
</tr>
<tr>
<td>E</td>
<td>±(0.15% of rdg + 0.5°C)</td>
<td>±(0.2% of rdg + 2.5°C)</td>
<td>400 to 600°C: ±7°C, Accuracy not guaranteed for values less than 400°C.</td>
</tr>
<tr>
<td>J</td>
<td>±(0.15% of rdg + 0.7°C)</td>
<td>±(0.2% of rdg + 2.5°C)</td>
<td>±(0.15% of rdg + 1°C), ±(0.15% of rdg + 1°C)</td>
</tr>
<tr>
<td>T</td>
<td>±(0.15% of rdg + 0.7°C)</td>
<td>±(0.3% of rdg + 3.5°C)</td>
<td>±(0.2% of rdg + 2.5°C), ±(0.15% of rdg + 1°C)</td>
</tr>
<tr>
<td>W</td>
<td>±(0.15% of rdg + 0.7°C)</td>
<td>±(0.3% of rdg + 3.5°C)</td>
<td>±(0.3% of rdg + 3.5°C)</td>
</tr>
<tr>
<td>L</td>
<td>±(0.15% of rdg + 0.5°C)</td>
<td>±(0.2% of rdg + 2.5°C)</td>
<td>±(0.3% of rdg + 1°C), ±(0.15% of rdg + 0.7°C)</td>
</tr>
<tr>
<td>U</td>
<td>±(0.15% of rdg + 0.7°C)</td>
<td>±(0.2% of rdg + 2.5°C)</td>
<td>±(0.3% of rdg + 1°C), ±(0.15% of rdg + 1°C)</td>
</tr>
<tr>
<td>WRe</td>
<td>±(0.2% of rdg + 2.5°C)</td>
<td>±(0.3% of rdg + 1°C)</td>
<td>±(0.3% of rdg + 1°C)</td>
</tr>
<tr>
<td>RTD</td>
<td>±(0.15% of rdg + 0.3°C)</td>
<td>±(0.3% of rdg + 1.5°C)</td>
<td>±(0.3% of rdg + 1°C)</td>
</tr>
<tr>
<td>DI Voltage</td>
<td>Threshold level (Vth=2.4 V) accuracy ± 0.1 V</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Contact</td>
<td>With parallel capacitance of 0.01 μF or less, 1 kΩ or less: 1 (ON), 100 kΩ or more: 0 (OFF).</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
12.6 General Specifications

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
</table>
| Measuring accuracy in case of scaling | Accuracy during scaling (digits) = measurement accuracy (digits) \* multiplier + 2 digits (rounded up)  
  * Fractions rounded up  
  where the multiplier = scaling span (digits)/measuring span (digits).  
  Example: For 1-5 V range (A/D integration time is 16.7 ms or more), measurement span of 1.000 to 5.000 V, and scaling span of 0.000 to 2.000  
  The measuring accuracy for 5 V input is as follows.  
  Measuring accuracy (1-5 V range) = ±(0.05% \* 5 V + 3 digits) = ±(0.0025 V [3 digits] + 3 digits) = ±6 digits  
  Multiplier = (2000 digits (0.000 to 2.000))/4000 digits (1.000 to 5.000) = 0.5  
  Thus, accuracy during scaling = ±(6 \* 0.5 + 2) digits = 5 digits (rounded up) |

Reference junction compensation accuracy  
When measuring temperature greater than or equal to 0 °C and when input terminal temperature is balanced  
Type R, S, W, WRe: ±1.0°C  
Type K, J, E, T, N, L, and U: ±0.5°C. Type B: Internal reference compensation is fixed to 0°C |

<table>
<thead>
<tr>
<th>Maximum input voltage</th>
<th>±60 VDC (continuous)</th>
</tr>
</thead>
</table>

| Input resistance | 200 mV range or less and TC: 10 MΩ or more  
  2 V range or higher: Approx. 1 MΩ |

| Input source resistance | Volt, TC: 2 kΩ or less  
  RTD input: 10 Ω or less per wire (The resistance of all three wires must be equal) |
|-------------------------|---------------------|

| Bias current | 10 nA or less (except when burnout detection function is enabled) |

<table>
<thead>
<tr>
<th>Maximum common mode noise voltage</th>
<th>260 VA Crms (50 Hz/60 Hz)</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Maximum noise voltage between channels</th>
<th>250 VA Crms (50 Hz/60 Hz)</th>
</tr>
</thead>
</table>

| Interference across channels | 120 dB (when the input source resistance is 500 Ω and the input to other channels is 60 VDC) |

| Common mode rejection ratio |  |

<table>
<thead>
<tr>
<th>When the A/D integration time is 20 ms</th>
<th>120 dB (50 Hz ± 0.1%, 500 Ω unbalanced, between the minus terminal and ground)</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>When the A/D integration time is 16.7 ms</th>
<th>120 dB (60 Hz ± 0.1%, 500 Ω unbalanced, between the minus terminal and ground)</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>When the A/D integration time is 1.67 ms</th>
<th>80 dB or higher (50/60 Hz ± 0.1%, 500 Ω unbalanced, between the minus terminal and ground)</th>
</tr>
</thead>
</table>

| Normal mode rejection ratio |  |

<table>
<thead>
<tr>
<th>When the A/D integration time is 20 ms</th>
<th>40 dB or more (50 Hz ± 0.1%)</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>When the A/D integration time is 16.7 ms</th>
<th>40 dB or more (60 Hz ± 0.1%)</th>
</tr>
</thead>
</table>

| When the A/D integration time is 1.67 ms | Not reject 50/60 Hz |

**Effects of Operating Conditions**

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
</table>
| Ambient temperature (applies when the A/D integration time is 16.7 ms or greater, with temperature variation of 10°C) | ±(0.1% of rdg + 0.05% of range) or less  
  * Excluding the error of reference junction compensation |

<table>
<thead>
<tr>
<th>DC voltage, TC range</th>
<th>±(0.1% of rdg + 2 digits) or less</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>RTD range</th>
<th>±(0.1% of rdg + 2 digits) or less</th>
</tr>
</thead>
</table>

| Power supply fluctuation | With variation within 90 to 132 V and 180 to 250 VAC (50/60 Hz):  
  Accuracy specifications are satisfied.  
  With variation of ±2 Hz from rated power frequency (power supply voltage 100 VAC):  
  Accuracy specifications are satisfied. |

<table>
<thead>
<tr>
<th>Magnetic field</th>
<th>AC (50/60 Hz) and DC 400 A/m fields: ±(0.1% of rdg + 10 digits) or less</th>
</tr>
</thead>
</table>

| DC voltage range | With variation of +1 kΩ:  
  200 mV range or less: ±10 µV or less  
  2 V range or higher: ±0.15% of rdg or less |
|----------------|---------------------------------------------------------------|

<table>
<thead>
<tr>
<th>TC range</th>
<th>With variation of +1 kΩ: ±10 µV or less</th>
</tr>
</thead>
</table>

| RTD range (Pt100) | With variation of 10 Ω per wire (resistance of all three wires must be equal): ±(0.1% of rdg + 1 digits) or less  
  With maximum difference of 40 mΩ between wires: Approx. 0.1 °C |
|----------------|---------------------------------------|

| Effects of vibration | Effects from a sinusoidal vibration along all three axis at a frequency between 10 to 60 Hz and an acceleration of 0.2 m/s²: ±(0.1% of rdg + 1 digit) or less |
### Miscellaneous

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory backup</td>
<td>A built-in lithium battery backs up the settings and runs the clock</td>
</tr>
<tr>
<td></td>
<td>Battery life: Approximately 10 years (at room temperature)</td>
</tr>
</tbody>
</table>
12.7 External Dimensions

See the DX1000/DX1000N Operation Guide (IM04L41B01-02E).
Appendix 1  File Size of Display Data and Event Data

This section explains how to calculate the file size of display data files and event data files. The calculation examples are given for the display data only and event data only cases. If you are recording both display and event data, calculate the data size of each and add them together.

Use the calculated file size as a rough guide.

These calculation examples only apply to DXs that do not have the /AS1 advanced security option.

File Size

A file consists of the following data.

**Information other than the sampled data + the sampled data**

The maximum size of a single display data file or event data file is 8 MB.

### Size of Information Other Than the Sampled Data

<table>
<thead>
<tr>
<th>Item</th>
<th>Size [Bytes]</th>
</tr>
</thead>
<tbody>
<tr>
<td>File header</td>
<td>216</td>
</tr>
<tr>
<td>Channel information</td>
<td>88*N + 32</td>
</tr>
<tr>
<td>Group information</td>
<td>96*10 + 32 = 992</td>
</tr>
<tr>
<td>Message information</td>
<td>104*50 + 32 (an add message area is reserved by default)</td>
</tr>
<tr>
<td>Batch information</td>
<td>832</td>
</tr>
<tr>
<td>Sampled data header</td>
<td>80 + 32 + N*8 + 16 + 2</td>
</tr>
<tr>
<td>Alarm information header</td>
<td>24 + 8 (add the size of this item even if there is no alarm)</td>
</tr>
<tr>
<td>Message information</td>
<td>Up to 104*1050 (varies depending on the number of messages)</td>
</tr>
<tr>
<td>Alarm information</td>
<td>Up to 32*5000 (varies depending on the number of alarms)</td>
</tr>
<tr>
<td>Release number 3 expansion information</td>
<td>1696 + 80*N</td>
</tr>
</tbody>
</table>

Expansion information is always stored.

N is the number of channels (measurement channels + computation channels).

**Example 1:** If display data of 12 measurement channels and 24 computation channels is recorded. There are no messages or alarms.

\[
216 + (88 \times 36 + 32) + 992 + (104 \times 50 + 32) + 832 + (80 + 32 + 36 \times 8 + 16 + 2) + (24 + 8) + 4,576 \\
= 15,498 \text{ bytes}
\]

### Sampled Data Size

**Data Size of Display Data and Event Data**

<table>
<thead>
<tr>
<th>Channel</th>
<th>Display Data</th>
<th>Event Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Measurement channel</td>
<td>4 bytes/channel</td>
<td>2 bytes/channel</td>
</tr>
<tr>
<td>Computation channel</td>
<td>8 bytes/channel</td>
<td>4 bytes/channel</td>
</tr>
</tbody>
</table>

Time data common to all channels is added for each sample.

<table>
<thead>
<tr>
<th>Time data</th>
<th>8 bytes/sample</th>
</tr>
</thead>
</table>

**Data Size per Sample**

**Display Data**

(Number of measurement channels\*4 bytes) + (number of computation channels\*8 bytes) + 8 bytes (time data)

**Event Data**

(Number of measurement channels\*2 bytes) + (number of computation channels\*4 bytes) + 8 bytes (time data)
Appendix 1  File Size of Display Data and Event Data

- **Sampled Data Size per File**

  **Display Data**
  
  Data size per sample × file save interval/sampling interval
  
  The sampling interval is determined by dividing the trend interval (in seconds) by 30 (40 if the trend interval is 5 or 10 s).
  
  **Example 2**: If the display data of 12 measurement channels and 24 computation channels is recorded with a trend interval of 30 min/div (the sampling interval of display data is 60 s) and a file save interval of 1 day (24 h)
  
  \[(12 \times 4 \text{ bytes} + 24 \times 8 \text{ bytes} + 8 \text{ bytes}) \times 24 \text{ h} \times 60 \times 60 / 60 \text{ s} = 248 \text{ bytes} \times 24 \text{ h} \times 60 \times 60 / 60 \text{ s}\]
  
  = 357,120 bytes

  **Event Data**
  
  Data size per sample×data length/sample rate
  
  **Example 3**: If the event data of 12 measurement channels and 24 computation channels is recorded with a sample rate of 1 s and data length of 2 h
  
  \[(12 \times 2 \text{ bytes} + 24 \times 4 \text{ bytes} + 8 \text{ bytes}) \times 2 \text{ h} \times 60 \times 60 / 1 \text{ s} = 128 \text{ bytes} \times 2 \text{ h} \times 60 \times 60 / 1 \text{ s}\]
  
  = 921,600 bytes

**Size per File**

The size per file is the sum of the size of information other than the sampled data and the size of the sampled data.

  **Display Data**
  
  **Example 4**: If recording under the conditions of examples 1 and 2
  
  From examples one and two, we obtain 15,498 + 357,120 = 372,618 bytes = 0.355 MB

  **Event Data**
  
  **Example 5**: If recording under the conditions of examples 1 and 3
  
  From examples one and three, we obtain 15,498 + 921,600 = 937,098 bytes = 0.893 MB
Save Duration to the CF Card

We will estimate the duration over which measured data can be saved to a CF card when measured data is being saved automatically.

Display Data

Save duration to the CF card (estimate) = (Size of the CF card/size of a file) × [file save interval]

Example 6: We will estimate the save duration to the CF card under the conditions of examples 1 and 2. In this example, the size of the CF card is assumed to be 256 MB.

\[
\frac{256 \text{ MB}}{0.355 \text{ MB}} \times 24 \text{ h} = 17,307 \text{ h} = 721 \text{ days}
\]

Event Data

Save duration to the CF card (estimate) = (Size of the CF card/size of a file) × [data length]

Example 7: We will estimate the time until the CF card needs to be replaced under the conditions of examples 1 and 3. In this example, the size of the CF card is assumed to be 256 MB.

\[
\frac{256 \text{ MB}}{0.893 \text{ MB}} \times 2 \text{ h} = 573 \text{ h} = 23 \text{ days}
\]

Note

If you format a 256-MB CF card, you will be able to use approximately 246 MB.

Time until the Internal Memory Becomes Full

If you are manually saving the measured data in the internal memory, old data is overwritten when the internal memory is full. You must save the measured data to the CF card before the data is overwritten.

Display Data

Time until the internal memory becomes full (estimate) = (Size of the internal memory/size of a file) × [file save interval]

Example 8: We will estimate the time until the internal memory becomes full under the conditions of examples 1 and 2. The size of the internal memory is 400 M bytes.

\[
\frac{400 \text{ MB}}{0.355 \text{ MB}} \times 24 \text{ h} = 27,042 \text{ h} = 1,126 \text{ days}
\]

Event Data

Time until the internal memory becomes full (estimate) = (Size of the internal memory/size of a file) × [data length]

Example 9: We will estimate the time until the internal memory becomes full under the conditions of examples 1 and 3. The size of the internal memory is 400 M bytes.

\[
\frac{400 \text{ MB}}{0.893 \text{ MB}} \times 2 \text{ h} = 895 \text{ h} = 37.3 \text{ days}
\]
## Appendix 2 Types of Data Files That the DX Can Create and Their Application

This section explains the types of data files that the DX can create and their application.

<table>
<thead>
<tr>
<th>Data Type</th>
<th>Extension</th>
<th>Format</th>
<th>Display Method *1</th>
<th>DX</th>
<th>DAQ</th>
<th>Application</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display data</td>
<td>DAD</td>
<td>Binary (undisclosed)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>*2, *3</td>
</tr>
<tr>
<td></td>
<td>DSD</td>
<td>Binary (undisclosed)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>*2, *3</td>
</tr>
<tr>
<td>Event data</td>
<td>DAE</td>
<td>Binary (undisclosed)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>*2, *3</td>
</tr>
<tr>
<td></td>
<td>DSE</td>
<td>Binary (undisclosed)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>*2, *3</td>
</tr>
<tr>
<td>Report data</td>
<td>DAR</td>
<td>Text (see appendix 3)</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Manual sampled data</td>
<td>DAM</td>
<td>Text (see appendix 3)</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Setup data</td>
<td>PDL</td>
<td>Binary (undisclosed)</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td></td>
<td>PEL</td>
<td>Binary (undisclosed)</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>Snapshot data</td>
<td>PNG</td>
<td>PNG (general format)</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Custom display setup data</td>
<td>CDC</td>
<td>Text</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>Change settings log</td>
<td>TXT</td>
<td>Text</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
<td></td>
</tr>
</tbody>
</table>

*1 DX: DX main unit, DAQ: DAQSTANDARD, Application: Software application

*2 The data format can be converted on DAQSTANDARD and displayed on a software application such as Microsoft Excel.

*3 The data can be retrieved from the DX using the communication function and displayed on a software application.
Appendix 3  Text File Data Format

This section explains the format of text files. The text files that the DX can create are manual sampled data files and report files.

In the explanation below, CRLF represents a terminator.

Format of the Manual Sample Data File

• The manual sampled data is output using numerical values and strings in text format delimited by tabs.

• Values of measurement channels set to Skip and computation channels set to Off are not output.

• The data is appended to the file each time manual sample operation is performed.

Format

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>YRECCRLF</td>
<td></td>
</tr>
<tr>
<td>Manual Sample Data</td>
<td>Version 1.02.00 CRLF</td>
</tr>
<tr>
<td>Model</td>
<td>DX1000 CRLF</td>
</tr>
<tr>
<td>Language Code</td>
<td>shift-JIS CRLF</td>
</tr>
<tr>
<td>File Status</td>
<td>ffffffff CRLF</td>
</tr>
<tr>
<td>Serial No.</td>
<td>III···I CRLF</td>
</tr>
<tr>
<td>File Header</td>
<td>HHH···H CRLF</td>
</tr>
<tr>
<td>Ch</td>
<td>ccccc ccccc ... ccccccCRLF</td>
</tr>
<tr>
<td>Ch Id</td>
<td>ddd···d ddd···d ... ddd···dCRLF</td>
</tr>
<tr>
<td>Tag</td>
<td>ttt···t ttt···t ... ttt···tCRLF</td>
</tr>
<tr>
<td>Unit</td>
<td>uuuuuu uuuuuu ... uuuuuuCRLF</td>
</tr>
<tr>
<td>yyyy/mo/dd hh:mi:ss</td>
<td>nnn···n nnn···n ... nnn···nCRLF</td>
</tr>
</tbody>
</table>

* Ch Id is only output when Tag numbers are being used, on DXs with release number 3 or later.

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ffffffff</td>
<td>File status (8 characters)</td>
</tr>
<tr>
<td>Complete</td>
<td>Completed. (A file with 100 manually sampled data acquisitions that is now complete.)</td>
</tr>
<tr>
<td>Progress</td>
<td>Data is being added. (An incomplete file that does not yet have 100 manually sampled data acquisitions.)</td>
</tr>
<tr>
<td>Decrease</td>
<td>The file is defective. (A file that is missing some of the manually sampled data that was stored on it.)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>III···I</td>
<td>Serial number of the DX (16 characters)</td>
</tr>
<tr>
<td>HHH···H</td>
<td>File header (50 characters)</td>
</tr>
<tr>
<td>ccccc</td>
<td>Channel number (5 characters)</td>
</tr>
<tr>
<td>ddd···d</td>
<td>Tag number (16 characters)</td>
</tr>
<tr>
<td>ttt···t</td>
<td>Tag comment (32 characters)</td>
</tr>
<tr>
<td>uuuuuu</td>
<td>Unit (6 characters)</td>
</tr>
<tr>
<td>yyyy/mo/dd hh:mi:ss</td>
<td>Sampling year, month, day, and time (19 characters)</td>
</tr>
<tr>
<td>nnn···n</td>
<td>Measured value (13 characters)</td>
</tr>
</tbody>
</table>
Appendix 3  Text File Data Format

File Output Example
Below is a manual sample data example of channels 1, 2, 3, and 4.

YREC
Manual Sample Data Version 1.02.00
Model DX1000
Language Code shift-JIS
File Status Progress
Serial No. SSE701600

File Header
Ch CH001 CH002 CH003 CH004
Ch Id TI-101 OUT-102 FI-103 VA-204
Tag abc def hij klmn
Unit °C V m³/h %
2005/10/01 08:57:22 213.8 0.517 368.4 68.9
2005/10/01 08:57:28 208.6 0.494 363.0 68.1

Note
- Output when error data, overrange data, or computation overflow data is detected

<table>
<thead>
<tr>
<th>Channel</th>
<th>Data</th>
<th>Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>Measurement channels</td>
<td>Error</td>
<td>(Space)</td>
</tr>
<tr>
<td></td>
<td>+over range (includes burnout detection)</td>
<td>99999</td>
</tr>
<tr>
<td></td>
<td>−over range (includes burnout detection)</td>
<td>−99999</td>
</tr>
<tr>
<td>Computation channel</td>
<td>Error</td>
<td>999999999</td>
</tr>
<tr>
<td></td>
<td>Positive computation overflow</td>
<td>999999999</td>
</tr>
<tr>
<td></td>
<td>(when the value exceeds 3.4E + 38)</td>
<td>999999999</td>
</tr>
<tr>
<td></td>
<td>Negative computation overflow</td>
<td>−999999999</td>
</tr>
<tr>
<td></td>
<td>(when the value falls below −3.4E + 38)</td>
<td>−999999999</td>
</tr>
</tbody>
</table>

- A new manual sampled data file is created in the following cases.
  - A measurement channel is changed to Skip from a range other than Skip.
  - A measurement channel is changed from Skip to a range other than Skip.
  - A computation channel is changed from On to Off or Off to On.
  - The unit is changed.
Appendix 3  Text File Data Format

Report File Format
- The hourly, daily, weekly, and monthly reports are output using numeric values and strings in text format delimited by tabs.
- Values of measurement channels set to Skip and computation channels set to Off are not output.
- The data is appended to this file every time a report is created.

Format

| YRECCRLF |
| Report Data | Version 1.02.00  CRLF |
| Model | DX1000  CRLF |
| Language Code | shift-JIS  CRLF |
| File Status | ffffffff  CRLF |
| Serial No. | III...I  CRLF |
| File Header | HHH...H  CRLF |
| Report Set | RRR...R  CRLF |
| File Data | rrr...r  CRLF |
| Math Set | MMM MMM MMM MMM  CRLF |
| Start Time | YYYY/MM/DD HH:MI:SS  CRLF |
| Ch | ccccc ccccc ... cccccCRLF |
| Ch Id | dddd...d dddd...d ... dddd...dCRLF |
| Tag | ttt...t ttt...t ... ttt...tCRLF |
| Unit | uuuuu uuuuu ... uuuuuCRLF |
| Data Type | sss...s CRLF |
| Time | yyyy/mo/dd hh:mi:ss  CRLF |
| Status | eeeeeee CRLF |
| Ave | nnn...n nnn...n ... nnn...nCRLF |
| Max | nnn...n nnn...n ... nnn...nCRLF |
| Min | nnn...n nnn...n ... nnn...nCRLF |
| Sum | nnn...n nnn...n ... nnn...nCRLF |

* Ch Id is only output when Tag numbers are being used, on DXs with release number 3 or later.

ffffffff  File status (8 characters)
- Complete  Completed. (A file with the necessary number of acquisitions for its report type, for example one acquisition for an Hourly report type, that is now complete.)
- Progress  Data is being added. (An incomplete file that does not yet have the necessary number of acquisitions for its report type.)
- Decrease  The file is defective. (A file that is missing some of the report data that was stored on it.)

III...I  Serial number of the DX (16 characters)
HHH...H  File header (50 characters)
RRR...R  Report setting (setting on the DX) (13 characters)
- Hourly
- Daily
- Hourly+Daily
- Daily+Weekly
- Daily+Monthly
## Appendix 3  Text File Data Format

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>rrr···r</td>
<td>Contents of the report file (13 characters)</td>
</tr>
<tr>
<td>Hourly</td>
<td></td>
</tr>
<tr>
<td>Daily</td>
<td></td>
</tr>
<tr>
<td>Hourly+Daily</td>
<td></td>
</tr>
<tr>
<td>Daily+Weekly</td>
<td></td>
</tr>
<tr>
<td>Daily+Monthly</td>
<td></td>
</tr>
<tr>
<td>Example:</td>
<td>When the DX is set to <strong>Hourly+Daily</strong> and <strong>Combine</strong>, <strong>Hourly+Daily</strong> is output.</td>
</tr>
<tr>
<td></td>
<td>When the DX is set to <strong>Hourly+Daily</strong> and <strong>Separate</strong>, the hourly report is output as <strong>Hourly</strong>, and the daily report as <strong>Daily</strong>.</td>
</tr>
<tr>
<td>MMMMM</td>
<td>Report items (16 characters (including tabs that are counted as one character each), up to four types)</td>
</tr>
<tr>
<td>Ave</td>
<td>Instantaneous value</td>
</tr>
<tr>
<td>Max</td>
<td></td>
</tr>
<tr>
<td>Min</td>
<td></td>
</tr>
<tr>
<td>Sum</td>
<td></td>
</tr>
<tr>
<td>YYYY/MO/DD HH:MI:SS</td>
<td>Report start year, month, day, and time (19 characters)</td>
</tr>
<tr>
<td>ccccc</td>
<td>Channel number (5 characters)</td>
</tr>
<tr>
<td>ddd···d</td>
<td>Tag number (16 characters)</td>
</tr>
<tr>
<td>ttt···t</td>
<td>Tag comment (32 characters)</td>
</tr>
<tr>
<td>uuuuuu</td>
<td>Unit (6 characters)</td>
</tr>
<tr>
<td>eeeeeeeeeee</td>
<td>Status (output the events that occurred while creating report data) (10 characters)</td>
</tr>
<tr>
<td>Bo</td>
<td>Burn out detected</td>
</tr>
<tr>
<td>Er</td>
<td>Error (error detection)</td>
</tr>
<tr>
<td>Ov</td>
<td>Over (overrange/computation overflow detection)</td>
</tr>
<tr>
<td>Pw</td>
<td>Power failure (power failure occurrence)</td>
</tr>
<tr>
<td>Cg</td>
<td>Change (time change present)</td>
</tr>
<tr>
<td>SSS···S</td>
<td>Report type (7 characters)</td>
</tr>
<tr>
<td>Hourly</td>
<td></td>
</tr>
<tr>
<td>Daily</td>
<td></td>
</tr>
<tr>
<td>Weekly</td>
<td></td>
</tr>
<tr>
<td>Monthly</td>
<td></td>
</tr>
<tr>
<td>yyyy/mo/dd hh:mi:ss</td>
<td>Report year, month, day, and time (19 characters)</td>
</tr>
<tr>
<td>nnn···n</td>
<td>Average, maximum, minimum, sum, or instantaneous value (13 characters)</td>
</tr>
</tbody>
</table>
**File Output Example**
Below is an example of an hourly report of 4 channels while creating hourly and daily reports and saving each type of report to a separate file.

<table>
<thead>
<tr>
<th>YREC</th>
<th>Report Data Version 1.02.00</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model</td>
<td>DX1000</td>
</tr>
<tr>
<td>Language Code</td>
<td>shift-JIS</td>
</tr>
<tr>
<td>File Status</td>
<td>Complete</td>
</tr>
<tr>
<td>Serial No.</td>
<td>S5E701600</td>
</tr>
<tr>
<td>File Header</td>
<td></td>
</tr>
<tr>
<td>Report Set</td>
<td>Hourly+Daily</td>
</tr>
<tr>
<td>File Data</td>
<td>Hourly</td>
</tr>
<tr>
<td>Math Set</td>
<td>Ave  Max  Min  Sum</td>
</tr>
<tr>
<td>Start Time</td>
<td>2005/10/01 08:10:56</td>
</tr>
<tr>
<td>Ch Id</td>
<td>TI-101 OUT-102 FI-103 VA-204</td>
</tr>
<tr>
<td>Tag</td>
<td>abc  def  hij  klmn</td>
</tr>
<tr>
<td>Unit</td>
<td>°C  V  m3/h  %</td>
</tr>
<tr>
<td>Data Type</td>
<td>Hourly</td>
</tr>
<tr>
<td>Time</td>
<td>2005/10/01 09:00:00</td>
</tr>
<tr>
<td>Status Ave</td>
<td>91.5 -0.039 241.1 48.6</td>
</tr>
<tr>
<td>Status Max</td>
<td>259.8 0.726 416.5 76.6</td>
</tr>
<tr>
<td>Status Min</td>
<td>-59.9 -0.727 83.4 23.3</td>
</tr>
<tr>
<td>Status Sum</td>
<td>3.293636E+05 -1.392980E+02 8.680871E+05 1.748983E+05</td>
</tr>
</tbody>
</table>
**Note**

- When the channel data is in the condition shown in the table below, the Er, Ov, or Bo status is output to a report.

<table>
<thead>
<tr>
<th>Data Condition</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Error</td>
<td>Er</td>
</tr>
<tr>
<td>Measurement channels</td>
<td></td>
</tr>
<tr>
<td>Positive over range</td>
<td>Ov</td>
</tr>
<tr>
<td>Negative over range</td>
<td>Ov</td>
</tr>
<tr>
<td>Burn out detection</td>
<td>Bo</td>
</tr>
<tr>
<td>Computation channels</td>
<td></td>
</tr>
<tr>
<td>Positive computation overflow (when the value exceeds 3.4E + 38)</td>
<td>Ov</td>
</tr>
<tr>
<td>Negative computation overflow (when the value falls below –3.4E + 38)</td>
<td>Ov</td>
</tr>
</tbody>
</table>

- The report output value of Ave, Max, Min, Sum, and Inst varies depending on the channel data condition as shown in the table below.

<table>
<thead>
<tr>
<th>Item</th>
<th>Data Condition of Measurement Channels</th>
<th>Report Output Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ave</td>
<td>When all of the data are errors or over range</td>
<td>(Space)</td>
</tr>
<tr>
<td>Max,</td>
<td>When all of the data are errors</td>
<td>(Space)</td>
</tr>
<tr>
<td>Min,</td>
<td>For +over range (includes burnout detection)</td>
<td>99999</td>
</tr>
<tr>
<td>Inst</td>
<td>For –over range (includes burnout detection)</td>
<td>–99999</td>
</tr>
<tr>
<td>Sum</td>
<td>When all of the data are errors or over range</td>
<td>(Space)</td>
</tr>
<tr>
<td></td>
<td>When the sum value exceeds approx. 3.4E + 38</td>
<td>9.999999E+99</td>
</tr>
<tr>
<td></td>
<td>When the sum value is below approx. –3.4E + 38</td>
<td>–9.999999E+99</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Item</th>
<th>Data Condition of Computation Channels</th>
<th>Report Output Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ave</td>
<td>When all of the data are errors or computation overflow</td>
<td>(Space)</td>
</tr>
<tr>
<td>Max,</td>
<td>When all of the data are errors</td>
<td>(Space)</td>
</tr>
<tr>
<td>Min,</td>
<td>When the maximum value or instantaneous value exceeds 999999999</td>
<td>999999999</td>
</tr>
<tr>
<td>Inst</td>
<td>When the minimum value or instantaneous value is less than –999999999</td>
<td>–999999999</td>
</tr>
<tr>
<td>Sum</td>
<td>When all of the data are errors or computation overflow</td>
<td>(Space)</td>
</tr>
<tr>
<td></td>
<td>When the sum value exceeds approx. 3.4E + 38</td>
<td>9.999999E+99</td>
</tr>
<tr>
<td></td>
<td>When the sum value is below approx. –3.4E + 38</td>
<td>–9.999999E+99</td>
</tr>
</tbody>
</table>

* The decimal place that was specified when the span for the channel was specified applies to the maximum and minimum values or the instantaneous values. For example, if the span setting of the channel is “200.0,” then “999999999” is output when the value exceeds “9999999.9” and “–999999999” is output when the value is below “–9999999.9.”
Format of the Change Settings Log (/AS1 option)

- The change settings log is output as a tab-separated text file.
- Each time a report is created, data is added to the file.

**Format**

YRECCRLF
Setting Change Data Version 1.00.00CRLF
File Status  ffffffffCRLF
Serial No.   III•••ICRLF
Changed      yyyy/mo/dd hh:mm:ssCRLF
Contents     ccc•••cCRLF
File Info    ddd•••d nnn•••nCRLF
User Info    ppp•••p ttt•••t uuu•••uCRLF

fffffff File status (8 characters)
  Complete Completed (A file with 100 change settings log entries that is now complete.)
  Progress Data is being added. (An incomplete file that does not yet have 100 change settings log entries.)

III•••I       Serial number (up to 16 characters)
yyyy/mo/dd hh:mm:ss Year, month, day, and time when the setting change was executed (19 characters)
ccc•••c       The following are connected with pluses (16 characters).
  Eng         Changing of setting mode settings
  Sys         Changing of basic setting mode settings
  Login       Changing of login information

ddd•••d       File serial number (10 characters)
nnn•••n       File name (12 characters)
ppp•••p       Type of setting change (10 characters)
  Manual      Settings changed by the user
  Key         Settings changed by the user
  Communication Settings changed by the user

ttt•••t       Input method (8 characters)

uuu•••u       User name (20 characters)
File Output Example
Below is an example of a change settings log file with two change settings log entries.

YREC
Setting Change Data Version 1.00.00
File Status Progress
Serial No. S5H907377
Changed 2010/04/01 00:55:44
Contents Sys
File Info 209 40100550.PEL
User Info Manual KEY
Changed 2010/04/02 00:56:18
Contents Login
File Info 210 40100560.PEL
User Info Manual KEY Admin1
Index

Symbol

**................................................................. 9-6
+Over.............................................................. 1-15
-Over.............................................................. 1-15
[a/b/c]............................................................. 9-10
24 VDC transmitter power supply ................. 12-15
24 V power supply ......................................... 12-17
3 leg isolated RTD input ................................... 12-14

A
A/D integration time ........................................ 3-1
ABS .................................................................... 9-6
absolute time ................................................ 4-19
absolute time mode ........................................... 1-38
action ................................................................ 1-39
added messages .............................................. 1-17
administrator .................................................. 1-43, 8-5
advanced security function ......................... 1-56, 12-18
advanced security option .............................. 1-40
alarm .............................................................. 1-4, 12-2
alarm ACK ...................................................... 1-7, 3-15
alarm acknowledge ......................................... 1-7
alarm acknowledge operation ....................... 3-15
alarm annunciator ......................................... 1-8, 3-21
alarm colors .................................................. 1-5
alarm delay time ............................................ 3-14, 9-3
alarm hide function ......................................... 1-5
alarm indication .............................................. 1-5
alarm levels .................................................... 1-5
alarm mark indication ...................................... 5-15
alarm output relay .......................................... 1-6, 3-8, 12-11
alarm settings ................................................ 3-11
alarm summary .............................................. 1-20, 4-28
alarm value ................................................... 3-13
all channel ..................................................... 4-17
all channel display ......................................... 4-6, 4-15
all data display .............................................. 4-13
AND .............................................................. 9-7
AND/OR ........................................................ 1-6
annunciator display ........................................ 3-23
annunciator sequence .................................... 3-21, 3-25
annunciator window ....................................... 3-23
auto increment ............................................. 8-7
auto logout ..................................................... 1-43, 8-4, 8-6
automatic message writing ......................... 1-12
auto save ....................................................... 1-31, 6-5
auto scroll ...................................................... 4-6
auto span ....................................................... 4-20
auto span display .......................................... 1-18
auto zone ....................................................... 1-13, 4-6, 4-17

B
background color ........................................... 1-25, 5-23
background color (historical trend) ............... 4-21
backlight saver .............................................. 1-25, 2-8
bar graph display ........................................... 2-22
channel display ............................................. 5-20
basic setting mode ........................................ 2-27
batch comment ............................................. 1-36, 6-7
batch function ............................................... 6-7, 12-10
batch name ................................................... 6-7
brightness ...................................................... 1-25, 2-8
burnout ........................................................ 1-15, 3-2
burnout Detection .......................................... 1-2

calculate the file size ....................................... App-1
calendar ....................................................... 4-16
calibration ..................................................... 11-2
calibration correction ...................................... 1-3, 3-16, 12-16
calibration due date ........................................ 3-32
calibration management .................................. 1-3
calibration notification screen ....................... 3-31
carry ............................................................. 9-10
change message ............................................ 5-5
change settings log ........................................... 4-38, 12-7
changing settings during recording ............... 6-13
channel (computation) .................................. 1-44
channel display colors .................................... 5-10
channel number ........................................... 5-3
clamped input terminal ................................... 12-11
clog computation .......................................... 9-9
color scale band ............................................. 5-16
comma .......................................................... 2-26
comment text block ........................................ 5-34
comment text field ......................................... 5-34
communication application errors ............... 10-9
communication errors ................................... 10-15
communication functions ............................ 12-10
communication log ........................................ 4-36
computation channel .................................... 9-1
computation data dropout ............................. 1-47, 9-15
computation error .......................................... 9-4
computation function ................................... 1-44, 12-12
computation types ......................................... 1-44
conditional expression ................................... 9-10
configuration (storage) ................................. 12-6
construction (DX) ........................................... 12-19
continuing data .............................................. 4-12
count (moving average) ................................. 3-8
Cu10, Cu25 RTD input .................................... 12-13
current value display ...................................... 5-14
cursor (historical trend) ................................. 4-12
cursor time .................................................... 4-19
custom display ............................................. 1-56
custom display setup data ............................... 1-35, 12-8
customizing the display selection menus ....... 5-29
customizing the FUNC key menus ................. 5-29
customizing the menus .................................. 1-24, 4-3

data display section ....................................... 1-9
data file loading ............................................. 12-8
data files that the DX can create ................... App-4
data kind ....................................................... 6-2
data length .................................................... 6-3
data save mode ............................................. 2-24, 4-33
data that can be used in equations .................. 1-48
data type ....................................................... 12-8
data types ..................................................... 1-26
date/time ....................................................... 2-1
date format .................................................... 1-54, 2-4
de-energize .................................................... 1-7
decimal point type .......................................... 2-26
Index

delay high limit alarm ........................................... 1-4
delay low limit alarm ........................................... 1-4
displaying a file ...................................................... 6-17
display type ............................................................ 12-12
detect (alarm hide function) ................................... 3-14
DHCP log .............................................................. 4-38
difference computation ........................................... 1-3
difference lower limit alarm .................................... 1-4
difference upper limit alarm ..................................... 1-4
digit (scale value) ................................................... 5-14
digital display .......................................................... 1-15, 4-4
directory (data save) ......... ................................. 1-31
display (LCD) ........................................................ 12-3
display color (channels) .......................................... 5-10
display color (messages) .......................................... 5-9
display comments .................................................. 5-33
display data ............................................................ 1-261-56, 1-28, 12-6
display direction (bar graphs) .............................. 5-20
display direction (messages) ................................... 5-19
display direction (trend) ......................................... 5-19
displayed information .......................................... 12-3
displayed language ............................................... 1-55
display group ......................................................... 5-1
display menu ........................................................ 4-1, 5-31
display positions .................................................... 3-24
display selection menu ......................................... 4-1, 5-31
display window ....................................................... 3-24
display zone ........................................................... 5-11
divided (report file) ............................................... 9-17
division (scale) ...................................................... 5-13
DST (daylight saving time) ..................................... 1-54, 2-1

e-mail entry .......................................................... 4-37
easy text entry ...................................................... 1-55, 12-15
effects of operating conditions ............................... 12-22
electrical conditions .............................................. 1-4
energize ............................................................... 1-7
EQ ................................................................. 9-6
error codes ........................................................... 10-1
error data ............................................................. 1-50
error log ............................................................... 4-36
error messages ...................................................... 10-1
ers related to parameter settings ............................ 10-1
event ................................................................. 1-37
evaction .............................................................. 1-37, 7-1, 12-9
event data ............................................................ 1-26, 1-28, 12-6
event level switch status ........................................ 1-24
event level switch status display .......................... 4-27
EXP ............................................................... 9-6
expressions (computation) .................................... 9-5
extended input type .............................................. 12-14
extension (file) ..................................................... 1-33
external dimensions ........................................... 12-24
external storage medium ..................................... 1-31

flow of data recording and storage ..................... 1-27
format of the change settings log ....................... App-11
formatting .......................................................... 6-17
format type ......................................................... 6-17
fourth arithmetic operation ................................. 9-6
free (event data) .................................................. 1-29, 6-3
free messages ...................................................... 1-12, 5-9
free space ......................................................... 6-17
FTP log ............................................................. 4-36
FUNC key menu .................................................. 4-2, 5-30

G

GE ................................................................. 9-6
gradually correcting the internal clock .................. 1-54
graph display ..................................................... 1-9
grid ................................................................. 5-19
groups .............................................................. 5-1
group set .......................................................... 5-1
GT ................................................................. 9-6

H

historical trend display ....................................... 1-17, 4-9
HOLD ............................................................ 9-10
hold (alarm indication) ........................................ 1-5
hold (alarm output relay) ..................................... 1-7
hysteresis ......................................................... 1-4, 3-9

I

identified strings ................................................ 6-5
ID number ......................................................... 2-15
indicator ............................................................ 3-8
individual alarm ACK operation ......................... 4-23
information on the displayed measured data ....... 4-21
initialize ........................................................... 2-10
inner instrument ............................................... 11-4
input calibration interval .................................... 3-30
input processing ................................................ 1-2
input range ....................................................... 3-3
input type ......................................................... 1-1, 3-4
integration time ................................................. 1-1
internal memory ............................................... 1-27
internal switch .................................................. 1-7, 1-37, 3-8
interval (rate-of-change alarm) ......................... 1-4, 3-7
invalid keys ...................................................... 2-21
invalid user relay .............................................. 1-52
ISA-A ............................................................. 3-27
ISA-A-4 .......................................................... 3-25
ISA-M ............................................................. 3-29
isolation ............................................................ 12-19

J

jump default display ........................................... 5-25

K

keyboard .......................................................... 2-20
key lock ............................................................ 1-42, 8-1
keywords ........................................................ 9-20

L

LIMIT ........................................................... 4-16
line width of the trend ........................................ 5-19
list of files ....................................................... 6-16
LN ................................................................. 9-6
loading a file ..................................................... 6-18

Index-2
loading a template file ................................................. 6-22
loading setup data ........................................................ 6-21
LOG ............................................................................. 1-9-6
log display ......................................................................... 1-24
logging in ............................................................................. 8-6
logging out .......................................................................... 8-6
logical computation .......................................................... 9-7
login function ..................................................................... 1-43, 8-4
login log ................................................................................ 4-35
log into the DX ..................................................................... 6-8
lot-No. digit .......................................................................... 6-7
lot number ............................................................................. 1-36
low-cut ................................................................................... 1-3, 3-5
LT ......................................................................................... 9-6

M
MAC address ..................................................................... 2-5
maintenance ........................................................................ 11-1
maintenance and test communication command errors ..... 10-16
manuals ................................................................................ 1
manual sampled data ......................................................... 1-28, 1-30, 6-14, 12-7
manual sampled data (format) ............................................. App-5
manual save .......................................................................... 1-32
match time timer .................................................................. 1-37, 7-4
math start action .................................................................. 9-14
measurement channel ......................................................... 1-1
measurement input ............................................................... 12-1
measure soft key .................................................................... 3-16
media FIFO ........................................................................... 1-32, 6-6
memory backup ..................................................................... 12-23
memory sample ..................................................................... 1
memory sample relay ......................................................... 1-52
memory start ......................................................................... 6-10
memory stop .......................................................................... 6-11
memory summary .................................................................. 1-22, 4-32
message colors ...................................................................... 5-9
message display ...................................................................... 4-6, 4-19
message display methods ..................................................... 4-31
messages .............................................................................. 1-12, 5-7
messages (errors, status, etc) ................................................ 10-1
message summary .................................................................. 1-21, 4-30
modbus client status display ............................................... 1-24
modbus master status display ............................................... 1-24
modbus status display ........................................................ 4-26
modbus status log .................................................................. 4-38
mode (input range) ................................................................ 3-4
moving average ..................................................................... 1-2, 3-6
multi batch function ............................................................. 1-56, 12-17

N
NE ......................................................................................... 9-6
network information ........................................................... 2-5
next soft key ......................................................................... 4-2
No logging ............................................................................ 3-10
non-hold (alarm indication) ................................................. 1-5-7
non-hold (alarm output relay) ................................................ 1-7
normal operating conditions ............................................. 12-19
NOT ....................................................................................... 9-7
number of pulses per minute ............................................. 3-18
numeric display ..................................................................... 1-15, 4-6

O
operating event switches .................................................... 7-5
operation errors .................................................................... 10-7
operation log .......................................................................... 4-39
operation logs ........................................................................ 4-35
operations that can be carried out when logged out .......... 1-43

P
parameters ............................................................................ 9-22
partial expanded display .................................................... 1-14, 1-17
parts replacement ............................................................... 11-1
password (login function) ................................................... 8-5
password change ................................................................... 8-7
point ..................................................................................... 2-26
privacy display ....................................................................... 5-28
power computations ............................................................ 9-6
power failure operation ....................................................... 1-50
power supply ......................................................................... 12-19
power supply for transmitter ............................................. 1-55
PRE ......................................................................................... 9-10
pre-trigger ............................................................................ 6-3
preset display ......................................................................... 5-25
pretrigger .............................................................................. 1-29
processing order of computation ......................................... 1-16
PROFIBUS-DP ................................................................... 12-17
progress of the save operation ............................................. 4-34
pulse input ............................................................................. 1-3, 12-16
pulse sum value ..................................................................... 3-17

R
range (input range) ............................................................... 3-4
rate-of-change alarm .......................................................... 1-4
recommended replacement periods for worn parts ............. 11-1
recording conditions (data display) ....................................... 1-28
recording conditions (event data) .......................................... 1-29
ref. CH .................................................................................. 3-5
reference channel .................................................................. 3-5
reference junction compensation ......................................... 1-2, 3-2
reflash ................................................................................. 1-6, 3-7
relational computation ......................................................... 9-6
relative time ........................................................................... 4-19
relative time mode ............................................................... 1-38
relay action ............................................................................ 2-12
Relay Action on Ack ............................................................ 3-9
relay status display ............................................................. 1-24, 4-38
release number ...................................................................... 1-24
releasing the key lock .......................................................... 8-2
remote contact input operation ........................................... 7-10
remote control (R1) .............................................................. 12-15
remote control function ....................................................... 1-37, 7-1
remote controller ID ............................................................. 2-5, 2-14
remote control terminal ....................................................... 2-15
repeat (event data) ............................................................... 1-28
report .................................................................................... 9-16
report channel ...................................................................... 9-18
report data ............................................................................ 1-23, 1-26, 1-30, 12-7
report data keyword examples ......................................... 9-23
report data keywords ........................................................ 9-21
report display ........................................................................ 4-25
report file (format) ............................................................... App-7
report function ....................................................................... 1-49
report groups ......................................................................... 9-18
report template ..................................................................... 1-51, 6-24, 9-19
RESET ................................................................................... 9-10
reset (TLOG) ........................................................................ 1-48
 resets the computed result (Rst+St) ...................................... 9-14
reset the sum value ............................................................. 3-18
resetting the computed results ............................................ 9-15
resetting the match time timer ............................................ 7-6
resetting the relative timer ................................................ 7-5, 7-6

Index